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Teil I
Erste Schritte

In diesem Teil enthaltene Kapitel:

• Einführung in die Abfüllung mit der Auswerteelektronik für Masseabfüllung
• Schnellstart mittels ProLink II

• Schnellstart mittels PROFIBUS EDD

• Schnellstart mit PROFIBUS-Parameter
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1 Einführung in die Abfüllung mit der 
Auswerteelektronik für Masseabfüllung
In diesem Kapitel behandelte Themen:

• Die Auswerteelektronik für Masseabfüllung von Micro Motion

• Befüllungsart mit Fülloptionen

• Optionen für Bedieninterface

1.1 Die Auswerteelektronik für Masseabfüllung von
Micro Motion
Die Auswerteelektronik für Masseabfüllung eignet sich für jedes Verfahren, das bei 
der Abfüllung oder der Dosierung höchste Genauigkeit erfordert.

Zusammen mit einem Coriolis-Sensor von Micro Motion kann die Auswerteelektronik für 
Masseabfüllung für massenbasierte Messungen eingesetzt werden, die durch 
Veränderungen des Prozessmediums, der Temperatur oder des Drucks unbeeinflusst 
bleiben. Abfüllungen mit integrierter Ventilsteuerung werden mittels hochpräzisen 
Binärausgängen realisiert, um so schnellstmögliche Ansprechzeiten des Ventils zu 
erhalten. Die automatische Überfüllkompensation passt das System so an, dass 
Verarbeitungsverzögerungen bei der Ventilsteuerung minimiert werden. 
Volumenbasierte Abfüllungen sind ebenfalls möglich.

Die Auswerteelektronik für Masseabfüllung vereint alle erweiterten 
digitalen Singalverarbeitungsalgorithmen, Diagnose und Merkmale der 
Produktfamilie Micro Motion von Auswerteelektroniken.

1.2 Befüllungsart mit Fülloptionen
Je nach Bestelloption unterstützt die Auswerteelektronik für Masseabfüllung entweder 
Befüllungen mit integrierter oder mit externer Ventilsteuerung. Bei Installationen mit 
integrierter Ventilsteuerung gibt es fünf Arten von Befüllungen mit integrierter 
Ventilsteuerung und drei Befüllungsoptionen. Jede Befüllungsart und Kombination 
verfügt über unterschiedliche Ausgangsanforderungen und wird unterschiedlich 
konfiguriert.

Abfüllarten und BeschreibungenTabelle 1-1:   

Modellcode der Auswer-
teelektronik Unterstützte Abfüllarten Beschreibung

FMT*P

FMT*Q

Externe Ventilsteuerung Die Auswerteelektronik misst den Durchfluss und sendet die
Durchflussdaten über den Frequenz-/Impulsausgang an einen
Host. Der Host öffnet und schließt die Ventile und führt eine
Messung der Abfüllmengen durch. Die Auswerteelektronik er-
kennt keine Abfüllanwendung.

Einführung in die Abfüllung mit der Auswerteelektronik für Masseabfüllung
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Abfüllarten und Beschreibungen (Fortsetzung)Tabelle 1-1:   

Modellcode der Auswer-
teelektronik Unterstützte Abfüllarten Beschreibung

FMT*R

FMT*S

FMT*T

FMT*U

FMT*V

Integrierte Ventilsteuer-
ung

Der Host leitet die Abfüllung ein. Die Auswerteelektronik setzt
den Abfüll-Gesamtzähler zurück, öffnet die Ventile, führt Mes-
sungen der Abfüllmenge durch und schließt die Ventile.

Einstufig diskret Die Abfüllung wird von einem einzelnen diskreten Ventil (EIN/
AUS) gesteuert. Das Ventil öffnet vollständig, wenn die Abfül-
lung beginnt, und schließt vollständig, wenn Fill Target erreicht
ist bzw. die Abfüllung angehalten oder beendet wird.

Zweistufig diskret Die Abfüllung wird von zwei diskreten Ventilen gesteuert: ei-
nem primären und einem sekundären Ventil. Ein Ventil muss
beim Beginn der Abfüllung öffnen und das andere öffnet bei ei-
nem vom Anwender definierten Punkt. Ein Ventil muss bis zum
Ende der Abfüllung geöffnet bleiben und das andere schließt
bei einem vom Anwender definierten Punkt.

Zeitgesteuert Der Ventil ist für eine bestimmte Anzahl von Sekunden geöf-
fnet.

Doppelter Füllkopf Abfüllsequenz:
1. Behälter Nr. 1 wird in Position gebracht.
2. Füllkopf Nr. 1 beginnt mit der Abfüllung von Behälter Nr. 1,

und Behälter Nr. 2 wird in Position gebracht.
3. Abfüllung Nr. 1 wird beendet. Füllkopf Nr. 2 beginnt mit

der Abfüllung von Behälter Nr. 2. Behälter Nr. 1 wird durch
einen neuen Behälter ersetzt.

Einstufige Standard-Abfüllsteuerung wird auf beide Abfüllun-
gen angewendet: Das Ventil öffnet vollständig, wenn die Ab-
füllung beginnt, und schließt vollständig, wenn Fill Target er-
reicht ist bzw. die Abfüllung angehalten oder beendet wird.

Doppelter Füllkopf,
zeitgesteuert

Abfüllsequenz:
1. Behälter Nr. 1 wird in Position gebracht.
2. Füllkopf Nr. 1 beginnt mit der Abfüllung von Behälter Nr. 1,

und Behälter Nr. 2 wird in Position gebracht.
3. Abfüllung Nr. 1 wird beendet. Füllkopf Nr. 2 beginnt mit

der Abfüllung von Behälter Nr. 2. Behälter Nr. 1 wird durch
einen neuen Behälter ersetzt.

Zeitsteuerung wird auf beide Abfüllungen angewendet: Jedes
Ventil wird für eine bestimmte Anzahl von Sekunden geöffnet.

Abfüllarten und BeschreibungenTabelle 1-2:   

Option Beschreibung Kompatibilität

Spülen Die Spülfunktion wird verwendet, um ein Hilfsventil zu
steuern, das nicht für die Abfüllung eingesetzt wird. Beis-
pielsweise kann damit ein Behälter mit Wasser oder Gas
aufgefüllt werden, nachdem der Füllvorgang abgeschlos-
sen ist, oder sie kann als “ Dämpfung dienen.” Der Durch-
fluss durch das Hilfsventil wird von der Auswerteelektronik
nicht gemessen.

Kompatibel mit:

• Einstufigen diskreten Abfüllungen
• Zweistufigen diskreten Abfüllun-

gen
• Zeitgesteuerten Abfüllungen

Einführung in die Abfüllung mit der Auswerteelektronik für Masseabfüllung
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Abfüllarten und Beschreibungen (Fortsetzung)Tabelle 1-2:   

Option Beschreibung Kompatibilität

Pumpe Die Pumpfunktion wird verwendet, um den Druck während
der Abfüllung zu erhöhen, indem eine in Flussrichtung
liegende Pumpe kurz vor dem Beginn der Abfüllung ges-
tartet wird.

Kompatibel mit:

• Einstufigen diskreten Abfüllungen

Automatische
Überfüllkompen-
sation (AOC)

Die automatische Überfüllkompensation (AOC) wird ver-
wendet, um die Abfüllzeit anzupassen und um für die Zeit
zu kompensieren, die benötigt wird, den Befehl zum
Schließen des Ventils zu übertragen bzw. damit das Ventil
vollständig schließt.

Kompatibel mit:

• Einstufigen diskreten Abfüllungen
• Zweistufigen diskreten Abfüllun-

gen
• Abfüllungen mit doppeltem Füll-

kopf

1.2.1 E/A-Anforderungen
Um eine bestimmte Befüllungsart und -option zu implementieren, müssen die binären
Ausgänge der Auswerteelektronik mit den entsprechenden Ventilen oder Geräten
verdrahtet und konfiguriert werden.

E/A-Anforderungen für Befüllungsarten und -optionenTabelle 1-3:   

Befüllart
Präzisions-
BA1

Präzisions-
BA2

Kanal B wird
als BA betrie-
ben mA-Ausgang

Frequen-
zausgang

Externe Ventilsteuerung – – Nach Wunsch – Zum Host

Integrierte
Ventilsteuer-
ung

Einstufig diskret Primärventil – – Nach Wunsch –

Einstufig binär mit
Spülzyklus

Primärventil – Spülventil Nach Wunsch –

Einstufig binär mit
Pumpe

Primärventil Pumpe Nach Wunsch Nach Wunsch –

Zweistufig binär Primärventil Sekundärven-
til

Nach Wunsch Nach Wunsch –

Zweistufig binär mit
Spülzyklus

Primärventil Sekundärven-
til

Spülventil Nach Wunsch –

Zeitgesteuert Primärventil – Nach Wunsch Nach Wunsch –

Zeitgesteuert mit
Spülung

Primärventil – Spülventil Nach Wunsch –

Doppelter Füllkopf Ventil in
Füllkopf 1

Ventil in
Füllkopf 2

Nach Wunsch Nach Wunsch –

Zeitgesteuerter dop-
pelter Füllkopf

Ventil in
Füllkopf 1

Ventil in
Füllkopf 2

Nach Wunsch Nach Wunsch –

Einführung in die Abfüllung mit der Auswerteelektronik für Masseabfüllung
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1.3 Optionen für Bedieninterface
Die Optionen für das Bedieninterface und den Abfüllvorgang richten sich nach dem von
der Auswerteelektronik unterstützten Protokoll. Das Protokoll ergibt sich aus dem
Modellcode der Auswerteelektronik.

Optionen für Auswerteelektronik-Protokoll und BedieninterfaceTabelle 1-4:   

Modellcode der Aus-
werteelektronik

Unterstütztes Proto-
koll

Bedieninterface-Optionen

Konfiguration, Wartung und
Fehlersuche- und beseitigung Abfüllvorgang

FMT*P

FMT*R

FMT*S

FMT*T

Modbus • ProLink II
• Modbus-Hilfsprogramm

• ProLink II
• Modbus-Host

FMT*Q

FMT*U

FMT*V

PROFIBUS-DP • ProLink II
• EDD
• Busparameter

• ProLink II
• EDD
• GSD
• Busparameter

Einführung in die Abfüllung mit der Auswerteelektronik für Masseabfüllung
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2 Schnellstart mittels ProLink II
In diesem Kapitel behandelte Themen:

• Einschalten der Auswerteelektronik

• Status des Durchfluss-Messsystems prüfen

• Herstellen einer Verbindung von ProLink II zur Auswerteelektronik

• Abschluss der Konfiguration und Inbetriebnahme

2.1 Einschalten der Auswerteelektronik
Die Auswerteelektronik muss für alle Konfigurations- und Inbetriebnahmeaufgaben sowie
für Prozessmessungen eingeschaltet sein.

1. Den entsprechenden Verfahren folgen, um sicherzustellen, dass ein neues im
Netzwerk befindliches Gerät nicht die bestehenden Messungen und Messkreise
stört.

2. Sicherstellen, dass die Kabel an die Auswerteelektronik, wie in Micro Motion FMT
Auswerteelektronik für Masseabfüllung: Installationsanleitung beschrieben,
angeschlossen sind.

3. Stellen Sie sicher, dass alle Auswerteelektronik und Sensor Gehäusedeckel sowie
Verschlüsse geschlossen sind.

VORSICHT!

Sicherstellen, dass alle Gehäusedeckel und Dichtungen dicht verschlossen sind, um eine
Entzündung in einer brennbaren Umgebung zu vermeiden. Bei Installationen in
explosionsgefährdeten Bereichen und mit geöffneten Gehäusedeckeln kann das
Einschalten der Stromversorgung zu einer Explosion führen.

4. Schalten Sie die Spannungsversorgung ein.

Die Auswerteelektronik führt automatisch Diagnoseroutinen durch. In dieser
Zeitspanne ist Alarm 009 aktiv. Die Diagnoseroutinen sind in ungefähr 30 Sekunden
abgeschlossen.

Nachbereitungsverfahren

Obwohl der Sensor bereits kurz nach dem Startvorgang das Prozessmedium verarbeiten
kann, kann die Elektronik bis zu 10 Minuten benötigen, um ein thermisches Gleichgewicht
zu erreichen. Aus diesem Grund kann es bei dem erstmaligen Startvorgang bzw. bei einer
Abschaltung, die so lange gedauert hat, dass die Komponenten die
Umgebungstemperatur annehmen konnten, ungefähr 10 Minuten dauern, bis sich die
Elektronik erwärmt hat und zuverlässige Prozessmessungen liefert. Während dieser
Warmlaufphase kann es sein, dass Sie geringfügige Instabilitäten oder Ungenauigkeiten
der Messung feststellen.

Schnellstart mittels ProLink II
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2.2 Status des Durchfluss-Messsystems prüfen
Das Durchfluss-Messsystem auf jegliche Störbedingungen prüfen, die eine Aktion des
Anwenders erforderlich machen oder die die Messgenauigkeit beeinflussen.

1. Ca. 10 Sekunden warten, bis der Startvorgang abgeschlossen ist.

Sofort nach dem Startvorgang durchläuft die Auswerteelektronik Diagnoseroutinen
und prüft auf Störbedingungen. Während des Startvorgangs ist Alarm A009 aktiv.
Dieser Alarm sollte nach dem Startvorgang automatisch gelöscht werden.

2. Eine Verbindung mit der Auswerteelektronik herstellen und auf aktive Alarme
prüfen.

Nachbereitungsverfahren

Weitere Informationen bzgl. der Anzeige der Liste aktiver Alarme sind unter Abschnitt 18.3
zu finden.

Weitere Informationen bzgl. der einzelnen Alarme und empfohlener Maßnahmen sind
unter Abschnitt 20.1 zu finden.

2.3 Herstellen einer Verbindung von ProLink II zur
Auswerteelektronik
Durch das Herstellen einer Verbindung mittels ProLink II können Sie Prozessdaten
anzeigen, ProLink II verwenden, um die Auswerteelektronik zu konfigurieren,
wartungstechnische und fehlerbehebende Aufgaben durchführen oder einen
Abfüllvorgang ausführen.

Vorbereitungsverfahren

Folgende Systeme müssen installiert und einsatzbereit sein:

• ProLink II v2.91 oder höher

• ProLink II Installationskit für Modbus/RS-485-Verbindungen

Verfahren

1. Schließen Sie die Kabel des Signalwandlers an die Kabel an, die an den RS-485
angeschlossen sind, oder an die Serviceport-Pins an der Auswerteelektronik.
Weitere Informationen finden Sie im Micro Motion FMT Auswerteelektronik für
Masseabfüllung: Installationsanleitung .

2. Starten Sie ProLink II und wählen Connect > Connect to Device.

3. Geben Sie im Dialogfeld Connection die hier dargestellten Parameter ein und klicken
dann auf Connect.

Verbindungsparameter

Protokoll der Auswerteelektronik

Modbus PROFIBUS-DP

Protocol Modbus RTU Service Port

COM Port Der Port an Ihrem PC, den Sie
für diese Verbindung ver-
wenden

Der Port an Ihrem PC, den Sie
für diese Verbindung ver-
wenden

Schnellstart mittels ProLink II
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Verbindungsparameter

Protokoll der Auswerteelektronik

Modbus PROFIBUS-DP

Address Konfigurierte Modbus-
Adresse der Auswerteelek-
tronik (Voreinstellung = 1)

–

Anmerkung
Die Auswerteelektronik analysiert automatisch die eingehende Verbindungsanfrage und
beantwortet alle Verbindungsanfragen mit einer beliebigen Einstellung für Parität und
Stoppbits und allen Netzwerkgeschwindigkeiten zwischen 1200 und 38.400 Baud. Sie
brauchen keine Werte für diese Verbindungsparameter einrichten.

Zeigt ProLink II den Bildschirm Process Variables bei erfolgreicher Verbindung an.

Benötigen Sie Hilfe?  Falls eine Fehlermeldung angezeigt wird:

• Stellen Sie sicher, dass Sie den korrekten COM-Port angegeben haben.

• Prüfen Sie die gesamte Verkabelung zwischen PC und Auswerteelektronik.

• Setzen Sie an beiden Enden des Segments 1/2-Watt-Abschlusswiderstände mit 120 Ω ein.

2.4 Abschluss der Konfiguration und
Inbetriebnahme
Verwenden Sie das folgende Verfahren als allgemeine Richtlinien, um die Konfiguration
und Inbetriebnahme der Auswerteelektronik abzuschließen.

1. Konfigurieren Sie die Abfüllung.

• Siehe Kapitel 8 bzgl. Abfüllung mit integrierter Ventilsteuerung.

• Siehe Kapitel 13 bzgl. Abfüllung mit externer Ventilsteuerung.

2. Führen Sie alle erforderlichen Konfigurationen der Auswerteelektronik durch, die
sich nicht speziell auf die Abfüllung beziehen.

Siehe Kapitel 15, Kapitel 16 und Kapitel 17.

2.4.1 Testen oder Anpassen des Systems mittels
Sensorsimulation
Verwenden Sie Sensor Simulation, um die Reaktion des Systems auf eine Vielzahl von
Prozessbedingungen zu testen. Dazu gehören Grenz-, Problem- und Alarmbedingungen
sowie die Abstimmung des Messkreises.

Vorbereitungsverfahren

Bevor Sie die Sensor Simulation aktivieren, stellen Sie sicher, dass der Prozess die
Auswirkungen der simulierten Prozesswerte tolerieren kann.

Verfahren

1. Navigieren Sie zum Sensorsimulationsmenü.

Schnellstart mittels ProLink II
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Kommunikations-Hilfsmittel Menüpfad

ProLink II ProLink > Configuration > Sensor Simulation

ProLink III Device Tools > Diagnostics > Testing > Sensor Simulation

2. Aktivieren Sie die Sensor Simulation.

3. Für Massedurchfluss setzen Sie Wellenform wie gewünscht und geben Sie die
erforderlichen Werte ein.

Option Erforderliche Werte

Fixed Fester Wert

Sawtooth Periode

Minimum

Maximum

Sine Periode

Minimum

Maximum

4. Für Dichte setzen Sie Wellenform wie gewünscht und geben Sie die erforderlichen
Werte ein.

Option Erforderliche Werte

Fixed Fester Wert

Sawtooth Periode

Minimum

Maximum

Sine Periode

Minimum

Maximum

5. Für Temperatur setzen Sie Wellenform wie gewünscht und geben Sie die
erforderlichen Werte ein.

Option Erforderliche Werte

Fixed Fester Wert

Sawtooth Periode

Minimum

Maximum

Sine Periode

Minimum

Maximum

6. Beobachten Sie die Reaktion des Systems auf die simulierten Werte und nehmen Sie
nach Bedarf entsprechende Änderungen an der Konfiguration der
Auswerteelektronik oder am System vor.

Schnellstart mittels ProLink II
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7. Modifizieren Sie die simulierten Werte und wiederholen Sie die
Simulationsverfahren.

8. Nachdem Sie alle Test- oder Simulationsverfahren abgeschlossen haben,
deaktivieren Sie die Sensor Simulation.

Sensorsimulation
Mit der Sensorsimulation können Sie das System testen oder den Messkreis einstellen,
ohne die Testbedingungen in Ihrem Prozess erstellen zu müssen. Bei aktivierter
Sensorsimulation gibt die Auswerteelektronik die simulierten Werte für Massedurchfluss,
Dichte und Temperatur aus und ergreift alle erforderlichen Maßnahmen. Beispielsweise
kann die Auswerteelektronik eine Abschaltung durchführen, ein Ereignis aktivieren oder
einen Alarm setzen.

Ist der Simulationsmodus aktiv, werden die simulierten Werte im gleichen Speicher wie die
Prozessdaten vom Sensor abgelegt. Dann werden die simulierten Werte während des
Betriebs der Auswerteelektronik verwendet. Zum Beispie beeinflusst die Simulation:

• Alle Werte wie Massedurchfluss, Temperatur oder Dichte, die auf dem Display
angezeigt oder mittels Ausgängen oder digitaler Kommunikation ausgegeben
werden

• Die Summen- und Gesamtzähler für Masse

• Alle Volumenberechnungen und Daten, inkl. ausgegebener Werte, Volumen-
Summenzähler und Volumen-Gesamtzähler

• Alle im Datenlogger gespeicherten Werte für Masse, Dichte oder Volumen

Die Sensorsimulation ändert keine Diagnosewerte.

Im Gegensatz zu tatsächlichen Massedurchfluss- und Dichtewerten sind die simulierten
Werte nicht temperaturkompensiert (d. h. angepasst an den Temperatureinfluss auf die
Sensormessrohre).

2.4.2 Backup der Auswerteelektronik Konfiguration
ProLink II und ProLink III bieten Upload- und Download-Funktionen für die Konfiguration,
um Konfigurationssätze auf Ihrem PC zu speichern. Dies ermöglicht ein Sichern und
Wiederherstellen der Auswerteelektronik Konfiguration. Außerdem ist dies eine bequeme
Methode, um eine Konfiguration über mehrere Geräte hinweg zu zu reproduzieren.

Vorbereitungsverfahren

Eine der folgenden Versionen:

• Eine aktive Verbindung von ProLink II

• Eine aktive Verbindung von ProLink III

Einschränkung
Diese Funktion ist mit keinem anderen Kommunikations-Hilfsmittel verfügbar.

Verfahren

• Sichern der Auswerteelektronik Konfiguration mittels ProLink II:

1. File > . Load from Xmtr to File auswählen.

Schnellstart mittels ProLink II
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2. Einen Namen und einen Speicherort für die Sicherungsdatei auswählen und auf
Save klicken.

3. Die Optionen auswählen, die die Sicherungsdatei enthalten soll, und auf Download
Configuration klicken.

• Backup der Auswerteelektronik Konfiguration mittels ProLink III:

1. Device Tools > Configuration Transfer > Save or Load Configuration Data auswählen.

2. Im Gruppenfeld Configuration die Konfigurationsdaten auswählen, die gesichert
werden sollen.

3. Auf Save klicken und den Dateinamen und den Speicherort auf Ihrem Computer
auswählen.

4. Klicken Sie auf Start Save.

Die Sicherungsdatei wird mit dem ausgewählten Namen und an dem ausgewählten
Speicherort gespeichert. Sie wird als Textdatei gespeichert und kann mittels beliebigem
Text-Editor geöffnet werden.

2.4.3 Werkskonfiguration wiederherstellen

ProLink II ProLink > Configuration > Device > Werkskonfiguration wiederherstellen

ProLink III Geräte Extras > Konfigurationsübertragung > Restore Factory Configuration

Überblick

Das Wiederherstellen der Werkskonfiguration versetzt die Auswerteelektronik in eine
bekannte Betriebskonfiguration. Dies kann hilfreich sein, wenn während der Konfiguration
Probleme auftreten.

Hinweis
Die Wiederherstellung der Werkskonfiguration ist keine Aktion, die häufig durchgeführt werden
sollte. Wenn Sie einen diesbezüglichen Bedarf erkennen, sollten Sie sich an Micro Motion wenden,
um in Erfahrung zu bringen, ob für die Lösung bestimmter Probleme eine bevorzugte Methode
existiert.

Schnellstart mittels ProLink II
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3 Schnellstart mittels PROFIBUS EDD
In diesem Kapitel behandelte Themen:

• Einschalten der Auswerteelektronik

• Status des Durchfluss-Messsystems prüfen

• Einrichten der PROFIBUS EDD

• Machen Sie eine PROFIBUS EDD Verbindung zum Sender

• Abschluss der Konfiguration und Inbetriebnahme

3.1 Einschalten der Auswerteelektronik
Die Auswerteelektronik muss für alle Konfigurations- und Inbetriebnahmeaufgaben sowie
für Prozessmessungen eingeschaltet sein.

1. Den entsprechenden Verfahren folgen, um sicherzustellen, dass ein neues im
Netzwerk befindliches Gerät nicht die bestehenden Messungen und Messkreise
stört.

2. Sicherstellen, dass die Kabel an die Auswerteelektronik, wie in Micro Motion FMT
Auswerteelektronik für Masseabfüllung: Installationsanleitung beschrieben,
angeschlossen sind.

3. Stellen Sie sicher, dass alle Auswerteelektronik und Sensor Gehäusedeckel sowie
Verschlüsse geschlossen sind.

VORSICHT!

Sicherstellen, dass alle Gehäusedeckel und Dichtungen dicht verschlossen sind, um eine
Entzündung in einer brennbaren Umgebung zu vermeiden. Bei Installationen in
explosionsgefährdeten Bereichen und mit geöffneten Gehäusedeckeln kann das
Einschalten der Stromversorgung zu einer Explosion führen.

4. Schalten Sie die Spannungsversorgung ein.

Die Auswerteelektronik führt automatisch Diagnoseroutinen durch. In dieser
Zeitspanne ist Alarm 009 aktiv. Die Diagnoseroutinen sind in ungefähr 30 Sekunden
abgeschlossen.

Nachbereitungsverfahren

Obwohl der Sensor bereits kurz nach dem Startvorgang das Prozessmedium verarbeiten
kann, kann die Elektronik bis zu 10 Minuten benötigen, um ein thermisches Gleichgewicht
zu erreichen. Aus diesem Grund kann es bei dem erstmaligen Startvorgang bzw. bei einer
Abschaltung, die so lange gedauert hat, dass die Komponenten die
Umgebungstemperatur annehmen konnten, ungefähr 10 Minuten dauern, bis sich die
Elektronik erwärmt hat und zuverlässige Prozessmessungen liefert. Während dieser
Warmlaufphase kann es sein, dass Sie geringfügige Instabilitäten oder Ungenauigkeiten
der Messung feststellen.

Schnellstart mittels PROFIBUS EDD
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3.2 Status des Durchfluss-Messsystems prüfen
Das Durchfluss-Messsystem auf jegliche Störbedingungen prüfen, die eine Aktion des
Anwenders erforderlich machen oder die die Messgenauigkeit beeinflussen.

1. Ca. 10 Sekunden warten, bis der Startvorgang abgeschlossen ist.

Sofort nach dem Startvorgang durchläuft die Auswerteelektronik Diagnoseroutinen
und prüft auf Störbedingungen. Während des Startvorgangs ist Alarm A009 aktiv.
Dieser Alarm sollte nach dem Startvorgang automatisch gelöscht werden.

2. Eine Verbindung mit der Auswerteelektronik herstellen und auf aktive Alarme
prüfen.

Nachbereitungsverfahren

Weitere Informationen bzgl. der Anzeige der Liste aktiver Alarme sind unter Abschnitt 18.3
zu finden.

Weitere Informationen bzgl. der einzelnen Alarme und empfohlener Maßnahmen sind
unter Abschnitt 20.1 zu finden.

3.3 Einrichten der PROFIBUS EDD
Die PROFIBUS EDD (Electronic Device Description) unterstützt die azyklische
Kommunikation zwischen der Auswerteelektronik und einem PROFIBUS Host. Mittels der
EDD können Sie die Auswerteelektronik konfigurieren sowie manuelle Betriebs- und
Wartungsfunktionen durchführen.

1. Laden Sie die für Ihre Auswerteelektronik spezifische EDD von der Emerson Website
herunter.

a. Öffnen Sie www.micromotion.com im Browser.

b. Klicken Sie in der Liste Quick Links auf Software Downloads und navigieren Sie zur
Seite „Device Drivers“.

c. Gehen Sie zum Geräte-Installationskit für Ihre Auswerteelektronik, wählen Sie die
EDD und laden Sie die Datei auf Ihren PC herunter.

2. Importieren Sie die EDD in Ihren PROFIBUS Host.

3. Konfigurieren Sie Ihren PROFIBUS Host mit der Netzknotenadresse der
Auswerteelektronik und anderen erforderlichen Daten.

Hinweis
Knotenadresse des Senders wurde während der Installation festgelegt Sender. Sehen
Micro Motion FMT Auswerteelektronik für Masseabfüllung: Installationsanleitung für weitere
Informationen.

Schnellstart mittels PROFIBUS EDD
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3.4 Machen Sie eine PROFIBUS EDD Verbindung
zum Sender
Durch die Herstellung einer PROFIBUS EDD Verbindung kann ein PROFIBUS-tool verwendet
werden, um Prozessdaten anzuzeigen, die Auswerteelektronik zu konfigurieren oder
wartungstechnische und fehlerbehebende Aufgaben bzw. einen Befüllvorgang
auszuführen.

Vorbereitungsverfahren

Muss ein PROFIBUS-Konfigurationstool, wie Siemens Simatic PDM haben.

EDD muss von Micro Motion installiert werden. Micro Motion.

Verfahren

1. Führen Sie Ihre PROFIBUS-Konfiguration-Tool.

2. Schließen Sie den Sender mit den entsprechenden Methoden für Ihre Umwelt.

Hinweis
Knotenadresse des Senders wurde während der Installation festgelegt Sender. Sehen
Micro Motion FMT Auswerteelektronik für Masseabfüllung: Installationsanleitung für weitere
Informationen.

3.5 Abschluss der Konfiguration und
Inbetriebnahme
Verwenden Sie das folgende Verfahren als allgemeine Richtlinien, um die Konfiguration
und Inbetriebnahme der Auswerteelektronik abzuschließen.

1. Konfigurieren Sie die Abfüllung.

• Siehe Kapitel 8 bzgl. Abfüllung mit integrierter Ventilsteuerung.

• Siehe Kapitel 13 bzgl. Abfüllung mit externer Ventilsteuerung.

2. Führen Sie alle erforderlichen Konfigurationen der Auswerteelektronik durch, die
sich nicht speziell auf die Abfüllung beziehen.

Siehe Kapitel 15, Kapitel 16 und Kapitel 17.

Schnellstart mittels PROFIBUS EDD
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4 Schnellstart mit PROFIBUS-Parameter
In diesem Kapitel behandelte Themen:

• Einschalten der Auswerteelektronik

• Status des Durchfluss-Messsystems prüfen

• Machen Sie eine PROFIBUS Busparameter Verbindung zum Sender

• Abschluss der Konfiguration und Inbetriebnahme

4.1 Einschalten der Auswerteelektronik
Die Auswerteelektronik muss für alle Konfigurations- und Inbetriebnahmeaufgaben sowie
für Prozessmessungen eingeschaltet sein.

1. Den entsprechenden Verfahren folgen, um sicherzustellen, dass ein neues im
Netzwerk befindliches Gerät nicht die bestehenden Messungen und Messkreise
stört.

2. Sicherstellen, dass die Kabel an die Auswerteelektronik, wie in Micro Motion FMT
Auswerteelektronik für Masseabfüllung: Installationsanleitung beschrieben,
angeschlossen sind.

3. Stellen Sie sicher, dass alle Auswerteelektronik und Sensor Gehäusedeckel sowie
Verschlüsse geschlossen sind.

VORSICHT!

Sicherstellen, dass alle Gehäusedeckel und Dichtungen dicht verschlossen sind, um eine
Entzündung in einer brennbaren Umgebung zu vermeiden. Bei Installationen in
explosionsgefährdeten Bereichen und mit geöffneten Gehäusedeckeln kann das
Einschalten der Stromversorgung zu einer Explosion führen.

4. Schalten Sie die Spannungsversorgung ein.

Die Auswerteelektronik führt automatisch Diagnoseroutinen durch. In dieser
Zeitspanne ist Alarm 009 aktiv. Die Diagnoseroutinen sind in ungefähr 30 Sekunden
abgeschlossen.

Nachbereitungsverfahren

Obwohl der Sensor bereits kurz nach dem Startvorgang das Prozessmedium verarbeiten
kann, kann die Elektronik bis zu 10 Minuten benötigen, um ein thermisches Gleichgewicht
zu erreichen. Aus diesem Grund kann es bei dem erstmaligen Startvorgang bzw. bei einer
Abschaltung, die so lange gedauert hat, dass die Komponenten die
Umgebungstemperatur annehmen konnten, ungefähr 10 Minuten dauern, bis sich die
Elektronik erwärmt hat und zuverlässige Prozessmessungen liefert. Während dieser
Warmlaufphase kann es sein, dass Sie geringfügige Instabilitäten oder Ungenauigkeiten
der Messung feststellen.

Schnellstart mit PROFIBUS-Parameter
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4.2 Status des Durchfluss-Messsystems prüfen
Das Durchfluss-Messsystem auf jegliche Störbedingungen prüfen, die eine Aktion des
Anwenders erforderlich machen oder die die Messgenauigkeit beeinflussen.

1. Ca. 10 Sekunden warten, bis der Startvorgang abgeschlossen ist.

Sofort nach dem Startvorgang durchläuft die Auswerteelektronik Diagnoseroutinen
und prüft auf Störbedingungen. Während des Startvorgangs ist Alarm A009 aktiv.
Dieser Alarm sollte nach dem Startvorgang automatisch gelöscht werden.

2. Eine Verbindung mit der Auswerteelektronik herstellen und auf aktive Alarme
prüfen.

Nachbereitungsverfahren

Weitere Informationen bzgl. der Anzeige der Liste aktiver Alarme sind unter Abschnitt 18.3
zu finden.

Weitere Informationen bzgl. der einzelnen Alarme und empfohlener Maßnahmen sind
unter Abschnitt 20.1 zu finden.

4.3 Machen Sie eine PROFIBUS Busparameter
Verbindung zum Sender
Durch die Herstellung einer PROFIBUS EDD Verbindung kann ein PROFIBUS-tool verwendet
werden, um Prozessdaten anzuzeigen, die Auswerteelektronik zu konfigurieren oder
wartungstechnische und fehlerbehebende Aufgaben bzw. einen Befüllvorgang
auszuführen..

Vorbereitungsverfahren

Sie müssen über einen kompatiblen PROFIBUS-Tool Lese Dienstleistungen und DP-V1-
Schreiben..

Verfahren

1. Führen Sie Ihr Werkzeug PROFIBUS.

2. Schließen Sie den Sender mit den entsprechenden Methoden für Ihre Umwelt.

Hinweis
Knotenadresse des Senders wurde während der Installation festgelegt Sender. Sehen
Micro Motion FMT Auswerteelektronik für Masseabfüllung: Installationsanleitung für weitere
Informationen.

4.4 Abschluss der Konfiguration und
Inbetriebnahme
Verwenden Sie das folgende Verfahren als allgemeine Richtlinien, um die Konfiguration
und Inbetriebnahme der Auswerteelektronik abzuschließen.

1. Konfigurieren Sie die Abfüllung.

Schnellstart mit PROFIBUS-Parameter
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• Siehe Kapitel 8 bzgl. Abfüllung mit integrierter Ventilsteuerung.

• Siehe Kapitel 13 bzgl. Abfüllung mit externer Ventilsteuerung.

2. Führen Sie alle erforderlichen Konfigurationen der Auswerteelektronik durch, die
sich nicht speziell auf die Abfüllung beziehen.

Siehe Kapitel 15, Kapitel 16 und Kapitel 17.

4.4.1 Wiederherstellen der Werkskonfiguration mittels
PROFIBUS Busparameter
Das Wiederherstellen der Werkskonfiguration versetzt die Auswerteelektronik in eine
bekannte Betriebskonfiguration. Dies kann hilfreich sein, wenn während der Konfiguration
Probleme auftreten.

Vorbereitungsverfahren

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, das DP-V1 Lese- und
Schreibdienste unterstützt, und Sie müssen eine Verbindung mit der Auswerteelektronik
hergestellt haben.

Verfahren

Schreiben Sie ein in die Diagnose-Block, 51-Index.

Schnellstart mit PROFIBUS-Parameter
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Teil II
Konfigurieren und Durchführen von
Abfüllungen mit integrierter
Ventilsteuerung

In diesem Teil enthaltene Kapitel:

• Vorbereiten der Konfiguration einer integrierten Abfüll-Ventilsteuerung

• Konfigurieren einer integrierten Abfüll-Ventilsteuerung mittels ProLink II

• Abfüllvorgang mittels ProLink II

• Konfigurieren einer integrierten Abfüll-Ventilsteuerung mittels PROFIBUS EDD

• Abfüllverfahren mittels PROFIBUS EDD

• Konfigurieren einer integrierten Abfüll-Ventilsteuerung mittels PROFIBUS
Busparametern

• Abfüllverfahren mittels PROFIBUS Busparametern

Konfigurieren und Durchführen von Abfüllungen mit integrierter Ventilsteuerung
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5 Vorbereiten der Konfiguration einer
integrierten Abfüll-Ventilsteuerung
In diesem Kapitel behandelte Themen:

• Allgemeines Verfahren zur Konfiguration und Durchführung einer Abfüllung mit
integrierter Ventilsteuerung

• Tipps und Tricks zum Konfigurieren der Abfüllung mit integrierter
Ventilsteuerung

Vorbereiten der Konfiguration einer integrierten Abfüll-Ventilsteuerung
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5.1 Allgemeines Verfahren zur Konfiguration und
Durchführung einer Abfüllung mit integrierter
Ventilsteuerung

Konfigurieren und Durchführen einer Abfüllung mit integrierter VentilsteuerungAbbildung 5-1:   

Konfigurieren fill

Konfigurieren fill Optionen

Konfigurieren fill Kontrollmethoden

Konfigurieren fill Reporting-
Methoden

Wählen Sie füllen Typ

Füllen
Operationsmethode Automatisch

Wählen Bedienungswerkzeug

Führen fill

Einrichten und Programm-Host

Führen fill

Wählen Sie Konfigurationstool

Handbuch

5.2 Tipps und Tricks zum Konfigurieren der
Abfüllung mit integrierter Ventilsteuerung
Folgende Einstellungen überprüfen, bevor mit der Füllkonfiguration begonnen wird:

Vorbereiten der Konfiguration einer integrierten Abfüll-Ventilsteuerung
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• Zur Konfiguration einer Abfüllung mit den werksseitigen Standardeinstellungen
beginnen. Andernfalls können bestimmte Parameterkombinationen von der
Auswerteelektronik abgelehnt werden. Siehe Abschnitt 5.2.1.

• Die Einstellungen für Mass Flow Cutoff oder Volume Flow Cutoff sind für die
Abfüllgenauigkeit wichtig. Sicherstellen, dass die entsprechende Abschaltung vor
dem Beginn einer Abfüllung oder vor dem Durchführen einer AOC-Kalibrierung
eingestellt ist. Siehe Abschnitt 15.2.3, wenn Masse zur Messung der Abfüllung
verwendet wird. Siehe Abschnitt 15.3.2, wenn Volumen zur Messung der Abfüllung
verwendet wird.

• Die Einstellung von Flow Direction regelt, wie die Gesamt-Abfüllmenge gemessen
wird. Siehe Auswirkung der Durchflussrichtung auf die Gesamtbefüllung bzgl. der
Abfüllung mit integrierter Ventilsteuerung.

• Die Messung der Abfüllmenge und der Betrieb können durch andere Parameter der
Auswerteelektronik beeinflusst werden. Allgemeine Informationen zur
Konfiguration können unter Kapitel 15, Kapitel 16 und Kapitel 17 eingesehen werden.

• Die Konfiguration der Abfüllung oder die allgemeine Konfiguration der
Auswerteelektronik kann während einer Abfüllung verändert werden. Die Änderung
der Konfiguration wird aktiv, sobald die Abfüllung beendet ist.

5.2.1 Werkseinstellungen für grundlegende
Befüllungsparameter
Zur Konfiguration einer Befüllung beginnen Sie mit den hier aufgeführten
Werkseinstellungen. Andernfalls können bestimmte Parameterkombinationen von der
Auswerteelektronik abgelehnt werden.

Grundlegende Befüllungsparameter und WerkseinstellungenTabelle 5-1:   

Parameter Werkseinstellung

Option Befüllung aktiv Aktiviert

Doppelbefüllung aktiv Deaktiviert

AOC aktiv Aktiviert

Spülung aktiv Deaktiviert

Enable Timed Fill Deaktiviert

Befüllart Einstufig binär

Hochzählen Aktiviert

Konfiguration % Sollwert

Vorbereiten der Konfiguration einer integrierten Abfüll-Ventilsteuerung
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6 Konfigurieren einer integrierten
Abfüll-Ventilsteuerung mittels
ProLink II
In diesem Kapitel behandelte Themen:

• Konfigurieren einer Abfüllung mit integrierter Ventilsteuerung mittels ProLink II

• Konfigurieren von Abfülloptionen mittels ProLink II

• Konfigurieren einer Abfüllsteuerung mittels ProLink II (optional)

• Konfigurieren der Abfüllprotokollierung mittels ProLink II (optional)

6.1 Konfigurieren einer Abfüllung mit integrierter
Ventilsteuerung mittels ProLink II
Die Befüllungsart entsprechend der Anwendung konfigurieren.

Hinweis
Eine einstufige Binärbefüllung eignet sich für die meisten Anwendungen. Diese Befüllungsart
verwenden, soweit keine speziellen Anforderungen für andere Befüllungsarten bestehen. In den
meisten Fällen ist die Auswerteelektronik werksseitig für einstufige Binärbefüllungen konfiguriert
und mit einem Minimum an Konfigurationsanpassungen vor Ort einsatzbereit.

6.1.1 Konfigurieren einer einstufigen Abfüllung mittels
ProLink II
Eine einstufige Binärbefüllung konfigurieren, wenn ein einzelner Behälter von einem
einzelnen Ventil befüllt werden soll. Das Ventil ist solange geöffnet, bis der Befüllungssollwert
erreicht ist.

Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Wählen Sie ProLink > Configuration (Konfiguration) > Discrete Output (Binärausgang).
b. Setzen Sie Precision DO1 auf Primary Valve.

c. Stellen Sie Precision DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Konfigurieren einer integrierten Abfüll-Ventilsteuerung mittels ProLink II
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Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

2. Durchflussmessungen konfigurieren:

a. Öffnen Sie das Fenster Flow (Durchfluss).

b. Flow Direction (Durchflussrichtung) auf die für Ihre Installation angemessene
Option einstellen.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die durch den Pfeil auf dem Sensor angegebene Rich-
tung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der auf dem Sensor durch den Pfeil angegebenen
Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die entgegengesetzte durch den Pfeil auf dem Sensor
angegebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der entgegengesetzten durch den Pfeil auf dem
Sensor angegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

c. Mass Flow Units (Massedurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Mass Flow Rate (Massedurchflussrate)
eingestellt ist, wird die entsprechende Masseeinheit zur Befüllungsmessung
verwendet.

d. Volume Flow Units (Volumendurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Volume Flow Rate
(Volumendurchflussrate) eingestellt ist, wird die entsprechende Volumeneinheit
zur Befüllungsmessung verwendet.

e. Die anderen Durchflussoptionen wie gewünscht einstellen.

Konfigurieren einer integrierten Abfüll-Ventilsteuerung mittels ProLink II
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Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

3. Öffnen Sie das Fenster Filling (Abfüllung).

4. Flow Source (Durchflussquelle) auf die Prozessvariable einstellen, die zur
Befüllungsmessung verwendet werden soll.

Option Beschreibung

Massedurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Massedurchfluss

Volumendurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Volumendurchfluss

5. Folgende Parameter einstellen oder überprüfen:

Parameter Einstellung

Befüllungsoption aktivieren Aktiviert

Doppelbefüllung aktiv Deaktiviert

AOC aktiv Aktiviert

Spülung aktiv Deaktiviert

Enable Timed Fill Deaktiviert

Befüllart Einstufig binär

Hinweis
Micro Motion empfiehlt dringendst die Verwendung der automatischen
Überfüllkompensation (AOC). AOC verbessert, sofern aktiviert und kalibriert, die
Befüllgenauigkeit und Reproduzierbarkeit.

6. Count Up (Hochzählen) wie gewünscht einstellen.

Count Up (Hochzählen) steuert, wie der Befüllzähler rechnet und angezeigt wird.

Option Beschreibung

Enabled (Aktiviert) Der Abfüllzähler beginnt bei 0 und zählt bis zu Fill Target (Befüllungssoll)
hoch.

Disabled (Deaktiviert) Der Abfüllzähler beginnt bei Fill Target und zählt bis 0 herunter.

7. Fill Target (Befüllungssoll) auf die Menge einstellen, bei der der Befüllungsvorgang
abgeschlossen ist.

Den Wert in den Messeinheiten für Flow Source (Durchflussquelle) konfigurierten
Wert eingeben.

8. Max Fill Time (Maximale Befüllungszeit) auf die Anzahl von Sekunden einstellen, bei
der die Befüllungszeit überschritten wird.

Konfigurieren einer integrierten Abfüll-Ventilsteuerung mittels ProLink II
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Kann die Befüllung vor Ablauf dieser Zeit nicht abgeschlossen werden, wird die
Befüllung verworfen und Fehlernachrichten werden wegen
Befüllungszeitüberschreitung angezeigt.

Max Fill Time (Maximale Befüllungszeit) auf 0 einstellen, um die
Befüllungszeitüberschreitungsfunktion zu deaktivieren.

Der Standardwert für Max Fill Time (Maximale Befüllungszeit) ist 0 (deaktiviert). Der
Bereich liegt bei 0 Sekunden bis 800 Sekunden.

9. Measured Fill Time (Gemessene Befüllungszeit) wie gewünscht einstellen.

Measured Fill Time (Gemessene Befüllungszeit) steuert, wie die Befüllungszeit
gemessen wird.

Option Beschreibung

Durchfluss stoppt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik erkennt, dass
der Durchfluss nach dem Schließen des Ventils stoppt.

Ventil schließt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik den Binäraus-
gang nach Bedarf einstellt, um das Ventil zu schließen.

Nachbereitungsverfahren

Optionen für einstufige Abfüllungen sind:

• Automatische Überfüllkompensation (AOC) konfigurieren. Wenn die automatische
Überfüllkompensation aktiviert ist, sicherstellen, dass AOC für die entsprechende
Anwendung ordnungsgemäß konfiguriert und kalibriert ist.

• Implementieren der Spülfunktion.

• Implementieren der Pumpfunktion.

6.1.2 Konfigurieren einer zweistufigen Abfüllung mittels
ProLink II
Eine zweistufige Binärbefüllung konfigurieren, wenn ein einzelner Behälter von zwei
Ventilen befüllt werden soll.

Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Öffnen Sie das Fenster Discrete Output (Binärausgang).

b. Setzen Sie Precision DO1 auf Primary Valve.

c. Stellen Sie Precision DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Konfigurieren einer integrierten Abfüll-Ventilsteuerung mittels ProLink II
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Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

d. Setzen Sie Precision DO2 auf Secondary Valve.

e. Stellen Sie Precision DO2 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

2. Durchflussmessungen konfigurieren:

a. Öffnen Sie das Fenster Flow (Durchfluss).

b. Flow Direction (Durchflussrichtung) auf die für Ihre Installation angemessene
Option einstellen.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die durch den Pfeil auf dem Sensor angegebene Rich-
tung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der auf dem Sensor durch den Pfeil angegebenen
Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die entgegengesetzte durch den Pfeil auf dem Sensor
angegebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der entgegengesetzten durch den Pfeil auf dem
Sensor angegebenen Richtung.

Konfigurieren einer integrierten Abfüll-Ventilsteuerung mittels ProLink II

26  Micro Motion® Auswerteelektronik für Masseabfüllung mit PROFIBUS-DP



Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

c. Mass Flow Units (Massedurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Mass Flow Rate (Massedurchflussrate)
eingestellt ist, wird die entsprechende Masseeinheit zur Befüllungsmessung
verwendet.

d. Volume Flow Units (Volumendurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Volume Flow Rate
(Volumendurchflussrate) eingestellt ist, wird die entsprechende Volumeneinheit
zur Befüllungsmessung verwendet.

e. Die anderen Durchflussoptionen wie gewünscht einstellen.

Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

3. Öffnen Sie das Fenster Filling (Abfüllung).

4. Flow Source (Durchflussquelle) auf die Prozessvariable einstellen, die zur
Befüllungsmessung verwendet werden soll.

Option Beschreibung

Massedurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Massedurchfluss

Volumendurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Volumendurchfluss

5. Folgende Parameter einstellen oder überprüfen:

Parameter Einstellung

Befüllungsoption aktivieren Aktiviert

Doppelbefüllung aktiv Deaktiviert

AOC aktivieren Aktiviert

Spülung aktiv Deaktiviert

Enable Timed Fill Deaktiviert

Befüllungsart Zweistufig binär

Hinweis
Micro Motion empfiehlt dringendst die Verwendung der automatischen
Überfüllkompensation (AOC). AOC verbessert, sofern aktiviert und kalibriert, die
Befüllgenauigkeit und Reproduzierbarkeit.

6. Count Up (Hochzählen) wie gewünscht einstellen.

Count Up (Hochzählen) steuert, wie der Befüllzähler rechnet und angezeigt wird.
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Option Beschreibung

Enabled (Aktiviert) Der Abfüllzähler beginnt bei 0 und zählt bis zu Fill Target (Befüllungssoll)
hoch.

Disabled (Deaktiviert) Der Abfüllzähler beginnt bei Fill Target und zählt bis 0 herunter.

7. Configure By (Konfigurieren von) wie gewünscht einstellen.

Configure By (Konfigurieren von) steuert, wie die Ventilsteuerzeit konfiguriert ist.

Option Beschreibung

% Sol-
lwert

Die Ventilöffnungs- und schließzeit wird als Prozentsatz von Fill Target (Befüllungs-
soll) konfiguriert. Zum Beispiel:
• Ventil öffnet = 0 %: Das Ventil öffnet, wenn die aktuelle Befüllunssumme 0 %

von Fill Target (Befüllungssoll) beträgt.
• Ventil schließt = 90 %: Das Ventil schließt, wenn die aktuelle Befüllungs-

summe 90 % von Fill Target (Befüllungssoll) beträgt.

Menge Die Ventilöffnungs- und schließzeiten werden zusammen mit der konfigurierten
Messeinheit konfiguriert. Zum Beispiel:
• Ventil öffnet = 0 g: Das Ventil öffnet, wenn die aktuelle Befüllungssumme 0 g

beträgt.
• Ventil schließt = 50 g: Das Ventil schließt, wenn die aktuelle Befüllungs-

summe 50 g weniger als Fill Target (Befüllungssoll) beträgt.

8. Fill Target (Befüllungssoll) auf die Menge einstellen, bei der der Befüllungsvorgang
abgeschlossen ist.

Den Wert in den Messeinheiten für Flow Source (Durchflussquelle) konfigurierten
Wert eingeben.

9. Max Fill Time (Maximale Befüllungszeit) auf die Anzahl von Sekunden einstellen, bei
der die Befüllungszeit überschritten wird.

Kann die Befüllung vor Ablauf dieser Zeit nicht abgeschlossen werden, wird die
Befüllung verworfen und Fehlernachrichten werden wegen
Befüllungszeitüberschreitung angezeigt.

Max Fill Time (Maximale Befüllungszeit) auf 0 einstellen, um die
Befüllungszeitüberschreitungsfunktion zu deaktivieren.

Der Standardwert für Max Fill Time (Maximale Befüllungszeit) ist 0 (deaktiviert). Der
Bereich liegt bei 0 Sekunden bis 800 Sekunden.

10. Measured Fill Time (Gemessene Befüllungszeit) wie gewünscht einstellen.

Measured Fill Time (Gemessene Befüllungszeit) steuert, wie die Befüllungszeit
gemessen wird.

Option Beschreibung

Durchfluss stoppt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik erkennt, dass
der Durchfluss nach dem Schließen des Ventils stoppt.

Ventil schließt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik den Binäraus-
gang nach Bedarf einstellt, um das Ventil zu schließen.

11. Open Primary (Primär öffnen), Open Secondary (Sekundär öffnen), Close Primary (Primär
schließen) und Close Secondary (Sekundär schließen) wie gewünscht einstellen.
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Diese Werte steuern den Zeitpunkt in der Befüllung, bei dem die primären und
sekundären Ventile öffnen und schließen. Entweder werden sie durch die Menge
oder den Prozentsatz des Sollwertes, wie durch den Configure By (Konfiguriert durch)
Parameter gesteuert, konfiguriert.

Entweder muss Open Primary (Primär öffnen) oder Open Secondary (Sekundär öffnen)
so eingestellt werden, dass sie zu Befüllungsbeginn öffnen. Sofern dies gewünscht
wird, können beide zu Befüllungsbeginn öffnen. Wird ein Wert so eingestellt, dass er
später öffnet, wird der andere automatisch so eingestellt, dass er zu
Befüllungsbeginn öffnet.

Entweder muss Close Primary (Primär schließen) oder Close Secondary (Sekundär
schließen) auf Schließen bei Befüllungsende eingestellt werden. Sofern dies
gewünscht wird, können beide bei Befüllungsende schließen. Wird ein Wert so
eingestellt, dass er früher schließt, wird der andere automatisch so eingestellt, dass
er bei Befüllungsende schließt.

Nachbereitungsverfahren

Optionen für zweistufige Abfüllungen sind:

• Automatische Überfüllkompensation (AOC) konfigurieren. Wenn die automatische
Überfüllkompensation aktiviert ist, sicherstellen, dass AOC für die entsprechende
Anwendung ordnungsgemäß konfiguriert und kalibriert ist.

• Implementieren der Spülfunktion.

Ventilöffnungs- und Schließsequenzen für zweistufige
diskrete Abfüllungen
Die folgenden Abbildungen zeigen das Öffnen und Schließen der Sekundärventile,
gesteuert durch die Konfiguration von Primär öffnen, Sekundär öffnen, Primär schließen und
Sekundär schließen.

Diese Abbildungen setzen voraus, dass die Abfüllung von Anfang bis Ende ohne
Unterbrechungen läuft.

Zuerst Primär öffnen, zuerst Primär schließenAbbildung 10-1:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Primary

Target 
(AOC adjusted)

T1 T2
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Zuerst Primär öffnen, zuerst Sekundär schließenAbbildung 10-2:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Secondary

Target 
(AOC adjusted)

T1 T2

Zuerst Sekundär öffnen, zuerst Primär schließenAbbildung 10-3:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Primary

Target 
(AOC adjusted)

T1 T2

Zuerst Sekundär öffnen, zuerst Sekundär schließenAbbildung 10-4:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Secondary

Target 
(AOC adjusted)

T1 T2

Einfluss von Configure By (Konfigurieren durch) auf das Öffnen
und Schließen des Ventils
Configure By (Konfigurieren durch) steuert, wie die Werte für Open Primary (Primär öffnen),
Open Secondary Sekundär öffnen), Close Primary (Primär schließen) und Close Secondary
(Sekundär schließen) konfiguriert und angewendet werden.

• Wenn Configure By(Konfiguriert durch) = % Target (Sollwert), addiert die
Auswerteelektronik die konfigurierten Werte für „Valve Open“ (Ventil geöffnet) und
„Valve Close“ (Ventil geschlossen) zu 0 %.

• Wenn Configure By (Konfiguriert durch) = Quantity (Menge), addiert die
Auswerteelektronik die konfigurierten Werte für „Valve Open“ (Ventil geöffnet) zu
0, und subtrahiert die konfigurierten Werte für „Valve Close“ (Ventil geschlossen)
von Fill Target (Befüllungssollwert).
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Beispiel: Configure By (Konfiguriert durch) und Befehle zum Öffnen/Schließen des
Ventils

Fill Target (Befüllungssollwert) = 200 g. Das Primärventil soll zu Beginn des
Befüllungsvorgangs öffnen und am Ende des Befüllungsvorgangs schließen. Das
Sekundärventil soll öffnen, nachdem 10 g abgefüllt wurden und wieder schließen,
nachdem 190 g abgefüllt wurden. Siehe Tabelle 10-1 bzgl. der erforderlichen
Einstellungen, die dieses Ergebnis bewirken.

Configure By (Konfiguriert durch) und Ventilkonfiguration Tabelle 10-1:   

Configure By (Konfiguriert durch)
Werte für „Valve Open“ (Ventil geöffnet) und „Valve
Close“ (Ventil geschlossen)

% Sollwert • Open Primary (Primär öffnen) = 0 %
• Open Secondary (Sekundär öffnen) = 5 %
• Close Secondary (Sekundär schließen) = 95 %
• Close Primary (Primär schließen) = 100 %

Menge • Open Primary (Primär öffnen) = 0 g
• Open Secondary (Sekundär öffnen) = 10 g
• Close Secondary (Sekundär schließen) = 10 g
• Close Primary (Primär schließen) = 0 g

6.1.3 Konfigurieren einer zeitgesteuerten Abfüllung mittels
ProLink II
Eine zeitgesteuerte Befüllung konfigurieren, wenn ein einzelner Behälter von einem
einzelnen Ventil befüllt werden soll. Der Ventil ist für eine bestimmte Anzahl von Sekunden
geöffnet.

Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Wählen Sie ProLink > Configuration (Konfiguration) > Discrete Output (Binärausgang).
b. Setzen Sie Precision DO1 auf Primary Valve.

c. Stellen Sie Precision DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC
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Option
Signal von der Auswertee-
lektronik Spannung

OFF Standortspezifisch bis zu
30 VDC

2. Durchflussmessungen konfigurieren:

a. Öffnen Sie das Fenster Flow (Durchfluss).

b. Flow Direction (Durchflussrichtung) auf die für Ihre Installation angemessene
Option einstellen.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die durch den Pfeil auf dem Sensor angegebene Rich-
tung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der auf dem Sensor durch den Pfeil angegebenen
Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die entgegengesetzte durch den Pfeil auf dem Sensor
angegebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der entgegengesetzten durch den Pfeil auf dem
Sensor angegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

c. Mass Flow Units (Massedurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Mass Flow Rate (Massedurchflussrate)
eingestellt ist, wird die entsprechende Masseeinheit zur Befüllungsmessung
verwendet.

d. Volume Flow Units (Volumendurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Volume Flow Rate
(Volumendurchflussrate) eingestellt ist, wird die entsprechende Volumeneinheit
zur Befüllungsmessung verwendet.

e. Die anderen Durchflussoptionen wie gewünscht einstellen.

Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

3. Folgende Parameter einstellen oder überprüfen:
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Parameter Einstellung

Befüllungsoption aktivieren Aktiviert

Hochzählen Aktiviert

Doppelbefüllung aktiv Deaktiviert

AOC aktivieren Deaktiviert

Spülung aktivieren Deaktiviert

Zeitgesteuerte Befüllung aktivieren Aktiviert

Befüllungsart Einstufig binär

4. Target Time (Sollwertzeit) auf die Anzahl von Sekunden einstellen, die der
Befüllungsvorgang dauern wird.

Nachbereitungsverfahren

Die folgende Option ist für zeitgesteuerte Abfüllungen verfügbar:

• Implementieren der Spülfunktion.

6.1.4 Konfigurieren einer Abfüllung mit doppeltem Füllkopf
mittels ProLink II
Eine Befüllung mit doppeltem Füllkopf konfigurieren, wenn zwei Behälter abwechselnd
von doppelten Füllköpfen befüllt werden sollen. Jedes Ventil ist solange geöffnet, bis der
Befüllungssollwert erreicht ist.

Wichtig
Das konfigurierte Fill Target (Befüllungssoll) wird auf beide Befüllungsköpfe angewendet.

Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Wählen Sie ProLink > Configuration (Konfiguration) > Discrete Output (Binärausgang).
b. Setzen Sie Precision DO1 auf Primary Valve.

c. Stellen Sie Precision DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC
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Option
Signal von der Auswertee-
lektronik Spannung

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

d. Setzen Sie Precision DO2 auf Secondary Valve.

e. Stellen Sie Precision DO2 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

2. Durchflussmessungen konfigurieren:

a. Öffnen Sie das Fenster Flow (Durchfluss).

b. Flow Direction (Durchflussrichtung) auf die für Ihre Installation angemessene
Option einstellen.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die durch den Pfeil auf dem Sensor angegebene Rich-
tung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der auf dem Sensor durch den Pfeil angegebenen
Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die entgegengesetzte durch den Pfeil auf dem Sensor
angegebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der entgegengesetzten durch den Pfeil auf dem
Sensor angegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.
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c. Mass Flow Units (Massedurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Mass Flow Rate (Massedurchflussrate)
eingestellt ist, wird die entsprechende Masseeinheit zur Befüllungsmessung
verwendet.

d. Volume Flow Units (Volumendurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Volume Flow Rate
(Volumendurchflussrate) eingestellt ist, wird die entsprechende Volumeneinheit
zur Befüllungsmessung verwendet.

e. Die anderen Durchflussoptionen wie gewünscht einstellen.

Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

3. Öffnen Sie das Fenster Filling (Abfüllung).

4. Flow Source (Durchflussquelle) auf die Prozessvariable einstellen, die zur
Befüllungsmessung verwendet werden soll.

Option Beschreibung

Massedurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Massedurchfluss

Volumendurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Volumendurchfluss

5. Folgende Parameter einstellen oder überprüfen:

Parameter Einstellung

Befüllungsoption aktivieren Aktiviert

Hochzählen Aktiviert

Doppelbefüllung aktivieren Aktiviert

AOC aktivieren Aktiviert

Spülung aktiv Deaktiviert

Enable Timed Fill Deaktiviert

Befüllart Einstufig binär

Hinweis
Micro Motion empfiehlt dringendst die Verwendung der automatischen
Überfüllkompensation (AOC). AOC verbessert, sofern aktiviert und kalibriert, die
Befüllgenauigkeit und Reproduzierbarkeit.

6. Fill Target (Befüllungssoll) auf die Menge einstellen, bei der der Befüllungsvorgang
abgeschlossen ist.

Anmerkung
Das konfigurierte Fill Target (Befüllungssoll) wird auf beide Befüllungsköpfe angewendet.
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7. Max Fill Time (Maximale Befüllungszeit) auf die Anzahl von Sekunden einstellen, bei
der die Befüllungszeit überschritten wird.

Kann die Befüllung vor Ablauf dieser Zeit nicht abgeschlossen werden, wird die
Befüllung verworfen und Fehlernachrichten werden wegen
Befüllungszeitüberschreitung angezeigt.

Max Fill Time (Maximale Befüllungszeit) auf 0 einstellen, um die
Befüllungszeitüberschreitungsfunktion zu deaktivieren.

Der Standardwert für Max Fill Time (Maximale Befüllungszeit) ist 0 (deaktiviert). Der
Bereich liegt bei 0 Sekunden bis 800 Sekunden.

8. Measured Fill Time (Gemessene Befüllungszeit) wie gewünscht einstellen.

Measured Fill Time (Gemessene Befüllungszeit) steuert, wie die Befüllungszeit
gemessen wird.

Option Beschreibung

Durchfluss stoppt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik erkennt, dass
der Durchfluss nach dem Schließen des Ventils stoppt.

Ventil schließt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik den Binäraus-
gang nach Bedarf einstellt, um das Ventil zu schließen.

Nachbereitungsverfahren

Optionen für Abfüllungen mit doppeltem Füllkopf sind:

• Automatische Überfüllkompensation (AOC) konfigurieren. Wenn die automatische
Überfüllkompensation aktiviert ist, sicherstellen, dass AOC für die entsprechende
Anwendung ordnungsgemäß konfiguriert und kalibriert ist.

6.1.5 Konfigurieren einer zeitgesteuerten Abfüllung mit
doppeltem Füllkopf mittels ProLink II
Eine zeitgesteuerte Befüllung mit doppeltem Füllkopf konfigurieren, wenn zwei Behälter
abwechselnd von doppelten Füllköpfen befüllt werden sollen. Jedes Ventil ist für eine
bestimmte Anzahl von Sekunden geöffnet.

Wichtig
Die konfigurierte Target Time (Sollwertzeit) wird auf beide Befüllungsköpfe angewendet.

Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Wählen Sie ProLink > Configuration (Konfiguration) > Discrete Output (Binärausgang).
b. Setzen Sie Precision DO1 auf Primary Valve.

c. Stellen Sie Precision DO1 Polarity entsprechend Ihrer Installation ein.
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Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

d. Setzen Sie Precision DO2 auf Secondary Valve.

e. Stellen Sie Precision DO2 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

2. Durchflussmessungen konfigurieren:

a. Öffnen Sie das Fenster Flow (Durchfluss).

b. Flow Direction (Durchflussrichtung) auf die für Ihre Installation angemessene
Option einstellen.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die durch den Pfeil auf dem Sensor angegebene Rich-
tung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der auf dem Sensor durch den Pfeil angegebenen
Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die entgegengesetzte durch den Pfeil auf dem Sensor
angegebene Richtung.
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Option Beschreibung

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der entgegengesetzten durch den Pfeil auf dem
Sensor angegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

c. Mass Flow Units (Massedurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Mass Flow Rate (Massedurchflussrate)
eingestellt ist, wird die entsprechende Masseeinheit zur Befüllungsmessung
verwendet.

d. Volume Flow Units (Volumendurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Volume Flow Rate
(Volumendurchflussrate) eingestellt ist, wird die entsprechende Volumeneinheit
zur Befüllungsmessung verwendet.

e. Die anderen Durchflussoptionen wie gewünscht einstellen.

Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

3. Öffnen Sie das Fenster Filling (Abfüllung).

4. Flow Source (Durchflussquelle) auf die Prozessvariable einstellen, die zur
Befüllungsmessung verwendet werden soll.

Option Beschreibung

Massedurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Massedurchfluss

Volumendurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Volumendurchfluss

5. Folgende Parameter einstellen oder überprüfen:

Parameter Einstellung

Befüllungsoption aktivieren Aktiviert

Hochzählen Aktiviert

Doppelbefüllung aktivieren Aktiviert

AOC aktivieren Deaktiviert

Spülung aktivieren Deaktiviert

Zeitgesteuerte Befüllung aktivieren Aktiviert
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Parameter Einstellung

Befüllungsart Einstufig binär

6. Target Time (Sollwertzeit) auf die Anzahl von Sekunden einstellen, die der
Befüllungsvorgang dauern wird.

Anmerkung
Die konfigurierte Target Time (Sollwertzeit) wird auf beide Befüllungsköpfe angewendet.

6.2 Konfigurieren von Abfülloptionen mittels
ProLink II
Je nach Befüllungsart kann die automatische Überfüllkompensation (AOC), die Spül- oder
die Pumpenfunktion konfiguriert und angewendet werden.

6.2.1 Konfigurieren und Implementieren der automatischen
Überfüllkompensation (AOC) mittels ProLink II
Die automatische Überfüllkompensation (AOC) wird verwendet, um die Abfüllzeit
anzupassen und um für die Zeit zu kompensieren, die benötigt wird, den Befehl zum
Schließen des Ventils zu übertragen bzw. damit das Ventil vollständig schließt.

Vorbereitungsverfahren

Vor Einrichtung der AOC stellen Sie sicher, dass alle anderen Abfüllparameter richtig
konfiguriert sind.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Wählen Sie ProLink > Configuration (Konfiguration) > Temperature (Temperatur).
2. Wählen Sie die Art der zu implementierenden AOC.

Option Beschreibung

Fixed Das Ventil schließt an dem Punkt, der durch Fill Target minus der Menge, die in Fixed
Overshoot Comp eingegeben ist, definiert wird. Verwenden Sie diese Option nur
dann, wenn der Wert für die „Frühwarnung“ bereits bekannt ist.

Overfill Definiert die Richtung, aus der der AOC-Algorithmus sich der Sollmenge nähert.
Der AOC-Algorithmus beginnt mit der Schätzung eines Überfüllungswerts und re-
duziert dann die Überfüllung in aufeinanderfolgenden Kalibrierabfüllungen.

Underfill Definiert die Richtung, aus der der AOC-Algorithmus sich der Sollmenge nähert.
Der AOC-Algorithmus beginnt mit der Schätzung eines Unterfüllungswerts und re-
duziert dann die Unterfüllung in aufeinanderfolgenden Kalibrierabfüllungen.
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Hinweis
Die Option Fixed wird normalerweise nicht verwendet. Wenn Sie Fixed wählen, funktioniert die
Auswerteelektronik als Legacy-Batchsteuerung. In typischen Einsatzbereichen bieten die
anderen AOC-Optionen bessere Genauigkeit und Wiederholbarkeit.

Einschränkung
Die Optionen Fixed und Overfill werden für Abfüllungen mit doppeltem Füllkopf nicht
unterstützt.

3. Implementierung der Fixed AOC:

a. Deaktivieren Sie Enable AOC.

b. Setzen Sie AOC Algorithm auf Fixed.

c. Stellen Sie Fixed Overshoot Comp nach Wunsch ein.

Die Voreinstellung ist 0 und wird in Prozesseinheiten gemessen.

Die Auswerteelektronik schließt das Ventil, wenn der aktuelle Abfüllzähler gleich
dem Fill Target minus dem angegebenen Wert (in Prozesseinheiten) ist.

4. So implementieren Sie Overfill oder Underfill:

a. Stellen Sie sicher, dass Enable AOC aktiviert ist.

b. Setzen Sie AOC Algorithm auf Underfill oder Overfill.
c. Stellen Sie AOC Window Length auf die Anzahl der Abfüllungen ein, die zur AOC-

Kalibrierung verwendet wird.

Die Voreinstellung ist 10. Der Auswahlbereich ist 2 bis 32.

Hinweis
Micro Motion empfiehlt die Verwendung des Standardwerts, es sei denn, Sie haben
besondere Anwendungsanforderungen.

Wichtig
Ändern Sie die Werte für AOC Change Limit oder AOC Convergence Rate nur auf Anweisung des
Kundendienstes von Micro Motion. Diese Parameter werden verwendet, um die Funktion des
AOC-Algorithmus für besondere Anwendungsanforderungen einzustellen.

Nachbereitungsverfahren

Wenn Sie AOC Algorithm auf Overfill oder Underfill setzen, müssen Sie eine AOC-Kalibrierung
durchführen.

Durchführen einer AOC-Kalibrierung mittels ProLink II
Die AOC-Kalibrierung wird verwendet, um den Wert für die automatische
Überfüllkompensation (Automatic Overshoot Compensation, AOC) anhand der Ist-
Abfülldaten zu berechnen. Wenn Sie AOC Algorithm auf Overfill oder Underfill setzen, müssen
Sie eine AOC-Kalibrierung durchführen.

Es gibt zwei Arten der AOC-Kalibrierung:
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• Standard: Die Kalibrierung wird manuell durchgeführt. Der AOC-Koeffizient wird
anhand von Abfülldaten berechnet, die bei dieser Kalibrierung eingeholt werden,
und derselbe AOC-Koeffizient wird solange angewandt, bis die Kalibrierung
wiederholt wird.

• Rolling: Die Kalibrierung wird kontinuierlich und automatisch durchgeführt, und der
AOC-Koeffizient wird kontinuierlich - auf Basis von Abfülldaten des letzten
Abfüllvorgangs - aktualisiert.

Hinweis
Für stabile Prozesse empfiehlt Micro Motion die AOC-Standardkalibrierung. Testen Sie nach Bedarf
beide Methoden und wählen Sie die Methode, mit der Sie die besten Ergebnisse erzielen.

Durchführen einer AOC-Standardkalibrierung

Standard AOC Calibration wird verwendet, um einen konstanten AOC-Koeffizienten zu
erzeugen.

Vorbereitungsverfahren

AOC Window Length muss entsprechend gesetzt werden. Micro Motion empfiehlt die
Verwendung des Standardwerts (10), es sei denn, Sie haben besondere
Anwendungsanforderungen.

Mass Flow Cutoff bzw. Volume Flow Cutoff müssen entsprechend der Betriebsumgebung
gesetzt werden.

• Wenn Flow Source auf Mass Flow Rate gesetzt ist, siehe Abschnitt 15.2.3.

• Wenn Flow Source auf Volume Flow Rate gesetzt ist, siehe Abschnitt 15.3.2.

Ihr System muss zum Abfüllen bereit sein, und Sie müssen wissen, wie Abfüllvorgänge
ausgeführt werden.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Wählen Sie ProLink > Run Filler.
2. Kalibrierung des Primärventils (alle Befüllarten):

a. Klicken Sie auf Start AOC Cal.
b. Führen Sie zwischen zwei und der in AOC Window Length angegebenen Anzahl von

Kalibrierabfüllungen aus.

Anmerkung
Sie können nach Wahl auch mehr Kalibrierabfüllungen durchführen. Der AOC-Koeffizient
wird anhand der letzten Abfüllungen berechnet.

Hinweis
Normalerweise werden, aufgrund der werksseitigen Standardeinstellungen, die ersten
Abfüllungen leicht über- oder unterfüllt. Im Laufe der Kalibrierung werden diese
Abfüllungen auf dem Fill Target konvergieren.

c. Wenn die Abfüllzähler kontinuierlich zufriedenstellend sind, klicken Sie auf Save
AOC Cal.
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3. Kalibrierung des Sekundärventils (Abfüllungen mit doppeltem Füllkopf):

a. Klicken Sie auf Start Secondary AOC Cal.
b. Führen Sie zwischen zwei und der in AOC Window Length angegebenen Anzahl von

Kalibrierabfüllungen aus.

Die Auswerteelektronik führt die Abfüllungen automatisch durch das
Sekundärventil durch.

Anmerkung
Sie können nach Wahl auch mehr Kalibrierabfüllungen durchführen. Der AOC-Koeffizient
wird anhand der letzten Abfüllungen berechnet.

Hinweis
Normalerweise werden, aufgrund der werksseitigen Standardeinstellungen, die ersten
Abfüllungen leicht über- oder unterfüllt. Im Laufe der Kalibrierung werden diese
Abfüllungen auf dem Fill Target konvergieren.

c. Wenn die Abfüllzähler kontinuierlich zufriedenstellend sind, klicken Sie auf Save
Secondary AOC Cal.

Der aktuelle AOC-Koeffizient wird im Fenster Run Filler angezeigt. Falls Sie eine Abfüllung
mit doppeltem Füllkopf durchführen, zeigt das Fenster Run Filler den AOC-Koeffizienten
für das Primär- und für das Sekundärventil an. Diese Koeffizienten werden solange auf die
Abfüllvorgänge angewandt, wie AOC aktiviert ist.

Anmerkung
Bei zweistufigen Abfüllungen wird der AOC-Wert auf das Ventil angewandt, das sich schließt,
nachdem die Sollmenge erreicht ist. Falls die Abfüllparameter so eingestellt sind, dass sich beide
Ventile nach Erreichen der Sollmenge schließen, wird der AOC-Koeffizient auf beide Ventile
angewandt.

Hinweis
Micro Motion empfiehlt eine Wiederholung der AOC-Kalibierung, falls einer der folgenden Zustände
eintritt:

• Wenn Geräte ausgetauscht oder eingestellt wurden.

• Wenn sich die Durchflussmenge bedeutend geändert hat.

• Wenn die Abfüllgenauigkeit niedriger als erwartet ist.

• Wenn Mass Flow Cutoff oder Volume Flow Cutoff geändert wurden.

Einrichten einer kontinuierlichen AOC-Kalibrierung

Rolling AOC Calibration wird verwendet, um den AOC-Koeffizienten kontinuierlich - auf
Basis von Abfülldaten des letzten Abfüllvorgangs - zu aktualisieren.

Vorbereitungsverfahren

AOC Window Length muss entsprechend gesetzt werden. Micro Motion empfiehlt die
Verwendung des Standardwerts (10), es sei denn, Sie haben besondere
Anwendungsanforderungen.

Ihr System muss zum Abfüllen bereit sein, und Sie müssen wissen, wie Abfüllvorgänge
ausgeführt werden.
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ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Wählen Sie ProLink > Run Filler.
2. Zur Kalibrierung des Primärventils (alle Abfüllarten) klicken Sie auf Start AOC Cal: Zur

Kalibrierung des Sekundärventils (Abfüllungen mit doppeltem Füllkopf) klicken Sie
auf Start Secondary AOC Cal.

Sie können die kontinuierliche AOC-Kalibrierung für ein oder beide Ventile
einrichten.

3. Starten Sie die Serienabfüllung.

Die Auswerteelektronik berechnet den/die AOC-Koeffizienten nach jeder Abfüllung
anhand der letzten xAbfüllungen neu, wobei x die in AOC Window Length festgelegte Anzahl
ist. Die aktuellen Werte werden im Fenster Run Filler angezeigt. Falls sich die Konfiguration
oder die Prozessbedingungen geändert haben, gleicht die kontinuierliche AOC-
Kalibrierung diese Änderungen aus. Diese Einstellung findet jedoch über mehrere
Abfüllungen hinweg statt, das heißt, dass es einige Abfüllvorgänge dauern wird, ehe AOC
die Werte angepasst hat.

Hinweis
Während die AOC-Kalibrierung läuft, auf Save AOC Cal (AOC-Kal. speichern) oder Save Secondary AOC
Cal (Sekundär-AOC-Kal. speichern) klicken. Der aktuelle AOC-Koeffizient wird gespeichert und auf
alle nachfolgenden Abfüllungen durch das entsprechende Ventil angewandt. Mit anderen Worten
ändert diese Aktion die AOC-Kalibriermethode für dieses Ventil von Rolling auf Standard.

6.2.2 Konfigurieren der Spülfunktion mittels ProLink II
Die Spülfunktion wird verwendet, um ein Hilfsventil zu steuern, das nicht für die Abfüllung
eingesetzt wird. Beispielsweise kann damit ein Behälter mit Wasser oder Gas aufgefüllt
werden, nachdem der Füllvorgang abgeschlossen ist, oder sie kann als “ Dämpfung
dienen.” Der Durchfluss durch das Hilfsventil wird von der Auswerteelektronik nicht
gemessen. Eine Konfiguration der Spülfunktion zur automatischen oder manuellen
Spülsteuerung ist möglich. Bei der Auswahl der automatischen Steuerung wird das
Hilfsventil nach jeder Befüllung geöffnet und nach dem Ablauf der konfigurierten Spülzeit
geschlossen.

Einschränkung
Die Spülfunktion wird nicht für Befüllungen mit doppeltem Füllkopf oder zeitgesteuerte Befüllungen
mit doppeltem Füllkopf unterstützt.

Vorbereitungsverfahren

Die Binärausgänge müssen entsprechend Ihrer Abfüllart und Abfülloptionen geschaltet
sein.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Konfigurieren von Kanal B als Binärausgang:

a. Wählen Sie ProLink > Configuration > Channel.
b. Setzen Sie Channel B Type Assignment auf Discrete Output.
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c. Öffnen Sie das Fenster Discrete Output (Binärausgang).

d. Setzen Sie DO1 Assignment auf Discrete Batch: Purge Valve.

e. Stellen Sie DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

f. Stellen Sie DO1 Fault Action entsprechend Ihrer Installation ein.

Option Beschreibung

Upscale Der Binäreingang wird auf EIN geschaltet (Ventil geöf-
fnet), wenn eine Störung auftritt.

Downscale Der Binäreingang wird auf AUS geschaltet (Ventil ges-
chlossen), wenn eine Störung auftritt.

None Bei Auftreten einer Störung werden keine Maßnahmen er-
griffen. Der Binärausgang bleibt in dem Zustand, in dem
er vor Auftreten der Störung war.

2. Spülung konfigurieren:

a. Wählen Sie ProLink > Configuration (Konfiguration) > Temperature (Temperatur).
b. Enable Purge (Spülung aktivieren) aktivieren.

c. Purge Mode (Spülmodus) wie gewünscht einstellen.

Option Beschreibung

Auto (Automatisch) Eine Spülung wird nach jeder Befüllung automatisch
durchgeführt.

Manual (Manuell) Spülvorgänge müssen manuell gestartet und ges-
toppt werden.

Hinweis
Wenn Purge Mode (Spülmodus) auf Auto (Automatisch) eingestellt ist, ist eine manuelle
Steuerung des Spülventils weiterhin möglich. Eine Spülung kann manuell gestartet oder
gestoppt werden oder sie kann durch die Auswerteelektronik nach der abgelaufenen
Purge Time (Spülzeit) gestoppt werden. Wird eine Spülung automatisch gestartet, kann sie
manuell gestoppt werden.
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d. Wenn Purge Mode (Spülmodus) auf Auto (Automatisch) eingestellt ist, Purge Delay
(Spülverzögerung) auf die Anzahl von Sekunden einstellen, die die
Auswerteelektronik nach der Befüllung warten soll, umd das Spülventil zu
öffnen.

Der Standardwert für Purge Delay (Spülverzögerung) beträgt 2 Sekunden.

e. Wenn Purge Mode (Spülmodus) auf Auto (Automatisch) eingestellt wird, Purge Time
(Spülzeit) auf die Anzahl von Sekunden einstellen, die die Auswerteelektronik das
Ventil offen halten soll.

Der Standardwert für Purge Time (Spülzeit) beträgt 1 Sekunde. Der Bereich liegt
bei 0 Sekunden bis 800 Sekunden.

Hinweis
Die nächste Befüllung kann erst beginnen, wenn das Spülventil geschlossen ist.

6.2.3 Konfigurieren der Pumpenfunktion mittels ProLink II
Die Pumpfunktion wird verwendet, um den Druck während der Abfüllung zu erhöhen,
indem eine in Flussrichtung liegende Pumpe kurz vor dem Beginn der Abfüllung gestartet
wird.

Einschränkung
Die Pumpenfunktion wird nicht für zweistufige Binärbefüllungen, Befüllungen mit doppeltem
Füllkopf, zeitgesteuerte Befüllungen oder zeitgesteuerte Befüllungen mit doppeltem Füllkopf
unterstützt.

Vorbereitungsverfahren

Die Binärausgänge müssen entsprechend Ihrer Abfüllart und Abfülloptionen geschaltet
sein.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Öffnen Sie das Fenster Discrete Output (Binärausgang).

b. Setzen Sie Precision DO2 auf Pump.

c. Stellen Sie Precision DO2 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC
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Option
Signal von der Auswertee-
lektronik Spannung

OFF Standortspezifisch bis zu
30 VDC

2. Wählen Sie ProLink > Configuration (Konfiguration) > Temperature (Temperatur).
3. Pump to Valve Delay (Pumpe-zu-Ventilverzögerung) auf die Anzahl von Sekunden

einstellen, die die Pumpe laufen soll, bevor das Ventil geöffnet wird.

Der Standardwert beträgt 10 Sekunden. Der Bereich liegt bei 0 Sekunden bis
30 Sekunden.

Wenn der Befehl Begin Filling (Befüllung beginnen) empfangen wird, startet die
Auswerteelektronik die Pumpe, wartet die unter Pump to Valve Delay (Pumpe-zu-
Ventilverzögerung) spezifizierte Anzahl von Sekunden und öffnet dann das Ventil. Die
Pumpe läuft, bis die Befüllung abgeschlossen ist.

6.3 Konfigurieren einer Abfüllsteuerung mittels
ProLink II (optional)
Bei einer typischen Serienfertigung erfolgt die Abfüllsteuerung (Starten und Stoppen der
Abfüllung) durch den Host oder die SPS. Sie können auf Wunsch das System auch so
einrichten, dass die Abfüllung über den Binäreingang (falls verfügbar) begonnen, beendet,
angehalten und fortgesetzt wird. Außerdem können Sie ein Ereignis definieren, bei dem
die Abfüllung beginnt, endet, angehalten oder fortgesetzt wird.

6.3.1 Konfigurieren des Binäreingangs für die Abfüllsteuerung
mittels ProLink II
Wenn Kanal B verfügbar ist, können Sie diesen als Binäreingang konfigurieren und
verwenden, um eine Abfüllung zu beginnen oder zu beenden oder um eine laufende
Abfüllung anzuhalten und fortzusetzen. Außerdem können Sie den Kanal zum
Zurücksetzen des Masse Summenzählers, des Volumen Summenzählers oder aller
Summenzähler konfigurieren. Wenn der Binäreingang aktiviert ist, werden alle
zugewiesenen Aktionen durchgeführt.

Vorbereitungsverfahren

Kanal B muss als Binärausgang geschaltet sein.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Konfigurieren von Kanal B als Binäreingang:

a. Wählen Sie ProLink > Configuration > Channel.
b. Setzen Sie Type Assignment für Kanal B auf Discrete Input.

2. Weisen Sie dem Binäreingang Steuerungsaktionen zur Abfüllung zu.

a. Öffnen Sie das Fenster Discrete Input (Binäreingang).
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b. Wählen Sie die Aktion oder Aktionen, die bei Aktivierung des Binäreingangs
ausgeführt werden sollen.

Aktion Beschreibung Bemerkungen

Begin Filling Beginnt die Abfüllung mit der aktuellen Abfüll-
konfiguration. Der Abfüllzähler wird automa-
tisch zurückgesetzt, bevor die Abfüllung be-
ginnt.

Falls eine Abfüllung läuft, wird der Befehl ig-
noriert.

Wenn ein automatischer Spülvorgang läuft,
werden die Funktionen zum Start der Abfül-
lung ausgeführt, sobald der Spülvorgang ab-
geschlossen ist.

End Filling Beendet die aktuelle Abfüllung und führt Funk-
tionen zum Ende der Abfüllung aus. Die Abfül-
lung kann nicht fortgesetzt werden.

Wird ausgeführt, während eine Abfüllung läuft
oder angehalten ist und während eines Spül-
vorgangs oder einer Spülverzögerung.

Für Abfüllungen mit doppeltem Füllkopf und
zeitgesteuerte Abfüllungen mit doppeltem
Füllkopf beendet der Befehl immer die zurzeit
aktive Abfüllung.

Pause Filling Zeitgesteuerte Abfüllungen, Abfüllungen mit
doppeltem Füllkopf und zeitgesteuerte Abfül-
lungen mit doppeltem Füllkopf: Identisch mit
End Filling.

Einstufige Abfüllungen und zweistufige Abfül-
lungen: Hält die Abfüllung vorläufig an. Die
Abfüllung kann fortgesetzt werden, wenn die
Abfüllmenge kleiner als die Sollmenge ist.

Falls ein Spülvorgang oder eine Spülverzöger-
ung läuft, wird der Befehl ignoriert.

Resume Filling Startet die Abfüllung wieder, nachdem sie un-
terbrochen wurde. Die Zählung wird an der
Stelle oder an dem Zeitpunkt wieder fortge-
setzt, an der/dem sie unterbrochen wurde.

Wird nur ausgeführt, wenn eine einstufige Ab-
füllung oder eine zweistufige Abfüllung ange-
halten wurden. Wird alle anderen Male ignor-
iert.

Reset Mass Total Setzt den Wert des Masse Summenzählers auf
0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

Reset Volume Total Setzt den Wert des Volumen Summenzählers
auf 0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

Reset All Totals Setzt den Wert des Masse Summenzählers und
des Volumen Summenzählers auf 0 zurück,
und setzt den Abfüllzähler auf 0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

c. Öffnen Sie für jede ausgewählte Aktion die Dropdown-Liste und wählen Sie
Discrete Input 1.

3. Stellen Sie DI1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das vom Binäreingang gesendete EIN-Signal auch als EIN
gelesen wird, und umgekehrt.
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Option
Angelegte Spannung über
Anschlussklemmen Auswerteelektronik liest

Active High 3 bis 30 VDC ON

<0,8 VDC OFF

Active Low <0,8 VDC ON

3 bis 30 VDC OFF

6.3.2 Einrichten eines Ereignisses zur Durchführung einer
Abfüllsteuerung mittels ProLink II
Sie können ein Ereignis zuweisen, um eine Abfüllung zu starten, zu stoppen, anzuhalten
oder fortzusetzen. Außerdem können Sie das Ereignis zum Zurücksetzen des Masse
Summenzählers, des Volumen Summenzählers oder aller Summenzähler zuweisen. Beim
Schalten des Ereignisses auf ON (EIN) werden alle zugewiesenen Aktionen durchgeführt.

Vorbereitungsverfahren

Sie müssen alle gewünschten Ereignisse konfigurieren. Sie können diese Ereignisse sowohl
vor als auch nach dem Zuweisen von Aktionen konfigurieren.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Weisen Sie dem Ereignis Steuerungsaktionen zur Abfüllung zu.

a. Wählen Sie ProLink > Configuration (Konfiguration) > Discrete Events (Binärereignisse).
b. Identifizieren Sie die Aktion oder Aktionen, die bei Auftreten des Discrete Event 1

ausgeführt werden soll bzw. sollen.

Aktion Beschreibung Bemerkungen

Begin Filling Beginnt die Abfüllung mit der aktuellen Abfüll-
konfiguration. Der Abfüllzähler wird automa-
tisch zurückgesetzt, bevor die Abfüllung be-
ginnt.

Falls eine Abfüllung läuft, wird der Befehl ig-
noriert.

Wenn ein automatischer Spülvorgang läuft,
werden die Funktionen zum Start der Abfül-
lung ausgeführt, sobald der Spülvorgang ab-
geschlossen ist.

End Filling Beendet die aktuelle Abfüllung und führt Funk-
tionen zum Ende der Abfüllung aus. Die Abfül-
lung kann nicht fortgesetzt werden.

Wird ausgeführt, während eine Abfüllung läuft
oder angehalten ist und während eines Spül-
vorgangs oder einer Spülverzögerung.

Für Abfüllungen mit doppeltem Füllkopf und
zeitgesteuerte Abfüllungen mit doppeltem
Füllkopf beendet der Befehl immer die zurzeit
aktive Abfüllung.

Pause Filling Zeitgesteuerte Abfüllungen, Abfüllungen mit
doppeltem Füllkopf und zeitgesteuerte Abfül-
lungen mit doppeltem Füllkopf: Identisch mit
End Filling.
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Aktion Beschreibung Bemerkungen

Einstufige Abfüllungen und zweistufige Abfül-
lungen: Hält die Abfüllung vorläufig an. Die
Abfüllung kann fortgesetzt werden, wenn die
Abfüllmenge kleiner als die Sollmenge ist.

Falls ein Spülvorgang oder eine Spülverzöger-
ung läuft, wird der Befehl ignoriert.

Resume Filling Startet die Abfüllung wieder, nachdem sie un-
terbrochen wurde. Die Zählung wird an der
Stelle oder an dem Zeitpunkt wieder fortge-
setzt, an der/dem sie unterbrochen wurde.

Wird nur ausgeführt, wenn eine einstufige Ab-
füllung oder eine zweistufige Abfüllung ange-
halten wurden. Wird alle anderen Male ignor-
iert.

Reset Mass Total Setzt den Wert des Masse Summenzählers auf
0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

Reset Volume Total Setzt den Wert des Volumen Summenzählers
auf 0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

Reset All Totals Setzt den Wert des Masse Summenzählers und
des Volumen Summenzählers auf 0 zurück,
und setzt den Abfüllzähler auf 0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

2. Wiederholen Sie das Verfahren für Discrete Event 2–5.

Beispiel: Ereignisse überwachen den Prozess und pausieren oder beenden die
Abfüllung

Der akzeptable Dichtebereich für Ihren Prozess ist 1,1 g/cm3 bis 1,12 g/cm3. Der
akzeptable Temperaturbereich ist 20 °C bis 25 °C. Wenn die Dichte den Messbereich
überschreitet, möchten Sie die Abfüllung anhalten. Wenn die Temperatur den
Messbereich überschreitet, möchten Sie die Abfüllung beenden.

Konfiguration der Ereignisse:

• Discrete Event 1:

- Event Type: Out of Range
- Process Variable: Density
- Low Setpoint (A): 1,1 g/cm3

- High Setpoint (B): 1,12 g/cm3

• Discrete Event 2:

- Event Type: Out of Range
- Process Variable: Temperature
- Low Setpoint (A): 20 °C

- High Setpoint (B): 25 °C

Aktionszuordnungen:

• Pause Fill: Discrete Event 1
• End Fill: Discrete Event 2
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Nachbereitungsverfahren

Wenn Sie Ereignissen Aktionen zugeordnet haben, die nicht konfiguriert sind, müssen Sie
diese Ereignisse konfigurieren, bevor Sie diese Methode der Abfüllsteuerung
implementieren können.

6.3.3 Mehrere Maßnahmen, die einem Binäreingang oder
Ereignis zugewiesen sind
Wenn mehrere Maßnahmen einem Binäreingang oder Ereignis zugewiesen sind, führt die
Auswerteelektronik nur die Maßnahmen durch, die jeweils für die aktuelle Situation von
Bedeutung sind. Wenn zwei oder mehr der Maßnahmen sich gegenseitig ausschließen,
führt die Auswerteelektronik Maßnahmen gemäß einem Prioritätenschema durch, das in
der Firmware der Auswerteelektronik definiert ist.

Die folgenden Beispiele zeigen drei Konfigurationen, die Micro Motion empfiehlt, und zwei
Konfigurationen, die nicht empfohlen werden.

Beispiel: Verwenden des Binäreingangs oder des Ereignisses, um eine Abfüllung zu
beginnen und zu beenden (empfohlen)

Maßnahmezuordnungen:

• Abfüllung-Beginn
• Abfüllung-Ende
• Masse Summenzähler zurücksetzen
• Volumen Summenzähler zurücksetzen

Ergebnis der Aktivierung:

• Wenn keine Abfüllung läuft, werden der Masse Summenzähler und der Volumen
Summenzähler zurückgesetzt und eine Abfüllung beginnt.

• Wenn eine Abfüllung läuft, wird diese beendet und der Masse Summenzähler und
der Volumen Summenzähler werden zurückgesetzt.

Beispiel: Verwenden des Binäreingangs oder des Ereignisses, um die Abfüllung zu
beginnen, anzuhalten und sie fortzusetzen (empfohlen)

Maßnahmezuordnungen:

• Abfüllung-Beginn
• Abfüllung-Pause
• Abfüllung-Fortsetzung

Ergebnis der Aktivierung:

• Wenn keine Abfüllung läuft, wird diese gestartet.

• Wenn eine Abfüllung läuft und nicht angehalten wurde, wird diese angehalten.

• Wenn eine Abfüllung angehalten wurde, wird diese fortgesetzt.

Beispiel: Verwenden des Binäreingangs, um die Abfüllung zu starten und den
Volumenzähler zurückzusetzen (empfohlen)

Maßnahmezuordnungen:

• Abfüllung-Beginn
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• Volumen Summenzähler zurücksetzen

Ergebnis der Aktivierung:

• Wenn keine Abfüllung läuft, wird der Volumen Summenzähler zurückgesetzt und
eine Abfüllung beginnt.

• Wenn eine Abfüllung läuft, wird der Volumen Summenzähler zurückgesetzt.

Hinweis
Diese Konfiguration ist nützlich, wenn die Abfüllung hinsichtlich der Masse konfiguriert wird, das
Gesamtvolumen für die Abfüllung aber ebenfalls ermittelt werden soll. In diesem Fall nicht den
Binäreingang aktivieren, während die Abfüllung läuft. Am Ende der Abfüllung kann das
Gesamtvolumen abgelesen werden. Danach mit der nächsten Abfüllung fortfahren.

Beispiel: Inkompatible Zuordnungen (nicht empfohlen)

Maßnahmezuordnungen:

• Abfüllung-Beginn
• Abfüllung-Ende
• Abfüllung-Pause
• Abfüllung-Fortsetzung

Ergebnis der Aktivierung:

• Wenn keine Abfüllung läuft, wird diese gestartet.

• Wenn eine Abfüllung läuft, wird diese beendet.

In diesem Beispiel wird die Abfüllung durch den Binäreingang oder das Ereignis nicht
angehalten, weil die Maßnahme End Fill Priorität hat.

Beispiel: Inkompatible Zuordnungen (nicht empfohlen)

Maßnahmezuordnungen:

• Abfüllung-Ende
• Alle Zähler zurücksetzen

Ergebnis der Aktivierung:

• Wenn keine Abfüllung läuft, werden alle Zähler, einschließlich dem Abfüll-
Summenzähler, zurückgesetzt.

• Wenn eine Abfüllung läuft, wird diese beendet und alle Zähler, einschließlich dem
Abfüll-Summenzähler, werden zurückgesetzt.

Das Ergebnis dieser Kombination ist, dass der Abfüll-Summenzähler vor dem Abrufen der
Daten zurückgesetzt wird.

6.4 Konfigurieren der Abfüllprotokollierung
mittels ProLink II (optional)
Sie können die Auswerteelektronik so konfigurieren, dass der ON/OFF-Status über Kanal B
(falls verfügbar) und der Prozentsatz der Abfüllung über den mA-Ausgang ausgegeben
wird.
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6.4.1 Konfigurieren von Kanal B als Binärausgang und
Übertragen des Abfüllstatus ON/OFF mittels ProLink II
Falls Kanal B verfügbar ist, können Sie diesen verwenden, um auszugeben, ob ein
Abfüllvorgang läuft.

Vorbereitungsverfahren

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Kanal B muss als Binärausgang geschaltet sein.

Verfahren

1. Wählen Sie ProLink > Configuration > Channel.
2. Setzen Sie Channel B Type Assignment auf Discrete Output.
3. Öffnen Sie das Fenster Discrete Output (Binärausgang).

4. Setzen Sie DO1 Assignment auf Discrete Batch: Batching/Filling In Progress.

5. Stellen Sie DO1 Polarity entsprechend Ihrer Installation ein.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

6. Stellen Sie DO1 Fault Action entsprechend Ihrer Installation ein.

Option Beschreibung

Upscale Der Binäreingang wird auf EIN geschaltet (Ventil geöffnet),
wenn eine Störung auftritt.

Downscale Der Binäreingang wird auf AUS geschaltet (Ventil geschlos-
sen), wenn eine Störung auftritt.

None Bei Auftreten einer Störung werden keine Maßnahmen er-
griffen. Der Binärausgang bleibt in dem Zustand, in dem er
vor Auftreten der Störung war.

Hinweis
Wenn der Binärausgang zur Ausgabe von Abfüllberichten verwendet wird, empfiehlt Micro
Motion die Einstellung von DO1 Fault Action auf None.

Konfigurieren einer integrierten Abfüll-Ventilsteuerung mittels ProLink II

52  Micro Motion® Auswerteelektronik für Masseabfüllung mit PROFIBUS-DP



6.4.2 Konfigurieren des mA-Ausgangs, um die prozentuale
Abfüllung auszugeben mittels ProLink II
Sie können den mA-Ausgang so konfigurieren, dass er den Prozentsatz der abgebenenen
Sollmenge ausgibt. In einer typischen Konfiguration steigt der Strom von 4 mA auf 20 mA,
wenn der Abfüllzähler von 0 % auf 100 % geht.

Vorbereitungsverfahren

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Wählen Sie ProLink > Configuration (Konfiguration) > Analog Output (Analogausgang).
2. Setzen Sie Secondary Variable Is auf Discrete Batch: Percent Fill.
3. Setzen Sie Lower Range Value auf den durch 4 mA dargestellten Abfüllprozentwert.

4. Setzen Sie Upper Range Value auf den durch 20 mA dargestellten Abfüllprozentwert.

5. Stellen Sie AO Fault Action wie gewünscht ein.

Wenn Lower Range Value auf 0 % eingestellt ist und Upper Range Value auf 100 % eingestellt
ist: Wenn die Abfüllung beginnt, erzeugt der mA-Ausgang 4 mA (0 % von Fill Target). Der
Strom wird proportional zum Abfüllzähler bis auf 20 mA (100 % von Fill Target) steigen.

Anmerkung
Wenn Flow Direction auf Bidirectional oder Negate Bidirectional eingestellt ist, kann der Abfüllzähler unter
bestimmten Durchflussbedingungen sinken. In diesem Fall wird der vom mA-Ausgang erzeugte
Strom proportional reduziert.
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7 Abfüllvorgang mittels ProLink II
In diesem Kapitel behandelte Themen:

• Abfüllung mit integrierter Ventilsteuerung mittels ProLink II

• Durchführen einer manuellen Spülung mittels ProLink II

• Durchführen eines Cleaning-in-Place-Verfahrens (CIP) mittels ProLink II

• Überwachen und Analysieren der Abfüllleistung mittels ProLink II

7.1 Abfüllung mit integrierter Ventilsteuerung
mittels ProLink II
Mit ProLink II können Sie eine Abfüllung starten, überwachen, anhalten, fortsetzen und
beenden.

Vorbereitungsverfahren

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Wählen Sie ProLink > Run Filler.
2. (Optional) Auf Wunsch wählen Sie einen anderen Wert für Fill Target (einstufige

Abfüllungen, zweistufige Abfüllungen oder Abfüllungen mit doppeltem Füllkopf)
oder für Target Time (zeitgesteuerte Abfüllungen oder zeitgesteuerte Abfüllungen
mit doppeltem Füllkopf).

3. (Optional) Falls die automatische Überfüllkompensation (Automatic Overshoot
Compensation, AOC) aktiviert ist, können Sie einen anderen Wert für AOC Coeff
eingeben.

Hinweis
Während der Produktion empfiehlt Micro Motion, AOC Coeff auf dem während der AOC-
Kalibrierung festgelegten Wert zu belassen. Falls Sie AOC-Kalibrierabfüllungen ausführen und
über einen AOC Coeff Wert von einem ähnlichen Gerät verfügen, können Sie diesen Wert als
„ersten Näherungswert“ im aktuellen Gerät verwenden. Dies kann nützlich sein, wenn Sie
Auslaufen verhindern oder auf ein Minimum reduzieren möchten.

4. Klicken Sie auf Begin Filling.

Der Abfüllzähler wird automatisch zurückgesetzt und das/die Ventil(e) wird/werden
geöffnet. Die Anzeige für Filling in Progress sollte On sein. Ist dies nicht der Fall und
stattdessen die Anzeige Start Not Okay oder die Anzeige AOC Flow Rate Too High Ein
sind, führen Sie eine Fehlersuche der Abfüllkonfiguration durch und wiederholen Sie
das Verfahren.

5. Überwachen Sie die Abfüllung anhand der Werte unter Current Total und Percent Fill
der Anzeige Fill Status.
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Werte des Abfüllforts-
chritts Beschreibung

Current Total Abfüllmenge zum aktuellen Zeitpunkt. Dieser Wert wird von
Count Up beeinflusst:
• Wenn Count Up aktiviert ist, beginnt Current Total bei 0 und

zählt bis zu Fill Target hoch.
• Wenn Count Up deaktiviert ist, beginnt Current Total bei Fill

Target und zähl bis auf 0 herunter.

Percent Fill Prozentwert des Fill Target, der bis zum aktuellen Zeitpunkt
gemessen wurde. Dieser Wert wird nicht von Count Up beein-
flusst.

Fill Status Anzeige Beschreibung

Filling in Progress Zurzeit wird eine Abfüllung durch das Primärventil durchge-
führt. Diese Anzeige ist auch dann aktiv, wenn die Abfüllung
angehalten wird.

Secondary Fill in Progress Zurzeit wird eine Abfüllung durch das Sekundärventil durch-
geführt. Diese Anzeige ist auch dann aktiv, wenn die Abfül-
lung angehalten wird. Dies gilt nur für Abfüllungen mit dop-
peltem Füllkopf.

Max Fill Time Exceeded Die aktuelle Abfüllung hat die derzeitige Einstellung für Max
Fill Time überschritten. Die Abfüllung wird abgebrochen.

Primary Valve Das Primärventil ist offen.

Secondary Valve Das Sekundärventil ist offen.

Pump Die Pumpe läuft.

Purge In Progress Ein Spülvorgang wurde, entweder automatisch oder man-
uell, gestartet.

Purge Delay Phase Ein automatischer Spülzyklus läuft und ist aktuell in der Ver-
zögerungsperiode zwischen Beendigung der Abfüllung und
Start des Spülvorgangs.

Purge Valve Das Spülventil ist offen.

6. (Optional) Halten Sie die Abfüllung nach Wunsch an.

Während die Abfüllung angehalten ist, können Sie den Wert für Current Target
ändern, die Abfüllung manuell mit End Filling beenden oder mit Resume Filling
fortsetzen. Die Abfüllung wird mit dem aktuellen Wert für Current Total und Percent Fill
fortgesetzt.

Einschränkung
Eine zeitgesteuerte Abfüllung oder eine zeitgesteuerte Abfüllung mit doppeltem Füllkopf
kann nicht angehalten werden.

Wichtig
Für zweistufige Abfüllungen hängt die Auswirkung eines Anhaltens und Fortsetzens der
Abfüllung von der Zeitsteuerung der Befehle zum Öffnen und Schließen des Ventils und von
dem Punkt, an welchem die Abfüllung angehalten wird, ab.
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7. (Optional) Verwenden Sie End Filling, um die Abfüllung nach Wunsch manuell zu
beenden.

Nachdem die Abfüllung beendet wurde, kann sie nicht wieder gestartet werden.

Hinweis
In den meisten Fällen sollten Sie den Abfüllvorgang automatisch beenden lassen. Beenden Sie
den Abfüllvorgang nur dann manuell, wenn Sie die Füllung entsorgen möchten.

7.1.1 Wenn die Abfüllung nicht startet
Falls die Abfüllung nicht beginnt, die Anzeigen für Start Not Okay und AOC Flow Rate Too High
prüfen.

Wenn die Anzeige Start Not Okay aufleuchtet, Folgendes prüfen:

• Sicherstellen, dass die Abfüllung aktiviert ist.

• Darauf achten, dass die vorherige Abfüllung bereits beendet ist.

• Sicherstellen, dass Fill Target oder Target Time auf positive Werte eingestellt sind.

• Sicherstellen, dass alle Ausgänge dem Ventil oder der Pumpe zugeordnet sind, das
bzw. die der Abfüllart und der Abfülloption entsprechen.

• Sicherstellen, dass keine aktiven Fehlerbedingungen an der Auswerteelektronik
vorherrschen.

• Bei Abfüllungen mit doppelten Füllköpfen sicherstellen, dass auf keinem der
Füllköpfe eine Abfüllung läuft.

Wenn die Anzeige AOC Flow Rate Too High leuchtet, ist die zuletzt gemessene
Durchflussgeschwindigkeit zu hoch, und die Abfüllung kann nicht gestartet werden.
Anders ausgedrückt bedeutet dies, dass der AOC Koeffizient, kompensiert für die
Durchflussgeschwindigkeit, angibt, dass der Befehl zum Schließen des Ventils vor dem
Beginn der Abfüllung gegeben werden müsste. Dies kann vorkommen, wenn die
Durchflussgeschwindigkeit signifikant höher liegt, seit der AOC-Koeffizient berechnet
wurde. Micro Motion empfiehlt das folgende Wiederherstellungsverfahren:

1. Jede Einrichtung durchführen, die erforderlich ist, um die AOC-Kalibrierung
durchzuführen.

2. Im Fenster Run Filler auf Override Blocked Start klicken.

3. AOC-Kalibrierung durchführen.

4. Die Produktionsabfüllung des Systems unter Verwendung des neuen AOC-
Koeffizienten wieder aufnehmen.

7.1.2 Wenn die Abfüllung nicht vollständig durchgeführt
wurde
Falls die Abfüllung anormal beendet wurde, die Auswerteelektronik und die AnzeigeMax Fill
Time Exceeded prüfen.

Wenn ein Fehler während einer Abfüllung auftritt, wird diese von der Auswerteelektronik
automatisch abgebrochen.
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Wenn die Anzeige Max Fill Time Exceeded leuchtet, konnte die Abfüllung nicht ihren Zielwert
vor der konfigurierten Max Fill Time erreichen. Folgende Möglichkeiten oder Maßnahmen
sind in Betracht zu ziehen:

• Die Durchflussgeschwindigkeit des Prozesses erhöhen.

• Auf Gaseinschlüsse (Schwallströmung) im Prozessmedium prüfen.

• Auf Verstopfungen des Durchflusses prüfen.

• Sicherstellen, dass die Ventile mit der erwarteten Geschwindigkeit schließen.

• Max Fill Time auf einen höheren Wert einstellen.

• Max Fill Time durch eine Einstellung auf 0 deaktivieren.

7.1.3 Auswirkungen von Pause und Fortfahren bei zweistufigen
diskreten Abfüllungen
Bei zweistufigen diskreten Abfüllungen hängt es davon ab, wo Pause und Fortfahren in
Zusammenhang mit dem Öffnen und Schließen der primären und sekundären Ventile
auftreten.

Zuerst Primär öffnen, zuerst Primär schließen

In den folgenden Abbildungen:

• Das Primärventil öffnet zum Beginn der Abfüllung.

• Das Sekundärventil öffnet während der Abfüllung an dem vom Anwender
konfigurierten Punkt. T stellt die Zeit oder Anzahl dar, die für Sekundär öffnen
konfiguriert ist.

• Das Primärventil schließt, bevor die Abfüllung abgeschlossen ist.

• Das Sekundärventil schließt, wenn die Abfüllung abgeschlossen ist.

Fall AAbbildung 11-1:   

Secondary valve
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Fall BAbbildung 11-2:   
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Fall DAbbildung 11-4:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Primary

Target 
(AOC adjusted)

T T

Secondary valve 
opened early

Pause Resume

Open 
Secondary

Zuerst Primär öffnen, zuerst Sekundär schließen

In den folgenden Abbildungen:

• Das Primärventil öffnet zum Beginn der Abfüllung.

• Das Sekundärventil öffnet während der Abfüllung an dem vom Anwender
konfigurierten Punkt. T stellt die Zeit oder Anzahl dar, die für Sekundär öffnen
konfiguriert ist.

• Das Sekundärventil schließt, bevor die Abfüllung abgeschlossen ist.
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• Das Primärventil schließt, wenn die Abfüllung abgeschlossen ist.

Fall EAbbildung 11-5:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Secondary

Target 
(AOC adjusted)

Pause Resume

TT

Open Secondary 
not performed

Fall FAbbildung 11-6:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Secondary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Secondary

Fall GAbbildung 11-7:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Secondary

Target 
(AOC adjusted)

T T

Secondary valve 
not reopened

Pause Resume

Open 
Secondary
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Fall HAbbildung 11-8:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Secondary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Secondary

Secondary valve 
not reopened

Zuerst Sekundär öffnen, zuerst Primär schließen

In den folgenden Abbildungen:

• Das Sekundärventil öffnet zum Beginn der Abfüllung.

• Das Primärventil öffnet während der Abfüllung an dem vom Anwender
konfigurierten Punkt. T stellt die Zeit oder Anzahl dar, die für Primär öffnen
konfiguriert ist.

• Das Primärventil schließt, bevor die Abfüllung abgeschlossen ist.

• Das Sekundärventil schließt, wenn die Abfüllung abgeschlossen ist.

Fall IAbbildung 11-9:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Primary

Target 
(AOC adjusted)

Pause Resume

TT

Open Primary 
not performed
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Fall JAbbildung 11-10:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Primary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Primary

Fall KAbbildung 11-11:   

Secondary valve

Primary valve

Start Open 
Primary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Primary not 
performed

Close 
Primary

Fall LAbbildung 11-12:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Primary

Target 
(AOC adjusted)

T T

Pause Resume

Open Primary 
not performed

Zuerst Sekundär öffnen, zuerst Sekundär schließen

In den folgenden Abbildungen:

• Das Sekundärventil öffnet zum Beginn der Abfüllung.

• Das Primärventil öffnet während der Abfüllung an dem vom Anwender
konfigurierten Punkt. T stellt die Zeit oder Anzahl dar, die für Primär öffnen
konfiguriert ist.

• Das Sekundärventil schließt, bevor die Abfüllung abgeschlossen ist.

• Das Primärventil schließt, wenn die Abfüllung abgeschlossen ist.
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Fall MAbbildung 11-13:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Secondary

Target 
(AOC adjusted)

Pause Resume

TT

Open Primary 
not performed

Fall NAbbildung 11-14:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Secondary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Primary

Fall OAbbildung 11-15:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Secondary

Target 
(AOC adjusted)

T T

Primary valve 
opened early

Pause Resume

Open 
Primary
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Fall PAbbildung 11-16:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Secondary

Target 
(AOC adjusted)

T T

Primary valve 
opened early

Pause Resume

Open 
Primary

7.2 Durchführen einer manuellen Spülung mittels
ProLink II
Die Spülfunktion wird verwendet, um ein Hilfsventil zu steuern, das nicht für die Abfüllung
eingesetzt wird. Beispielsweise kann damit ein Behälter mit Wasser oder Gas aufgefüllt
werden, nachdem der Füllvorgang abgeschlossen ist, oder sie kann als “ Dämpfung
dienen.” Der Durchfluss durch das Hilfsventil wird von der Auswerteelektronik nicht
gemessen.

Vorbereitungsverfahren

Die Spülfunktion muss in Ihrem System implementiert sein.

Die vorhergehende Abfüllung muss beendet worden sein.

Das Hilfsventil muss an das Medium, das Sie verwenden möchten (z. B. Luft, Wasser,
Stickstoff), angeschlossen sein.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Wählen Sie ProLink > Run Filler.
2. Klicken Sie auf Begin Purge.

Die Anzeigen Purge In Progress und Purge Valve werden eingeschaltet.

3. Lassen Sie das Spülmedium eine angemessene Zeit durch das System laufen.

4. Klicken Sie auf End Purge.

Die Anzeigen Purge In Progress und Purge Valve werden ausgeschaltet.

7.3 Durchführen eines Cleaning-in-Place-
Verfahrens (CIP) mittels ProLink II
Die Clean-in-Place (CIP) Funktion wird verwendet, um ein Reinigungsmedium durch das
System zu leiten. Mit dem CIP-Verfahren können Sie die Innenflächen von Rohren,
Ventilen, Stutzen usw. reinigen, ohne das Gerät zerlegen zu müssen.
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Vorbereitungsverfahren

Hierbei darf kein Abfüllvorgang laufen.

Das Reinigungsmedium muss zum Durchfluss durch das System bereit stehen.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Tauschen Sie das Prozessmedium gegen das Reinigungsmedium aus.

2. Wählen Sie ProLink > Run Filler.
3. Klicken Sie auf Begin Cleaning.

Die Auswerteelektronik öffnet das Primärventil und, falls dieses zum Abfüllen
verwendet wird, das Sekundärventil. Falls die Pumpenfunktion aktiviert ist, wird die
Pumpe gestartet, bevor das Ventil geöffnet wird. Die Anzeige Cleaning In Progress
wird eingeschaltet.

4. Lassen Sie das Reinigungsmedium eine angemessene Zeit durch das System laufen.

5. Klicken Sie auf End Cleaning.

Die Auswerteelektronik schließt alle offenen Ventile und stoppt die Pumpe (falls
zutreffend). Die Anzeige Cleaning In Progress wird ausgeschaltet.

6. Tauschen Sie das Reinigungsmedium gegen das Prozessmedium aus.

7.4 Überwachen und Analysieren der
Abfüllleistung mittels ProLink II
Für eine Einzelabfüllung können detaillierte Durchflussdaten gesammelt werden und diese
Daten können dann mit denen anderer Abfüllungen verglichen werden.

7.4.1 Sammeln detaillierter Abfülldaten für eine einzelne
Abfüllung mittels ProLink II
Detaillierte Daten der letzten Abfüllung werden in der Auswerteelektronik gespeichert,
sofern die Abfüllungsprotokollierung aktiviert ist. Die Daten können mittels digitaler
Kommunikation zu Analysezwecken ausgelesen werden. Die detaillierten Daten können
zur Optimierung oder Fehlersuche in der Produktionsumgebung verwendet werden.

Einschränkung
Obwohl Sie ProLink II benutzen können, um die Abfüllprotokollierung zu aktivieren und zu
deaktivieren, können Sie das Abfüllprotokoll nicht mit ProLink II ansehen. Um das Abfüllprotokoll
ansehen zu können, müssen Sie eine Modbus- oder PROFIBUS-Verbindung wählen.

Vorbereitungsverfahren

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Wählen Sie ProLink > Configuration (Konfiguration) > Temperature (Temperatur).
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2. Aktivieren Sie Enable Fill Logging.

3. Führen Sie einen Abfüllvorgang aus.

4. Deaktivieren Sie Enable Fill Logging, wenn Sie die Datensammlung beendet haben.

Das Abfüllprotokoll enthält Datensätze von einem einzigen Abfüllvorgang. Die
Aufzeichnung beginnt mit dem Start der Abfüllung und endet 50 Millisekunden nach
Beendigung der Abfüllung oder wenn die maximale Prokotollgröße erreicht wurde.
Datensätze werden alle 10 Millisekunden geschrieben. Jeder Datensatz enthält den
aktuellen Wert für Flow Source (die zum Messen der Abfüllung verwendete Prozessvariable).
Das Abfüllprotokoll ist auf 1000 Datensätze bzw. 10 Sekunden Abfülldauer begrenzt.
Nachdem die maximale Größe erreicht ist, stoppt die Protokollierung zwar, aber die Daten
sind in der Auswerteelektronik verfügbar, bis der nächste Abfüllvorgang beginnt. Das
Abfüllprotokoll wird zu Beginn eines neuen Abfüllvorgangs immer gelöscht.

7.4.2 Analyse der Abfüllleistung mittels Abfüllstatistiken und
ProLink II
Die Auswerteelektronik zeichnet automatisch eine Vielzahl von Daten über jeden
Abfüllungsvorgang auf. Diese Daten dienen zur Optimierung des Systems.

Vorbereitungsverfahren

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Wählen Sie ProLink > Run Filler.
2. (Optional) Klicken Sie auf Reset Fill Statistics, um die Analyse mit einem neuen Satz

Abfülldaten zu starten.

3. Führen Sie Abfüllvoränge aus und beobachten Sie die Abfülldaten.

Abfülldaten Abfüllart Beschreibung

Durchschnittliche Gesamtab-
füllung

Einstufige Abfüllungen,
zweistufige Abfüllungen
und zeitgesteuerte Ab-
füllungen

Berechneter Durchschnitt aller Abfüll-
summen seit Zurücksetzen der Abfüll-
statistik.

Abfüllungen mit doppel-
tem Füllkopf und zeit-
gesteuerte Abfüllungen
mit doppeltem Füllkopf

Berechneter Durchschnitt aller Abfüll-
summen durch den Füllkopf Nr. 1 seit
Zurücksetzen der Abfüllstatistik.

Abweichung der Gesamtab-
füllung

Einstufige Abfüllungen,
zweistufige Abfüllungen
und zeitgesteuerte Ab-
füllungen

Berechnete Abweichung aller Füll-
summen seit Zurücksetzen der Abfüll-
statistik.

Abfüllungen mit doppel-
tem Füllkopf und zeit-
gesteuerte Abfüllungen
mit doppeltem Füllkopf

Berechnete Abweichung aller Abfüll-
summen durch den Füllkopf Nr. 1 seit
Zurücksetzen der Abfüllstatistik.
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Abfülldaten Abfüllart Beschreibung

Durchschnittliche sekundäre
Gesamtabfüllung

Nur Abfüllungen mit
doppeltem Füllkopf und
zeitgesteuerte Abfüllun-
gen mit doppeltem Füll-
kopf

Berechneter Durchschnitt aller Abfüll-
summen durch den Füllkopf Nr. 2 seit
Zurücksetzen der Abfüllstatistik.

Abweichung der sekundären
Gesamtabfüllung

Nur Abfüllungen mit
doppeltem Füllkopf und
zeitgesteuerte Abfüllun-
gen mit doppeltem Füll-
kopf

Berechnete Abweichung aller Abfüll-
summen durch den Füllkopf Nr. 2 seit
Zurücksetzen der Abfüllstatistik.
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8 Konfigurieren einer integrierten
Abfüll-Ventilsteuerung mittels
PROFIBUS EDD
In diesem Kapitel behandelte Themen:

• Konfigurieren einer integrierten Abfüll-Ventilsteuerung mittels PROFIBUS EDD

• Konfigurieren von Abfülloptionen mittels PROFIBUS EDD

• Konfigurieren fill Steuerung unter Verwendung des PROFIBUS EDD (optional)

• Konfigurieren der Abfüllprotokollierung mittels PROFIBUS EDD (optional)

8.1 Konfigurieren einer integrierten Abfüll-
Ventilsteuerung mittels PROFIBUS EDD
Die Befüllungsart entsprechend der Anwendung konfigurieren.

Hinweis
Eine einstufige Binärbefüllung eignet sich für die meisten Anwendungen. Diese Befüllungsart
verwenden, soweit keine speziellen Anforderungen für andere Befüllungsarten bestehen. In den
meisten Fällen ist die Auswerteelektronik werksseitig für einstufige Binärbefüllungen konfiguriert
und mit einem Minimum an Konfigurationsanpassungen vor Ort einsatzbereit.

8.1.1 Konfigurieren einer einstufigen Abfüllung mittels
PROFIBUS EDD
Eine einstufige Binärbefüllung konfigurieren, wenn ein einzelner Behälter von einem
einzelnen Ventil befüllt werden soll. Das Ventil ist solange geöffnet, bis der Befüllungssollwert
erreicht ist.

Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, die PROFIBUS EDD muss installiert
sein und Sie müssen eine Verbindung mit der Auswerteelektronik hergestellt haben.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Choose Online > Configure > Manual Setup > Inputs/Outputs > Discrete Output.
b. Setzen Sie Precision DO1 auf Primary Valve.

c. Stellen Sie Precision DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.
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Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

2. Durchflussmessungen konfigurieren:

a. Choose Online > Configure > Manual Setup > Measurements.

b. Flow Direction (Durchflussrichtung) auf die für Ihre Installation angemessene
Option einstellen.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die durch den Pfeil auf dem Sensor angegebene Rich-
tung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der auf dem Sensor durch den Pfeil angegebenen
Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die entgegengesetzte durch den Pfeil auf dem Sensor
angegebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der entgegengesetzten durch den Pfeil auf dem
Sensor angegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

c. Mass Flow Units (Massedurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Mass Flow Rate (Massedurchflussrate)
eingestellt ist, wird die entsprechende Masseeinheit zur Befüllungsmessung
verwendet.

d. Volume Flow Units (Volumendurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Volume Flow Rate
(Volumendurchflussrate) eingestellt ist, wird die entsprechende Volumeneinheit
zur Befüllungsmessung verwendet.

e. Die anderen Durchflussoptionen wie gewünscht einstellen.
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Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

3. Choose Online > Configure > Manual Setup > Filling > Filling Configuration.

4. Flow Source (Durchflussquelle) auf die Prozessvariable einstellen, die zur
Befüllungsmessung verwendet werden soll.

Option Beschreibung

Massedurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Massedurchfluss

Volumendurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Volumendurchfluss

5. Folgende Parameter einstellen oder überprüfen:

Parameter Einstellung

Enable Dual Fill Disabled

Enable Timed Fill Disabled

Fill Stages One Stage Discrete

6. Set Fill Count Direction as desired.

Option Description

Count Up to Target The fill total starts at 0 and increases toward Fill Target.

Count Down to Target The fill total starts at Fill Target and decreases toward 0.

7. Fill Target (Befüllungssoll) auf die Menge einstellen, bei der der Befüllungsvorgang
abgeschlossen ist.

Den Wert in den Messeinheiten für Flow Source (Durchflussquelle) konfigurierten
Wert eingeben.

8. Max Fill Time (Maximale Befüllungszeit) auf die Anzahl von Sekunden einstellen, bei
der die Befüllungszeit überschritten wird.

Kann die Befüllung vor Ablauf dieser Zeit nicht abgeschlossen werden, wird die
Befüllung verworfen und Fehlernachrichten werden wegen
Befüllungszeitüberschreitung angezeigt.

Max Fill Time (Maximale Befüllungszeit) auf 0 einstellen, um die
Befüllungszeitüberschreitungsfunktion zu deaktivieren.

Der Standardwert für Max Fill Time (Maximale Befüllungszeit) ist 0 (deaktiviert). Der
Bereich liegt bei 0 Sekunden bis 800 Sekunden.

9. Measured Fill Time (Gemessene Befüllungszeit) wie gewünscht einstellen.

Measured Fill Time (Gemessene Befüllungszeit) steuert, wie die Befüllungszeit
gemessen wird.
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Option Beschreibung

Durchfluss stoppt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik erkennt, dass
der Durchfluss nach dem Schließen des Ventils stoppt.

Ventil schließt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik den Binäraus-
gang nach Bedarf einstellt, um das Ventil zu schließen.

10. Choose Online > Configure > Manual Setup > Filling > AOC Configuration.

11. Setzen Sie AOC Enable auf Enable.

Hinweis
Micro Motion empfiehlt dringendst die Verwendung der automatischen
Überfüllkompensation (AOC). AOC verbessert, sofern aktiviert und kalibriert, die
Befüllgenauigkeit und Reproduzierbarkeit.

12. Choose Online > Configure > Manual Setup > Filling > Purge Configuration.

13. Setzen Sie Enable Purge auf Disable.

Nachbereitungsverfahren

Optionen für einstufige Abfüllungen sind:

• Automatische Überfüllkompensation (AOC) konfigurieren. Wenn die automatische
Überfüllkompensation aktiviert ist, sicherstellen, dass AOC für die entsprechende
Anwendung ordnungsgemäß konfiguriert und kalibriert ist.

• Implementieren der Spülfunktion.

• Implementieren der Pumpfunktion.

8.1.2 Konfigurieren einer zweistufigen Abfüllung mittels
PROFIBUS EDD
Eine zweistufige Binärbefüllung konfigurieren, wenn ein einzelner Behälter von zwei
Ventilen befüllt werden soll.

Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, die PROFIBUS EDD muss installiert
sein und Sie müssen eine Verbindung mit der Auswerteelektronik hergestellt haben.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Choose Online > Configure > Manual Setup > Inputs/Outputs > Discrete Output.
b. Setzen Sie Precision DO1 auf Primary Valve.

c. Stellen Sie Precision DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.
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Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

d. Setzen Sie Precision DO2 auf Secondary Valve.

e. Stellen Sie Precision DO2 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

2. Durchflussmessungen konfigurieren:

a. Choose Online > Configure > Manual Setup > Measurements.

b. Flow Direction (Durchflussrichtung) auf die für Ihre Installation angemessene
Option einstellen.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die durch den Pfeil auf dem Sensor angegebene Rich-
tung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der auf dem Sensor durch den Pfeil angegebenen
Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die entgegengesetzte durch den Pfeil auf dem Sensor
angegebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der entgegengesetzten durch den Pfeil auf dem
Sensor angegebenen Richtung.
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Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

c. Mass Flow Units (Massedurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Mass Flow Rate (Massedurchflussrate)
eingestellt ist, wird die entsprechende Masseeinheit zur Befüllungsmessung
verwendet.

d. Volume Flow Units (Volumendurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Volume Flow Rate
(Volumendurchflussrate) eingestellt ist, wird die entsprechende Volumeneinheit
zur Befüllungsmessung verwendet.

e. Die anderen Durchflussoptionen wie gewünscht einstellen.

Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

3. Choose Online > Configure > Manual Setup > Filling > Filling Configuration.

4. Flow Source (Durchflussquelle) auf die Prozessvariable einstellen, die zur
Befüllungsmessung verwendet werden soll.

Option Beschreibung

Massedurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Massedurchfluss

Volumendurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Volumendurchfluss

5. Folgende Parameter einstellen oder überprüfen:

Parameter Einstellung

Enable Dual Fill Disabled

Enable Timed Fill Disabled

Fill Stages Two Stage Discrete

6. Set Fill Count Direction as desired.

Option Description

Count Up to Target The fill total starts at 0 and increases toward Fill Target.

Count Down to Target The fill total starts at Fill Target and decreases toward 0.

7. Configure By (Konfigurieren von) wie gewünscht einstellen.

Configure By (Konfigurieren von) steuert, wie die Ventilsteuerzeit konfiguriert ist.
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Option Beschreibung

% Sol-
lwert

Die Ventilöffnungs- und schließzeit wird als Prozentsatz von Fill Target (Befüllungs-
soll) konfiguriert. Zum Beispiel:
• Ventil öffnet = 0 %: Das Ventil öffnet, wenn die aktuelle Befüllunssumme 0 %

von Fill Target (Befüllungssoll) beträgt.
• Ventil schließt = 90 %: Das Ventil schließt, wenn die aktuelle Befüllungs-

summe 90 % von Fill Target (Befüllungssoll) beträgt.

Menge Die Ventilöffnungs- und schließzeiten werden zusammen mit der konfigurierten
Messeinheit konfiguriert. Zum Beispiel:
• Ventil öffnet = 0 g: Das Ventil öffnet, wenn die aktuelle Befüllungssumme 0 g

beträgt.
• Ventil schließt = 50 g: Das Ventil schließt, wenn die aktuelle Befüllungs-

summe 50 g weniger als Fill Target (Befüllungssoll) beträgt.

8. Fill Target (Befüllungssoll) auf die Menge einstellen, bei der der Befüllungsvorgang
abgeschlossen ist.

Den Wert in den Messeinheiten für Flow Source (Durchflussquelle) konfigurierten
Wert eingeben.

9. Max Fill Time (Maximale Befüllungszeit) auf die Anzahl von Sekunden einstellen, bei
der die Befüllungszeit überschritten wird.

Kann die Befüllung vor Ablauf dieser Zeit nicht abgeschlossen werden, wird die
Befüllung verworfen und Fehlernachrichten werden wegen
Befüllungszeitüberschreitung angezeigt.

Max Fill Time (Maximale Befüllungszeit) auf 0 einstellen, um die
Befüllungszeitüberschreitungsfunktion zu deaktivieren.

Der Standardwert für Max Fill Time (Maximale Befüllungszeit) ist 0 (deaktiviert). Der
Bereich liegt bei 0 Sekunden bis 800 Sekunden.

10. Measured Fill Time (Gemessene Befüllungszeit) wie gewünscht einstellen.

Measured Fill Time (Gemessene Befüllungszeit) steuert, wie die Befüllungszeit
gemessen wird.

Option Beschreibung

Durchfluss stoppt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik erkennt, dass
der Durchfluss nach dem Schließen des Ventils stoppt.

Ventil schließt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik den Binäraus-
gang nach Bedarf einstellt, um das Ventil zu schließen.

11. Open Primary (Primär öffnen), Open Secondary (Sekundär öffnen), Close Primary (Primär
schließen) und Close Secondary (Sekundär schließen) wie gewünscht einstellen.

Diese Werte steuern den Zeitpunkt in der Befüllung, bei dem die primären und
sekundären Ventile öffnen und schließen. Entweder werden sie durch die Menge
oder den Prozentsatz des Sollwertes, wie durch den Configure By (Konfiguriert durch)
Parameter gesteuert, konfiguriert.

Entweder muss Open Primary (Primär öffnen) oder Open Secondary (Sekundär öffnen)
so eingestellt werden, dass sie zu Befüllungsbeginn öffnen. Sofern dies gewünscht
wird, können beide zu Befüllungsbeginn öffnen. Wird ein Wert so eingestellt, dass er
später öffnet, wird der andere automatisch so eingestellt, dass er zu
Befüllungsbeginn öffnet.
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Entweder muss Close Primary (Primär schließen) oder Close Secondary (Sekundär
schließen) auf Schließen bei Befüllungsende eingestellt werden. Sofern dies
gewünscht wird, können beide bei Befüllungsende schließen. Wird ein Wert so
eingestellt, dass er früher schließt, wird der andere automatisch so eingestellt, dass
er bei Befüllungsende schließt.

12. Choose Online > Configure > Manual Setup > Filling > AOC Configuration.

13. Setzen Sie AOC Enable auf Enable.

Hinweis
Micro Motion empfiehlt dringendst die Verwendung der automatischen
Überfüllkompensation (AOC). AOC verbessert, sofern aktiviert und kalibriert, die
Befüllgenauigkeit und Reproduzierbarkeit.

14. Choose Online > Configure > Manual Setup > Filling > Purge Configuration.

15. Setzen Sie Enable Purge auf Disable.

Nachbereitungsverfahren

Optionen für zweistufige Abfüllungen sind:

• Automatische Überfüllkompensation (AOC) konfigurieren. Wenn die automatische
Überfüllkompensation aktiviert ist, sicherstellen, dass AOC für die entsprechende
Anwendung ordnungsgemäß konfiguriert und kalibriert ist.

• Implementieren der Spülfunktion.

Ventilöffnungs- und Schließsequenzen für zweistufige
diskrete Abfüllungen
Die folgenden Abbildungen zeigen das Öffnen und Schließen der Sekundärventile,
gesteuert durch die Konfiguration von Primär öffnen, Sekundär öffnen, Primär schließen und
Sekundär schließen.

Diese Abbildungen setzen voraus, dass die Abfüllung von Anfang bis Ende ohne
Unterbrechungen läuft.

Zuerst Primär öffnen, zuerst Primär schließenAbbildung 10-1:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Primary

Target 
(AOC adjusted)

T1 T2
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Zuerst Primär öffnen, zuerst Sekundär schließenAbbildung 10-2:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Secondary

Target 
(AOC adjusted)

T1 T2

Zuerst Sekundär öffnen, zuerst Primär schließenAbbildung 10-3:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Primary

Target 
(AOC adjusted)

T1 T2

Zuerst Sekundär öffnen, zuerst Sekundär schließenAbbildung 10-4:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Secondary

Target 
(AOC adjusted)

T1 T2

Einfluss von Configure By (Konfigurieren durch) auf das Öffnen
und Schließen des Ventils
Configure By (Konfigurieren durch) steuert, wie die Werte für Open Primary (Primär öffnen),
Open Secondary Sekundär öffnen), Close Primary (Primär schließen) und Close Secondary
(Sekundär schließen) konfiguriert und angewendet werden.

• Wenn Configure By(Konfiguriert durch) = % Target (Sollwert), addiert die
Auswerteelektronik die konfigurierten Werte für „Valve Open“ (Ventil geöffnet) und
„Valve Close“ (Ventil geschlossen) zu 0 %.

• Wenn Configure By (Konfiguriert durch) = Quantity (Menge), addiert die
Auswerteelektronik die konfigurierten Werte für „Valve Open“ (Ventil geöffnet) zu
0, und subtrahiert die konfigurierten Werte für „Valve Close“ (Ventil geschlossen)
von Fill Target (Befüllungssollwert).
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Beispiel: Configure By (Konfiguriert durch) und Befehle zum Öffnen/Schließen des
Ventils

Fill Target (Befüllungssollwert) = 200 g. Das Primärventil soll zu Beginn des
Befüllungsvorgangs öffnen und am Ende des Befüllungsvorgangs schließen. Das
Sekundärventil soll öffnen, nachdem 10 g abgefüllt wurden und wieder schließen,
nachdem 190 g abgefüllt wurden. Siehe Tabelle 10-1 bzgl. der erforderlichen
Einstellungen, die dieses Ergebnis bewirken.

Configure By (Konfiguriert durch) und Ventilkonfiguration Tabelle 10-1:   

Configure By (Konfiguriert durch)
Werte für „Valve Open“ (Ventil geöffnet) und „Valve
Close“ (Ventil geschlossen)

% Sollwert • Open Primary (Primär öffnen) = 0 %
• Open Secondary (Sekundär öffnen) = 5 %
• Close Secondary (Sekundär schließen) = 95 %
• Close Primary (Primär schließen) = 100 %

Menge • Open Primary (Primär öffnen) = 0 g
• Open Secondary (Sekundär öffnen) = 10 g
• Close Secondary (Sekundär schließen) = 10 g
• Close Primary (Primär schließen) = 0 g

8.1.3 Konfigurieren einer zeitgesteuerten Abfüllung mittels
PROFIBUS EDD
Eine zeitgesteuerte Befüllung konfigurieren, wenn ein einzelner Behälter von einem
einzelnen Ventil befüllt werden soll. Der Ventil ist für eine bestimmte Anzahl von Sekunden
geöffnet.

Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, die PROFIBUS EDD muss installiert
sein und Sie müssen eine Verbindung mit der Auswerteelektronik hergestellt haben.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Choose Online > Configure > Manual Setup > Inputs/Outputs > Discrete Output.
b. Setzen Sie Precision DO1 auf Primary Valve.

c. Stellen Sie Precision DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC
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Option
Signal von der Auswertee-
lektronik Spannung

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

2. Durchflussmessungen konfigurieren:

a. Choose Online > Configure > Manual Setup > Measurements.

b. Flow Direction (Durchflussrichtung) auf die für Ihre Installation angemessene
Option einstellen.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die durch den Pfeil auf dem Sensor angegebene Rich-
tung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der auf dem Sensor durch den Pfeil angegebenen
Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die entgegengesetzte durch den Pfeil auf dem Sensor
angegebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der entgegengesetzten durch den Pfeil auf dem
Sensor angegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

c. Mass Flow Units (Massedurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Mass Flow Rate (Massedurchflussrate)
eingestellt ist, wird die entsprechende Masseeinheit zur Befüllungsmessung
verwendet.

d. Volume Flow Units (Volumendurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Volume Flow Rate
(Volumendurchflussrate) eingestellt ist, wird die entsprechende Volumeneinheit
zur Befüllungsmessung verwendet.

e. Die anderen Durchflussoptionen wie gewünscht einstellen.

Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.
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3. Choose Online > Configure > Manual Setup > Filling > Filling Configuration.

4. Flow Source (Durchflussquelle) auf die Prozessvariable einstellen, die zur
Befüllungsmessung verwendet werden soll.

Option Beschreibung

Massedurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Massedurchfluss

Volumendurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Volumendurchfluss

5. Folgende Parameter einstellen oder überprüfen:

Parameter Setting

Enable Dual Fill Disabled

Enable Timed Fill Enabled

Fill Stages One Stage Discrete

6. Set Fill Count Direction as desired.

Option Description

Count Up to Target The fill total starts at 0 and increases toward Fill Target.

Count Down to Target The fill total starts at Fill Target and decreases toward 0.

7. Target Time (Sollwertzeit) auf die Anzahl von Sekunden einstellen, die der
Befüllungsvorgang dauern wird.

8. Choose Online > Configure > Manual Setup > Filling > AOC Configuration.

9. Set AOC Enable to Disable.

10. Choose Online > Configure > Manual Setup > Filling > Purge Configuration.

11. Set Enable Purge to Disable.

Nachbereitungsverfahren

Die folgende Option ist für zeitgesteuerte Füllungen erhältlich:

• Implementieren der Spülfunktion.

8.1.4 Konfigurieren einer Doppelfüllkopf Abfüllung mittels
PROFIBUS EDD
Eine Befüllung mit doppeltem Füllkopf konfigurieren, wenn zwei Behälter abwechselnd
von doppelten Füllköpfen befüllt werden sollen. Jedes Ventil ist solange geöffnet, bis der
Befüllungssollwert erreicht ist.

Wichtig
Das konfigurierte Fill Target (Befüllungssoll) wird auf beide Befüllungsköpfe angewendet.
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Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, die PROFIBUS EDD muss installiert
sein und Sie müssen eine Verbindung mit der Auswerteelektronik hergestellt haben.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Choose Online > Configure > Manual Setup > Inputs/Outputs > Discrete Output.
b. Setzen Sie Precision DO1 auf Primary Valve.

c. Stellen Sie Precision DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

d. Setzen Sie Precision DO2 auf Secondary Valve.

e. Stellen Sie Precision DO2 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

2. Durchflussmessungen konfigurieren:

a. Choose Online > Configure > Manual Setup > Measurements.

b. Flow Direction (Durchflussrichtung) auf die für Ihre Installation angemessene
Option einstellen.
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Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die durch den Pfeil auf dem Sensor angegebene Rich-
tung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der auf dem Sensor durch den Pfeil angegebenen
Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die entgegengesetzte durch den Pfeil auf dem Sensor
angegebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der entgegengesetzten durch den Pfeil auf dem
Sensor angegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

c. Mass Flow Units (Massedurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Mass Flow Rate (Massedurchflussrate)
eingestellt ist, wird die entsprechende Masseeinheit zur Befüllungsmessung
verwendet.

d. Volume Flow Units (Volumendurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Volume Flow Rate
(Volumendurchflussrate) eingestellt ist, wird die entsprechende Volumeneinheit
zur Befüllungsmessung verwendet.

e. Die anderen Durchflussoptionen wie gewünscht einstellen.

Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

3. Choose Online > Configure > Manual Setup > Filling > Filling Configuration.

4. Flow Source (Durchflussquelle) auf die Prozessvariable einstellen, die zur
Befüllungsmessung verwendet werden soll.

Option Beschreibung

Massedurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Massedurchfluss

Volumendurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Volumendurchfluss

5. Folgende Parameter einstellen oder überprüfen:
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Parameter Setting

Enable Dual Fill Enabled

Enable Timed Fill Disabled

Fill Stages One Stage Discrete

6. Set Fill Count Direction as desired.

Option Description

Count Up to Target The fill total starts at 0 and increases toward Fill Target.

Count Down to Target The fill total starts at Fill Target and decreases toward 0.

7. Fill Target (Befüllungssoll) auf die Menge einstellen, bei der der Befüllungsvorgang
abgeschlossen ist.

Den Wert in den Messeinheiten für Flow Source (Durchflussquelle) konfigurierten
Wert eingeben.

8. Max Fill Time (Maximale Befüllungszeit) auf die Anzahl von Sekunden einstellen, bei
der die Befüllungszeit überschritten wird.

Kann die Befüllung vor Ablauf dieser Zeit nicht abgeschlossen werden, wird die
Befüllung verworfen und Fehlernachrichten werden wegen
Befüllungszeitüberschreitung angezeigt.

Max Fill Time (Maximale Befüllungszeit) auf 0 einstellen, um die
Befüllungszeitüberschreitungsfunktion zu deaktivieren.

Der Standardwert für Max Fill Time (Maximale Befüllungszeit) ist 0 (deaktiviert). Der
Bereich liegt bei 0 Sekunden bis 800 Sekunden.

9. Measured Fill Time (Gemessene Befüllungszeit) wie gewünscht einstellen.

Measured Fill Time (Gemessene Befüllungszeit) steuert, wie die Befüllungszeit
gemessen wird.

Option Beschreibung

Durchfluss stoppt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik erkennt, dass
der Durchfluss nach dem Schließen des Ventils stoppt.

Ventil schließt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik den Binäraus-
gang nach Bedarf einstellt, um das Ventil zu schließen.

10. Choose Online > Configure > Manual Setup > Filling > AOC Configuration.

11. Set AOC Enable to Enable.

Hinweis
Micro Motion empfiehlt dringendst die Verwendung der automatischen
Überfüllkompensation (AOC). AOC verbessert, sofern aktiviert und kalibriert, die
Befüllgenauigkeit und Reproduzierbarkeit.

12. Choose Online > Configure > Manual Setup > Filling > Purge Configuration.

13. Set Enable Purge to Disable.
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Nachbereitungsverfahren

Optionen für Dual-fillhead Füllungen enthalten:

• Automatische Überfüllkompensation (AOC) konfigurieren. Wenn die automatische
Überfüllkompensation aktiviert ist, sicherstellen, dass AOC für die entsprechende
Anwendung ordnungsgemäß konfiguriert und kalibriert ist.

8.1.5 Konfigurieren einer zeitgesteuerten Abfüllung mit
doppeltem Füllkopf mittels PROFIBUS EDD
Eine zeitgesteuerte Befüllung mit doppeltem Füllkopf konfigurieren, wenn zwei Behälter
abwechselnd von doppelten Füllköpfen befüllt werden sollen. Jedes Ventil ist für eine
bestimmte Anzahl von Sekunden geöffnet.

Wichtig
Die konfigurierte Target Time (Sollwertzeit) wird auf beide Befüllungsköpfe angewendet.

Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, die PROFIBUS EDD muss installiert
sein und Sie müssen eine Verbindung mit der Auswerteelektronik hergestellt haben.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Choose Online > Configure > Manual Setup > Inputs/Outputs > Discrete Output.
b. Setzen Sie Precision DO1 auf Primary Valve.

c. Stellen Sie Precision DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

d. Setzen Sie Precision DO2 auf Secondary Valve.

e. Stellen Sie Precision DO2 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.
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Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

2. Durchflussmessungen konfigurieren:

a. Choose Online > Configure > Manual Setup > Measurements.

b. Flow Direction (Durchflussrichtung) auf die für Ihre Installation angemessene
Option einstellen.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die durch den Pfeil auf dem Sensor angegebene Rich-
tung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der auf dem Sensor durch den Pfeil angegebenen
Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die entgegengesetzte durch den Pfeil auf dem Sensor
angegebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der entgegengesetzten durch den Pfeil auf dem
Sensor angegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

c. Mass Flow Units (Massedurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Mass Flow Rate (Massedurchflussrate)
eingestellt ist, wird die entsprechende Masseeinheit zur Befüllungsmessung
verwendet.

d. Volume Flow Units (Volumendurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Volume Flow Rate
(Volumendurchflussrate) eingestellt ist, wird die entsprechende Volumeneinheit
zur Befüllungsmessung verwendet.

e. Die anderen Durchflussoptionen wie gewünscht einstellen.
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Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

3. Choose Online > Configure > Manual Setup > Filling > Filling Configuration.

4. Flow Source (Durchflussquelle) auf die Prozessvariable einstellen, die zur
Befüllungsmessung verwendet werden soll.

Option Beschreibung

Massedurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Massedurchfluss

Volumendurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Volumendurchfluss

5. Folgende Parameter einstellen oder überprüfen:

Parameter Einstellung

Enable Dual Fill Enabled

Enable Timed Fill Enabled

Fill Stages One Stage Discrete

6. Target Time (Sollwertzeit) auf die Anzahl von Sekunden einstellen, die der
Befüllungsvorgang dauern wird.

Anmerkung
Die konfigurierte Target Time (Sollwertzeit) wird auf beide Befüllungsköpfe angewendet.

7. Choose Online > Configure > Manual Setup > Filling > AOC Configuration.

8. Setzen Sie AOC Enable auf Disable.

9. Choose Online > Configure > Manual Setup > Filling > Purge Configuration.

10. Setzen Sie Enable Purge auf Disable.

8.2 Konfigurieren von Abfülloptionen mittels
PROFIBUS EDD
Je nach Befüllungsart kann die automatische Überfüllkompensation (AOC), die Spül- oder
die Pumpenfunktion konfiguriert und angewendet werden.

8.2.1 Konfigurieren und Implementieren der automatischen
Überfüllkompensation (AOC) mittels PROFIBUS EDD
Die automatische Überfüllkompensation (AOC) wird verwendet, um die Abfüllzeit
anzupassen und um für die Zeit zu kompensieren, die benötigt wird, den Befehl zum
Schließen des Ventils zu übertragen bzw. damit das Ventil vollständig schließt.
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Vorbereitungsverfahren

Vor Einrichtung der AOC stellen Sie sicher, dass alle anderen Abfüllparameter richtig
konfiguriert sind.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, die PROFIBUS EDD muss installiert
sein und Sie müssen eine Verbindung mit der Auswerteelektronik hergestellt haben.

Verfahren

1. Choose Online > Configure > Manual Setup > Filling > AOC Configuration.

2. Wählen Sie die Art der zu implementierenden AOC.

Option Beschreibung

Fixed Das Ventil schließt an dem Punkt, der durch Fill Target minus der Menge, die in Fixed
Overshoot Comp eingegeben ist, definiert wird. Verwenden Sie diese Option nur
dann, wenn der Wert für die „Frühwarnung“ bereits bekannt ist.

Overfill Definiert die Richtung, aus der der AOC-Algorithmus sich der Sollmenge nähert.
Der AOC-Algorithmus beginnt mit der Schätzung eines Überfüllungswerts und re-
duziert dann die Überfüllung in aufeinanderfolgenden Kalibrierabfüllungen.

Underfill Definiert die Richtung, aus der der AOC-Algorithmus sich der Sollmenge nähert.
Der AOC-Algorithmus beginnt mit der Schätzung eines Unterfüllungswerts und re-
duziert dann die Unterfüllung in aufeinanderfolgenden Kalibrierabfüllungen.

Hinweis
Die Option Fixed wird normalerweise nicht verwendet. Wenn Sie Fixed wählen, funktioniert die
Auswerteelektronik als Legacy-Batchsteuerung. In typischen Einsatzbereichen bieten die
anderen AOC-Optionen bessere Genauigkeit und Wiederholbarkeit.

Einschränkung
Die Optionen Fixed und Overfill werden für Abfüllungen mit doppeltem Füllkopf nicht
unterstützt.

3. Implementierung der Fixed AOC:

a. Deaktivieren Sie Enable AOC.

b. Setzen Sie AOC Algorithm auf Fixed.

c. Stellen Sie Fixed Overshoot Comp nach Wunsch ein.

Die Voreinstellung ist 0 und wird in Prozesseinheiten gemessen.

Die Auswerteelektronik schließt das Ventil, wenn der aktuelle Abfüllzähler gleich
dem Fill Target minus dem angegebenen Wert (in Prozesseinheiten) ist.

4. So implementieren Sie Overfill oder Underfill:

a. Stellen Sie sicher, dass Enable AOC aktiviert ist.

b. Setzen Sie AOC Algorithm auf Underfill oder Overfill.
c. Stellen Sie AOC Window Length auf die Anzahl der Abfüllungen ein, die zur AOC-

Kalibrierung verwendet wird.

Die Voreinstellung ist 10. Der Auswahlbereich ist 2 bis 32.
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Hinweis
Micro Motion empfiehlt die Verwendung des Standardwerts, es sei denn, Sie haben
besondere Anwendungsanforderungen.

Wichtig
Ändern Sie die Werte für AOC Change Limit oder AOC Convergence Rate nur auf Anweisung des
Kundendienstes von Micro Motion. Diese Parameter werden verwendet, um die Funktion des
AOC-Algorithmus für besondere Anwendungsanforderungen einzustellen.

Nachbereitungsverfahren

Wenn Sie AOC Algorithm auf Overfill oder Underfill setzen, müssen Sie eine AOC-Kalibrierung
durchführen.

Durchführen einer AOC-Kalibrierung mittels PROFIBUS EDD
Die AOC-Kalibrierung wird verwendet, um den Wert für die automatische
Überfüllkompensation (Automatic Overshoot Compensation, AOC) anhand der Ist-
Abfülldaten zu berechnen. Wenn Sie AOC Algorithm auf Overfill oder Underfill setzen, müssen
Sie eine AOC-Kalibrierung durchführen.

Es gibt zwei Arten der AOC-Kalibrierung:

• Standard: Die Kalibrierung wird manuell durchgeführt. Der AOC-Koeffizient wird
anhand von Abfülldaten berechnet, die bei dieser Kalibrierung eingeholt werden,
und derselbe AOC-Koeffizient wird solange angewandt, bis die Kalibrierung
wiederholt wird.

• Rolling: Die Kalibrierung wird kontinuierlich und automatisch durchgeführt, und der
AOC-Koeffizient wird kontinuierlich - auf Basis von Abfülldaten des letzten
Abfüllvorgangs - aktualisiert.

Hinweis
Für stabile Prozesse empfiehlt Micro Motion die AOC-Standardkalibrierung. Testen Sie nach Bedarf
beide Methoden und wählen Sie die Methode, mit der Sie die besten Ergebnisse erzielen.

Durchführen einer AOC-Standardkalibrierung

Standard AOC Calibration wird verwendet, um einen konstanten AOC-Koeffizienten zu
erzeugen.

Vorbereitungsverfahren

AOC Window Length muss entsprechend gesetzt werden. Micro Motion empfiehlt die
Verwendung des Standardwerts (10), es sei denn, Sie haben besondere
Anwendungsanforderungen.

Mass Flow Cutoff bzw. Volume Flow Cutoff müssen entsprechend der Betriebsumgebung
gesetzt werden.

• Wenn Flow Source auf Mass Flow Rate gesetzt ist, siehe Abschnitt 15.2.3.

• Wenn Flow Source auf Volume Flow Rate gesetzt ist, siehe Abschnitt 15.3.2.

Ihr System muss zum Abfüllen bereit sein, und Sie müssen wissen, wie Abfüllvorgänge
ausgeführt werden.
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Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, die PROFIBUS EDD muss installiert
sein und Sie müssen eine Verbindung mit der Auswerteelektronik hergestellt haben.

Verfahren

1. Choose Online > Overview > Fill Control > AOC Control.
2. Kalibrierung des Primärventils (alle Befüllarten):

a. Klicken Sie auf Start AOC Cal.
b. Führen Sie zwischen zwei und der in AOC Window Length angegebenen Anzahl von

Kalibrierabfüllungen aus.

Anmerkung
Sie können nach Wahl auch mehr Kalibrierabfüllungen durchführen. Der AOC-Koeffizient
wird anhand der letzten Abfüllungen berechnet.

Hinweis
Normalerweise werden, aufgrund der werksseitigen Standardeinstellungen, die ersten
Abfüllungen leicht über- oder unterfüllt. Im Laufe der Kalibrierung werden diese
Abfüllungen auf dem Fill Target konvergieren.

c. Wenn die Abfüllzähler kontinuierlich zufriedenstellend sind, klicken Sie auf Save
AOC Cal.

3. Kalibrierung des Sekundärventils (Abfüllungen mit doppeltem Füllkopf):

a. Klicken Sie auf Start Secondary AOC Cal.
b. Führen Sie zwischen zwei und der in AOC Window Length angegebenen Anzahl von

Kalibrierabfüllungen aus.

Die Auswerteelektronik führt die Abfüllungen automatisch durch das
Sekundärventil durch.

Anmerkung
Sie können nach Wahl auch mehr Kalibrierabfüllungen durchführen. Der AOC-Koeffizient
wird anhand der letzten Abfüllungen berechnet.

Hinweis
Normalerweise werden, aufgrund der werksseitigen Standardeinstellungen, die ersten
Abfüllungen leicht über- oder unterfüllt. Im Laufe der Kalibrierung werden diese
Abfüllungen auf dem Fill Target konvergieren.

c. Wenn die Abfüllzähler kontinuierlich zufriedenstellend sind, klicken Sie auf Save
Secondary AOC Cal.

Der aktuelle AOC-Koeffizient wird im Fenster Run Filler angezeigt. Falls Sie eine Abfüllung
mit doppeltem Füllkopf durchführen, zeigt das Fenster Run Filler den AOC-Koeffizienten
für das Primär- und für das Sekundärventil an. Diese Koeffizienten werden solange auf die
Abfüllvorgänge angewandt, wie AOC aktiviert ist.
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Anmerkung
Bei zweistufigen Abfüllungen wird der AOC-Wert auf das Ventil angewandt, das sich schließt,
nachdem die Sollmenge erreicht ist. Falls die Abfüllparameter so eingestellt sind, dass sich beide
Ventile nach Erreichen der Sollmenge schließen, wird der AOC-Koeffizient auf beide Ventile
angewandt.

Hinweis
Micro Motion empfiehlt eine Wiederholung der AOC-Kalibierung, falls einer der folgenden Zustände
eintritt:

• Wenn Geräte ausgetauscht oder eingestellt wurden.

• Wenn sich die Durchflussmenge bedeutend geändert hat.

• Wenn die Abfüllgenauigkeit niedriger als erwartet ist.

• Wenn Mass Flow Cutoff oder Volume Flow Cutoff geändert wurden.

Einrichten einer kontinuierlichen AOC-Kalibrierung

Rolling AOC Calibration wird verwendet, um den AOC-Koeffizienten kontinuierlich - auf
Basis von Abfülldaten des letzten Abfüllvorgangs - zu aktualisieren.

Vorbereitungsverfahren

AOC Window Length muss entsprechend gesetzt werden. Micro Motion empfiehlt die
Verwendung des Standardwerts (10), es sei denn, Sie haben besondere
Anwendungsanforderungen.

Ihr System muss zum Abfüllen bereit sein, und Sie müssen wissen, wie Abfüllvorgänge
ausgeführt werden.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, die PROFIBUS EDD muss installiert
sein und Sie müssen eine Verbindung mit der Auswerteelektronik hergestellt haben.

Verfahren

1. Choose Online > Configure > Manual Setup > Filling > AOC Configuration.

2. Zur Kalibrierung des Primärventils (alle Abfüllarten) klicken Sie auf Start AOC Cal: Zur
Kalibrierung des Sekundärventils (Abfüllungen mit doppeltem Füllkopf) klicken Sie
auf Start Secondary AOC Cal.

Sie können die kontinuierliche AOC-Kalibrierung für ein oder beide Ventile
einrichten.

3. Starten Sie die Serienabfüllung.

Die Auswerteelektronik berechnet den/die AOC-Koeffizienten nach jeder Abfüllung
anhand der letzten xAbfüllungen neu, wobei x die in AOC Window Length festgelegte Anzahl
ist. Die aktuellen Werte werden im Fenster Run Filler angezeigt. Falls sich die Konfiguration
oder die Prozessbedingungen geändert haben, gleicht die kontinuierliche AOC-
Kalibrierung diese Änderungen aus. Diese Einstellung findet jedoch über mehrere
Abfüllungen hinweg statt, das heißt, dass es einige Abfüllvorgänge dauern wird, ehe AOC
die Werte angepasst hat.

Hinweis
Der aktuelle AOC-Koeffizient wird gespeichert und auf alle nachfolgenden Abfüllungen durch das
entsprechende Ventil angewandt. Mit anderen Worten ändert diese Aktion die AOC-
Kalibriermethode für dieses Ventil von Rolling auf Standard.
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8.2.2 Konfigurieren der Spülfunktion mittels PROFIBUS EDD
Die Spülfunktion wird verwendet, um ein Hilfsventil zu steuern, das nicht für die Abfüllung
eingesetzt wird. Beispielsweise kann damit ein Behälter mit Wasser oder Gas aufgefüllt
werden, nachdem der Füllvorgang abgeschlossen ist, oder sie kann als “ Dämpfung
dienen.” Der Durchfluss durch das Hilfsventil wird von der Auswerteelektronik nicht
gemessen. Eine Konfiguration der Spülfunktion zur automatischen oder manuellen
Spülsteuerung ist möglich. Bei der Auswahl der automatischen Steuerung wird das
Hilfsventil nach jeder Befüllung geöffnet und nach dem Ablauf der konfigurierten Spülzeit
geschlossen.

Einschränkung
Die Spülfunktion wird nicht für Befüllungen mit doppeltem Füllkopf oder zeitgesteuerte Befüllungen
mit doppeltem Füllkopf unterstützt.

Vorbereitungsverfahren

Die Binärausgänge müssen entsprechend Ihrer Abfüllart und Abfülloptionen geschaltet
sein.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, die PROFIBUS EDD muss installiert
sein und Sie müssen eine Verbindung mit der Auswerteelektronik hergestellt haben.

Verfahren

1. Konfigurieren von Kanal B als Binärausgang:

a. Choose Online > Configure > Manual Setup > Inputs/Outputs > Channels.

b. Setzen Sie Channel B Type Assignment auf Discrete Output.
c. Choose Online > Configure > Manual Setup > Inputs/Outputs > Discrete Output.
d. Setzen Sie DO1 Assignment auf Discrete Batch: Purge Valve.

e. Stellen Sie DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

f. Stellen Sie DO1 Fault Action entsprechend Ihrer Installation ein.

Option Beschreibung

Upscale Der Binäreingang wird auf EIN geschaltet (Ventil geöf-
fnet), wenn eine Störung auftritt.
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Option Beschreibung

Downscale Der Binäreingang wird auf AUS geschaltet (Ventil ges-
chlossen), wenn eine Störung auftritt.

None Bei Auftreten einer Störung werden keine Maßnahmen er-
griffen. Der Binärausgang bleibt in dem Zustand, in dem
er vor Auftreten der Störung war.

2. Spülung konfigurieren:

a. Choose Online > Configure > Manual Setup > Filling > Filling Configuration.

b. Enable Purge (Spülung aktivieren) aktivieren.

c. Purge Mode (Spülmodus) wie gewünscht einstellen.

Option Beschreibung

Auto (Automatisch) Eine Spülung wird nach jeder Befüllung automatisch
durchgeführt.

Manual (Manuell) Spülvorgänge müssen manuell gestartet und ges-
toppt werden.

Hinweis
Wenn Purge Mode (Spülmodus) auf Auto (Automatisch) eingestellt ist, ist eine manuelle
Steuerung des Spülventils weiterhin möglich. Eine Spülung kann manuell gestartet oder
gestoppt werden oder sie kann durch die Auswerteelektronik nach der abgelaufenen
Purge Time (Spülzeit) gestoppt werden. Wird eine Spülung automatisch gestartet, kann sie
manuell gestoppt werden.

d. Wenn Purge Mode (Spülmodus) auf Auto (Automatisch) eingestellt ist, Purge Delay
(Spülverzögerung) auf die Anzahl von Sekunden einstellen, die die
Auswerteelektronik nach der Befüllung warten soll, umd das Spülventil zu
öffnen.

Der Standardwert für Purge Delay (Spülverzögerung) beträgt 2 Sekunden.

e. Wenn Purge Mode (Spülmodus) auf Auto (Automatisch) eingestellt wird, Purge Time
(Spülzeit) auf die Anzahl von Sekunden einstellen, die die Auswerteelektronik das
Ventil offen halten soll.

Der Standardwert für Purge Time (Spülzeit) beträgt 1 Sekunde. Der Bereich liegt
bei 0 Sekunden bis 800 Sekunden.

Hinweis
Die nächste Befüllung kann erst beginnen, wenn das Spülventil geschlossen ist.

8.2.3 Konfigurieren der Pumpenfunktion mittels PROFIBUS
EDD
Die Pumpfunktion wird verwendet, um den Druck während der Abfüllung zu erhöhen,
indem eine in Flussrichtung liegende Pumpe kurz vor dem Beginn der Abfüllung gestartet
wird.
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Einschränkung
Die Pumpenfunktion wird nicht für zweistufige Binärbefüllungen, Befüllungen mit doppeltem
Füllkopf, zeitgesteuerte Befüllungen oder zeitgesteuerte Befüllungen mit doppeltem Füllkopf
unterstützt.

Vorbereitungsverfahren

Die Binärausgänge müssen entsprechend Ihrer Abfüllart und Abfülloptionen geschaltet
sein.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, die PROFIBUS EDD muss installiert
sein und Sie müssen eine Verbindung mit der Auswerteelektronik hergestellt haben.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Choose Online > Configure > Manual Setup > Inputs/Outputs > Discrete Output.
b. Setzen Sie Precision DO2 auf Pump.

c. Stellen Sie Precision DO2 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

2. Choose Online > Configure > Manual Setup > Filling > Filling Configuration
3. Pump to Valve Delay (Pumpe-zu-Ventilverzögerung) auf die Anzahl von Sekunden

einstellen, die die Pumpe laufen soll, bevor das Ventil geöffnet wird.

Der Standardwert beträgt 10 Sekunden. Der Bereich liegt bei 0 Sekunden bis
30 Sekunden.

Wenn der Befehl Begin Filling (Befüllung beginnen) empfangen wird, startet die
Auswerteelektronik die Pumpe, wartet die unter Pump to Valve Delay (Pumpe-zu-
Ventilverzögerung) spezifizierte Anzahl von Sekunden und öffnet dann das Ventil. Die
Pumpe läuft, bis die Befüllung abgeschlossen ist.

Konfigurieren einer integrierten Abfüll-Ventilsteuerung mittels PROFIBUS EDD

Konfigurations- und Bedienungsanleitung 91



8.3 Konfigurieren fill Steuerung unter
Verwendung des PROFIBUS EDD (optional)
Bei einer typischen Serienfertigung erfolgt die Abfüllsteuerung (Starten und Stoppen der
Abfüllung) durch den Host oder die SPS. Sie können auf Wunsch das System auch so
einrichten, dass die Abfüllung über den Binäreingang (falls verfügbar) begonnen, beendet,
angehalten und fortgesetzt wird. Außerdem können Sie ein Ereignis definieren, bei dem
die Abfüllung beginnt, endet, angehalten oder fortgesetzt wird.

8.3.1 Konfigurieren des Binäreingangs für die Abfüllsteuerung
mittels PROFIBUS EDD
Wenn Kanal B verfügbar ist, können Sie diesen als Binäreingang konfigurieren und
verwenden, um eine Abfüllung zu beginnen oder zu beenden oder um eine laufende
Abfüllung anzuhalten und fortzusetzen. Außerdem können Sie den Kanal zum
Zurücksetzen des Masse Summenzählers, des Volumen Summenzählers oder aller
Summenzähler konfigurieren. Wenn der Binäreingang aktiviert ist, werden alle
zugewiesenen Aktionen durchgeführt.

Vorbereitungsverfahren

Kanal B muss als Binärausgang geschaltet sein.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, die PROFIBUS EDD muss installiert
sein und Sie müssen eine Verbindung mit der Auswerteelektronik hergestellt haben.

Verfahren

1. Konfigurieren von Kanal B als Binäreingang:

a. Choose Online > Configure > Manual Setup > Inputs/Outputs > Channels.

b. Setzen Sie Type Assignment für Kanal B auf Discrete Input.
2. Weisen Sie dem Binäreingang Steuerungsaktionen zur Abfüllung zu.

a. Choose Online > Configure > Manual Setup > Inputs/Outputs > Discrete Intput.
b. Wählen Sie die Aktion oder Aktionen, die bei Aktivierung des Binäreingangs

ausgeführt werden sollen.

Aktion Beschreibung Bemerkungen

Begin Filling Beginnt die Abfüllung mit der aktuellen Abfüll-
konfiguration. Der Abfüllzähler wird automa-
tisch zurückgesetzt, bevor die Abfüllung be-
ginnt.

Falls eine Abfüllung läuft, wird der Befehl ig-
noriert.

Wenn ein automatischer Spülvorgang läuft,
werden die Funktionen zum Start der Abfül-
lung ausgeführt, sobald der Spülvorgang ab-
geschlossen ist.

End Filling Beendet die aktuelle Abfüllung und führt Funk-
tionen zum Ende der Abfüllung aus. Die Abfül-
lung kann nicht fortgesetzt werden.

Wird ausgeführt, während eine Abfüllung läuft
oder angehalten ist und während eines Spül-
vorgangs oder einer Spülverzögerung.

Für Abfüllungen mit doppeltem Füllkopf und
zeitgesteuerte Abfüllungen mit doppeltem
Füllkopf beendet der Befehl immer die zurzeit
aktive Abfüllung.
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Aktion Beschreibung Bemerkungen

Pause Filling Zeitgesteuerte Abfüllungen, Abfüllungen mit
doppeltem Füllkopf und zeitgesteuerte Abfül-
lungen mit doppeltem Füllkopf: Identisch mit
End Filling.

Einstufige Abfüllungen und zweistufige Abfül-
lungen: Hält die Abfüllung vorläufig an. Die
Abfüllung kann fortgesetzt werden, wenn die
Abfüllmenge kleiner als die Sollmenge ist.

Falls ein Spülvorgang oder eine Spülverzöger-
ung läuft, wird der Befehl ignoriert.

Resume Filling Startet die Abfüllung wieder, nachdem sie un-
terbrochen wurde. Die Zählung wird an der
Stelle oder an dem Zeitpunkt wieder fortge-
setzt, an der/dem sie unterbrochen wurde.

Wird nur ausgeführt, wenn eine einstufige Ab-
füllung oder eine zweistufige Abfüllung ange-
halten wurden. Wird alle anderen Male ignor-
iert.

Reset Mass Total Setzt den Wert des Masse Summenzählers auf
0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

Reset Volume Total Setzt den Wert des Volumen Summenzählers
auf 0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

Reset All Totals Setzt den Wert des Masse Summenzählers und
des Volumen Summenzählers auf 0 zurück,
und setzt den Abfüllzähler auf 0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

c. Öffnen Sie für jede ausgewählte Aktion die Dropdown-Liste und wählen Sie
Discrete Input 1.

3. Stellen Sie DI1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das vom Binäreingang gesendete EIN-Signal auch als EIN
gelesen wird, und umgekehrt.

Option
Angelegte Spannung über
Anschlussklemmen Auswerteelektronik liest

Active High 3 bis 30 VDC ON

<0,8 VDC OFF

Active Low <0,8 VDC ON

3 bis 30 VDC OFF

8.3.2 Einrichten eines Ereignisses zur Durchführung einer
Abfüllsteuerung mittels PROFIBUS EDD
Sie können ein Ereignis zuweisen, um eine Abfüllung zu starten, zu stoppen, anzuhalten
oder fortzusetzen. Außerdem können Sie das Ereignis zum Zurücksetzen des Masse
Summenzählers, des Volumen Summenzählers oder aller Summenzähler zuweisen. Beim
Schalten des Ereignisses auf ON (EIN) werden alle zugewiesenen Aktionen durchgeführt.
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Vorbereitungsverfahren

Sie müssen alle gewünschten Ereignisse konfigurieren. Sie können diese Ereignisse sowohl
vor als auch nach dem Zuweisen von Aktionen konfigurieren.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, die PROFIBUS EDD muss installiert
sein und Sie müssen eine Verbindung mit der Auswerteelektronik hergestellt haben.

Verfahren

1. Weisen Sie dem Ereignis Steuerungsaktionen zur Abfüllung zu.

a. Choose Online > Configure > Alert Setup > Discrete Events.

b. Identifizieren Sie die Aktion oder Aktionen, die bei Auftreten des Discrete Event 1
ausgeführt werden soll bzw. sollen.

Aktion Beschreibung Bemerkungen

Begin Filling Beginnt die Abfüllung mit der aktuellen Abfüll-
konfiguration. Der Abfüllzähler wird automa-
tisch zurückgesetzt, bevor die Abfüllung be-
ginnt.

Falls eine Abfüllung läuft, wird der Befehl ig-
noriert.

Wenn ein automatischer Spülvorgang läuft,
werden die Funktionen zum Start der Abfül-
lung ausgeführt, sobald der Spülvorgang ab-
geschlossen ist.

End Filling Beendet die aktuelle Abfüllung und führt Funk-
tionen zum Ende der Abfüllung aus. Die Abfül-
lung kann nicht fortgesetzt werden.

Wird ausgeführt, während eine Abfüllung läuft
oder angehalten ist und während eines Spül-
vorgangs oder einer Spülverzögerung.

Für Abfüllungen mit doppeltem Füllkopf und
zeitgesteuerte Abfüllungen mit doppeltem
Füllkopf beendet der Befehl immer die zurzeit
aktive Abfüllung.

Pause Filling Zeitgesteuerte Abfüllungen, Abfüllungen mit
doppeltem Füllkopf und zeitgesteuerte Abfül-
lungen mit doppeltem Füllkopf: Identisch mit
End Filling.

Einstufige Abfüllungen und zweistufige Abfül-
lungen: Hält die Abfüllung vorläufig an. Die
Abfüllung kann fortgesetzt werden, wenn die
Abfüllmenge kleiner als die Sollmenge ist.

Falls ein Spülvorgang oder eine Spülverzöger-
ung läuft, wird der Befehl ignoriert.

Resume Filling Startet die Abfüllung wieder, nachdem sie un-
terbrochen wurde. Die Zählung wird an der
Stelle oder an dem Zeitpunkt wieder fortge-
setzt, an der/dem sie unterbrochen wurde.

Wird nur ausgeführt, wenn eine einstufige Ab-
füllung oder eine zweistufige Abfüllung ange-
halten wurden. Wird alle anderen Male ignor-
iert.

Reset Mass Total Setzt den Wert des Masse Summenzählers auf
0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

Reset Volume Total Setzt den Wert des Volumen Summenzählers
auf 0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.
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Aktion Beschreibung Bemerkungen

Reset All Totals Setzt den Wert des Masse Summenzählers und
des Volumen Summenzählers auf 0 zurück,
und setzt den Abfüllzähler auf 0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

2. Wiederholen Sie das Verfahren für Discrete Event 2–5.

Beispiel: Ereignisse überwachen den Prozess und pausieren oder beenden die
Abfüllung

Der akzeptable Dichtebereich für Ihren Prozess ist 1,1 g/cm3 bis 1,12 g/cm3. Der
akzeptable Temperaturbereich ist 20 °C bis 25 °C. Wenn die Dichte den Messbereich
überschreitet, möchten Sie die Abfüllung anhalten. Wenn die Temperatur den
Messbereich überschreitet, möchten Sie die Abfüllung beenden.

Konfiguration der Ereignisse:

• Discrete Event 1:

- Event Type: Out of Range
- Process Variable: Density
- Low Setpoint (A): 1,1 g/cm3

- High Setpoint (B): 1,12 g/cm3

• Discrete Event 2:

- Event Type: Out of Range
- Process Variable: Temperature
- Low Setpoint (A): 20 °C

- High Setpoint (B): 25 °C

Aktionszuordnungen:

• Pause Fill: Discrete Event 1
• End Fill: Discrete Event 2

Nachbereitungsverfahren

Wenn Sie Ereignissen Aktionen zugeordnet haben, die nicht konfiguriert sind, müssen Sie
diese Ereignisse konfigurieren, bevor Sie diese Methode der Abfüllsteuerung
implementieren können.

8.3.3 Mehrere Maßnahmen, die einem Binäreingang oder
Ereignis zugewiesen sind
Wenn mehrere Maßnahmen einem Binäreingang oder Ereignis zugewiesen sind, führt die
Auswerteelektronik nur die Maßnahmen durch, die jeweils für die aktuelle Situation von
Bedeutung sind. Wenn zwei oder mehr der Maßnahmen sich gegenseitig ausschließen,
führt die Auswerteelektronik Maßnahmen gemäß einem Prioritätenschema durch, das in
der Firmware der Auswerteelektronik definiert ist.

Die folgenden Beispiele zeigen drei Konfigurationen, die Micro Motion empfiehlt, und zwei
Konfigurationen, die nicht empfohlen werden.
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Beispiel: Verwenden des Binäreingangs oder des Ereignisses, um eine Abfüllung zu
beginnen und zu beenden (empfohlen)

Maßnahmezuordnungen:

• Abfüllung-Beginn
• Abfüllung-Ende
• Masse Summenzähler zurücksetzen
• Volumen Summenzähler zurücksetzen

Ergebnis der Aktivierung:

• Wenn keine Abfüllung läuft, werden der Masse Summenzähler und der Volumen
Summenzähler zurückgesetzt und eine Abfüllung beginnt.

• Wenn eine Abfüllung läuft, wird diese beendet und der Masse Summenzähler und
der Volumen Summenzähler werden zurückgesetzt.

Beispiel: Verwenden des Binäreingangs oder des Ereignisses, um die Abfüllung zu
beginnen, anzuhalten und sie fortzusetzen (empfohlen)

Maßnahmezuordnungen:

• Abfüllung-Beginn
• Abfüllung-Pause
• Abfüllung-Fortsetzung

Ergebnis der Aktivierung:

• Wenn keine Abfüllung läuft, wird diese gestartet.

• Wenn eine Abfüllung läuft und nicht angehalten wurde, wird diese angehalten.

• Wenn eine Abfüllung angehalten wurde, wird diese fortgesetzt.

Beispiel: Verwenden des Binäreingangs, um die Abfüllung zu starten und den
Volumenzähler zurückzusetzen (empfohlen)

Maßnahmezuordnungen:

• Abfüllung-Beginn
• Volumen Summenzähler zurücksetzen

Ergebnis der Aktivierung:

• Wenn keine Abfüllung läuft, wird der Volumen Summenzähler zurückgesetzt und
eine Abfüllung beginnt.

• Wenn eine Abfüllung läuft, wird der Volumen Summenzähler zurückgesetzt.

Hinweis
Diese Konfiguration ist nützlich, wenn die Abfüllung hinsichtlich der Masse konfiguriert wird, das
Gesamtvolumen für die Abfüllung aber ebenfalls ermittelt werden soll. In diesem Fall nicht den
Binäreingang aktivieren, während die Abfüllung läuft. Am Ende der Abfüllung kann das
Gesamtvolumen abgelesen werden. Danach mit der nächsten Abfüllung fortfahren.

Beispiel: Inkompatible Zuordnungen (nicht empfohlen)

Maßnahmezuordnungen:

• Abfüllung-Beginn
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• Abfüllung-Ende
• Abfüllung-Pause
• Abfüllung-Fortsetzung

Ergebnis der Aktivierung:

• Wenn keine Abfüllung läuft, wird diese gestartet.

• Wenn eine Abfüllung läuft, wird diese beendet.

In diesem Beispiel wird die Abfüllung durch den Binäreingang oder das Ereignis nicht
angehalten, weil die Maßnahme End Fill Priorität hat.

Beispiel: Inkompatible Zuordnungen (nicht empfohlen)

Maßnahmezuordnungen:

• Abfüllung-Ende
• Alle Zähler zurücksetzen

Ergebnis der Aktivierung:

• Wenn keine Abfüllung läuft, werden alle Zähler, einschließlich dem Abfüll-
Summenzähler, zurückgesetzt.

• Wenn eine Abfüllung läuft, wird diese beendet und alle Zähler, einschließlich dem
Abfüll-Summenzähler, werden zurückgesetzt.

Das Ergebnis dieser Kombination ist, dass der Abfüll-Summenzähler vor dem Abrufen der
Daten zurückgesetzt wird.

8.4 Konfigurieren der Abfüllprotokollierung
mittels PROFIBUS EDD (optional)
Sie können die Auswerteelektronik so konfigurieren, dass der ON/OFF-Status über Kanal B
(falls verfügbar) und der Prozentsatz der Abfüllung über den mA-Ausgang ausgegeben
wird.

8.4.1 Konfigurieren von Kanal B als Binärausgang und
Übertragen des Abfüllstatus ON/OFF mittels PROFIBUS
EDD
Falls Kanal B verfügbar ist, können Sie diesen verwenden, um auszugeben, ob ein
Abfüllvorgang läuft.

Vorbereitungsverfahren

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, die PROFIBUS EDD muss installiert
sein und Sie müssen eine Verbindung mit der Auswerteelektronik hergestellt haben.

Kanal B muss als Binärausgang geschaltet sein.

Verfahren

1. Choose Online > Configure > Manual Setup > Inputs/Outputs > Channels.
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2. Setzen Sie Channel B Type Assignment auf Discrete Output.
3. Choose Online > Configure > Manual Setup > Inputs/Outputs > Discrete Output.
4. Setzen Sie DO1 Assignment auf Discrete Batch: Batching/Filling In Progress.

5. Stellen Sie DO1 Polarity entsprechend Ihrer Installation ein.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

6. Stellen Sie DO1 Fault Action entsprechend Ihrer Installation ein.

Option Beschreibung

Upscale Der Binäreingang wird auf EIN geschaltet (Ventil geöffnet),
wenn eine Störung auftritt.

Downscale Der Binäreingang wird auf AUS geschaltet (Ventil geschlos-
sen), wenn eine Störung auftritt.

None Bei Auftreten einer Störung werden keine Maßnahmen er-
griffen. Der Binärausgang bleibt in dem Zustand, in dem er
vor Auftreten der Störung war.

Hinweis
Wenn der Binärausgang zur Ausgabe von Abfüllberichten verwendet wird, empfiehlt Micro
Motion die Einstellung von DO1 Fault Action auf None.

8.4.2 Konfigurieren des mA-Ausgangs, um die prozentuale
Abfüllung mittels PROFIBUS EDD auszugeben
Sie können den mA-Ausgang so konfigurieren, dass er den Prozentsatz der abgebenenen
Sollmenge ausgibt. In einer typischen Konfiguration steigt der Strom von 4 mA auf 20 mA,
wenn der Abfüllzähler von 0 % auf 100 % geht.

Vorbereitungsverfahren

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, die PROFIBUS EDD muss installiert
sein und Sie müssen eine Verbindung mit der Auswerteelektronik hergestellt haben.

Verfahren

1. Choose Online > Configure > Manual Setup > Inputs/Outputs > mA Output.
2. Setzen Sie Secondary Variable Is auf Discrete Batch: Percent Fill.
3. Setzen Sie Lower Range Value auf den durch 4 mA dargestellten Abfüllprozentwert.

4. Setzen Sie Upper Range Value auf den durch 20 mA dargestellten Abfüllprozentwert.
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5. Stellen Sie AO Fault Action wie gewünscht ein.

Wenn Lower Range Value auf 0 % eingestellt ist und Upper Range Value auf 100 % eingestellt
ist: Wenn die Abfüllung beginnt, erzeugt der mA-Ausgang 4 mA (0 % von Fill Target). Der
Strom wird proportional zum Abfüllzähler bis auf 20 mA (100 % von Fill Target) steigen.

Anmerkung
Wenn Flow Direction auf Bidirectional oder Negate Bidirectional eingestellt ist, kann der Abfüllzähler unter
bestimmten Durchflussbedingungen sinken. In diesem Fall wird der vom mA-Ausgang erzeugte
Strom proportional reduziert.
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9 Abfüllverfahren mittels PROFIBUS
EDD
In diesem Kapitel behandelte Themen:

• Führen Sie ein integrierter Ventilsteuerfüllung mit dem PROFIBUS EDD

• Führen Sie eine manuelle Spülung mit dem PROFIBUS EDD

• Durchführen eines Cleaning-in-Place-Verfahrens (CIP) mittels PROFIBUS EDD

• Überwachen und Analysieren der Abfüllleistung mittels PROFIBUS EDD

9.1 Führen Sie ein integrierter Ventilsteuerfüllung
mit dem PROFIBUS EDD
Mit dem digitalen Kommunikationsprotokoll PROFIBUS können Sie eine Abfüllung starten,
überwachen, anhalten, fortsetzen und beenden.

Vorbereitungsverfahren

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, die PROFIBUS EDD muss installiert
sein und Sie müssen eine Verbindung mit der Auswerteelektronik hergestellt haben.

Verfahren

1. SeleccioneOnline (Online) > Overview (Überblick) > Fill Control (Füllen Steuer) > Fill Control
(Füllen Steuer).

2. (Optional) Auf Wunsch wählen Sie einen anderen Wert für Fill Target (einstufige
Abfüllungen, zweistufige Abfüllungen oder Abfüllungen mit doppeltem Füllkopf)
oder für Target Time (zeitgesteuerte Abfüllungen oder zeitgesteuerte Abfüllungen
mit doppeltem Füllkopf).

3. (Optional) Falls die automatische Überfüllkompensation (Automatic Overshoot
Compensation, AOC) aktiviert ist, können Sie einen anderen Wert für AOC Coeff
eingeben.

Hinweis
Während der Produktion empfiehlt Micro Motion, AOC Coeff auf dem während der AOC-
Kalibrierung festgelegten Wert zu belassen. Falls Sie AOC-Kalibrierabfüllungen ausführen und
über einen AOC Coeff Wert von einem ähnlichen Gerät verfügen, können Sie diesen Wert als
„ersten Näherungswert“ im aktuellen Gerät verwenden. Dies kann nützlich sein, wenn Sie
Auslaufen verhindern oder auf ein Minimum reduzieren möchten.

4. Klicken Sie auf Begin Filling.

Der Abfüllzähler wird automatisch zurückgesetzt und das/die Ventil(e) wird/werden
geöffnet. Die Anzeige für Filling in Progress sollte On sein. Ist dies nicht der Fall und
stattdessen die Anzeige Start Not Okay oder die Anzeige AOC Flow Rate Too High Ein
sind, führen Sie eine Fehlersuche der Abfüllkonfiguration durch und wiederholen Sie
das Verfahren.
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5. Überwachen Sie die Abfüllung anhand der Werte unter Current Total und Percent Fill
der Anzeige Fill Status.

Werte des Abfüllforts-
chritts Beschreibung

Current Total Abfüllmenge zum aktuellen Zeitpunkt. Dieser Wert wird von
Count Up beeinflusst:
• Wenn Count Up aktiviert ist, beginnt Current Total bei 0 und

zählt bis zu Fill Target hoch.
• Wenn Count Up deaktiviert ist, beginnt Current Total bei Fill

Target und zähl bis auf 0 herunter.

Percent Fill Prozentwert des Fill Target, der bis zum aktuellen Zeitpunkt
gemessen wurde. Dieser Wert wird nicht von Count Up beein-
flusst.

Fill Status Anzeige Beschreibung

Filling in Progress Zurzeit wird eine Abfüllung durch das Primärventil durchge-
führt. Diese Anzeige ist auch dann aktiv, wenn die Abfüllung
angehalten wird.

Secondary Fill in Progress Zurzeit wird eine Abfüllung durch das Sekundärventil durch-
geführt. Diese Anzeige ist auch dann aktiv, wenn die Abfül-
lung angehalten wird. Dies gilt nur für Abfüllungen mit dop-
peltem Füllkopf.

Max Fill Time Exceeded Die aktuelle Abfüllung hat die derzeitige Einstellung für Max
Fill Time überschritten. Die Abfüllung wird abgebrochen.

Primary Valve Das Primärventil ist offen.

Secondary Valve Das Sekundärventil ist offen.

Pump Die Pumpe läuft.

Purge In Progress Ein Spülvorgang wurde, entweder automatisch oder man-
uell, gestartet.

Purge Delay Phase Ein automatischer Spülzyklus läuft und ist aktuell in der Ver-
zögerungsperiode zwischen Beendigung der Abfüllung und
Start des Spülvorgangs.

Purge Valve Das Spülventil ist offen.

6. (Optional) Halten Sie die Abfüllung nach Wunsch an.

Während die Abfüllung angehalten ist, können Sie den Wert für Current Target
ändern, die Abfüllung manuell mit End Filling beenden oder mit Resume Filling
fortsetzen. Die Abfüllung wird mit dem aktuellen Wert für Current Total und Percent Fill
fortgesetzt.

Einschränkung
Eine zeitgesteuerte Abfüllung oder eine zeitgesteuerte Abfüllung mit doppeltem Füllkopf
kann nicht angehalten werden.
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Wichtig
Für zweistufige Abfüllungen hängt die Auswirkung eines Anhaltens und Fortsetzens der
Abfüllung von der Zeitsteuerung der Befehle zum Öffnen und Schließen des Ventils und von
dem Punkt, an welchem die Abfüllung angehalten wird, ab.

7. (Optional) Verwenden Sie End Filling, um die Abfüllung nach Wunsch manuell zu
beenden.

Nachdem die Abfüllung beendet wurde, kann sie nicht wieder gestartet werden.

Hinweis
In den meisten Fällen sollten Sie den Abfüllvorgang automatisch beenden lassen. Beenden Sie
den Abfüllvorgang nur dann manuell, wenn Sie die Füllung entsorgen möchten.

9.1.1 Wenn die Abfüllung nicht startet
Falls die Abfüllung nicht beginnt, die Anzeigen für Start Not Okay und AOC Flow Rate Too High
prüfen.

Wenn die Anzeige Start Not Okay aufleuchtet, Folgendes prüfen:

• Sicherstellen, dass die Abfüllung aktiviert ist.

• Darauf achten, dass die vorherige Abfüllung bereits beendet ist.

• Sicherstellen, dass Fill Target oder Target Time auf positive Werte eingestellt sind.

• Sicherstellen, dass alle Ausgänge dem Ventil oder der Pumpe zugeordnet sind, das
bzw. die der Abfüllart und der Abfülloption entsprechen.

• Sicherstellen, dass keine aktiven Fehlerbedingungen an der Auswerteelektronik
vorherrschen.

• Bei Abfüllungen mit doppelten Füllköpfen sicherstellen, dass auf keinem der
Füllköpfe eine Abfüllung läuft.

Wenn die Anzeige AOC Flow Rate Too High leuchtet, ist die zuletzt gemessene
Durchflussgeschwindigkeit zu hoch, und die Abfüllung kann nicht gestartet werden.
Anders ausgedrückt bedeutet dies, dass der AOC Koeffizient, kompensiert für die
Durchflussgeschwindigkeit, angibt, dass der Befehl zum Schließen des Ventils vor dem
Beginn der Abfüllung gegeben werden müsste. Dies kann vorkommen, wenn die
Durchflussgeschwindigkeit signifikant höher liegt, seit der AOC-Koeffizient berechnet
wurde. Micro Motion empfiehlt das folgende Wiederherstellungsverfahren:

1. Jede Einrichtung durchführen, die erforderlich ist, um die AOC-Kalibrierung
durchzuführen.

2. Im Fenster Run Filler auf Override Blocked Start klicken.

3. AOC-Kalibrierung durchführen.

4. Die Produktionsabfüllung des Systems unter Verwendung des neuen AOC-
Koeffizienten wieder aufnehmen.

9.1.2 Wenn die Abfüllung nicht vollständig durchgeführt
wurde
Falls die Abfüllung anormal beendet wurde, die Auswerteelektronik und die AnzeigeMax Fill
Time Exceeded prüfen.
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Wenn ein Fehler während einer Abfüllung auftritt, wird diese von der Auswerteelektronik
automatisch abgebrochen.

Wenn die Anzeige Max Fill Time Exceeded leuchtet, konnte die Abfüllung nicht ihren Zielwert
vor der konfigurierten Max Fill Time erreichen. Folgende Möglichkeiten oder Maßnahmen
sind in Betracht zu ziehen:

• Die Durchflussgeschwindigkeit des Prozesses erhöhen.

• Auf Gaseinschlüsse (Schwallströmung) im Prozessmedium prüfen.

• Auf Verstopfungen des Durchflusses prüfen.

• Sicherstellen, dass die Ventile mit der erwarteten Geschwindigkeit schließen.

• Max Fill Time auf einen höheren Wert einstellen.

• Max Fill Time durch eine Einstellung auf 0 deaktivieren.

9.1.3 Auswirkungen von Pause und Fortfahren bei zweistufigen
diskreten Abfüllungen
Bei zweistufigen diskreten Abfüllungen hängt es davon ab, wo Pause und Fortfahren in
Zusammenhang mit dem Öffnen und Schließen der primären und sekundären Ventile
auftreten.

Zuerst Primär öffnen, zuerst Primär schließen

In den folgenden Abbildungen:

• Das Primärventil öffnet zum Beginn der Abfüllung.

• Das Sekundärventil öffnet während der Abfüllung an dem vom Anwender
konfigurierten Punkt. T stellt die Zeit oder Anzahl dar, die für Sekundär öffnen
konfiguriert ist.

• Das Primärventil schließt, bevor die Abfüllung abgeschlossen ist.

• Das Sekundärventil schließt, wenn die Abfüllung abgeschlossen ist.

Fall AAbbildung 11-1:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Primary

Target 
(AOC adjusted)

Pause Resume

TT

Open Secondary 
not performed
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Fall BAbbildung 11-2:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Primary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Secondary

Fall CAbbildung 11-3:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Primary

Target 
(AOC adjusted)

T T

Secondary valve 
opened early

Pause Resume

Open 
Secondary

Fall DAbbildung 11-4:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Primary

Target 
(AOC adjusted)

T T

Secondary valve 
opened early

Pause Resume

Open 
Secondary

Zuerst Primär öffnen, zuerst Sekundär schließen

In den folgenden Abbildungen:

• Das Primärventil öffnet zum Beginn der Abfüllung.

• Das Sekundärventil öffnet während der Abfüllung an dem vom Anwender
konfigurierten Punkt. T stellt die Zeit oder Anzahl dar, die für Sekundär öffnen
konfiguriert ist.

• Das Sekundärventil schließt, bevor die Abfüllung abgeschlossen ist.
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• Das Primärventil schließt, wenn die Abfüllung abgeschlossen ist.

Fall EAbbildung 11-5:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Secondary

Target 
(AOC adjusted)

Pause Resume

TT

Open Secondary 
not performed

Fall FAbbildung 11-6:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Secondary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Secondary

Fall GAbbildung 11-7:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Secondary

Target 
(AOC adjusted)

T T

Secondary valve 
not reopened

Pause Resume

Open 
Secondary
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Fall HAbbildung 11-8:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Secondary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Secondary

Secondary valve 
not reopened

Zuerst Sekundär öffnen, zuerst Primär schließen

In den folgenden Abbildungen:

• Das Sekundärventil öffnet zum Beginn der Abfüllung.

• Das Primärventil öffnet während der Abfüllung an dem vom Anwender
konfigurierten Punkt. T stellt die Zeit oder Anzahl dar, die für Primär öffnen
konfiguriert ist.

• Das Primärventil schließt, bevor die Abfüllung abgeschlossen ist.

• Das Sekundärventil schließt, wenn die Abfüllung abgeschlossen ist.

Fall IAbbildung 11-9:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Primary

Target 
(AOC adjusted)

Pause Resume

TT

Open Primary 
not performed
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Fall JAbbildung 11-10:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Primary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Primary

Fall KAbbildung 11-11:   

Secondary valve

Primary valve

Start Open 
Primary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Primary not 
performed

Close 
Primary

Fall LAbbildung 11-12:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Primary

Target 
(AOC adjusted)

T T

Pause Resume

Open Primary 
not performed

Zuerst Sekundär öffnen, zuerst Sekundär schließen

In den folgenden Abbildungen:

• Das Sekundärventil öffnet zum Beginn der Abfüllung.

• Das Primärventil öffnet während der Abfüllung an dem vom Anwender
konfigurierten Punkt. T stellt die Zeit oder Anzahl dar, die für Primär öffnen
konfiguriert ist.

• Das Sekundärventil schließt, bevor die Abfüllung abgeschlossen ist.

• Das Primärventil schließt, wenn die Abfüllung abgeschlossen ist.
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Fall MAbbildung 11-13:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Secondary

Target 
(AOC adjusted)

Pause Resume

TT

Open Primary 
not performed

Fall NAbbildung 11-14:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Secondary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Primary

Fall OAbbildung 11-15:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Secondary

Target 
(AOC adjusted)

T T

Primary valve 
opened early

Pause Resume

Open 
Primary
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Fall PAbbildung 11-16:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Secondary

Target 
(AOC adjusted)

T T

Primary valve 
opened early

Pause Resume

Open 
Primary

9.2 Führen Sie eine manuelle Spülung mit dem
PROFIBUS EDD
Die Spülfunktion wird verwendet, um ein Hilfsventil zu steuern, das nicht für die Abfüllung
eingesetzt wird. Beispielsweise kann damit ein Behälter mit Wasser oder Gas aufgefüllt
werden, nachdem der Füllvorgang abgeschlossen ist, oder sie kann als “ Dämpfung
dienen.” Der Durchfluss durch das Hilfsventil wird von der Auswerteelektronik nicht
gemessen.

Vorbereitungsverfahren

Die Spülfunktion muss in Ihrem System implementiert sein.

Die vorhergehende Abfüllung muss beendet worden sein.

Das Hilfsventil muss an das Medium, das Sie verwenden möchten (z. B. Luft, Wasser,
Stickstoff), angeschlossen sein.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, die PROFIBUS EDD muss installiert
sein und Sie müssen eine Verbindung mit der Auswerteelektronik hergestellt haben.

Verfahren

1. Wählen Overview (Überblick) > Fill Control (Füllen Steuer) > Fill Control (Füllen Steuer).
2. Klicken Begin Purge (Beginnen Purge) .

Die Anzeige Purge In Progress (Löschen In Bearbeitung) und Anzeige Purge Valve
(Ablaufventil) kommen.

3. Lassen Sie das Spülmedium eine angemessene Zeit durch das System laufen.

4. Klicken End Purge (Er Abzuschließen)

Die AnzeigePurge In Progress (Löschen In Bearbeitung) und Anzeige Purge Valve
(Ablaufventil) ausschalten.
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9.3 Durchführen eines Cleaning-in-Place-
Verfahrens (CIP) mittels PROFIBUS EDD
Die Clean-in-Place (CIP) Funktion wird verwendet, um ein Reinigungsmedium durch das
System zu leiten. Mit dem CIP-Verfahren können Sie die Innenflächen von Rohren,
Ventilen, Stutzen usw. reinigen, ohne das Gerät zerlegen zu müssen.

Vorbereitungsverfahren

Hierbei darf kein Abfüllvorgang laufen.

Das Reinigungsmedium muss zum Durchfluss durch das System bereit stehen.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, die PROFIBUS EDD muss installiert
sein und Sie müssen eine Verbindung mit der Auswerteelektronik hergestellt haben.

Verfahren

1. Tauschen Sie das Prozessmedium gegen das Reinigungsmedium aus.

2. Wählen Sie Online > Overview > Fill Control > Fill Control.
3. Klicken Sie auf Begin Cleaning.

Die Auswerteelektronik öffnet das Primärventil und, falls dieses zum Abfüllen
verwendet wird, das Sekundärventil. Falls die Pumpenfunktion aktiviert ist, wird die
Pumpe gestartet, bevor das Ventil geöffnet wird. Die Anzeige Cleaning In Progress
wird eingeschaltet.

4. Lassen Sie das Reinigungsmedium eine angemessene Zeit durch das System laufen.

5. Klicken Sie auf End Cleaning.

Die Auswerteelektronik schließt alle offenen Ventile und stoppt die Pumpe (falls
zutreffend). Die Anzeige Cleaning In Progress wird ausgeschaltet.

6. Tauschen Sie das Reinigungsmedium gegen das Prozessmedium aus.

9.4 Überwachen und Analysieren der
Abfüllleistung mittels PROFIBUS EDD
Für eine Einzelabfüllung können detaillierte Durchflussdaten gesammelt werden und diese
Daten können dann mit denen anderer Abfüllungen verglichen werden.

9.4.1 Sammeln detaillierter Abfülldaten für eine einzelne
Abfüllung mittels PROFIBUS EDD
Detaillierte Daten der letzten Abfüllung werden in der Auswerteelektronik gespeichert,
sofern die Abfüllungsprotokollierung aktiviert ist. Die Daten können mittels digitaler
Kommunikation zu Analysezwecken ausgelesen werden. Die detaillierten Daten können
zur Optimierung oder Fehlersuche in der Produktionsumgebung verwendet werden.
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Vorbereitungsverfahren

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, die PROFIBUS EDD muss installiert
sein und Sie müssen eine Verbindung mit der Auswerteelektronik hergestellt haben.

Verfahren

1. Wählen Sie Online > Configure > Manual Setup > Filling > Filling Configuration > Fill Type.

2. Aktivieren Sie Enable Fill Logging.

3. Führen Sie einen Abfüllvorgang aus.

4. Deaktivieren Sie Enable Fill Logging, wenn Sie die Datensammlung beendet haben.

Das Abfüllprotokoll enthält Datensätze von einem einzigen Abfüllvorgang. Die
Aufzeichnung beginnt mit dem Start der Abfüllung und endet 50 Millisekunden nach
Beendigung der Abfüllung oder wenn die maximale Prokotollgröße erreicht wurde.
Datensätze werden alle 10 Millisekunden geschrieben. Jeder Datensatz enthält den
aktuellen Wert für Flow Source (die zum Messen der Abfüllung verwendete Prozessvariable).
Das Abfüllprotokoll ist auf 1000 Datensätze bzw. 10 Sekunden Abfülldauer begrenzt.
Nachdem die maximale Größe erreicht ist, stoppt die Protokollierung zwar, aber die Daten
sind in der Auswerteelektronik verfügbar, bis der nächste Abfüllvorgang beginnt. Das
Abfüllprotokoll wird zu Beginn eines neuen Abfüllvorgangs immer gelöscht.

9.4.2 Analysieren Füllung füllen Leistung durch Statistiken und
die PROFIBUS EDD
Die Auswerteelektronik zeichnet automatisch eine Vielzahl von Daten über jeden
Abfüllungsvorgang auf. Diese Daten dienen zur Optimierung des Systems.

Vorbereitungsverfahren

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, die PROFIBUS EDD muss installiert
sein und Sie müssen eine Verbindung mit der Auswerteelektronik hergestellt haben.

Verfahren

1. Wählen Sie Online > Overview > Fill Control > Fill Statistics (Online > Überblick > Füllen
Steuer > Füllen Statistiken).

2. (Eines) Zu clic in Reset Fill Statistics (Statistiken zurücksetzen Füllung) ihre Analyse mit
einem neuen Datensatz Befüllen beginnen.

3. Führen abgeschlossen und beobachten Sie die Daten Füllung.

Datos de llenado Tipo de llenado Descripción

Fill Total Average (Füllen
Gesamtdurchschnitts)

Einstufige Abfüllungen,
zweistufige Abfüllungen
und zeitgesteuerte Ab-
füllungen

Berechneter Durchschnitt aller Abfüll-
summen seit Zurücksetzen der Abfüll-
statistik.

Abfüllungen mit doppel-
tem Füllkopf und zeit-
gesteuerte Abfüllungen
mit doppeltem Füllkopf

Berechneter Durchschnitt aller Abfüll-
summen durch den Füllkopf Nr. 1 seit
Zurücksetzen der Abfüllstatistik.

Abfüllverfahren mittels PROFIBUS EDD

Konfigurations- und Bedienungsanleitung 111



Datos de llenado Tipo de llenado Descripción

Fill Total Variance (Füllen
der Gesamtvarianz)

Einstufige Abfüllungen,
zweistufige Abfüllungen
und zeitgesteuerte Ab-
füllungen

Berechnete Abweichung aller Füll-
summen seit Zurücksetzen der Abfüll-
statistik.

Abfüllungen mit doppel-
tem Füllkopf und zeit-
gesteuerte Abfüllungen
mit doppeltem Füllkopf

Berechnete Abweichung aller Abfüll-
summen durch den Füllkopf Nr. 1 seit
Zurücksetzen der Abfüllstatistik.

Secondary Fill Total Average
(Durchschnittliche Gesamt-
sekundärfüllung)

Nur Abfüllungen mit
doppeltem Füllkopf und
zeitgesteuerte Abfüllun-
gen mit doppeltem Füll-
kopf

Berechneter Durchschnitt aller Abfüll-
summen durch den Füllkopf Nr. 2 seit
Zurücksetzen der Abfüllstatistik.

Secondary Fill Total Var-
iance (Varianz der Gesamt-
nebenbefüllungs)

Nur Abfüllungen mit
doppeltem Füllkopf und
zeitgesteuerte Abfüllun-
gen mit doppeltem Füll-
kopf

Berechnete Abweichung aller Abfüll-
summen durch den Füllkopf Nr. 2 seit
Zurücksetzen der Abfüllstatistik.
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10 Konfigurieren einer integrierten
Abfüll-Ventilsteuerung mittels
PROFIBUS Busparametern
In diesem Kapitel behandelte Themen:

• Konfigurieren einer Abfüllung mit integrierter Ventilsteuerung mittels PROFIBUS
Busparametern

• Konfigurieren von Abfülloptionen mittels PROFIBUS Busparametern

• Konfigurieren einer Abfüllsteuerung mittels PROFIBUS Busparametern (optional)

• Konfigurieren der Abfüllprotokollierung mittels PROFIBUS Busparametern
(optional)

10.1 Konfigurieren einer Abfüllung mit integrierter
Ventilsteuerung mittels PROFIBUS
Busparametern
Die Befüllungsart entsprechend der Anwendung konfigurieren.

Hinweis
Eine einstufige Binärbefüllung eignet sich für die meisten Anwendungen. Diese Befüllungsart
verwenden, soweit keine speziellen Anforderungen für andere Befüllungsarten bestehen. In den
meisten Fällen ist die Auswerteelektronik werksseitig für einstufige Binärbefüllungen konfiguriert
und mit einem Minimum an Konfigurationsanpassungen vor Ort einsatzbereit.

10.1.1 Konfigurieren einer einstufigen Abfüllung mittels
PROFIBUS Busparametern
Eine einstufige Binärbefüllung konfigurieren, wenn ein einzelner Behälter von einem
einzelnen Ventil befüllt werden soll. Das Ventil ist solange geöffnet, bis der Befüllungssollwert
erreicht ist.

Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, das DP-V1 Lese- und
Schreibdienste unterstützt, und Sie müssen eine Verbindung mit der Auswerteelektronik
hergestellt haben.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Setzen Sie Precision DO1 auf Primary Valve.

b. Stellen Sie Precision DO1 Polarity entsprechend Ihrer Installation ein.
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Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

2. Durchflussmessungen konfigurieren:

a. Flow Direction (Durchflussrichtung) auf die für Ihre Installation angemessene
Option einstellen.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die durch den Pfeil auf dem Sensor angegebene Rich-
tung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der auf dem Sensor durch den Pfeil angegebenen
Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die entgegengesetzte durch den Pfeil auf dem Sensor
angegebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der entgegengesetzten durch den Pfeil auf dem
Sensor angegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

b. Mass Flow Units (Massedurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Mass Flow Rate (Massedurchflussrate)
eingestellt ist, wird die entsprechende Masseeinheit zur Befüllungsmessung
verwendet.

c. Volume Flow Units (Volumendurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Volume Flow Rate
(Volumendurchflussrate) eingestellt ist, wird die entsprechende Volumeneinheit
zur Befüllungsmessung verwendet.

d. Die anderen Durchflussoptionen wie gewünscht einstellen.
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Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

3. Flow Source (Durchflussquelle) auf die Prozessvariable einstellen, die zur
Befüllungsmessung verwendet werden soll.

Option Beschreibung

Massedurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Massedurchfluss

Volumendurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Volumendurchfluss

4. Folgende Parameter einstellen oder überprüfen:

Parameter Einstellung

Befüllungsoption aktivieren Aktiviert

Doppelbefüllung aktiv Deaktiviert

AOC aktiv Aktiviert

Spülung aktiv Deaktiviert

Enable Timed Fill Deaktiviert

Befüllart Einstufig binär

Hinweis
Micro Motion empfiehlt dringendst die Verwendung der automatischen
Überfüllkompensation (AOC). AOC verbessert, sofern aktiviert und kalibriert, die
Befüllgenauigkeit und Reproduzierbarkeit.

5. Count Up (Hochzählen) wie gewünscht einstellen.

Count Up (Hochzählen) steuert, wie der Befüllzähler rechnet und angezeigt wird.

Option Beschreibung

Enabled (Aktiviert) Der Abfüllzähler beginnt bei 0 und zählt bis zu Fill Target (Befüllungssoll)
hoch.

Disabled (Deaktiviert) Der Abfüllzähler beginnt bei Fill Target und zählt bis 0 herunter.

6. Fill Target (Befüllungssoll) auf die Menge einstellen, bei der der Befüllungsvorgang
abgeschlossen ist.

Den Wert in den Messeinheiten für Flow Source (Durchflussquelle) konfigurierten
Wert eingeben.

7. Max Fill Time (Maximale Befüllungszeit) auf die Anzahl von Sekunden einstellen, bei
der die Befüllungszeit überschritten wird.
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Kann die Befüllung vor Ablauf dieser Zeit nicht abgeschlossen werden, wird die
Befüllung verworfen und Fehlernachrichten werden wegen
Befüllungszeitüberschreitung angezeigt.

Max Fill Time (Maximale Befüllungszeit) auf 0 einstellen, um die
Befüllungszeitüberschreitungsfunktion zu deaktivieren.

Der Standardwert für Max Fill Time (Maximale Befüllungszeit) ist 0 (deaktiviert). Der
Bereich liegt bei 0 Sekunden bis 800 Sekunden.

8. Measured Fill Time (Gemessene Befüllungszeit) wie gewünscht einstellen.

Measured Fill Time (Gemessene Befüllungszeit) steuert, wie die Befüllungszeit
gemessen wird.

Option Beschreibung

Durchfluss stoppt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik erkennt, dass
der Durchfluss nach dem Schließen des Ventils stoppt.

Ventil schließt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik den Binäraus-
gang nach Bedarf einstellt, um das Ventil zu schließen.

Beispiel: Konfigurieren einer einstufigen Abfüllung

Wichtig
In diesem Beispiel werden standardmäßige oder typische Einstellungen für die erforderlichen
Parameter verwendet. Für Ihre Anwendung sind möglicherweise andere Einstellungen erforderlich.
Weitere Informationen zu Datentypen und Integercodes finden Sie im MIT.

Block Index

Wert (de-
zima oder
Fließkom-
ma) Beschreibung

Abfüllung 33 110 Setzt die Genauigkeit DO1 auf Primärventil

Abfüllung 34 1 Setzt die DO1 Polarität Genauigkeit auf Aktiv hoch

Messung 21 0 Setzt die Durchflussrichtung auf Vorwärts

Messung 5 1318 Setzt die Massedurchfluss Einheiten auf g/s

Messung 11 1347 Setzt die Volumendurchfluss Einheiten auf m3/s

Abfüllung 5 0 Setzt dieDurchflussquelle auf Massedurchfluss

Abfüllung 17 0 Setzt Doppelbefüllung aktivieren auf Deaktiviert

Abfüllung 15 0 Setzt die Zeitgesteuerte Abfüllung aktivieren auf Deakti-
viert

Abfüllung 7 1 Setzt dieAbfüllart auf Einstufig

Abfüllung 8 1 Setzt Hochzählen auf Aktiviert

Abfüllung 6 100.00 Setzt den Abfüll Sollwert auf 100 g

Abfüllung 14 1.00 Setzt die Max Abfüllzeit auf 1 s

Abfüllung 19 1 Setzt die Gemessene Abfüllzeit auf Durchfluss gestoppt

Nachbereitungsverfahren

Optionen für einstufige Abfüllungen sind:
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• Automatische Überfüllkompensation (AOC) konfigurieren. Wenn die automatische
Überfüllkompensation aktiviert ist, sicherstellen, dass AOC für die entsprechende
Anwendung ordnungsgemäß konfiguriert und kalibriert ist.

• Implementieren der Spülfunktion.

• Implementieren der Pumpfunktion.

10.1.2 Konfigurieren einer zweistufigen Abfüllung mittels
PROFIBUS Busparametern
Eine zweistufige Binärbefüllung konfigurieren, wenn ein einzelner Behälter von zwei
Ventilen befüllt werden soll.

Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, das DP-V1 Lese- und
Schreibdienste unterstützt, und Sie müssen eine Verbindung mit der Auswerteelektronik
hergestellt haben.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Setzen Sie Precision DO1 auf Primary Valve.

b. Stellen Sie Precision DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

c. Setzen Sie Precision DO2 auf Secondary Valve.

d. Stellen Sie Precision DO2 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Konfigurieren einer integrierten Abfüll-Ventilsteuerung mittels PROFIBUS Busparametern

Konfigurations- und Bedienungsanleitung 117



Option
Signal von der Auswertee-
lektronik Spannung

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

2. Durchflussmessungen konfigurieren:

a. Flow Direction (Durchflussrichtung) auf die für Ihre Installation angemessene
Option einstellen.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die durch den Pfeil auf dem Sensor angegebene Rich-
tung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der auf dem Sensor durch den Pfeil angegebenen
Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die entgegengesetzte durch den Pfeil auf dem Sensor
angegebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der entgegengesetzten durch den Pfeil auf dem
Sensor angegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

b. Mass Flow Units (Massedurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Mass Flow Rate (Massedurchflussrate)
eingestellt ist, wird die entsprechende Masseeinheit zur Befüllungsmessung
verwendet.

c. Volume Flow Units (Volumendurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Volume Flow Rate
(Volumendurchflussrate) eingestellt ist, wird die entsprechende Volumeneinheit
zur Befüllungsmessung verwendet.

d. Die anderen Durchflussoptionen wie gewünscht einstellen.

Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.
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3. Flow Source (Durchflussquelle) auf die Prozessvariable einstellen, die zur
Befüllungsmessung verwendet werden soll.

Option Beschreibung

Massedurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Massedurchfluss

Volumendurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Volumendurchfluss

4. Folgende Parameter einstellen oder überprüfen:

Parameter Einstellung

Befüllungsoption aktivieren Aktiviert

Doppelbefüllung aktiv Deaktiviert

AOC aktivieren Aktiviert

Spülung aktiv Deaktiviert

Enable Timed Fill Deaktiviert

Befüllungsart Zweistufig binär

Hinweis
Micro Motion empfiehlt dringendst die Verwendung der automatischen
Überfüllkompensation (AOC). AOC verbessert, sofern aktiviert und kalibriert, die
Befüllgenauigkeit und Reproduzierbarkeit.

5. Count Up (Hochzählen) wie gewünscht einstellen.

Count Up (Hochzählen) steuert, wie der Befüllzähler rechnet und angezeigt wird.

Option Beschreibung

Enabled (Aktiviert) Der Abfüllzähler beginnt bei 0 und zählt bis zu Fill Target (Befüllungssoll)
hoch.

Disabled (Deaktiviert) Der Abfüllzähler beginnt bei Fill Target und zählt bis 0 herunter.

6. Configure By (Konfigurieren von) wie gewünscht einstellen.

Configure By (Konfigurieren von) steuert, wie die Ventilsteuerzeit konfiguriert ist.

Option Beschreibung

% Sol-
lwert

Die Ventilöffnungs- und schließzeit wird als Prozentsatz von Fill Target (Befüllungs-
soll) konfiguriert. Zum Beispiel:
• Ventil öffnet = 0 %: Das Ventil öffnet, wenn die aktuelle Befüllunssumme 0 %

von Fill Target (Befüllungssoll) beträgt.
• Ventil schließt = 90 %: Das Ventil schließt, wenn die aktuelle Befüllungs-

summe 90 % von Fill Target (Befüllungssoll) beträgt.
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Option Beschreibung

Menge Die Ventilöffnungs- und schließzeiten werden zusammen mit der konfigurierten
Messeinheit konfiguriert. Zum Beispiel:
• Ventil öffnet = 0 g: Das Ventil öffnet, wenn die aktuelle Befüllungssumme 0 g

beträgt.
• Ventil schließt = 50 g: Das Ventil schließt, wenn die aktuelle Befüllungs-

summe 50 g weniger als Fill Target (Befüllungssoll) beträgt.

7. Fill Target (Befüllungssoll) auf die Menge einstellen, bei der der Befüllungsvorgang
abgeschlossen ist.

Den Wert in den Messeinheiten für Flow Source (Durchflussquelle) konfigurierten
Wert eingeben.

8. Max Fill Time (Maximale Befüllungszeit) auf die Anzahl von Sekunden einstellen, bei
der die Befüllungszeit überschritten wird.

Kann die Befüllung vor Ablauf dieser Zeit nicht abgeschlossen werden, wird die
Befüllung verworfen und Fehlernachrichten werden wegen
Befüllungszeitüberschreitung angezeigt.

Max Fill Time (Maximale Befüllungszeit) auf 0 einstellen, um die
Befüllungszeitüberschreitungsfunktion zu deaktivieren.

Der Standardwert für Max Fill Time (Maximale Befüllungszeit) ist 0 (deaktiviert). Der
Bereich liegt bei 0 Sekunden bis 800 Sekunden.

9. Measured Fill Time (Gemessene Befüllungszeit) wie gewünscht einstellen.

Measured Fill Time (Gemessene Befüllungszeit) steuert, wie die Befüllungszeit
gemessen wird.

Option Beschreibung

Durchfluss stoppt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik erkennt, dass
der Durchfluss nach dem Schließen des Ventils stoppt.

Ventil schließt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik den Binäraus-
gang nach Bedarf einstellt, um das Ventil zu schließen.

10. Open Primary (Primär öffnen), Open Secondary (Sekundär öffnen), Close Primary (Primär
schließen) und Close Secondary (Sekundär schließen) wie gewünscht einstellen.

Diese Werte steuern den Zeitpunkt in der Befüllung, bei dem die primären und
sekundären Ventile öffnen und schließen. Entweder werden sie durch die Menge
oder den Prozentsatz des Sollwertes, wie durch den Configure By (Konfiguriert durch)
Parameter gesteuert, konfiguriert.

Entweder muss Open Primary (Primär öffnen) oder Open Secondary (Sekundär öffnen)
so eingestellt werden, dass sie zu Befüllungsbeginn öffnen. Sofern dies gewünscht
wird, können beide zu Befüllungsbeginn öffnen. Wird ein Wert so eingestellt, dass er
später öffnet, wird der andere automatisch so eingestellt, dass er zu
Befüllungsbeginn öffnet.

Entweder muss Close Primary (Primär schließen) oder Close Secondary (Sekundär
schließen) auf Schließen bei Befüllungsende eingestellt werden. Sofern dies
gewünscht wird, können beide bei Befüllungsende schließen. Wird ein Wert so
eingestellt, dass er früher schließt, wird der andere automatisch so eingestellt, dass
er bei Befüllungsende schließt.
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Beispiel: Konfigurieren einer zweistufigen Abfüllung

Wichtig
In diesem Beispiel werden standardmäßige oder typische Einstellungen für die erforderlichen
Parameter verwendet. Für Ihre Anwendung sind möglicherweise andere Einstellungen erforderlich.
Weitere Informationen zu Datentypen und Integercodes finden Sie im PROFIBUS Busparametern.

Block Index

Wert (de-
zimal oder
Fließkom-
ma) Beschreibung

Filling 33 110 Setzt Precision DO1 auf Primary Valve

Filling 34 1 Setzt Precision DO1 Polarity auf Active High

Filling 35 111 Setzt Precision DO2 auf Secondary Valve

Filling 36 1 Setzt Precision DO2 Polarity auf Active High

Measurement 21 0 Setzt Flow Direction auf Forward

Measurement 5 1318 Setzt Mass Flow Units auf g/sec

Measurement 11 1347 Setzt Volume Flow Units auf m3/sec

Filling 5 0 Setzt Flow Source auf Mass Flow Rate

Filling 17 0 Setzt Enable Dual Fill auf Disabled

Filling 15 0 Setzt Enable Timed Fill auf Disabled

Filling 7 2 Setzt Fill Type auf Two Stage Discrete

Filling 8 1 Setzt Count Up auf Enabled

Filling 9 0 Setzt Configure By auf % Target

Filling 6 100 Setzt Fill Target auf 100 g

Filling 14 1,00 Setzt Max Fill Time auf 1 s

Filling 19 1 Setzt Measured Fill Time auf Flow Stops

Filling 10 0,00 Setzt Open Primary auf 0 % von Fill Target

Filling 12 80,00 Setzt Close Primary auf 80 % von Fill Target

Filling 11 50,00 Setzt Open Secondary auf 50 % von Fill Target

Filling 13 100,00 Setzt Close Secondary auf 100 % von Fill Target

Nachbereitungsverfahren

Die folgende Option ist für zweistufige Abfüllungen verfügbar:

• Automatische Überfüllkompensation (AOC) konfigurieren. Wenn die automatische
Überfüllkompensation aktiviert ist, sicherstellen, dass AOC für die entsprechende
Anwendung ordnungsgemäß konfiguriert und kalibriert ist.

Ventilöffnungs- und Schließsequenzen für zweistufige
diskrete Abfüllungen
Die folgenden Abbildungen zeigen das Öffnen und Schließen der Sekundärventile,
gesteuert durch die Konfiguration von Primär öffnen, Sekundär öffnen, Primär schließen und
Sekundär schließen.
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Diese Abbildungen setzen voraus, dass die Abfüllung von Anfang bis Ende ohne
Unterbrechungen läuft.

Zuerst Primär öffnen, zuerst Primär schließenAbbildung 10-1:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Primary

Target 
(AOC adjusted)

T1 T2

Zuerst Primär öffnen, zuerst Sekundär schließenAbbildung 10-2:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Secondary

Target 
(AOC adjusted)

T1 T2

Zuerst Sekundär öffnen, zuerst Primär schließenAbbildung 10-3:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Primary

Target 
(AOC adjusted)

T1 T2

Zuerst Sekundär öffnen, zuerst Sekundär schließenAbbildung 10-4:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Secondary

Target 
(AOC adjusted)

T1 T2
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Einfluss von Configure By (Konfigurieren durch) auf das Öffnen
und Schließen des Ventils
Configure By (Konfigurieren durch) steuert, wie die Werte für Open Primary (Primär öffnen),
Open Secondary Sekundär öffnen), Close Primary (Primär schließen) und Close Secondary
(Sekundär schließen) konfiguriert und angewendet werden.

• Wenn Configure By(Konfiguriert durch) = % Target (Sollwert), addiert die
Auswerteelektronik die konfigurierten Werte für „Valve Open“ (Ventil geöffnet) und
„Valve Close“ (Ventil geschlossen) zu 0 %.

• Wenn Configure By (Konfiguriert durch) = Quantity (Menge), addiert die
Auswerteelektronik die konfigurierten Werte für „Valve Open“ (Ventil geöffnet) zu
0, und subtrahiert die konfigurierten Werte für „Valve Close“ (Ventil geschlossen)
von Fill Target (Befüllungssollwert).

Beispiel: Configure By (Konfiguriert durch) und Befehle zum Öffnen/Schließen des
Ventils

Fill Target (Befüllungssollwert) = 200 g. Das Primärventil soll zu Beginn des
Befüllungsvorgangs öffnen und am Ende des Befüllungsvorgangs schließen. Das
Sekundärventil soll öffnen, nachdem 10 g abgefüllt wurden und wieder schließen,
nachdem 190 g abgefüllt wurden. Siehe Tabelle 10-1 bzgl. der erforderlichen
Einstellungen, die dieses Ergebnis bewirken.

Configure By (Konfiguriert durch) und Ventilkonfiguration Tabelle 10-1:   

Configure By (Konfiguriert durch)
Werte für „Valve Open“ (Ventil geöffnet) und „Valve
Close“ (Ventil geschlossen)

% Sollwert • Open Primary (Primär öffnen) = 0 %
• Open Secondary (Sekundär öffnen) = 5 %
• Close Secondary (Sekundär schließen) = 95 %
• Close Primary (Primär schließen) = 100 %

Menge • Open Primary (Primär öffnen) = 0 g
• Open Secondary (Sekundär öffnen) = 10 g
• Close Secondary (Sekundär schließen) = 10 g
• Close Primary (Primär schließen) = 0 g

10.1.3 Konfigurieren einer zeitgesteuerten Abfüllung mittels
PROFIBUS Busparametern
Eine zeitgesteuerte Befüllung konfigurieren, wenn ein einzelner Behälter von einem
einzelnen Ventil befüllt werden soll. Der Ventil ist für eine bestimmte Anzahl von Sekunden
geöffnet.

Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, das DP-V1 Lese- und
Schreibdienste unterstützt, und Sie müssen eine Verbindung mit der Auswerteelektronik
hergestellt haben.
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Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Setzen Sie Precision DO1 auf Primary Valve.

b. Stellen Sie Precision DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

2. Durchflussmessungen konfigurieren:

a. Flow Direction (Durchflussrichtung) auf die für Ihre Installation angemessene
Option einstellen.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die durch den Pfeil auf dem Sensor angegebene Rich-
tung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der auf dem Sensor durch den Pfeil angegebenen
Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die entgegengesetzte durch den Pfeil auf dem Sensor
angegebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der entgegengesetzten durch den Pfeil auf dem
Sensor angegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

b. Mass Flow Units (Massedurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Mass Flow Rate (Massedurchflussrate)
eingestellt ist, wird die entsprechende Masseeinheit zur Befüllungsmessung
verwendet.
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c. Volume Flow Units (Volumendurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Volume Flow Rate
(Volumendurchflussrate) eingestellt ist, wird die entsprechende Volumeneinheit
zur Befüllungsmessung verwendet.

d. Die anderen Durchflussoptionen wie gewünscht einstellen.

Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

3. Folgende Parameter einstellen oder überprüfen:

Parameter Einstellung

Befüllungsoption aktivieren Aktiviert

Hochzählen Aktiviert

Doppelbefüllung aktiv Deaktiviert

AOC aktivieren Deaktiviert

Spülung aktivieren Deaktiviert

Zeitgesteuerte Befüllung aktivieren Aktiviert

Befüllungsart Einstufig binär

4. Target Time (Sollwertzeit) auf die Anzahl von Sekunden einstellen, die der
Befüllungsvorgang dauern wird.

Beispiel: Konfigurieren einer zeitgesteuerten Abfüllung

Wichtig
In diesem Beispiel werden standardmäßige oder typische Einstellungen für die erforderlichen
Parameter verwendet. Für Ihre Anwendung sind möglicherweise andere Einstellungen erforderlich.
Weitere Informationen zu Datentypen und Integercodes finden Sie im PROFIBUS Busparametern.

Block Index

Wert (de-
zimal oder
Fließkom-
ma) Beschreibung

Filling 33 110 Setzt Precision DO1 auf Primary Valve

Filling 34 1 Setzt Precision DO1 Polarity auf Active High

Measurement 21 0 Setzt Flow Direction auf Forward

Measurement 5 1318 Setzt Mass Flow Units auf g/sec

Measurement 11 1347 Setzt Volume Flow Units auf m3/sec

Filling 5 0 Setzt Flow Source auf Mass Flow Rate

Filling 17 0 Setzt Enable Dual Fill auf Disabled

Filling 15 1 Setzt Enable Timed Fill auf Enabled

Filling 7 1 Setzt Fill Type auf One Stage Discrete

Filling 8 1 Setzt Count Up auf Enabled

Konfigurieren einer integrierten Abfüll-Ventilsteuerung mittels PROFIBUS Busparametern

Konfigurations- und Bedienungsanleitung 125



Block Index

Wert (de-
zimal oder
Fließkom-
ma) Beschreibung

Filling 16 15,00 Setzt Target Time auf 15 s

Nachbereitungsverfahren

Die folgende Option ist für zeitgesteuerte Abfüllungen verfügbar:

• Implementieren der Spülfunktion.

10.1.4 Konfigurieren einer Abfüllung mit doppeltem Füllkopf
mittels PROFIBUS Busparametern
Eine Befüllung mit doppeltem Füllkopf konfigurieren, wenn zwei Behälter abwechselnd
von doppelten Füllköpfen befüllt werden sollen. Jedes Ventil ist solange geöffnet, bis der
Befüllungssollwert erreicht ist.

Wichtig
Das konfigurierte Fill Target (Befüllungssoll) wird auf beide Befüllungsköpfe angewendet.

Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, das DP-V1 Lese- und
Schreibdienste unterstützt, und Sie müssen eine Verbindung mit der Auswerteelektronik
hergestellt haben.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Setzen Sie Precision DO1 auf Primary Valve.

b. Stellen Sie Precision DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

c. Setzen Sie Precision DO2 auf Secondary Valve.

d. Stellen Sie Precision DO2 Polarity entsprechend Ihrer Installation ein.
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Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

2. Durchflussmessungen konfigurieren:

a. Flow Direction (Durchflussrichtung) auf die für Ihre Installation angemessene
Option einstellen.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die durch den Pfeil auf dem Sensor angegebene Rich-
tung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der auf dem Sensor durch den Pfeil angegebenen
Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die entgegengesetzte durch den Pfeil auf dem Sensor
angegebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der entgegengesetzten durch den Pfeil auf dem
Sensor angegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

b. Mass Flow Units (Massedurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Mass Flow Rate (Massedurchflussrate)
eingestellt ist, wird die entsprechende Masseeinheit zur Befüllungsmessung
verwendet.

c. Volume Flow Units (Volumendurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Volume Flow Rate
(Volumendurchflussrate) eingestellt ist, wird die entsprechende Volumeneinheit
zur Befüllungsmessung verwendet.

d. Die anderen Durchflussoptionen wie gewünscht einstellen.
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Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

3. Flow Source (Durchflussquelle) auf die Prozessvariable einstellen, die zur
Befüllungsmessung verwendet werden soll.

Option Beschreibung

Massedurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Massedurchfluss

Volumendurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Volumendurchfluss

4. Folgende Parameter einstellen oder überprüfen:

Parameter Einstellung

Befüllungsoption aktivieren Aktiviert

Hochzählen Aktiviert

Doppelbefüllung aktivieren Aktiviert

AOC aktivieren Aktiviert

Spülung aktiv Deaktiviert

Enable Timed Fill Deaktiviert

Befüllart Einstufig binär

Hinweis
Micro Motion empfiehlt dringendst die Verwendung der automatischen
Überfüllkompensation (AOC). AOC verbessert, sofern aktiviert und kalibriert, die
Befüllgenauigkeit und Reproduzierbarkeit.

5. Fill Target (Befüllungssoll) auf die Menge einstellen, bei der der Befüllungsvorgang
abgeschlossen ist.

Anmerkung
Das konfigurierte Fill Target (Befüllungssoll) wird auf beide Befüllungsköpfe angewendet.

6. Max Fill Time (Maximale Befüllungszeit) auf die Anzahl von Sekunden einstellen, bei
der die Befüllungszeit überschritten wird.

Kann die Befüllung vor Ablauf dieser Zeit nicht abgeschlossen werden, wird die
Befüllung verworfen und Fehlernachrichten werden wegen
Befüllungszeitüberschreitung angezeigt.

Max Fill Time (Maximale Befüllungszeit) auf 0 einstellen, um die
Befüllungszeitüberschreitungsfunktion zu deaktivieren.

Der Standardwert für Max Fill Time (Maximale Befüllungszeit) ist 0 (deaktiviert). Der
Bereich liegt bei 0 Sekunden bis 800 Sekunden.

7. Measured Fill Time (Gemessene Befüllungszeit) wie gewünscht einstellen.
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Measured Fill Time (Gemessene Befüllungszeit) steuert, wie die Befüllungszeit
gemessen wird.

Option Beschreibung

Durchfluss stoppt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik erkennt, dass
der Durchfluss nach dem Schließen des Ventils stoppt.

Ventil schließt Die Befüllungszeit erhöht sich, bis die Auswerteelektronik den Binäraus-
gang nach Bedarf einstellt, um das Ventil zu schließen.

Beispiel: Konfigurieren einer Abfüllung mit doppeltem Füllkopf

Wichtig
In diesem Beispiel werden standardmäßige oder typische Einstellungen für die erforderlichen
Parameter verwendet. Für Ihre Anwendung sind möglicherweise andere Einstellungen erforderlich.
Weitere Informationen zu Datentypen und Integercodes finden Sie im PROFIBUS Busparametern.

Block Index

Wert (de-
zimal oder
Fließkom-
ma) Beschreibung

Filling 33 110 Setzt Precision DO1 auf Primary Valve

Filling 34 1 Setzt Precision DO1 Polarity auf Active High

Filling 35 111 Setzt Precision DO2 auf Secondary Valve

Filling 36 1 Setzt Precision DO2 Polarity auf Active High

Measurement 21 0 Setzt Flow Direction auf Forward

Measurement 5 1318 Setzt Mass Flow Units auf g/sec

Measurement 11 1347 Setzt Volume Flow Units auf m3/sec

Filling 5 0 Setzt Flow Source auf Mass Flow Rate

Filling 17 1 Setzt Enable Dual Fill auf Enabled

Filling 15 0 Setzt Enable Timed Fill auf Disabled

Filling 7 1 Setzt Fill Type auf One Stage Discrete

Filling 8 1 Setzt Count Up auf Enabled

Filling 6 100,00 Setzt Fill Target auf 100 g

Filling 14 1,00 Setzt Max Fill Time auf 1 s

Filling 19 1 Setzt Measured Fill Time auf Flow Stops

Nachbereitungsverfahren

Optionen für Abfüllungen mit doppeltem Füllkopf sind:

• Automatische Überfüllkompensation (AOC) konfigurieren. Wenn die automatische
Überfüllkompensation aktiviert ist, sicherstellen, dass AOC für die entsprechende
Anwendung ordnungsgemäß konfiguriert und kalibriert ist.
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10.1.5 Konfigurieren einer zeitgesteuerten Abfüllung mit
doppeltem Füllkopf mittels PROFIBUS Busparametern
Eine zeitgesteuerte Befüllung mit doppeltem Füllkopf konfigurieren, wenn zwei Behälter
abwechselnd von doppelten Füllköpfen befüllt werden sollen. Jedes Ventil ist für eine
bestimmte Anzahl von Sekunden geöffnet.

Wichtig
Die konfigurierte Target Time (Sollwertzeit) wird auf beide Befüllungsköpfe angewendet.

Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, das DP-V1 Lese- und
Schreibdienste unterstützt, und Sie müssen eine Verbindung mit der Auswerteelektronik
hergestellt haben.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Setzen Sie Precision DO1 auf Primary Valve.

b. Stellen Sie Precision DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

c. Setzen Sie Precision DO2 auf Secondary Valve.

d. Stellen Sie Precision DO2 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC
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Option
Signal von der Auswertee-
lektronik Spannung

OFF Standortspezifisch bis zu
30 VDC

2. Durchflussmessungen konfigurieren:

a. Flow Direction (Durchflussrichtung) auf die für Ihre Installation angemessene
Option einstellen.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die durch den Pfeil auf dem Sensor angegebene Rich-
tung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der auf dem Sensor durch den Pfeil angegebenen
Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar
in die entgegengesetzte durch den Pfeil auf dem Sensor
angegebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder an-
dere Richtung fließen. Der Durchfluss entspricht überwie-
gend der entgegengesetzten durch den Pfeil auf dem
Sensor angegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

b. Mass Flow Units (Massedurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Mass Flow Rate (Massedurchflussrate)
eingestellt ist, wird die entsprechende Masseeinheit zur Befüllungsmessung
verwendet.

c. Volume Flow Units (Volumendurchflusseinheiten) wie gewünscht einstellen.

Wenn Flow Source (Durchflussquelle) auf Volume Flow Rate
(Volumendurchflussrate) eingestellt ist, wird die entsprechende Volumeneinheit
zur Befüllungsmessung verwendet.

d. Die anderen Durchflussoptionen wie gewünscht einstellen.

Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

3. Flow Source (Durchflussquelle) auf die Prozessvariable einstellen, die zur
Befüllungsmessung verwendet werden soll.
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Option Beschreibung

Massedurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Massedurchfluss

Volumendurchflussrate Die von der Auswerteelektronik gemessene Prozessvariable für den
Volumendurchfluss

4. Folgende Parameter einstellen oder überprüfen:

Parameter Einstellung

Befüllungsoption aktivieren Aktiviert

Hochzählen Aktiviert

Doppelbefüllung aktivieren Aktiviert

AOC aktivieren Deaktiviert

Spülung aktivieren Deaktiviert

Zeitgesteuerte Befüllung aktivieren Aktiviert

Befüllungsart Einstufig binär

5. Target Time (Sollwertzeit) auf die Anzahl von Sekunden einstellen, die der
Befüllungsvorgang dauern wird.

Anmerkung
Die konfigurierte Target Time (Sollwertzeit) wird auf beide Befüllungsköpfe angewendet.

Beispiel: Konfigurieren einer zeitgesteuerten Abfüllung mit doppeltem Füllkopf

Wichtig
In diesem Beispiel werden standardmäßige oder typische Einstellungen für die erforderlichen
Parameter verwendet. Für Ihre Anwendung sind möglicherweise andere Einstellungen erforderlich.
Weitere Informationen zu Datentypen und Integercodes finden Sie im PROFIBUS Busparametern.

Block Index

Wert (de-
zimal oder
Fließkom-
ma) Beschreibung

Filling 33 110 Setzt Precision DO1 auf Primary Valve

Filling 34 1 Setzt Precision DO1 Polarity auf Active High

Filling 35 111 Setzt Precision DO2 auf Secondary Valve

Filling 36 1 Setzt Precision DO2 Polarity auf Active High

Measurement 21 0 Setzt Flow Direction auf Forward

Measurement 5 1318 Setzt Mass Flow Units auf g/sec

Measurement 11 1347 Setzt Volume Flow Units auf m3/sec

Filling 5 0 Setzt Flow Source auf Mass Flow Rate

Filling 17 1 Setzt Enable Dual Fill auf Enabled

Filling 15 1 Setzt Enable Timed Fill auf Enabled

Filling 7 1 Setzt Fill Type auf One Stage Discrete

Konfigurieren einer integrierten Abfüll-Ventilsteuerung mittels PROFIBUS Busparametern

132  Micro Motion® Auswerteelektronik für Masseabfüllung mit PROFIBUS-DP



Block Index

Wert (de-
zimal oder
Fließkom-
ma) Beschreibung

Filling 8 1 Setzt Count Up auf Enabled

Filling 16 15,00 Setzt Target Time auf 15 s

10.2 Konfigurieren von Abfülloptionen mittels
PROFIBUS Busparametern
Je nach Befüllungsart kann die automatische Überfüllkompensation (AOC), die Spül- oder
die Pumpenfunktion konfiguriert und angewendet werden.

10.2.1 Konfigurieren und Implementieren der automatischen
Überfüllkompensation (AOC) mittels PROFIBUS
Busparametern
Die automatische Überfüllkompensation (AOC) wird verwendet, um die Abfüllzeit
anzupassen und um für die Zeit zu kompensieren, die benötigt wird, den Befehl zum
Schließen des Ventils zu übertragen bzw. damit das Ventil vollständig schließt.

Vorbereitungsverfahren

Darauf achten, dass mit der werksseitigen Standardkonfiguration begonnen wird.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, das DP-V1 Lese- und
Schreibdienste unterstützt, und Sie müssen eine Verbindung mit der Auswerteelektronik
hergestellt haben.

Verfahren

1. Choose ProLink > Configuration > Filling.

2. Wählen Sie die Art der zu implementierenden AOC.

Option Beschreibung

Fixed Das Ventil schließt an dem Punkt, der durch Fill Target minus der Menge, die in Fixed
Overshoot Comp eingegeben ist, definiert wird. Verwenden Sie diese Option nur
dann, wenn der Wert für die „Frühwarnung“ bereits bekannt ist.

Overfill Definiert die Richtung, aus der der AOC-Algorithmus sich der Sollmenge nähert.
Der AOC-Algorithmus beginnt mit der Schätzung eines Überfüllungswerts und re-
duziert dann die Überfüllung in aufeinanderfolgenden Kalibrierabfüllungen.

Underfill Definiert die Richtung, aus der der AOC-Algorithmus sich der Sollmenge nähert.
Der AOC-Algorithmus beginnt mit der Schätzung eines Unterfüllungswerts und re-
duziert dann die Unterfüllung in aufeinanderfolgenden Kalibrierabfüllungen.
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Hinweis
Die Option Fixed wird normalerweise nicht verwendet. Wenn Sie Fixed wählen, funktioniert die
Auswerteelektronik als Legacy-Batchsteuerung. In typischen Einsatzbereichen bieten die
anderen AOC-Optionen bessere Genauigkeit und Wiederholbarkeit.

Einschränkung
Die Optionen Fixed und Overfill werden für Abfüllungen mit doppeltem Füllkopf nicht
unterstützt.

3. Implementierung der Fixed AOC:

a. Deaktivieren Sie Enable AOC.

b. Setzen Sie AOC Algorithm auf Fixed.

c. Stellen Sie Fixed Overshoot Comp nach Wunsch ein.

Die Voreinstellung ist 0 und wird in Prozesseinheiten gemessen.

Die Auswerteelektronik schließt das Ventil, wenn der aktuelle Abfüllzähler gleich
dem Fill Target minus dem angegebenen Wert (in Prozesseinheiten) ist.

4. So implementieren Sie Overfill oder Underfill:

a. Stellen Sie sicher, dass Enable AOC aktiviert ist.

b. Setzen Sie AOC Algorithm auf Underfill oder Overfill.
c. Stellen Sie AOC Window Length auf die Anzahl der Abfüllungen ein, die zur AOC-

Kalibrierung verwendet wird.

Die Voreinstellung ist 10. Der Auswahlbereich ist 2 bis 32.

Hinweis
Micro Motion empfiehlt die Verwendung des Standardwerts, es sei denn, Sie haben
besondere Anwendungsanforderungen.

Wichtig
Ändern Sie die Werte für AOC Change Limit oder AOC Convergence Rate nur auf Anweisung des
Kundendienstes von Micro Motion. Diese Parameter werden verwendet, um die Funktion des
AOC-Algorithmus für besondere Anwendungsanforderungen einzustellen.

Beispiel: Konfigurieren der AOC

Wichtig
In diesem Beispiel werden standardmäßige oder typische Einstellungen für die erforderlichen
Parameter verwendet. Für Ihre Anwendung sind möglicherweise andere Einstellungen erforderlich.
Weitere Informationen zu Datentypen und Integercodes finden Sie im PROFIBUS Busparametern.

• Feste AOC:

Block Index
Wert (de-
zimal) Beschreibung

Filling 21 0 Setzt Enable AOC auf Disabled

Filling 22 2 Setzt AOC Algorithm auf Fixed

Konfigurieren einer integrierten Abfüll-Ventilsteuerung mittels PROFIBUS Busparametern

134  Micro Motion® Auswerteelektronik für Masseabfüllung mit PROFIBUS-DP



Block Index
Wert (de-
zimal) Beschreibung

Filling 26 0 Setzt Feste Überfüllkompensation auf 0

• AOC für die Über- oder Unterfüllung:

Block Index
Wert (de-
zimal) Beschreibung

Filling 21 1 Setzt Enable AOC auf Enabled

Filling 22 0 Setzt AOC Algorithm auf Overfill

Filling 23 10 Setzt AOC Window Length auf 10 Abfüllungen

Nachbereitungsverfahren

Wenn Sie AOC Algorithm auf Overfill oder Underfill setzen, müssen Sie eine AOC-Kalibrierung
durchführen.

Durchführen einer AOC-Kalibrierung mittels PROFIBUS
Busparametern
Die AOC-Kalibrierung wird verwendet, um den Wert für die automatische
Überfüllkompensation (Automatic Overshoot Compensation, AOC) anhand der Ist-
Abfülldaten zu berechnen. Wenn Sie AOC Algorithm auf Overfill oder Underfill setzen, müssen
Sie eine AOC-Kalibrierung durchführen.

Es gibt zwei Arten der AOC-Kalibrierung:

• Standard: Die Kalibrierung wird manuell durchgeführt. Der AOC-Koeffizient wird
anhand von Abfülldaten berechnet, die bei dieser Kalibrierung eingeholt werden,
und derselbe AOC-Koeffizient wird solange angewandt, bis die Kalibrierung
wiederholt wird.

• Rolling: Die Kalibrierung wird kontinuierlich und automatisch durchgeführt, und der
AOC-Koeffizient wird kontinuierlich - auf Basis von Abfülldaten des letzten
Abfüllvorgangs - aktualisiert.

Hinweis
Für stabile Prozesse empfiehlt Micro Motion die AOC-Standardkalibrierung. Testen Sie nach Bedarf
beide Methoden und wählen Sie die Methode, mit der Sie die besten Ergebnisse erzielen.

Durchführen einer AOC-Standardkalibrierung

Standard AOC Calibration wird verwendet, um einen konstanten AOC-Koeffizienten zu
erzeugen.

Vorbereitungsverfahren

AOC Window Length muss entsprechend gesetzt werden. Micro Motion empfiehlt die
Verwendung des Standardwerts (10), es sei denn, Sie haben besondere
Anwendungsanforderungen.

Mass Flow Cutoff bzw. Volume Flow Cutoff müssen entsprechend der Betriebsumgebung
gesetzt werden.
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• Wenn Flow Source auf Mass Flow Rate gesetzt ist, siehe Abschnitt 15.2.3.

• Wenn Flow Source auf Volume Flow Rate gesetzt ist, siehe Abschnitt 15.3.2.

Ihr System muss zum Abfüllen bereit sein, und Sie müssen wissen, wie Abfüllvorgänge
ausgeführt werden.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, das DP-V1 Lese- und
Schreibdienste unterstützt, und Sie müssen eine Verbindung mit der Auswerteelektronik
hergestellt haben.

Verfahren

1. Kalibrierung des Primärventils (alle Befüllarten):

a. Schreiben Sie 1 in Start AOC Cal (Filling Block, Index 99).

b. Führen Sie zwischen zwei und der in AOC Window Length angegebenen Anzahl von
Kalibrierabfüllungen aus.

Anmerkung
Sie können nach Wahl auch mehr Kalibrierabfüllungen durchführen. Der AOC-Koeffizient
wird anhand der letzten Abfüllungen berechnet.

Hinweis
Normalerweise werden, aufgrund der werksseitigen Standardeinstellungen, die ersten
Abfüllungen leicht über- oder unterfüllt. Im Laufe der Kalibrierung werden diese
Abfüllungen auf dem Fill Target konvergieren.

c. Wenn die Abfüllzähler kontinuierlich zufriedenstellend sind, schreiben Sie 1 in
Save AOC Cal (Filling Block, Index 101).

2. Kalibrierung des Sekundärventils (Abfüllungen mit doppeltem Füllkopf):

a. Schreiben Sie 1 in Start Secondary AOC Cal (Filling Block, Index 100).

b. Führen Sie zwischen zwei und der in AOC Window Length angegebenen Anzahl von
Kalibrierabfüllungen aus.

Die Auswerteelektronik führt die Abfüllungen automatisch durch das
Sekundärventil durch.

Anmerkung
Sie können nach Wahl auch mehr Kalibrierabfüllungen durchführen. Der AOC-Koeffizient
wird anhand der letzten Abfüllungen berechnet.

Hinweis
Normalerweise werden, aufgrund der werksseitigen Standardeinstellungen, die ersten
Abfüllungen leicht über- oder unterfüllt. Im Laufe der Kalibrierung werden diese
Abfüllungen auf dem Fill Target konvergieren.

c. Wenn die Abfüllzähler kontinuierlich zufriedenstellend sind, schreiben Sie 1 in
Save Secondary AOC Cal (Filling Block, Index 102).
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Der aktuelle AOC-Koeffizient wird im Fenster Run Filler angezeigt. Falls Sie eine Abfüllung
mit doppeltem Füllkopf durchführen, zeigt das Fenster Run Filler den AOC-Koeffizienten
für das Primär- und für das Sekundärventil an. Diese Koeffizienten werden solange auf die
Abfüllvorgänge angewandt, wie AOC aktiviert ist.

Anmerkung
Bei zweistufigen Abfüllungen wird der AOC-Wert auf das Ventil angewandt, das sich schließt,
nachdem die Sollmenge erreicht ist. Falls die Abfüllparameter so eingestellt sind, dass sich beide
Ventile nach Erreichen der Sollmenge schließen, wird der AOC-Koeffizient auf beide Ventile
angewandt.

Hinweis
Micro Motion empfiehlt eine Wiederholung der AOC-Kalibierung, falls einer der folgenden Zustände
eintritt:

• Wenn Geräte ausgetauscht oder eingestellt wurden.

• Wenn sich die Durchflussmenge bedeutend geändert hat.

• Wenn die Abfüllgenauigkeit niedriger als erwartet ist.

• Wenn Mass Flow Cutoff oder Volume Flow Cutoff geändert wurden.

Einrichten einer kontinuierlichen AOC-Kalibrierung

Rolling AOC Calibration wird verwendet, um den AOC-Koeffizienten kontinuierlich - auf
Basis von Abfülldaten des letzten Abfüllvorgangs - zu aktualisieren.

Vorbereitungsverfahren

AOC Window Length muss entsprechend gesetzt werden. Micro Motion empfiehlt die
Verwendung des Standardwerts (10), es sei denn, Sie haben besondere
Anwendungsanforderungen.

Ihr System muss zum Abfüllen bereit sein, und Sie müssen wissen, wie Abfüllvorgänge
ausgeführt werden.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, das DP-V1 Lese- und
Schreibdienste unterstützt, und Sie müssen eine Verbindung mit der Auswerteelektronik
hergestellt haben.

Verfahren

1. Zur Kalibrierung des Primärventils (alle Abfüllarten) schreiben Sie 1 in Start AOC Cal
(Filling Block, Index 99). Zur Kalibrierung des Sekundärventils (Abfüllungen mit
doppeltem Füllkopf) schreiben Sie 1 in Start Secondary AOC Cal (Filling Block, Index
100).

Sie können die kontinuierliche AOC-Kalibrierung für ein oder beide Ventile
einrichten.

2. Starten Sie die Serienabfüllung.

Die Auswerteelektronik berechnet den/die AOC-Koeffizienten nach jeder Abfüllung
anhand der letzten xAbfüllungen neu, wobei x die in AOC Window Length festgelegte Anzahl
ist. Die aktuellen Werte werden im Fenster Run Filler angezeigt. Falls sich die Konfiguration
oder die Prozessbedingungen geändert haben, gleicht die kontinuierliche AOC-
Kalibrierung diese Änderungen aus. Diese Einstellung findet jedoch über mehrere
Abfüllungen hinweg statt, das heißt, dass es einige Abfüllvorgänge dauern wird, ehe AOC
die Werte angepasst hat.
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Hinweis
Während die AOC-Kalibrierung läuft, können Sie jederzeit 1 in Save AOC Cal (Filling Block, Index 101)
oder 1 in Save Secondary AOC Cal (Filling Block, Index 102) schreiben. Der aktuelle AOC-Koeffizient
wird gespeichert und auf alle nachfolgenden Abfüllungen durch das entsprechende Ventil
angewandt. Mit anderen Worten ändert diese Aktion die AOC-Kalibriermethode für dieses Ventil von
Rolling auf Standard.

10.2.2 Konfigurieren der Spülfunktion mittels PROFIBUS
Busparametern
Die Spülfunktion wird verwendet, um ein Hilfsventil zu steuern, das nicht für die Abfüllung
eingesetzt wird. Beispielsweise kann damit ein Behälter mit Wasser oder Gas aufgefüllt
werden, nachdem der Füllvorgang abgeschlossen ist, oder sie kann als “ Dämpfung
dienen.” Der Durchfluss durch das Hilfsventil wird von der Auswerteelektronik nicht
gemessen. Eine Konfiguration der Spülfunktion zur automatischen oder manuellen
Spülsteuerung ist möglich. Bei der Auswahl der automatischen Steuerung wird das
Hilfsventil nach jeder Befüllung geöffnet und nach dem Ablauf der konfigurierten Spülzeit
geschlossen.

Einschränkung
Die Spülfunktion wird nicht für Befüllungen mit doppeltem Füllkopf oder zeitgesteuerte Befüllungen
mit doppeltem Füllkopf unterstützt.

Vorbereitungsverfahren

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, das DP-V1 Lese- und
Schreibdienste unterstützt, und Sie müssen eine Verbindung mit der Auswerteelektronik
hergestellt haben.

Verfahren

1. Konfigurieren von Kanal B als Binärausgang:

a. Setzen Sie Channel B Type Assignment auf Discrete Output.
b. Setzen Sie DO1 Assignment auf Discrete Batch: Purge Valve.

c. Stellen Sie DO1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

d. Stellen Sie DO1 Fault Action entsprechend Ihrer Installation ein.
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Option Beschreibung

Aufwärts Der Binäreingang wird auf EIN geschaltet (Ventil geöf-
fnet), wenn eine Störung auftritt.

Abwärts Der Binäreingang wird auf AUS geschaltet (Ventil ges-
chlossen), wenn eine Störung auftritt.

Keine Bei Auftreten einer Störung werden keine Maßnahmen er-
griffen. Der Binärausgang bleibt in dem Zustand, in dem
er vor Auftreten der Störung war.

2. Spülung konfigurieren:

a. Enable Purge (Spülung aktivieren) aktivieren.

b. Purge Mode (Spülmodus) wie gewünscht einstellen.

Option Beschreibung

Auto (Automatisch) Eine Spülung wird nach jeder Befüllung automatisch
durchgeführt.

Manual (Manuell) Spülvorgänge müssen manuell gestartet und ges-
toppt werden.

Hinweis
Wenn Purge Mode (Spülmodus) auf Auto (Automatisch) eingestellt ist, ist eine manuelle
Steuerung des Spülventils weiterhin möglich. Eine Spülung kann manuell gestartet oder
gestoppt werden oder sie kann durch die Auswerteelektronik nach der abgelaufenen
Purge Time (Spülzeit) gestoppt werden. Wird eine Spülung automatisch gestartet, kann sie
manuell gestoppt werden.

c. Wenn Purge Mode (Spülmodus) auf Auto (Automatisch) eingestellt ist, Purge Delay
(Spülverzögerung) auf die Anzahl von Sekunden einstellen, die die
Auswerteelektronik nach der Befüllung warten soll, umd das Spülventil zu
öffnen.

Der Standardwert für Purge Delay (Spülverzögerung) beträgt 2 Sekunden.

d. Wenn Purge Mode (Spülmodus) auf Auto (Automatisch) eingestellt wird, Purge Time
(Spülzeit) auf die Anzahl von Sekunden einstellen, die die Auswerteelektronik das
Ventil offen halten soll.

Der Standardwert für Purge Time (Spülzeit) beträgt 1 Sekunde. Der Bereich liegt
bei 0 Sekunden bis 800 Sekunden.

Hinweis
Die nächste Befüllung kann erst beginnen, wenn das Spülventil geschlossen ist.

Beispiel: Konfigurieren der Spülfunktion

Wichtig
In diesem Beispiel werden standardmäßige oder typische Einstellungen für die erforderlichen
Parameter verwendet. Für Ihre Anwendung sind möglicherweise andere Einstellungen erforderlich.
Weitere Informationen zu Datentypen und Integercodes finden Sie im PROFIBUS Busparametern.
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Block Index

Wert (de-
zimal oder
Fließkom-
ma) Beschreibung

Filling 83 4 Setzt Type Assignment für Kanal B auf Discrete Output

Filling 70 110 Setzt DO1 Assignment auf Primary Valve

Filling 71 1 Setzt DO1 Polarity auf Active High

Filling 72 4 Setzt DO1 Fault Action auf None

Filling 29 1 Aktiviert Enable Purge

Filling 30 0 Setzt Purge Mode auf Auto

Filling 31 3,00 Setzt Purge Delay auf 3 s

Filling 32 2,00 Setzt Purge Time auf 2 s

10.2.3 Konfigurieren der Pumpenfunktion mittels PROFIBUS
Busparametern
Die Pumpfunktion wird verwendet, um den Druck während der Abfüllung zu erhöhen,
indem eine in Flussrichtung liegende Pumpe kurz vor dem Beginn der Abfüllung gestartet
wird.

Einschränkung
Die Pumpenfunktion wird nicht für zweistufige Binärbefüllungen, Befüllungen mit doppeltem
Füllkopf, zeitgesteuerte Befüllungen oder zeitgesteuerte Befüllungen mit doppeltem Füllkopf
unterstützt.

Vorbereitungsverfahren

Die Binärausgänge müssen entsprechend Ihrer Abfüllart und Abfülloptionen geschaltet
sein.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, das DP-V1 Lese- und
Schreibdienste unterstützt, und Sie müssen eine Verbindung mit der Auswerteelektronik
hergestellt haben.

Verfahren

1. Konfigurieren des/der präzisen Binärausgangs/-ausgänge:

a. Setzen Sie Precision DO2 auf Pump.

b. Stellen Sie Precision DO2 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das EIN-Signal das Ventil öffnet und das AUS-Signal das
Ventil schließt.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Konfigurieren einer integrierten Abfüll-Ventilsteuerung mittels PROFIBUS Busparametern

140  Micro Motion® Auswerteelektronik für Masseabfüllung mit PROFIBUS-DP



Option
Signal von der Auswertee-
lektronik Spannung

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

2. Pump to Valve Delay (Pumpe-zu-Ventilverzögerung) auf die Anzahl von Sekunden
einstellen, die die Pumpe laufen soll, bevor das Ventil geöffnet wird.

Der Standardwert beträgt 10 Sekunden. Der Bereich liegt bei 0 Sekunden bis
30 Sekunden.

Wenn der Befehl Begin Filling (Befüllung beginnen) empfangen wird, startet die
Auswerteelektronik die Pumpe, wartet die unter Pump to Valve Delay (Pumpe-zu-
Ventilverzögerung) spezifizierte Anzahl von Sekunden und öffnet dann das Ventil. Die
Pumpe läuft, bis die Befüllung abgeschlossen ist.

Beispiel: Konfigurieren der Pumpenfunktion

Wichtig
In diesem Beispiel werden standardmäßige oder typische Einstellungen für die erforderlichen
Parameter verwendet. Für Ihre Anwendung sind möglicherweise andere Einstellungen erforderlich.
Weitere Informationen zu Datentypen und Integercodes finden Sie im PROFIBUS Busparametern.

Block Index

Wert (de-
zimal oder
Fließkom-
ma) Beschreibung

Filling 35 109 Setzt Precision DO2 auf Pump

Filling 36 1 Setzt Precision DO2 Polarity auf Active High

Filling 20 15,00 Setzt Pump to Valve Delay auf 15 s

10.3 Konfigurieren einer Abfüllsteuerung mittels
PROFIBUS Busparametern (optional)
Bei einer typischen Serienfertigung erfolgt die Abfüllsteuerung (Starten und Stoppen der
Abfüllung) durch den Host oder die SPS. Sie können auf Wunsch das System auch so
einrichten, dass die Abfüllung über den Binäreingang (falls verfügbar) begonnen, beendet,
angehalten und fortgesetzt wird. Außerdem können Sie ein Ereignis definieren, bei dem
die Abfüllung beginnt, endet, angehalten oder fortgesetzt wird.

10.3.1 Konfigurieren des Binäreingangs für die Abfüllsteuerung
mittels PROFIBUS Busparameter
Wenn Kanal B verfügbar ist, können Sie diesen als Binäreingang konfigurieren und
verwenden, um eine Abfüllung zu beginnen oder zu beenden oder um eine laufende
Abfüllung anzuhalten und fortzusetzen. Außerdem können Sie den Kanal zum
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Zurücksetzen des Masse Summenzählers, des Volumen Summenzählers oder aller
Summenzähler konfigurieren. Wenn der Binäreingang aktiviert ist, werden alle
zugewiesenen Aktionen durchgeführt.

Vorbereitungsverfahren

Kanal B muss als Binärausgang geschaltet sein.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, das DP-V1 Lese- und
Schreibdienste unterstützt, und Sie müssen eine Verbindung mit der Auswerteelektronik
hergestellt haben.

Verfahren

1. Konfigurieren von Kanal B als Binäreingang:

a. Setzen Sie Type Assignment für Kanal B auf Discrete Input.
2. Weisen Sie dem Binäreingang Steuerungsaktionen zur Abfüllung zu.

a. Wählen Sie die Aktion oder Aktionen, die bei Aktivierung des Binäreingangs
ausgeführt werden sollen.

Aktion Beschreibung Bemerkungen

Begin Filling Beginnt die Abfüllung mit der aktuellen Abfüll-
konfiguration. Der Abfüllzähler wird automa-
tisch zurückgesetzt, bevor die Abfüllung be-
ginnt.

Falls eine Abfüllung läuft, wird der Befehl ig-
noriert.

Wenn ein automatischer Spülvorgang läuft,
werden die Funktionen zum Start der Abfül-
lung ausgeführt, sobald der Spülvorgang ab-
geschlossen ist.

End Filling Beendet die aktuelle Abfüllung und führt Funk-
tionen zum Ende der Abfüllung aus. Die Abfül-
lung kann nicht fortgesetzt werden.

Wird ausgeführt, während eine Abfüllung läuft
oder angehalten ist und während eines Spül-
vorgangs oder einer Spülverzögerung.

Für Abfüllungen mit doppeltem Füllkopf und
zeitgesteuerte Abfüllungen mit doppeltem
Füllkopf beendet der Befehl immer die zurzeit
aktive Abfüllung.

Pause Filling Zeitgesteuerte Abfüllungen, Abfüllungen mit
doppeltem Füllkopf und zeitgesteuerte Abfül-
lungen mit doppeltem Füllkopf: Identisch mit
End Filling.

Einstufige Abfüllungen und zweistufige Abfül-
lungen: Hält die Abfüllung vorläufig an. Die
Abfüllung kann fortgesetzt werden, wenn die
Abfüllmenge kleiner als die Sollmenge ist.

Falls ein Spülvorgang oder eine Spülverzöger-
ung läuft, wird der Befehl ignoriert.

Resume Filling Startet die Abfüllung wieder, nachdem sie un-
terbrochen wurde. Die Zählung wird an der
Stelle oder an dem Zeitpunkt wieder fortge-
setzt, an der/dem sie unterbrochen wurde.

Wird nur ausgeführt, wenn eine einstufige Ab-
füllung oder eine zweistufige Abfüllung ange-
halten wurden. Wird alle anderen Male ignor-
iert.

Reset Mass Total Setzt den Wert des Masse Summenzählers auf
0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.
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Aktion Beschreibung Bemerkungen

Reset Volume Total Setzt den Wert des Volumen Summenzählers
auf 0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

Reset All Totals Setzt den Wert des Masse Summenzählers und
des Volumen Summenzählers auf 0 zurück,
und setzt den Abfüllzähler auf 0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

3. Stellen Sie DI1 Polarity entsprechend Ihrer Installation ein.

Stellen Sie sicher, dass das vom Binäreingang gesendete EIN-Signal auch als EIN
gelesen wird, und umgekehrt.

Option
Angelegte Spannung über
Anschlussklemmen Auswerteelektronik liest

Active High 3 bis 30 VDC ON

<0,8 VDC OFF

Active Low <0,8 VDC ON

3 bis 30 VDC OFF

Beispiel: Konfigurieren des Binäreingangs für die Abfüllsteuerung

Wichtig
In diesem Beispiel werden standardmäßige oder typische Einstellungen für die erforderlichen
Parameter verwendet. Für Ihre Anwendung sind möglicherweise andere Einstellungen erforderlich.
Weitere Informationen zu Datentypen und Integercodes finden Sie im PROFIBUS Busparametern.

Block Index
Wert (de-
zimal) Beschreibung

Filling 83 5 Setzt Type Assignment für Kanal B auf Discrete Input

Filling 75 98 Weist Begin Filling dem Discrete Input zu

Filling 82 1 Setzt DI1 Polarity auf Active High

10.3.2 Einrichten eines Ereignisses zur Durchführung einer
Abfüllsteuerung mit PROFIBUS
Sie können ein Ereignis zuweisen, um eine Abfüllung zu starten, zu stoppen, anzuhalten
oder fortzusetzen. Außerdem können Sie das Ereignis zum Zurücksetzen des Masse
Summenzählers, des Volumen Summenzählers oder aller Summenzähler zuweisen. Beim
Schalten des Ereignisses auf ON (EIN) werden alle zugewiesenen Aktionen durchgeführt.

Vorbereitungsverfahren

Sie müssen alle gewünschten Ereignisse konfigurieren. Sie können diese Ereignisse sowohl
vor als auch nach dem Zuweisen von Aktionen konfigurieren.
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Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, das DP-V1 Lese- und
Schreibdienste unterstützt, und Sie müssen eine Verbindung mit der Auswerteelektronik
hergestellt haben.

Verfahren

1. Weisen Sie dem Ereignis Steuerungsaktionen zur Abfüllung zu.

a. Identifizieren Sie die Aktion oder Aktionen, die bei Auftreten des Discrete Event 1
ausgeführt werden soll bzw. sollen.

Aktion Beschreibung Bemerkungen

Begin Filling Beginnt die Abfüllung mit der aktuellen Abfüll-
konfiguration. Der Abfüllzähler wird automa-
tisch zurückgesetzt, bevor die Abfüllung be-
ginnt.

Falls eine Abfüllung läuft, wird der Befehl ig-
noriert.

Wenn ein automatischer Spülvorgang läuft,
werden die Funktionen zum Start der Abfül-
lung ausgeführt, sobald der Spülvorgang ab-
geschlossen ist.

End Filling Beendet die aktuelle Abfüllung und führt Funk-
tionen zum Ende der Abfüllung aus. Die Abfül-
lung kann nicht fortgesetzt werden.

Wird ausgeführt, während eine Abfüllung läuft
oder angehalten ist und während eines Spül-
vorgangs oder einer Spülverzögerung.

Für Abfüllungen mit doppeltem Füllkopf und
zeitgesteuerte Abfüllungen mit doppeltem
Füllkopf beendet der Befehl immer die zurzeit
aktive Abfüllung.

Pause Filling Zeitgesteuerte Abfüllungen, Abfüllungen mit
doppeltem Füllkopf und zeitgesteuerte Abfül-
lungen mit doppeltem Füllkopf: Identisch mit
End Filling.

Einstufige Abfüllungen und zweistufige Abfül-
lungen: Hält die Abfüllung vorläufig an. Die
Abfüllung kann fortgesetzt werden, wenn die
Abfüllmenge kleiner als die Sollmenge ist.

Falls ein Spülvorgang oder eine Spülverzöger-
ung läuft, wird der Befehl ignoriert.

Resume Filling Startet die Abfüllung wieder, nachdem sie un-
terbrochen wurde. Die Zählung wird an der
Stelle oder an dem Zeitpunkt wieder fortge-
setzt, an der/dem sie unterbrochen wurde.

Wird nur ausgeführt, wenn eine einstufige Ab-
füllung oder eine zweistufige Abfüllung ange-
halten wurden. Wird alle anderen Male ignor-
iert.

Reset Mass Total Setzt den Wert des Masse Summenzählers auf
0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

Reset Volume Total Setzt den Wert des Volumen Summenzählers
auf 0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

Reset All Totals Setzt den Wert des Masse Summenzählers und
des Volumen Summenzählers auf 0 zurück,
und setzt den Abfüllzähler auf 0 zurück.

Wird nur ausgeführt, wenn keine Abfüllung
läuft (zwischen Abfüllungen oder wenn eine
Abfüllung angehalten wurde). Wird alle ander-
en Male ignoriert.

2. Wiederholen Sie das Verfahren für Discrete Event 2–5.
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Beispiel: Ereignisse überwachen den Prozess und pausieren oder beenden die
Abfüllung

Der akzeptable Dichtebereich für Ihren Prozess ist 1,1 g/cm3 bis 1,12 g/cm3. Der
akzeptable Temperaturbereich ist 20 °C bis 25 °C. Wenn die Dichte den Messbereich
überschreitet, möchten Sie die Abfüllung anhalten. Wenn die Temperatur den
Messbereich überschreitet, möchten Sie die Abfüllung beenden.

Veranstaltung-Konfiguration:

• Diskret Veranstaltung 1:

Blockieren Index

Wert (de-
zimal
oder
float) Beschreibung

Diagnostisch 4 0 Wählt Binärereignis 1

Diagnostisch 5 3 Stellt Ereignisart auf Außerhalb des Bereichs ein
Außerhalb des zulässigen Bereichs

Diagnostisch 8 3 Stellt Prozessvariable auf Dichte auf Dichte

Diagnostisch 6 1,10 Stellt Niedriger Sollwert (A) en 1.1 g/cm3

Diagnostisch 7 1,12 Stellt Hoher Sollwert (B) auf 1.12 g/cm3

• Diskret Veranstaltung 2:

Blockieren Index

Wert (de-
zimal
oder
float) Beschreibung

Diagnostisch 4 1 Wählt Binärereignis 2

Diagnostisch 5 3 Stellt Ereignisart auf Außerhalb des Bereichs ein
Außerhalb des zulässigen Bereichs

Diagnostisch 8 1 Stellt Prozessvariable auf Temperatur ein Temperatur

Diagnostisch 6 20,00 Stellt Niedriger Sollwert (A) auf 20 °C

Diagnostisch 7 25,00 Stellt Hoher Sollwert (B) auf 25 °C

• Action-Zuweisungen:

Blockie-
ren Index

Wert

(hexadezi-
mal)

Wert

(dezi-
mal) Beschreibung

Füllen 77 0x0039 57 Weist Pause zu füllen Diskret Veranstaltung
1

Füllen 76 0x003A 58 Weist End Füllen zu Diskret Veranstaltung 2
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Nachbereitungsverfahren

Wenn Sie Ereignissen Aktionen zugeordnet haben, die nicht konfiguriert sind, müssen Sie
diese Ereignisse konfigurieren, bevor Sie diese Methode der Abfüllsteuerung
implementieren können.

10.3.3 Mehrere Maßnahmen, die einem Binäreingang oder
Ereignis zugewiesen sind
Wenn mehrere Maßnahmen einem Binäreingang oder Ereignis zugewiesen sind, führt die
Auswerteelektronik nur die Maßnahmen durch, die jeweils für die aktuelle Situation von
Bedeutung sind. Wenn zwei oder mehr der Maßnahmen sich gegenseitig ausschließen,
führt die Auswerteelektronik Maßnahmen gemäß einem Prioritätenschema durch, das in
der Firmware der Auswerteelektronik definiert ist.

Die folgenden Beispiele zeigen drei Konfigurationen, die Micro Motion empfiehlt, und zwei
Konfigurationen, die nicht empfohlen werden.

Beispiel: Verwenden des Binäreingangs oder des Ereignisses, um eine Abfüllung zu
beginnen und zu beenden (empfohlen)

Maßnahmezuordnungen:

• Abfüllung-Beginn
• Abfüllung-Ende
• Masse Summenzähler zurücksetzen
• Volumen Summenzähler zurücksetzen

Ergebnis der Aktivierung:

• Wenn keine Abfüllung läuft, werden der Masse Summenzähler und der Volumen
Summenzähler zurückgesetzt und eine Abfüllung beginnt.

• Wenn eine Abfüllung läuft, wird diese beendet und der Masse Summenzähler und
der Volumen Summenzähler werden zurückgesetzt.

Beispiel: Verwenden des Binäreingangs oder des Ereignisses, um die Abfüllung zu
beginnen, anzuhalten und sie fortzusetzen (empfohlen)

Maßnahmezuordnungen:

• Abfüllung-Beginn
• Abfüllung-Pause
• Abfüllung-Fortsetzung

Ergebnis der Aktivierung:

• Wenn keine Abfüllung läuft, wird diese gestartet.

• Wenn eine Abfüllung läuft und nicht angehalten wurde, wird diese angehalten.

• Wenn eine Abfüllung angehalten wurde, wird diese fortgesetzt.

Beispiel: Verwenden des Binäreingangs, um die Abfüllung zu starten und den
Volumenzähler zurückzusetzen (empfohlen)

Maßnahmezuordnungen:

• Abfüllung-Beginn
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• Volumen Summenzähler zurücksetzen

Ergebnis der Aktivierung:

• Wenn keine Abfüllung läuft, wird der Volumen Summenzähler zurückgesetzt und
eine Abfüllung beginnt.

• Wenn eine Abfüllung läuft, wird der Volumen Summenzähler zurückgesetzt.

Hinweis
Diese Konfiguration ist nützlich, wenn die Abfüllung hinsichtlich der Masse konfiguriert wird, das
Gesamtvolumen für die Abfüllung aber ebenfalls ermittelt werden soll. In diesem Fall nicht den
Binäreingang aktivieren, während die Abfüllung läuft. Am Ende der Abfüllung kann das
Gesamtvolumen abgelesen werden. Danach mit der nächsten Abfüllung fortfahren.

Beispiel: Inkompatible Zuordnungen (nicht empfohlen)

Maßnahmezuordnungen:

• Abfüllung-Beginn
• Abfüllung-Ende
• Abfüllung-Pause
• Abfüllung-Fortsetzung

Ergebnis der Aktivierung:

• Wenn keine Abfüllung läuft, wird diese gestartet.

• Wenn eine Abfüllung läuft, wird diese beendet.

In diesem Beispiel wird die Abfüllung durch den Binäreingang oder das Ereignis nicht
angehalten, weil die Maßnahme End Fill Priorität hat.

Beispiel: Inkompatible Zuordnungen (nicht empfohlen)

Maßnahmezuordnungen:

• Abfüllung-Ende
• Alle Zähler zurücksetzen

Ergebnis der Aktivierung:

• Wenn keine Abfüllung läuft, werden alle Zähler, einschließlich dem Abfüll-
Summenzähler, zurückgesetzt.

• Wenn eine Abfüllung läuft, wird diese beendet und alle Zähler, einschließlich dem
Abfüll-Summenzähler, werden zurückgesetzt.

Das Ergebnis dieser Kombination ist, dass der Abfüll-Summenzähler vor dem Abrufen der
Daten zurückgesetzt wird.

10.4 Konfigurieren der Abfüllprotokollierung
mittels PROFIBUS Busparametern (optional)
Sie können die Auswerteelektronik so konfigurieren, dass der ON/OFF-Status über Kanal B
(falls verfügbar) und der Prozentsatz der Abfüllung über den mA-Ausgang ausgegeben
wird.
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10.4.1 Konfigurieren von Kanal B als Binärausgang und
Übertragen des Abfüllstatus ON/OFF mittels PROFIBUS
Busparametern
Falls Kanal B verfügbar ist, können Sie diesen verwenden, um auszugeben, ob ein
Abfüllvorgang läuft.

Vorbereitungsverfahren

Kanal B muss als Binärausgang geschaltet sein.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, das DP-V1 Lese- und
Schreibdienste unterstützt, und Sie müssen eine Verbindung mit der Auswerteelektronik
hergestellt haben.

Verfahren

1. Setzen Sie Channel B Type Assignment auf Discrete Output.
2. Setzen Sie DO1 Assignment auf Discrete Batch: Batching/Filling In Progress.

3. Stellen Sie DO1 Polarity entsprechend Ihrer Installation ein.

Option
Signal von der Auswertee-
lektronik Spannung

Active High ON Standortspezifisch bis zu
30 VDC

OFF 0 VDC

Active Low ON 0 VDC

OFF Standortspezifisch bis zu
30 VDC

4. Stellen Sie DO1 Fault Action entsprechend Ihrer Installation ein.

Option Beschreibung

Aufwärts Der Binäreingang wird auf EIN geschaltet (Ventil geöffnet),
wenn eine Störung auftritt.

Abwärts Der Binäreingang wird auf AUS geschaltet (Ventil geschlos-
sen), wenn eine Störung auftritt.

Keine Bei Auftreten einer Störung werden keine Maßnahmen er-
griffen. Der Binärausgang bleibt in dem Zustand, in dem er
vor Auftreten der Störung war.

Hinweis
Wenn der Binärausgang zur Ausgabe von Abfüllberichten verwendet wird, empfiehlt Micro
Motion die Einstellung von DO1 Fault Action auf None.
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Beispiel: Konfigurieren des Binärausgangs, um den Abfüllstatus ON/OFF zu
übertragen

Blockieren Index
Wert (de-
zimal) Beschreibung

Füllen 83 4 Setzt Type Assignment für Kanal B auf Discrete Output

Füllen 70 106 Setzt DO1 Assignment auf
Discrete Batch: Batch/Filling in Progress

Füllen 71 1 Setzt DO1 Polarity auf Active High

Füllen 72 4 Setzt DO1 Fault Action auf None

10.4.2 Konfigurieren des mA-Ausgangs, um die prozentuale
Abfüllung mittels PROFIBUS Busparametern auszugeben
Sie können den mA-Ausgang so konfigurieren, dass er den Prozentsatz der abgebenenen
Sollmenge ausgibt. In einer typischen Konfiguration steigt der Strom von 4 mA auf 20 mA,
wenn der Abfüllzähler von 0 % auf 100 % geht.

Vorbereitungsverfahren

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, das DP-V1 Lese- und
Schreibdienste unterstützt, und Sie müssen eine Verbindung mit der Auswerteelektronik
hergestellt haben.

Verfahren

1. Setzen Sie Secondary Variable Is auf Discrete Batch: Percent Fill.
2. Setzen Sie Lower Range Value auf den durch 4 mA dargestellten Abfüllprozentwert.

3. Setzen Sie Upper Range Value auf den durch 20 mA dargestellten Abfüllprozentwert.

4. Stellen Sie AO Fault Action wie gewünscht ein.

Wenn Lower Range Value auf 0 % eingestellt ist und Upper Range Value auf 100 % eingestellt
ist: Wenn die Abfüllung beginnt, erzeugt der mA-Ausgang 4 mA (0 % von Fill Target). Der
Strom wird proportional zum Abfüllzähler bis auf 20 mA (100 % von Fill Target) steigen.

Anmerkung
Wenn Flow Direction auf Bidirectional oder Negate Bidirectional eingestellt ist, kann der Abfüllzähler unter
bestimmten Durchflussbedingungen sinken. In diesem Fall wird der vom mA-Ausgang erzeugte
Strom proportional reduziert.

Beispiel: Konfigurieren des mA Ausgangs, um die prozentuale Abfüllung auszugeben

Blockieren Index

Wert (de-
zimal oder
Fließkom-
ma) Beschreibung

Abfüllung 42 207 Setzt Secondary Variable Is auf Discrete Batch: Percent Fill

Abfüllung 43 10,00 Setzt Lower Range Value auf 10 %
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Blockieren Index

Wert (de-
zimal oder
Fließkom-
ma) Beschreibung

Abfüllung 44 80,00 Setzt Upper Range Value auf 80 %

Abfüllung 47 4 Setzt AO Fault Action auf None
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11 Abfüllverfahren mittels PROFIBUS
Busparametern
In diesem Kapitel behandelte Themen:

• Abfüllung mit integrierter Ventilsteuerung mittels PROFIBUS Busparametern

• Durchführen einer manuellen Spülung mittels PROFIBUS Busparametern

• Durchführen eines Cleaning-in-Place-Verfahrens (CIP) mit PROFIBUS

• Überwachen und Analysieren der Abfüll Leistungsmerkmale mittels PROFIBUS

11.1 Abfüllung mit integrierter Ventilsteuerung
mittels PROFIBUS Busparametern
Mit dem digitalen Kommunikationsprotokoll PROFIBUS können Sie eine Abfüllung starten,
überwachen, anhalten, fortsetzen und beenden.

Vorbereitungsverfahren

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, das DP-V1 Lese- und
Schreibdienste unterstützt, und Sie müssen eine Verbindung mit der Auswerteelektronik
hergestellt haben.

Verfahren

1. (Optional) Auf Wunsch wählen Sie einen anderen Wert für Fill Target (einstufige
Abfüllungen, zweistufige Abfüllungen oder Abfüllungen mit doppeltem Füllkopf)
oder für Target Time (zeitgesteuerte Abfüllungen oder zeitgesteuerte Abfüllungen
mit doppeltem Füllkopf).

2. (Optional) Falls die automatische Überfüllkompensation (Automatic Overshoot
Compensation, AOC) aktiviert ist, können Sie einen anderen Wert für AOC Coeff
eingeben.

Hinweis
Während der Produktion empfiehlt Micro Motion, AOC Coeff auf dem während der AOC-
Kalibrierung festgelegten Wert zu belassen. Falls Sie AOC-Kalibrierabfüllungen ausführen und
über einen AOC Coeff Wert von einem ähnlichen Gerät verfügen, können Sie diesen Wert als
„ersten Näherungswert“ im aktuellen Gerät verwenden. Dies kann nützlich sein, wenn Sie
Auslaufen verhindern oder auf ein Minimum reduzieren möchten.

3. Schreiben Sie 1 in den Filling Block, Index 106.

Der Abfüllzähler wird automatisch zurückgesetzt und das/die Ventil(e) wird/werden
geöffnet. Die Anzeige für Filling in Progress sollte On sein. Ist dies nicht der Fall und
stattdessen die Anzeige Start Not Okay oder die Anzeige AOC Flow Rate Too High Ein
sind, führen Sie eine Fehlersuche der Abfüllkonfiguration durch und wiederholen Sie
das Verfahren.

4. Überwachen Sie die Abfüllung anhand der Werte unter Current Total und Percent Fill
der Anzeige Fill Status.
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Werte des Abfüllforts-
chritts Beschreibung

Current Total Abfüllmenge zum aktuellen Zeitpunkt. Dieser Wert wird von
Count Up beeinflusst:
• Wenn Count Up aktiviert ist, beginnt Current Total bei 0 und

zählt bis zu Fill Target hoch.
• Wenn Count Up deaktiviert ist, beginnt Current Total bei Fill

Target und zähl bis auf 0 herunter.

Percent Fill Prozentwert des Fill Target, der bis zum aktuellen Zeitpunkt
gemessen wurde. Dieser Wert wird nicht von Count Up beein-
flusst.

Fill Status Anzeige Beschreibung

Filling in Progress Zurzeit wird eine Abfüllung durch das Primärventil durchge-
führt. Diese Anzeige ist auch dann aktiv, wenn die Abfüllung
angehalten wird.

Secondary Fill in Progress Zurzeit wird eine Abfüllung durch das Sekundärventil durch-
geführt. Diese Anzeige ist auch dann aktiv, wenn die Abfül-
lung angehalten wird. Dies gilt nur für Abfüllungen mit dop-
peltem Füllkopf.

Max Fill Time Exceeded Die aktuelle Abfüllung hat die derzeitige Einstellung für Max
Fill Time überschritten. Die Abfüllung wird abgebrochen.

Primary Valve Das Primärventil ist offen.

Secondary Valve Das Sekundärventil ist offen.

Pump Die Pumpe läuft.

Purge In Progress Ein Spülvorgang wurde, entweder automatisch oder man-
uell, gestartet.

Purge Delay Phase Ein automatischer Spülzyklus läuft und ist aktuell in der Ver-
zögerungsperiode zwischen Beendigung der Abfüllung und
Start des Spülvorgangs.

Purge Valve Das Spülventil ist offen.

5. (Optional) Halten Sie die Abfüllung nach Wunsch an.

Während die Abfüllung angehalten ist, können Sie den Wert für Current Target
ändern, die Abfüllung manuell mit End Filling beenden oder mit Resume Filling
fortsetzen. Die Abfüllung wird mit dem aktuellen Wert für Current Total und Percent Fill
fortgesetzt.

Einschränkung
Eine zeitgesteuerte Abfüllung oder eine zeitgesteuerte Abfüllung mit doppeltem Füllkopf
kann nicht angehalten werden.

Wichtig
Für zweistufige Abfüllungen hängt die Auswirkung eines Anhaltens und Fortsetzens der
Abfüllung von der Zeitsteuerung der Befehle zum Öffnen und Schließen des Ventils und von
dem Punkt, an welchem die Abfüllung angehalten wird, ab.
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6. (Optional) Verwenden Sie End Filling, um die Abfüllung nach Wunsch manuell zu
beenden.

Nachdem die Abfüllung beendet wurde, kann sie nicht wieder gestartet werden.

Hinweis
In den meisten Fällen sollten Sie den Abfüllvorgang automatisch beenden lassen. Beenden Sie
den Abfüllvorgang nur dann manuell, wenn Sie die Füllung entsorgen möchten.

11.1.1 Wenn die Abfüllung nicht startet
Falls die Abfüllung nicht beginnt, die Anzeigen für Start Not Okay und AOC Flow Rate Too High
prüfen.

Wenn die Anzeige Start Not Okay aufleuchtet, Folgendes prüfen:

• Sicherstellen, dass die Abfüllung aktiviert ist.

• Darauf achten, dass die vorherige Abfüllung bereits beendet ist.

• Sicherstellen, dass Fill Target oder Target Time auf positive Werte eingestellt sind.

• Sicherstellen, dass alle Ausgänge dem Ventil oder der Pumpe zugeordnet sind, das
bzw. die der Abfüllart und der Abfülloption entsprechen.

• Sicherstellen, dass keine aktiven Fehlerbedingungen an der Auswerteelektronik
vorherrschen.

• Bei Abfüllungen mit doppelten Füllköpfen sicherstellen, dass auf keinem der
Füllköpfe eine Abfüllung läuft.

Wenn die Anzeige AOC Flow Rate Too High leuchtet, ist die zuletzt gemessene
Durchflussgeschwindigkeit zu hoch, und die Abfüllung kann nicht gestartet werden.
Anders ausgedrückt bedeutet dies, dass der AOC Koeffizient, kompensiert für die
Durchflussgeschwindigkeit, angibt, dass der Befehl zum Schließen des Ventils vor dem
Beginn der Abfüllung gegeben werden müsste. Dies kann vorkommen, wenn die
Durchflussgeschwindigkeit signifikant höher liegt, seit der AOC-Koeffizient berechnet
wurde. Micro Motion empfiehlt das folgende Wiederherstellungsverfahren:

1. Jede Einrichtung durchführen, die erforderlich ist, um die AOC-Kalibrierung
durchzuführen.

2. 1 in den Filling Block, Index 96 (Override Blocked Start) schreiben.

3. AOC-Kalibrierung durchführen.

4. Die Produktionsabfüllung des Systems unter Verwendung des neuen AOC-
Koeffizienten wieder aufnehmen.

Beispiel: Zu prüfende Werte, wenn die Abfüllung nicht startet

Block Index Beschreibung

Abfüllung 6 Prüfen, ob der Abfüll-Sollwert eine nicht-negative Zahl ist

Abfüllung 16 Prüfen, ob der Zeit-Sollwert eine nicht-negative Zahl ist

Abfüllung 41 Die Anzeigen für Start Not OK und AOC Flow Rate Too High prüfen
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11.1.2 Wenn die Abfüllung nicht vollständig durchgeführt
wurde
Falls die Abfüllung anormal beendet wurde, die Auswerteelektronik und die AnzeigeMax Fill
Time Exceeded prüfen.

Wenn ein Fehler während einer Abfüllung auftritt, wird diese von der Auswerteelektronik
automatisch abgebrochen.

Wenn die Anzeige Max Fill Time Exceeded leuchtet, konnte die Abfüllung nicht ihren Zielwert
vor der konfigurierten Max Fill Time erreichen. Folgende Möglichkeiten oder Maßnahmen
sind in Betracht zu ziehen:

• Die Durchflussgeschwindigkeit des Prozesses erhöhen.

• Auf Gaseinschlüsse (Schwallströmung) im Prozessmedium prüfen.

• Auf Verstopfungen des Durchflusses prüfen.

• Sicherstellen, dass die Ventile mit der erwarteten Geschwindigkeit schließen.

• Max Fill Time auf einen höheren Wert einstellen.

• Max Fill Time durch eine Einstellung auf 0 deaktivieren.

11.1.3 Auswirkungen von Pause und Fortfahren bei zweistufigen
diskreten Abfüllungen
Bei zweistufigen diskreten Abfüllungen hängt es davon ab, wo Pause und Fortfahren in
Zusammenhang mit dem Öffnen und Schließen der primären und sekundären Ventile
auftreten.

Zuerst Primär öffnen, zuerst Primär schließen

In den folgenden Abbildungen:

• Das Primärventil öffnet zum Beginn der Abfüllung.

• Das Sekundärventil öffnet während der Abfüllung an dem vom Anwender
konfigurierten Punkt. T stellt die Zeit oder Anzahl dar, die für Sekundär öffnen
konfiguriert ist.

• Das Primärventil schließt, bevor die Abfüllung abgeschlossen ist.

• Das Sekundärventil schließt, wenn die Abfüllung abgeschlossen ist.

Fall AAbbildung 11-1:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Primary

Target 
(AOC adjusted)

Pause Resume

TT

Open Secondary 
not performed
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Fall BAbbildung 11-2:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Primary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Secondary

Fall CAbbildung 11-3:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Primary

Target 
(AOC adjusted)

T T

Secondary valve 
opened early

Pause Resume

Open 
Secondary

Fall DAbbildung 11-4:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Primary

Target 
(AOC adjusted)

T T

Secondary valve 
opened early

Pause Resume

Open 
Secondary

Zuerst Primär öffnen, zuerst Sekundär schließen

In den folgenden Abbildungen:

• Das Primärventil öffnet zum Beginn der Abfüllung.

• Das Sekundärventil öffnet während der Abfüllung an dem vom Anwender
konfigurierten Punkt. T stellt die Zeit oder Anzahl dar, die für Sekundär öffnen
konfiguriert ist.

• Das Sekundärventil schließt, bevor die Abfüllung abgeschlossen ist.
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• Das Primärventil schließt, wenn die Abfüllung abgeschlossen ist.

Fall EAbbildung 11-5:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Secondary

Target 
(AOC adjusted)

Pause Resume

TT

Open Secondary 
not performed

Fall FAbbildung 11-6:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Secondary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Secondary

Fall GAbbildung 11-7:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Secondary

Target 
(AOC adjusted)

T T

Secondary valve 
not reopened

Pause Resume

Open 
Secondary
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Fall HAbbildung 11-8:   

Secondary valve

Primary valve

Start Open 
Secondary

Close 
Secondary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Secondary

Secondary valve 
not reopened

Zuerst Sekundär öffnen, zuerst Primär schließen

In den folgenden Abbildungen:

• Das Sekundärventil öffnet zum Beginn der Abfüllung.

• Das Primärventil öffnet während der Abfüllung an dem vom Anwender
konfigurierten Punkt. T stellt die Zeit oder Anzahl dar, die für Primär öffnen
konfiguriert ist.

• Das Primärventil schließt, bevor die Abfüllung abgeschlossen ist.

• Das Sekundärventil schließt, wenn die Abfüllung abgeschlossen ist.

Fall IAbbildung 11-9:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Primary

Target 
(AOC adjusted)

Pause Resume

TT

Open Primary 
not performed
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Fall JAbbildung 11-10:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Primary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Primary

Fall KAbbildung 11-11:   

Secondary valve

Primary valve

Start Open 
Primary

Target 
(AOC adjusted)

T T

Pause Resume

Open 
Primary not 
performed

Close 
Primary

Fall LAbbildung 11-12:   

Secondary valve

Primary valve

Start Open 
Primary

Close 
Primary

Target 
(AOC adjusted)

T T

Pause Resume

Open Primary 
not performed

Zuerst Sekundär öffnen, zuerst Sekundär schließen

In den folgenden Abbildungen:

• Das Sekundärventil öffnet zum Beginn der Abfüllung.

• Das Primärventil öffnet während der Abfüllung an dem vom Anwender
konfigurierten Punkt. T stellt die Zeit oder Anzahl dar, die für Primär öffnen
konfiguriert ist.

• Das Sekundärventil schließt, bevor die Abfüllung abgeschlossen ist.

• Das Primärventil schließt, wenn die Abfüllung abgeschlossen ist.
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Fall MAbbildung 11-13:   
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Fall NAbbildung 11-14:   
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Fall OAbbildung 11-15:   
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Fall PAbbildung 11-16:   

Secondary valve
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Start Open 
Primary

Close 
Secondary

Target 
(AOC adjusted)

T T

Primary valve 
opened early

Pause Resume

Open 
Primary

11.2 Durchführen einer manuellen Spülung mittels
PROFIBUS Busparametern
Die Spülfunktion wird verwendet, um ein Hilfsventil zu steuern, das nicht für die Abfüllung
eingesetzt wird. Beispielsweise kann damit ein Behälter mit Wasser oder Gas aufgefüllt
werden, nachdem der Füllvorgang abgeschlossen ist, oder sie kann als “ Dämpfung
dienen.” Der Durchfluss durch das Hilfsventil wird von der Auswerteelektronik nicht
gemessen.

Vorbereitungsverfahren

Die Spülfunktion muss in Ihrem System implementiert sein.

Die vorhergehende Abfüllung muss beendet worden sein.

Das Hilfsventil muss an das Medium, das Sie verwenden möchten (z. B. Luft, Wasser,
Stickstoff), angeschlossen sein.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, das DP-V1 Lese- und
Schreibdienste unterstützt, und Sie müssen eine Verbindung mit der Auswerteelektronik
hergestellt haben.

Verfahren

1. Schreiben Sie 1 in den Filling Block, Index 97 (Begin Purge).

Im Filling Block, Index 40, werden die Anzeigen Purge In Progress und Purge Valve
eingeschaltet.

2. Lassen Sie das Spülmedium eine angemessene Zeit durch das System laufen.

3. Schreiben Sie 0 in den Filling Block, Index 98 (End Purge).

Im Filling Block, Index 40, werden die Anzeigen Purge In Progress und Purge Valve
ausgeschaltet.
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11.3 Durchführen eines Cleaning-in-Place-
Verfahrens (CIP) mit PROFIBUS
Die Clean-in-Place (CIP) Funktion wird verwendet, um ein Reinigungsmedium durch das
System zu leiten. Mit dem CIP-Verfahren können Sie die Innenflächen von Rohren,
Ventilen, Stutzen usw. reinigen, ohne das Gerät zerlegen zu müssen.

Vorbereitungsverfahren

Hierbei darf kein Abfüllvorgang laufen.

Das Reinigungsmedium muss zum Durchfluss durch das System bereit stehen.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, das DP-V1 Lese- und
Schreibdienste unterstützt, und Sie müssen eine Verbindung mit der Auswerteelektronik
hergestellt haben.

Verfahren

1. Tauschen Sie das Prozessmedium gegen das Reinigungsmedium aus.

2. Schreiben Sie ein in die Füllung Block, Index 111 (Beginnen Reinigung) (Beginnen
Reinigung).

Der Sender öffnet das Primärventil und das Sekundärventil, wenn es verwendet
wird, Füllung. Wenn der Pump-Funktion aktiviert ist, wird die Pumpe gestartet wird,
bevor das Ventil eröffnet. In der Füllung Block, Index 40, die Reinigung In Progress-
Anzeige leuchtet auf.

3. Lassen Sie das Reinigungsmedium eine angemessene Zeit durch das System laufen.

4. Schreiben Sie ein in die Füllung Block, Index 112 (End-Reinigung ) (End-Reinigung).

Der Sender schließt alle offenen Ventile, und stoppt die Pumpe, wenn anwendbar. In
der Füllung Block,Index 40 die Reinigung In Progress-Anzeige erlischt.

5. Tauschen Sie das Reinigungsmedium gegen das Prozessmedium aus.

11.4 Überwachen und Analysieren der Abfüll
Leistungsmerkmale mittels PROFIBUS
Für eine Einzelabfüllung können detaillierte Durchflussdaten gesammelt werden und diese
Daten können dann mit denen anderer Abfüllungen verglichen werden.

11.4.1 Sammeln detaillierter Abfülldaten für eine einzelne
Abfüllung mittels PROFIBUS Busparametern
Detaillierte Daten der letzten Abfüllung werden in der Auswerteelektronik gespeichert,
sofern die Abfüllungsprotokollierung aktiviert ist. Die Daten können mittels digitaler
Kommunikation zu Analysezwecken ausgelesen werden. Die detaillierten Daten können
zur Optimierung oder Fehlersuche in der Produktionsumgebung verwendet werden.
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Vorbereitungsverfahren

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, das DP-V1 Lese- und
Schreibdienste unterstützt, und Sie müssen eine Verbindung mit der Auswerteelektronik
hergestellt haben.

Verfahren

1. Schreiben Sie 1 in den Filling Block, Index 37 (Enable Fill Logging).

2. Führen Sie einen Abfüllvorgang aus.

3. Nach Beendigung der Datensammlung schreiben Sie 0 in den Filling Block, Index 37
(Enable Fill Logging).

4. Lesen Sie das Abfüllprotokoll.

a. Schreiben Sie einen Abfüllprotokollindex in den Filling Block, Index 38.

Die Werte für den Abfüllprotokollindex reichen von 0 bis 1000 und stellen die
letzten 1000 Datensätze dar.

b. Lesen Sie die Protokollinformationen für diesen Index aus dem Filling Block,
Index 39.

Das Abfüllprotokoll enthält Datensätze von einem einzigen Abfüllvorgang. Die
Aufzeichnung beginnt mit dem Start der Abfüllung und endet 50 Millisekunden nach
Beendigung der Abfüllung oder wenn die maximale Prokotollgröße erreicht wurde.
Datensätze werden alle 10 Millisekunden geschrieben. Jeder Datensatz enthält den
aktuellen Wert für Flow Source (die zum Messen der Abfüllung verwendete Prozessvariable).
Das Abfüllprotokoll ist auf 1000 Datensätze bzw. 10 Sekunden Abfülldauer begrenzt.
Nachdem die maximale Größe erreicht ist, stoppt die Protokollierung zwar, aber die Daten
sind in der Auswerteelektronik verfügbar, bis der nächste Abfüllvorgang beginnt. Das
Abfüllprotokoll wird zu Beginn eines neuen Abfüllvorgangs immer gelöscht.

11.4.2 Analyse der Abfüllleistung mittels Abfüllstatistiken und
PROFIBUS Busparametern
Die Auswerteelektronik zeichnet automatisch eine Vielzahl von Daten über jeden
Abfüllungsvorgang auf. Diese Daten dienen zur Optimierung des Systems.

Vorbereitungsverfahren

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, das DP-V1 Lese- und
Schreibdienste unterstützt, und Sie müssen eine Verbindung mit der Auswerteelektronik
hergestellt haben.

Verfahren

1. (Optional) Schreiben Sie 1 in Filling Block, Index 95 (Reset Fill Statistics), um die
Analyse mit einem neuen Satz Abfülldaten zu starten.

2. Führen Sie Abfüllvoränge aus und beobachten Sie die Abfülldaten.
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Abfülldaten

Filling
Block In-
dex Abfüllart Beschreibung

Durchschnittliche
Gesamtabfüllung

91 Einstufige Abfüllungen,
zweistufige Abfüllungen
und zeitgesteuerte Ab-
füllungen

Berechneter Durchschnitt aller
Abfüllsummen seit Zurückset-
zen der Abfüllstatistik.

Abfüllungen mit doppel-
tem Füllkopf und zeit-
gesteuerte Abfüllungen
mit doppeltem Füllkopf

Berechneter Durchschnitt aller
Abfüllsummen durch den Füll-
kopf Nr. 1 seit Zurücksetzen
der Abfüllstatistik.

Abweichung der Ge-
samtabfüllung

92 Einstufige Abfüllungen,
zweistufige Abfüllungen
und zeitgesteuerte Ab-
füllungen

Berechnete Abweichung aller
Füllsummen seit Zurücksetzen
der Abfüllstatistik.

Abfüllungen mit doppel-
tem Füllkopf und zeit-
gesteuerte Abfüllungen
mit doppeltem Füllkopf

Berechnete Abweichung aller
Abfüllsummen durch den Füll-
kopf Nr. 1 seit Zurücksetzen
der Abfüllstatistik.

Durchschnittliche se-
kundäre Gesamtab-
füllung

93 Nur Abfüllungen mit
doppeltem Füllkopf und
zeitgesteuerte Abfüllun-
gen mit doppeltem Füll-
kopf

Berechneter Durchschnitt aller
Abfüllsummen durch den Füll-
kopf Nr. 2 seit Zurücksetzen
der Abfüllstatistik.

Abweichung der se-
kundären Gesamtab-
füllung

94 Nur Abfüllungen mit
doppeltem Füllkopf und
zeitgesteuerte Abfüllun-
gen mit doppeltem Füll-
kopf

Berechnete Abweichung aller
Abfüllsummen durch den Füll-
kopf Nr. 2 seit Zurücksetzen
der Abfüllstatistik.
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Teil III
Konfigurieren und bedienen externe-
Ventilsteuer Füllungen

In diesem Teil enthaltene Kapitel:

• Konfigurieren und Einrichten einer externen Abfüll-Ventilsteuerung mittels
ProLink II

• Konfigurieren und Einrichten einer externen Abfüll-Ventilsteuerung mittels
PROFIBUS EDD

• Konfigurieren und Einrichten einer externen Abfüll-Ventilsteuerung mittels
PROFIBUS Busparametern
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12 Konfigurieren und Einrichten einer
externen Abfüll-Ventilsteuerung
mittels ProLink II
In diesem Kapitel behandelte Themen:

• Konfigurieren einer mit einem externen Ventil gesteuerten Abfüllung mit ProLink
II

• Einrichten und Ausführen einer mit einem externen Ventil gesteuerten Abfüllung

12.1 Konfigurieren einer mit einem externen Ventil
gesteuerten Abfüllung mit ProLink II
Die Konfiguration einer Abfüllung mit externer Ventilsteuerung umfasst eine
Konfiguration des Frequenzausgangs und mehrerer Durchflussparameter. Bei der
Konfiguration der Abfüllung verwendet der Host Durchflussdaten vom Frequenzausgang
der Auswerteelektronik zur Messung der Abfüllung und zum Schließen der Ventile.

Vorbereitungsverfahren

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Wählen Sie ProLink > Configuration (Konfiguration) > Frequency (Frequenz).
2. Setzen Sie die Tertiary Variable auf die Prozessvariable, die der Host zur Messung der

Abfüllung verwenden wird: Mass Flow Rate oder Volume Flow Rate.

3. Stellen Sie die folgenden Parameter gemäß Ihrer Anwendung ein: FO Scaling Method
und relevante Parameter, Frequency Output Polarity und Fault Action.

4. Öffnen Sie das Fenster Flow (Durchfluss).

5. Wenn Sie Tertiary Variable auf Mass Flow Rate setzen:

a. Stellen Sie Mass Flow Units auf die vom Host verwendeten Einheiten für den
Massedurchfluss ein.

b. Stellen Sie Mass Flow Cutoff auf die niedrigste Durchflussrate ein, die gemessen
und dem Host gemeldet wird. Alle Durchflussraten unterhalb dieses
Abschaltungswerts werden als 0 ausgegeben.

6. Wenn Sie Tertiary Variable auf Volume Flow Rate setzen:

a. Stellen Sie Volume Flow Units auf die vom Host verwendeten Einheiten für den
Volumendurchfluss ein.

b. Stellen Sie Volume Flow Cutoff auf die niedrigste Durchflussrate ein, die gemessen
und dem Host gemeldet wird. Alle Durchflussraten unterhalb dieses
Abschaltungswerts werden als 0 ausgegeben.

7. Stellen Sie Flow Damping nach Wunsch ein.
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Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

8. Setzen Sie Flow Direction auf die für Ihre Installation angemessene Option.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar in
die durch den Pfeil auf dem Sensor angegebene Richtung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder andere
Richtung fließen. Der Durchfluss entspricht überwiegend
der auf dem Sensor durch den Pfeil angegebenen Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar in
die entgegengesetzte durch den Pfeil auf dem Sensor ange-
gebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder andere
Richtung fließen. Der Durchfluss entspricht überwiegend
der entgegengesetzten durch den Pfeil auf dem Sensor an-
gegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

Nachbereitungsverfahren

Stellen Sie sicher, dass Ihr Host entsprechend konfiguriert ist. Beispielsweise müssen Sie
sicherstellen, dass Ihr Host die richtige Messeinheit verwendet und falls erforderlich den
Durchfluss in den Gesamtdurchfluss konvertieren kann.

12.2 Einrichten und Ausführen einer mit einem
externen Ventil gesteuerten Abfüllung
Der Host muss Durchflussdaten von der Auswerteelektronik empfangen, erforderliche
Berechnungen durchführen und Ventile öffnen und schließen, um die Abfüllung zu regeln.

1. Sicherstellen, dass der Host die Durchflussdaten vom Frequenzausgang der
Auswerteelektronik empfängt.

2. Sicherstellen, dass der Host die von der Auswerteelektronik empfangenen Daten
richtig interpretiert und verarbeitet.

3. Jede erforderliche Verdrahtung und Konfiguration ausführen, damit der Host die
Ventile zeitgerecht öffnen und schließen kann.

4. Das Programm zum Starten und Regeln der Abfüllung einleiten.
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13 Konfigurieren und Einrichten einer
externen Abfüll-Ventilsteuerung
mittels PROFIBUS EDD
In diesem Kapitel behandelte Themen:

• Konfigurieren einer Abfüllung mit externer Ventilsteuerung mittels PROFIBUS
EDD

• Einrichten und Ausführen einer mit einem externen Ventil gesteuerten Abfüllung

13.1 Konfigurieren einer Abfüllung mit externer
Ventilsteuerung mittels PROFIBUS EDD
Die Konfiguration einer Abfüllung mit externer Ventilsteuerung umfasst eine
Konfiguration des Frequenzausgangs und mehrerer Durchflussparameter. Bei der
Konfiguration der Abfüllung verwendet der Host Durchflussdaten vom Frequenzausgang
der Auswerteelektronik zur Messung der Abfüllung und zum Schließen der Ventile.

Vorbereitungsverfahren

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, die PROFIBUS EDD muss installiert
sein und Sie müssen eine Verbindung mit der Auswerteelektronik hergestellt haben.

Verfahren

1. Wählen Sie Online > Configure > Manual Setup > Frequency Output.
2. Setzen Sie die Tertiary Variable auf die Prozessvariable, die der Host zur Messung der

Abfüllung verwenden wird: Mass Flow Rate oder Volume Flow Rate.

3. Stellen Sie die folgenden Parameter gemäß Ihrer Anwendung ein: FO Scaling Method
und relevante Parameter, Frequency Output Polarity und Fault Action.

4. Wählen Sie Online > Configure > Manual Setup > Measurements > Flow.

5. Wenn Sie Tertiary Variable auf Mass Flow Rate setzen:

a. Stellen Sie Mass Flow Units auf die vom Host verwendeten Einheiten für den
Massedurchfluss ein.

b. Stellen Sie Mass Flow Cutoff auf die niedrigste Durchflussrate ein, die gemessen
und dem Host gemeldet wird. Alle Durchflussraten unterhalb dieses
Abschaltungswerts werden als 0 ausgegeben.

6. Wenn Sie Tertiary Variable auf Volume Flow Rate setzen:

a. Stellen Sie Volume Flow Units auf die vom Host verwendeten Einheiten für den
Volumendurchfluss ein.

b. Stellen Sie Volume Flow Cutoff auf die niedrigste Durchflussrate ein, die gemessen
und dem Host gemeldet wird. Alle Durchflussraten unterhalb dieses
Abschaltungswerts werden als 0 ausgegeben.

7. Stellen Sie Flow Damping nach Wunsch ein.
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Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

8. Setzen Sie Flow Direction auf die für Ihre Installation angemessene Option.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar in
die durch den Pfeil auf dem Sensor angegebene Richtung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder andere
Richtung fließen. Der Durchfluss entspricht überwiegend
der auf dem Sensor durch den Pfeil angegebenen Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar in
die entgegengesetzte durch den Pfeil auf dem Sensor ange-
gebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder andere
Richtung fließen. Der Durchfluss entspricht überwiegend
der entgegengesetzten durch den Pfeil auf dem Sensor an-
gegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

Nachbereitungsverfahren

Stellen Sie sicher, dass Ihr Host entsprechend konfiguriert ist. Beispielsweise müssen Sie
sicherstellen, dass Ihr Host die richtige Messeinheit verwendet und falls erforderlich den
Durchfluss in den Gesamtdurchfluss konvertieren kann.

13.2 Einrichten und Ausführen einer mit einem
externen Ventil gesteuerten Abfüllung
Der Host muss Durchflussdaten von der Auswerteelektronik empfangen, erforderliche
Berechnungen durchführen und Ventile öffnen und schließen, um die Abfüllung zu regeln.

1. Sicherstellen, dass der Host die Durchflussdaten vom Frequenzausgang der
Auswerteelektronik empfängt.

2. Sicherstellen, dass der Host die von der Auswerteelektronik empfangenen Daten
richtig interpretiert und verarbeitet.

3. Jede erforderliche Verdrahtung und Konfiguration ausführen, damit der Host die
Ventile zeitgerecht öffnen und schließen kann.

4. Das Programm zum Starten und Regeln der Abfüllung einleiten.
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14 Konfigurieren und Einrichten einer
externen Abfüll-Ventilsteuerung
mittels PROFIBUS Busparametern
In diesem Kapitel behandelte Themen:

• Konfigurieren einer Abfüllung mit externer Ventilsteuerung mittels PROFIBUS
Busparametern

• Einrichten und Ausführen einer mit einem externen Ventil gesteuerten Abfüllung

14.1 Konfigurieren einer Abfüllung mit externer
Ventilsteuerung mittels PROFIBUS
Busparametern
Die Konfiguration einer Abfüllung mit externer Ventilsteuerung umfasst eine
Konfiguration des Frequenzausgangs und mehrerer Durchflussparameter. Bei der
Konfiguration der Abfüllung verwendet der Host Durchflussdaten vom Frequenzausgang
der Auswerteelektronik zur Messung der Abfüllung und zum Schließen der Ventile.

Vorbereitungsverfahren

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, das DP-V1 Lese- und
Schreibdienste unterstützt, und Sie müssen eine Verbindung mit der Auswerteelektronik
hergestellt haben.

Verfahren

1. Setzen Sie die Tertiary Variable auf die Prozessvariable, die der Host zur Messung der
Abfüllung verwenden wird: Mass Flow Rate oder Volume Flow Rate.

2. Stellen Sie die folgenden Parameter gemäß Ihrer Anwendung ein: FO Scaling Method
und relevante Parameter, Frequency Output Polarity und Fault Action.

3. Wenn Sie Tertiary Variable auf Mass Flow Rate setzen:

a. Stellen Sie Mass Flow Units auf die vom Host verwendeten Einheiten für den
Massedurchfluss ein.

b. Stellen Sie Mass Flow Cutoff auf die niedrigste Durchflussrate ein, die gemessen
und dem Host gemeldet wird. Alle Durchflussraten unterhalb dieses
Abschaltungswerts werden als 0 ausgegeben.

4. Wenn Sie Tertiary Variable auf Volume Flow Rate setzen:

a. Stellen Sie Volume Flow Units auf die vom Host verwendeten Einheiten für den
Volumendurchfluss ein.

b. Stellen Sie Volume Flow Cutoff auf die niedrigste Durchflussrate ein, die gemessen
und dem Host gemeldet wird. Alle Durchflussraten unterhalb dieses
Abschaltungswerts werden als 0 ausgegeben.

5. Stellen Sie Flow Damping nach Wunsch ein.
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Hinweis
Der Standardwert von Flow Damping (Durchflussdämpfung) beträgt 0,04 Sekunden. Für die
meisten Befüllungsanwendungen ist dies der ideale Wert und wird normalerweise nicht
geändert.

6. Setzen Sie Flow Direction auf die für Ihre Installation angemessene Option.

Option Beschreibung

Vorwärts Die Prozessflüssigkeit fließt nur in eine Richtung und zwar in
die durch den Pfeil auf dem Sensor angegebene Richtung.

Bidirektional Die Prozessflüssigkeit kann entweder in die eine oder andere
Richtung fließen. Der Durchfluss entspricht überwiegend
der auf dem Sensor durch den Pfeil angegebenen Richtung.

Vorwärts negieren Die Prozessflüssigkeit fließt nur in eine Richtung und zwar in
die entgegengesetzte durch den Pfeil auf dem Sensor ange-
gebene Richtung.

Bidirektional negieren Die Prozessflüssigkeit kann entweder in die eine oder andere
Richtung fließen. Der Durchfluss entspricht überwiegend
der entgegengesetzten durch den Pfeil auf dem Sensor an-
gegebenen Richtung.

Einschränkung
Alle Optionen für Flow Direction (Durchflussrichtung) sind ungültig und werden von der
Auswerteelektronik nicht akzeptiert.

Beispiel: Konfigurieren einer Abfüllung mit externer Ventilsteuerung

Wichtig
In diesem Beispiel werden standardmäßige oder typische Einstellungen für die erforderlichen
Parameter verwendet. Für Ihre Anwendung sind möglicherweise andere Einstellungen erforderlich.
Weitere Informationen zu Datentypen und Integercodes finden Sie im PROFIBUS Busparametern.

Blockieren Index

Wert (de-
zimal oder
Fließkom-
ma) Beschreibung

Abfüllung 57 0 Setzt Tertiary Variable auf Mass Flow Rate

Abfüllung 58 0 Setzt FO Scaling Method auf Frequency=Flow

Abfüllung 59 333,33 Setzt Frequency Factor auf 333,33

Abfüllung 60 2000,00 Setzt Rate Factor auf 2000

Abfüllung 66 1 Setzt Frequency Output Polarity auf Active High

Abfüllung 64 1 Setzt Frequency Output Fault Action auf Downscale

Messung 5 1318 Setzt Mass Flow Units auf g/sec

Messung 18 3,00 Setzt Mass Flow Cutoff auf 3 g/sec

Messung 11 1347 Setzt Volume Flow Units auf m3/sec

Messung 19 0,03 Setzt Volume Flow Cutoff) auf 0,03 m3/sec
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Blockieren Index

Wert (de-
zimal oder
Fließkom-
ma) Beschreibung

Messung 21 0 Setzt Flow Direction auf Forward

Nachbereitungsverfahren

Stellen Sie sicher, dass Ihr Host entsprechend konfiguriert ist. Beispielsweise müssen Sie
sicherstellen, dass Ihr Host die richtige Messeinheit verwendet und falls erforderlich den
Durchfluss in den Gesamtdurchfluss konvertieren kann.

14.2 Einrichten und Ausführen einer mit einem
externen Ventil gesteuerten Abfüllung
Der Host muss Durchflussdaten von der Auswerteelektronik empfangen, erforderliche
Berechnungen durchführen und Ventile öffnen und schließen, um die Abfüllung zu regeln.

1. Sicherstellen, dass der Host die Durchflussdaten vom Frequenzausgang der
Auswerteelektronik empfängt.

2. Sicherstellen, dass der Host die von der Auswerteelektronik empfangenen Daten
richtig interpretiert und verarbeitet.

3. Jede erforderliche Verdrahtung und Konfiguration ausführen, damit der Host die
Ventile zeitgerecht öffnen und schließen kann.

4. Das Programm zum Starten und Regeln der Abfüllung einleiten.
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Teil IV
Allgemeine Konfiguration der
Auswerteelektronik

In diesem Teil enthaltene Kapitel:

• Prozessmessung konfigurieren

• Geräteoptionen und Präferenzen konfigurieren

• Integrieren des Messgerätes mit dem Netzwerk
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15 Prozessmessung konfigurieren
In diesem Kapitel behandelte Themen:

• Charakterisieren des Durchfluss-Messsystems (falls erforderlich)

• Massedurchflussmessung konfigurieren

• Konfigurieren von Volumendurchflussmessungen für Flüssigkeitsanwendungen

• Konfigurieren von Durchflussrichtung
• Konfigurieren der Dichtemessung

• Konfigurieren einer Temperaturmessung

• Druckkompensation konfigurieren

15.1 Charakterisieren des Durchfluss-Messsystems
(falls erforderlich)

ProLink II ProLink > Configuration > Device > Sensor Type

ProLink > Configuration > Flow > Flow Cal

ProLink > Configuration > Density > D1

ProLink > Configuration > Density > D2

ProLink > Configuration > Density > Temp Coeff (DT)

ProLink > Configuration > Density > K1

ProLink > Configuration > Density > K2

ProLink > Configuration > Density > FD

ProLink III Device Tools > Calibration Data

PROFIBUS EDD Configure > Manual Setup > Characterize > Type

Configure > Manual Setup > Characterize > Flow FCF

Configure > Manual Setup > Characterize > D1

Configure > Manual Setup > Characterize > D2

Configure > Manual Setup > Characterize > DT

Configure > Manual Setup > Characterize > K1

Configure > Manual Setup > Characterize > K2

Configure > Manual Setup > Characterize > FD

PROFIBUS Buspara-

meter

Sensor Type: Block: Device Information, Index 7

Flow Calibration Factor (FCF): Block: Calibration, Index 4

Temperature coefficient for flow (FT) : Block: Calibration, Index 5

D1: Block: Calibration, Index 21

D2: Block: Calibration, Index 22

Density temperature coefficient (DT): Block: Calibration, Index 26

K1: Block: Calibration, Index 16

K2: Block: Calibration, Index 17

FD: Block: Calibration, Index 18
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Überblick

Die Charakterisierung des Durchfluss-Messsystems passt die Auswerteelektronik an die
spezifischen Eigenschaften des angeschlossenen Sensors an. Die
Charakterisierungsparameter (auch Kalibrierparameter genannt) stellen die
Sensorempfindlichkeit bezüglich Durchfluss, Dichte und Temperatur dar. Abhängig vom
Sensortyp sind unterschiedliche Parameter erforderlich. Die für den Sensor zutreffenden
Werte von Micro Motion sind auf dem Typenschild des Sensors oder dem Kalibrierzertifikat
abzulesen.

Hinweis
Wenn das Durchfluss-Messsystem als eine Einheit bestellt wurde, wurde die Charakterisierung
bereits ab Werk vorgenommen. Die Charakterisierungsparameter sollten trotzdem überprüft
werden.

Verfahren

1. Sensor Type spezifizieren.

• Curved-tube (alle Sensoren außer T-Serie)

2. Die Durchfluss Charakterisierungsparameter einstellen. Darauf achten, dass alle
Kommastellen berücksichtigt werden.

• Bei Sensoren mit gebogenem Rohr Flow Cal (Flow Calibration Factor) einstellen.

3. Die Dichte Charakterisierungsparameter einstellen.

• Bei Sensoren mit gebogenem Rohr D1, D2, TC, K1, K2 und FD einstellen. (TC wird
manchmal als DT angezeigt.)

15.1.1 Beispiel Sensor Typenschilder

Typenschild an neueren Sensoren mit gebogenem Messrohr (alle
Sensoren außer T-Serie)

Abbildung 15-1:   
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15.1.2 Durchflusskalibrierparameter (FCF, FT)
Zur Beschreibung der Durchflusskalibrierung werden zwei separate Werte verwendet: ein
6 Zeichen langer FCF-Wert und ein 4 Zeichen langer FT-Wert. Diese stehen auf dem
Sensor-Typenschild.

Beide Werte beinhalten Dezimalpunkte. Bei der Charakterisierung können diese als zwei
Werte oder als eine Zahl, bestehend aus 10 Zeichen eingegeben werden. Der 10 Zeichen
lange String wird entweder Flowcal oder FCF genannt.

Wenn die FCF- und FT-Werte separat auf Ihrem Sensor-Typenschild angezeigt werden und
sie einen einzelnen Wert eingeben müssen, verknüpfen Sie die beiden Werte, um den
einzelnen Parameterwert zu bilden.

Wenn Ihr Sensor-Typenschild einen verknüpften Flowcal- oder FCF-Wert anzeigt und Sie die
FCF- und FT-Werte separat eingeben müssen, trennen Sie den verknüpften Wert:

• FCF = Die ersten 6 Zeichen, einschließlich des Dezimalpunkts

• FT = Die letzten 4 Zeichen, einschließlich des Dezimalpunkts

Beispiel: Verknüpfen von FCF und FT
FCF = x.xxxx
FT = y.yy
Flow calibration parameter: x.xxxxy.yy

Beispiel: Teilen des verknüpften Flowcal- oder FCF-Werts

Flow calibration parameter: x.xxxxy.yy
FCF = x.xxxx
FT = y.yy

15.1.3 Dichtekalibrierparameter (D1, D2, K1, K2, FD, DT, TC)
Dichtekalibrierparameter sind normalerweise auf dem Sensortypenschild und dem
Kalibrierzertifikat zu finden.

Wenn das Typenschild Ihres Sensors keinen D1 oder D2 Wert aufweist:

• Für D1 geben Sie den Dens A oder den D1 Wert vom Kalibrierzertifikat ein. Dieser
Wert ist die Betriebsdichte des Kalibriermediums mit der niedrigen Dichte.
Micro Motion verwendet Luft. Wenn Sie keinen Wert Dens A oder D1 finden, geben
Sie 0,001 g/cm3 ein.

• Für D2 geben Sie den Wert Dens B oder D2 vom Kalibrierzertifikat ein. Dieser Wert ist
die Betriebsdichte des Kalibriermediums mit der höheren Dichte. Micro Motion
verwendet Wasser. Wenn Sie keinen Wert Dens B oder D2 finden, geben Sie
0,998 g/cm3 ein.

Wenn das Typenschild Ihres Sensors keinen Wert K1 oder K2 aufweist:

• Für K1 geben Sie die ersten 5 Ziffern des Dichtekalibrierfaktors ein. Im Beispiel-
Typenschild ist dieser Wert 12500.

• Für K2 geben Sie die zweiten 5 Ziffern des Dichtekalibrierfaktors ein. Im Beispiel-
Typenschild ist dieser Wert 14286.

Wenn das Typenschild Ihres Sensors keinen Wert FD aufweist, nehmen Sie mit dem
Micro Motion Kontakt auf.
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Wenn das Typenschild Ihres Sensors keinen Wert DT oder TC aufweist, geben Sie die
letzten 3 Ziffern des Dichtekalibrierfaktors ein. Im Beispiel-Typenschild ist dieser Wert
4,44.

15.2 Massedurchflussmessung konfigurieren
Die Parameter der Massedurchflussmessung steuern, wie Massedurchfluss gemessen und
ausgegeben wird.

Die Parameter der Massedurchflussmessung umfassen:

• Massedurchfluss Messeinheit
• Durchflussdämpfung
• Massedurchfluss Abschaltung

15.2.1 Massedurchfluss Messeinheit konfigurieren

ProLink II ProLink > Configuration > Flow > Mass Flow Units

ProLink III Device Tools > Configuration > Process Measurement > Flow

PROFIBUS EDD Configure > Manual Setup > Measurements > Flow > Mass Flow Unit

PROFIBUS Buspara-

meter

Block: Measurement, Index 5

Überblick

Massedurchfluss Messeinheit spezifiziert die Messeinheit, die für den Massedurchfluss
verwendet wird. Die für die Masse Summen- und Gesamtzähler verwendet Messeinheit
wird von dieser Einheit abgeleitet.

Verfahren

Setzen Sie Massedurchfluss Messeinheit auf die Einheit, die Sie verwenden möchten.

Die Voreinstellung für Massedurchfluss Messeinheit ist g/s (Gramm pro Sekunde).

Optionen für Massedurchfluss Messeinheit
Die Auswerteelektronik stellt einen Standardsatz sowie eine anwenderdefinierbare
Messeinheit für die Massedurchfluss Messeinheit zur Verfügung. Verschiedene
Kommunikations-Hilfsmittel verwenden u. U. unterschiedliche Kennzeichnungen für die
Geräte.

Optionen für Massedurchfluss MesseinheitTabelle 15-1:   

Beschreibung der Einheit

Bezeichnung

ProLink II ProLink III

Gramm pro Sekunde g/s g/sec

Gramm pro Minute g/min g/min

Gramm pro Stunde g/h g/hr
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Optionen für Massedurchfluss Messeinheit (Fortsetzung)Tabelle 15-1:   

Beschreibung der Einheit

Bezeichnung

ProLink II ProLink III

Kilogramm pro Sekunde kg/s kg/sec

Kilogramm pro Minute kg/min kg/min

Kilogramm pro Stunde kg/h kg/hr

Kilogramm pro Tag kg/Tag kg/day

Metrische Tonnen pro Minute T/min mTon/min

Metrische Tonnen pro Stunde T/h mTon/hr

Metrische Tonnen pro Tag mT/Tag mTon/day

Pfund pro Sekunde lbs/s lbs/sec

Pfund pro Minute lbs/min lbs/min

Pfund pro Stunde lbs/h lbs/hr

Pfund pro Tag lbs/Tag lbs/day

Short tons (2000 Pfund) pro Minute sTon/min sTon/min

Short tons (2000 Pfund) pro Stunde sTon/h sTon/hr

Short tons (2000 Pfund) pro Tag sTon/Tag sTon/day

Long tons (2240 Pfund) pro Stunde lTon/h lTon/hr

Long tons (2240 Pfund) pro Tag lTon/Tag lTon/day

15.2.2 Konfigurieren der Durchflussdämpfung

ProLink II ProLink > Configuration > Flow > Flow Damp

ProLink III Device Tools > Configuration > Process Measurement > Flow

PROFIBUS EDD Configure > Manual Setup > Measurements > Flow > Flow Damping

PROFIBUS Buspara-

meter

Block: Measurement, Index 12

Überblick

Die Dämpfung wird verwendet, um kleine, plötzlich auftretende Schwankungen des
Prozessmesswerts zu glätten. Damping Value gibt die Zeitdauer (in Sekunden) an, über die
die Auswerteelektronik die Änderungen in der ausgegebenen Prozessvariable verteilt. Am
Ende des Intervalls spiegelt die ausgegebene Prozessvariable 63 % der Änderung des
eigentlichen gemessenen Wertes wider.

Verfahren

Flow Damping auf den gewünschten Wert einstellen.

Der Standardwert ist 0,04 Sekunden. Der Bereich liegt bei 0 bis 40,96 Sekunden.
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Hinweise

• Ein hoher Dämpfungswert lässt die Prozessvariable regelmäßiger erscheinen, da der
ausgegebene Wert sich langsamer ändert.

• Ein niedriger Dämpfungswert lässt die Prozessvariable unregelmäßiger erscheinen, da der
ausgegebene Wert sich schneller ändert.

• Die Kombination eines hohen Dämpfungswertes und plötzlich auftretenden, großen
Änderungen in der Durchflussrate kann zu erhöhten Messfehlern führen.

• Immer, wenn der Dämpfungswert nicht Null ist, wird der ausgegebene Messwert hinter der
eigentlichen Messung liegen, da der ausgegebene Wert über die Zeit gemittelt wird.

• Allgemein werden niedrigere Dämpfungswerte vorgezogen, da das Risiko von Datenverlusten
und die Verzögerung zwischen dem eigentlichem und dem ausgegebenen Wert geringer ist.

• Micro Motion empfiehlt, den Standardwert von 0,04 Sekunden zu verwenden.

Der eingegebene Wert wird automatisch auf den nächst gültigen Wert abgerundet. Die
gültigen Werte für Flow Damping sind: 0, 0,04, 0,08, 0,16, ... 40,96.

Auswirkung der Durchflussdämpfung auf die Volumenmessung
Die Durchflussdämpfung wirkt sich auf die Volumenmessung für die
Flüssigkeitsvolumendaten aus. Die Die Auswerteelektronik berechnet die Volumendaten
anhand der gedämpften Massedurchflussdaten.

Wechselwirkung zwischen Durchflussdämpfung und Zusätzlicher
Dämpfung
In einigen Fällen werden sowohl die Durchflussdämpfung als auch die Zusätzliche Dämpfung auf
den ausgegebenen Massedurchfluss angewandt.

Die Durchflussdämpfung regelt die Änderungsrate der Durchfluss-Prozessvariablen. Die
Zusätzliche Dämpfung regelt die Änderungsrate, die über den mA-Ausgang ausgegeben wird.
Wenn die mA-Ausgangs-Prozessvariable auf Massedurchfluss gesetzt ist und sowohl die
Durchflussdämpfung als auch die Zusätzliche Dämpfung auf einen Wert ungleich Null gesetzt
sind, wird zuerst die Durchflussdämpfung angewandt, und die Berechnung der
zusätzlichen Dämpfung wird auf das Ergebnis der ersten Rechnung angewandt

15.2.3 Massedurchfluss Abschaltung für Abfüllanwendungen
konfigurieren

ProLink II ProLink > Configuration > Flow > Mass Flow Cutoff

ProLink III Device Tools > Configuration > Process Measurement > Flow

PROFIBUS EDD Configure > Manual Setup > Measurements > Flow > Mass Flow Cutoff

PROFIBUS Buspara-

meter

Block: Measurement, Index 18
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Überblick

Wenn Sie für eine Abfüllanwendung mit integrierter Ventilregelung die Durchflussquelle auf
Massedurchfluss gesetzt haben, müssen Sie Massedurchfluss Abschaltung auf einen Wert setzen,
der den Einfluss von Vibrationen und anderen Umgebungsbedingungen ausblendet. Dies
ist erforderlich, da die Auswerteelektronik die Abfüllverarbeitung erst dann abschließt,
wenn ein Null Durchfluss erkannt wird.

Wenn die Durchflussquelle auf Volumendurchfluss gesetzt ist, hat die Massedurchfluss Abschaltung
keinen Einfluss auf die Abfüllung.

Vorbereitungsverfahren

Stellen Sie sicher, dass der Nullpunktwert der Auswerteelektronik korrekt ist.

Verfahren

1. Setzen Sie die Massedurchfluss Abschaltung auf 0.

2. Stoppen Sie den Durchfluss durch den Sensor.

3. Schalten Sie die Abfüllanlage und andere Vibrationsquellen ein.

4. Beobachten Sie den ausgegebenen Massedurchfluss.

5. Setzen Sie Massedurchfluss Abschaltung auf einen Wert, der etwas über dem
ausgegebenen Massedurchfluss liegt.

6. Prüfen Sie, dass der Massedurchfluss als 0 ausgegeben wird.

Nachbereitungsverfahren

Wichtig
An Massedurchfluss Abschaltung vorgenommene Änderungen beeinflussen die automatische
Überfüllkompensation (AOC). Wenn Sie die Standard AOC implementiert haben, müssen Sie die AOC
Kalibrierung bei jeder Änderung des Wertes für Massedurchfluss Abschaltung wiederholen. Diese
Anforderung gilt nicht für rollende AOC oder feste AOC.

15.2.4 Massedurchfluss Abschaltung konfigurieren

ProLink II ProLink > Configuration > Flow > Mass Flow Cutoff

ProLink III Device Tools > Configuration > Process Measurement > Flow

PROFIBUS EDD Configure > Manual Setup > Measurements > Flow > Mass Flow Cutoff

PROFIBUS Buspara-

meter

Block: Measurement, Index 18

Überblick

Massedurchfluss Abschaltung spezifiziert den niedrigsten Massedurchfluss, der als Messwert
ausgegeben wird. Jeder Massedurchfluss unterhalb dieses Abschaltungswerts wird als 0
ausgegeben.

Anmerkung
Wenn Sie Massedurchfluss Abschaltung für eine Abfüllanwendung mit integrierter Ventilregelung
konfigurieren und Durchflussquelle auf Massedurchfluss gesetzt ist, siehe Abschnitt 15.2.3.
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Verfahren

Setzen Sie Massedurchfluss Abschaltung auf den gewünscthen Wert.

Der voreingestellte Wert für Massedurchfluss Abschaltung ist 0,0 g/s oder ein werkseitig
eingestellter, sensorspezifischer Wert. Die empfohlene Einstellung ist 0,05 % des
maximalen Nenndurchflusses des Sensors bzw. ein Wert unter dem höchsten erwarteten
Durchfluss. Setzen Sie Massedurchfluss Abschaltung nicht auf 0,0 g/s.

Auswirkung der Massedurchflussabschaltung auf die
Volumenmessung
Die Massedurchflussabschaltung wirkt sich nicht auf die Volumenmessung aus. Die
Volumendaten werden anhand der tatsächlichen Massendaten errechnet anstelle des
ausgegebenen Werts.

Wechselwirkung zwischen Massedurchflussabschaltung und AO-
Abschaltung
Massedurchflussabschaltung spezifiziert den niedrigsten Massedurchfluss, den die
Auswerteelektronik als Messwert ausgibt. Die AO-Abschaltung definiert die niedrigste
Durchflussrate, die über den mA-Ausgang ausgegeben wird. Wenn die Prozessvariable mA-
Ausgang auf Massedurchfluss eingestellt ist, wird der vom mA-Ausgang ausgegebene
Massedurchfluss vom höheren der beiden Abschaltwerte geregelt.

Massedurchflussabschaltung wirkt sich auf alle ausgegebenen Werte aus, die in anderen
Auswerteelektronik-Verhalten verwendet werden (z. B. Ereignisse, die für den
Massedurchfluss definiert wurden).

Die AO-Abschaltung wirkt sich nur auf die Massedurchflüsse aus, die über den mA-Ausgang
ausgegeben wurden.

Beispiel: Abschaltwechselwirkung bei AO-Abschaltung kleiner als
Massedurchflussabschaltung

Konfiguration:

• mA-Ausgang-Prozessvariable: Massedurchfluss
• Frequenzausgang-Prozessvariable: Massedurchfluss
• AO-Abschaltung: 10 g/s

• Massedurchflussabschaltung: 15 g/s

Ergebnis: Wenn der Massedurchfluss unter 15 g/s abfällt, wird der Massedurchfluss als 0
ausgegeben und für alle internen Verarbeitungsverfahren verwendet.

Beispiel: Abschaltwechselwirkung bei AO-Abschaltung größer als
Massedurchflussabschaltung

Konfiguration:

• mA-Ausgang-Prozessvariable: Massedurchfluss
• Frequenzausgang-Prozessvariable: Massedurchfluss
• AO-Abschaltung: 15 g/s

• Massedurchflussabschaltung: 10 g/s
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Ergebnis:

• Fällt der Massedurchfluss unter 15 g/s aber nicht unter 10 g/s:

- Gibt der mA-Ausgang Nulldurchfluss aus.

- Der Frequenzausgang gibt den Istdurchfluss aus, und der Istdurchfluss wird für
alle internen Verarbeitungsverfahren verwendet.

• Wenn der Massedurchfluss unter 10 g/s abfällt, geben beide Ausgänge
Nulldurchfluss aus, und für alle internen Verarbeitungsverfahren wird 0 verwendet.

15.3 Konfigurieren von
Volumendurchflussmessungen für
Flüssigkeitsanwendungen
Die Parameter für Volumendurchflussmessungen steuern, wie der
Flüssigkeitsvolumenstrom gemessen und gemeldet wird.

15.3.1 Konfigurieren von Volumendurchfluss-Messeinheit für
Flüssigkeitsanwendungen

ProLink II ProLink > Configuration > Flow > Vol Flow Units

ProLink III Device Tools > Configuration > Process Measurement > Flow

PROFIBUS EDD Configure > Manual Setup > Measurements > Flow > Volume Flow Unit

PROFIBUS Buspara-

meter

Block: Measurement, Index 11

Überblick

Volume Flow Measurement Unit gibt die Messeinheit an, die für die Anzeige des
Volumendurchflusses verwendet wird. Die Einheit, die für den Volumen Summen- und
Gesamtzähler verwendet wird, basiert auf dieser Einheit.

Vorbereitungsverfahren

Stellen Sie vor dem Konfigurieren von Volume Flow Measurement Unit sicherstellen, dass
Volume Flow Type auf Liquid gesetzt ist.

Verfahren

Setzen Sie Volume Flow Measurement Unit auf die gewünschte Einheit.

Die Voreinstellung für Volume Flow Measurement Unit ist l/s (Liter pro Sekunde).
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Optionen für Volume Flow Measurement Unit für
Flüssigkeitsanwendungen
Die Auswerteelektronik bietet ein Standardsatz an Messeinheiten für Volume Flow
Measurement Unit und eine zusätzliche benutzerdefinierbare Messeinheit. Unterschiedliche
Kommunikations-Hilfsmittel verwenden möglicherweise unterschiedliche
Kennzeichnungen für die Einheiten.

Optionen für Volume Flow Measurement UnitTabelle 15-2:   

Beschreibung der Einheit

Kennzeichnung

ProLink II ProLink III

Kubikfuss pro Sekunde ft3/sec ft3/sec

Kubikfuss pro Minute ft3/min ft3/min

Kubikfuss pro Stunde ft3/hr ft3/hr

Kubikfuss pro Tag ft3/day ft3/day

Kubikmeter pro Sekunde m3/sec m3/sec

Kubikmeter pro Minute m3/min m3/min

Kubikmeter pro Stunde m3/hr m3/hr

Kubikmeter pro Tag m3/day m3/day

U.S. Gallonen pro Sekunde US gal/sec US gal/sec

U.S. Gallonen pro Minute US gal/min US gal/min

U.S. Gallonen pro Stunde US gal/hr US gal/hr

U.S. Gallonen pro Tag US gal/Tag US gal/day

Millionen U.S. Gallonen pro Tag mil US gal/day mil US gal/day

Liter pro Sekunde l/sec l/sec

Liter pro Minute l/min l/min

Liter pro Stunde l/hr l/hr

Millionen Liter pro Tag mil l/Tag mil l/day

Imperial Gallonen pro Sekunde Imp gal/s Imp gal/sec

Imperial Gallonen pro Minute Imp gal/min Imp gal/min

Imperial Gallonen pro Stunde Imp gal/h Imp gal/hr

Imperial Gallonen pro Tag Imp gal/Tag Imp gal/day

Barrel pro Sekunde(1) Barrel/s barrels/sec

Barrel pro Minute(1) Barrel/min barrels/min

Barrel pro Stunde(1) Barrel/h barrels/hr

Barrel pro Tag(1) Barrel/Tag barrels/day

Bier Barrel pro Sekunde(2) Bier Barrel/s Beer barrels/sec

Bier Barrel pro Minute(2) Bier Barrel/min Beer barrels/min

Bier Barrel pro Stunde(2) Bier Barrel/h Beer barrels/hr

Bier Barrel pro Tag(2) Bier Barrel/Tag Beer barrels/day

(1) Einheiten basieren auf Öl Barrels (42 U.S Gallonen).

(2) Einheiten basieren auf Bier Barrels (31 U.S Gallonen).
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15.3.2 Konfigurieren der Volumendurchflussabschaltung in
Befüllanwendungen

ProLink II ProLink > Configuration > Flow > Vol Flow Cutoff

ProLink III Device Tools > Configuration > Process Measurement > Flow

PROFIBUS EDD Configure > Manual Setup > Measurements > Flow > Volume Flow Cutoff

PROFIBUS Buspara-

meter

Block: Measurement, Index 19

Überblick

Bei der Durchführung einer Befüllung mit integrierter Ventilsteuerung und eine auf Volume
Flow Rate eingestellte Flow Source muss Volume Flow Cutoff auf einen Wert gesetzt werden,
der den Einfluss von Vibrationen und anderen Umgebungsbedingungen ausblendet. Dies
ist erforderlich, da die Auswerteelektronik die Befüllung erst dann abschließt, wenn ein
Null Durchfluss erkannt wird.

Wenn Flow Source auf Mass Flow Rate eingestellt ist, hat Volume Flow Cutoff keinen Einfluss auf
die Befüllung.

Vorbereitungsverfahren

Stellen Sie sicher, dass der Nullpunktwert der Auswerteelektronik korrekt ist.

Verfahren

1. Volume Flow Cutoff (Volumendurchflussabschaltung) auf 0 einstellen.

2. Stoppen Sie den Durchfluss durch den Sensor.

3. Schalten Sie die Befüllanlage und andere Vibrationsquellen ein.

4. Beobachten Sie den ausgegebenen Volumendurchfluss.

5. Setzen Sie Volume Flow Cutoff auf einen Wert, der etwas über dem ausgegebenen
Volumendurchfluss liegt.

6. Prüfen Sie, ob der Volumendurchfluss als 0 ausgegeben wird.

Nachbereitungsverfahren

Wichtig
An Volume Flow Cutoff vorgenommene Änderungen beeinflussen die automatische
Überfüllkompensation (AOC). Wenn Sie die Standard AOC implementiert haben, müssen Sie die AOC
Kalibrierung bei jeder Änderung des Wertes für Volume Flow Cutoff wiederholen. Diese Anforderung
gilt nicht für rollende AOC oder feste AOC.
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15.3.3 Konfigurieren der Volumendurchflussabschaltung

ProLink II ProLink > Configuration > Flow > Vol Flow Cutoff

ProLink III Device Tools > Configuration > Process Measurement > Flow

PROFIBUS EDD Configure > Manual Setup > Measurements > Flow > Volume Flow Cutoff

PROFIBUS Buspara-

meter

Block: Measurement, Index 19

Überblick

Volume Flow Cutoff gibt den niedrigsten Volumendurchfluss an, der als gemessen gemeldet
wird. Jeder Volumendurchfluss unter diesem Grenzwert wird als 0 gemeldet.

Anmerkung
Wenn Volume Flow Cutoff für eine Befüllanwendung mit integrierter Ventilsteuerung konfiguriert wird
und Flow Source auf Volume Flow Rate gesetzt ist, siehe Abschnitt 15.3.2.

Verfahren

Setzen Sie Volume Flow Cutoff auf den gewünschten Wert.

Der Standardwert für Volume Flow Cutoff beträgt 0,0 l/s (Liter pro Sekunde). Der untere
Grenzwert ist 0. Der obere Grenzwert ist der Durchflusskalibrierfaktor des Sensors in
Einheiten von l/sec, multipliziert mit 0.2.

Wechselwirkung zwischen Volumendurchflussabschaltung und AO-
Abschaltung
Volumendurchflussabschaltung spezifiziert den niedrigsten Flüssigkeitsvolumendurchfluss, den
die Auswerteelektronik als Messwert ausgibt. Die AO-Abschaltung definiert die niedrigste
Durchflussrate, die über den mA-Ausgang ausgegeben wird. Wenn die Prozessvariable mA-
Ausgang auf Volumendurchfluss eingestellt ist, wird der vom mA-Ausgang ausgegebene
Volumendurchfluss vom höheren der beiden Abschaltwerte geregelt.

Die Volumendurchflussabschaltung wirkt sich auf die über die Ausgänge ausgegebenen
Vlumendurchflusswerte und die in anderen Auswerteelektronik-Verhalten (z. B. Ereignisse,
die für den Vvolumendurchfluss definiert wurden) verwendeten Volumendurchflusswerte
aus.

Die AO-Abschaltung wirkt sich nur auf die Durchflüsse aus, die über den mA-Ausgang
ausgegeben wurden.

Beispiel: Abschaltwechselwirkung bei AO-Abschaltung kleiner als
Volumendurchflussabschaltung

Konfiguration:

• mA-Ausgang-Prozessvariable: Volumendurchfluss
• Frequenzausgang-Prozessvariable: Volumendurchfluss
• AO-Abschaltung: 10 l/s

• Volumendurchflussabschaltung: 15 l/s
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Ergebnis: Wenn der Volumendurchfluss unter 15 SLPM abfällt, wird der
Volumendurchfluss als 0 ausgegeben und für alle internen Verarbeitungsverfahren
verwendet.

Beispiel: Abschaltwechselwirkung bei AO-Abschaltung größer als
Volumendurchflussabschaltung

Konfiguration:

• mA-Ausgang-Prozessvariable: Volumendurchfluss
• Frequenzausgang-Prozessvariable: Volumendurchfluss
• AO-Abschaltung: 15 l/s

• Volumendurchflussabschaltung: 10 l/s

Ergebnis:

• Fällt der Volumendurchfluss unter 15 l/s aber nicht unter 10 l/s:

- Gibt der mA-Ausgang Nulldurchfluss aus.

- Der Frequenzausgang gibt den Istdurchfluss aus, und der Istdurchfluss wird für
alle internen Verarbeitungsverfahren verwendet.

• Wenn der Volumendurchfluss unter 10 l/s abfällt, geben beide Ausgänge
Nulldurchfluss aus, und für alle internen Verarbeitungsverfahren wird 0 verwendet.

15.4 Konfigurieren von Durchflussrichtung
ProLink II ProLink > Configuration > Flow > Flow Direction

ProLink III Device Tools > Configuration > Process Measurement > Flow

PROFIBUS EDD Configure > Manual Setup > Measurements > Flow > Flow Direction

PROFIBUS Buspara-

meter

Block: Measurement, Index 21

Überblick

Mittels Flow Direction steuert, wie sich Vorwärts- und Rückwärtsströmung auf
Durchflussmessungen und deren Anzeige auswirken.

Flow Direction wird entsprechend dem Durchfluss-Richtungspfeil auf dem Sensor definiert:

• Eine Vorwärtsströmung (positiver Durchfluss) bewegt sich in Richtung des
Durchflusspfeils auf dem Sensor.

• Eine Rückwärtsströmung (negativer Durchfluss) bewegt sich entgegengesetzt zu
dem auf dem Sensor angegebenen Durchflusspfeil.

Hinweis
Micro Motion Die Sensoren sind bidirektional. Die Messgenauigkeit wird nicht durch die eigentliche
Durchflussrichtung oder durch die Einstellung des Parameters Durchflussrichtung beeinflusst.

Verfahren

Flow Direction auf den gewünschten Wert einstellen.
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15.4.1 Optionen der Durchflussrichtung

Optionen der Durchflussrichtung Tabelle 15-3:   

Einstellung der Durchflussrichtung Beziehung zum Durchflussrichtungspfeil auf
dem Sensor

ProLink II ProLink III

Vorwärts Vorwärts Korrekt, wenn der Durchflussrichtungspfeil in die-
selbe Richtung wie der Großteil des Durchflusses
weist.

Bidirektional Bidirektional Korrekt, wenn beide Strömungen (vorwärts, rück-
wärts) zu erwarten sind, der Vorwärtsfluss domi-
niert und der Rückwärtsfluss jedoch beachtlich ist.

Vorwärts negieren Vorwärts negieren Korrekt, wenn der Durchflussrichtungspfeil in die
entgegengesetzte Richtung wie der Großteil des
Durchflusses weist.

Bidirektional negieren Bidirektional negieren Korrekt, wenn beide Strömungen (vorwärts, rück-
wärts) zu erwarten sind, der Rückwärtsfluss domi-
niert und der Vorwärtsfluss jedoch beachtlich ist.

Auswirkungen der Durchflussrichtung auf die mA-Ausgänge
Die Durchflussrichtung beeinflusst die Art, in der die Auswerteelektronik Durchflusswerte
über die mA-Ausgänge ausgibt. Die mA-Ausgänge werden nur dann von der
Durchflussrichtung beeinflusst, wenn die Prozessvariable mA-Ausgang auf eine
Durchflussvariable eingestellt ist.

Beispiel:  Durchflussrichtung = Vorwärts und Messanfang = 0

Konfiguration:

• Durchflussrichtung = Vorwärts
• Messanfang = 0 g/s

• Messende = 100 g/s

Ergebnis:

• Bei Rückwärts- oder Nulldurchfluss hat der mA-Ausgang 4 mA.

• Bei Vorwärtsdurchfluss bis zu einem Durchfluss von 100 g/s liegt der mA-Ausgang
zwischen 4 mA und 20 mA, proportional zum Durchfluss.

• Bei Vorwärtsdurchfluss, wenn der Durchfluss gleich oder höher als 100 g/s ist, ist der
mA-Ausgang bis 20,5 mA proportional zum Durchfluss und wird bei höherem
Durchfluss auf 20,5 mA begrenzt.

Beispiel:  Durchflussrichtung = Vorwärts und Messanfang < 0

Konfiguration:

• Durchflussrichtung = Vorwärts
• Messanfang = -100 g/s

• Messende = +100 g/s

Ergebnis:
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• Bei Nulldurchfluss hat der mA Ausgang 12 mA.

• Bei Vorwärtsdurchfluss bis zu einem Durchfluss zwischen 0 und +100 g/s liegt der
mA-Ausgang zwischen 12 mA und 20 mA, proportional zum Durchfluss (absoluter
Wert).

• Bei Vorwärtsdurchfluss, wenn der Durchfluss (absoluter Wert) gleich oder höher als
100 g/s ist, ist der mA-Ausgang bis 20,5 mA proportional zum Durchfluss und wird
bei höherem Durchfluss auf 20,5 mA begrenzt.

• Bei Rückwärtsdurchfluss bis zu einem Durchfluss zwischen 0 und -100 g/s liegt der
mA-Ausgang zwischen 4 mA und 12 mA umgekehrt proportional zum absoluten
Wert des Durchflusses.

• Bei Rückwärtsdurchfluss, wenn der absolute Wert des Durchflusses gleich oder
höher als 100 g/s ist, ist der mA-Ausgang bis 3,8 mA umgekehrt proportional und
wird bei höheren Absolutwerten auf 3,8 mA begrenzt.

Auswirkungen der Durchflussrichtung auf die Frequenzausgänge
Die Durchflussrichtung beeinflusst die Art, in der die Auswerteelektronik Durchflusswerte
über die Frequenzausgänge ausgibt. Frequenzausgänge werden nur dann von der
Durchflussrichtung beeinflusst, wenn die Prozessvariable Frequenzausgang auf eine
Durchflussvariable eingestellt ist.

Auswirkung des Parameters Durchflussrichtung und der tatsächlichen
Durchflussrichtung auf die Frequenzausgänge

Tabelle 15-4:   

Einstellung der Durch-
flussrichtung

Tatsächliche Durchflussrichtung

Vorwärts Nulldurchfluss Rückwärts

Vorwärts Hz > 0 0 Hz 0 Hz

Bidirektional Hz > 0 0 Hz Hz > 0

Vorwärts negieren 0 Hz 0 Hz Hz > 0

Bidirektional negieren Hz > 0 0 Hz Hz > 0

Auswirkungen der Durchflussrichtung auf die Binärausgänge
Die Durchflussrichtung wirkt sich nur dann auf das Verhalten der Binärausgänge aus, wenn die
Binärausgangsquelle auf Durchflussrichtung eingestellt ist.

Auswirkung des Parameters Durchflussrichtung und der tatsächlichen
Durchflussrichtung auf die Binärausgänge

Tabelle 15-5:   

Einstellung der Durchflussrich-
tung

Tatsächliche Durchflussrichtung

Vorwärts Nulldurchfluss Rückwärts

Vorwärts OFF OFF ON

Rückwärts OFF OFF ON

Bidirektional OFF OFF ON

Absolutwert OFF OFF OFF

Vorwärts negieren ON OFF OFF

Bidirektional negieren ON OFF OFF
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Auswirkungen der Durchflussrichtung auf die digitale
Kommunikation
Die Durchflussrichtung wirkt sich auf die Ausgabe von Durchflusswerten über die digitale
Kommunikation aus.

Auswirkung des Parameters Durchflussrichtung und der tatsächlichen
Durchflussrichtung auf die über die digitale Kommunikation
ausgegebenen Durchflusswerte

Tabelle 15-6:   

Einstellung der Durch-
flussrichtung

Tatsächliche Durchflussrichtung

Vorwärts Nulldurchfluss Rückwärts

Vorwärts Positiv 0 Negativ

Bidirektional Positiv 0 Negativ

Vorwärts negieren Negativ 0 Positiv

Bidirektional negieren Negativ 0 Positiv

Auswirkung der Durchflussrichtung auf Durchflusswerte
Die Durchflussrichtung wirkt sich auf die Berechnung von Summen- und Gesamtzählern aus.

Auswirkung des Parameters Durchflussrichtung und der tatsächlichen
Durchflussrichtung auf die Summen- und Gesamtzähler

Tabelle 15-7:   

Einstellung der Durch-
flussrichtung

Tatsächliche Durchflussrichtung

Vorwärts Nulldurchfluss Rückwärts

Vorwärts Zähler steigen Zähler ändern sich nicht Zähler ändern sich
nicht

Bidirektional Zähler steigen Zähler ändern sich nicht Zähler fallen

Vorwärts negieren Zähler ändern sich
nicht

Zähler ändern sich nicht Zähler steigen

Bidirektional negieren Zähler fallen Zähler ändern sich nicht Zähler steigen

Auswirkung der Durchflussrichtung auf die Gesamtbefüllung
Die Durchflussrichtung wirkt sich darauf aus, wie die Auswerteelektronik Befüllungen misst
und bestimmt, wann die Befüllung abgeschlossen ist (die Gesamtmenge wurde erreicht).

Auswirkung des Parameters Durchflussrichtung und der tatsächlichen
Durchflussrichtung auf die Gesamtbefüllung

Tabelle 15-8:   

Einstellung der Durch-
flussrichtung

Tatsächliche Durchflussrichtung

Vorwärts Nulldurchfluss Rückwärts

Vorwärts Befüllzähler steigt Befüllzähler ändert sich
nicht

Befüllzähler ändert
sich nicht

Bidirektional Befüllzähler steigt Befüllzähler ändert sich
nicht

Befüllzähler fällt
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Auswirkung des Parameters Durchflussrichtung und der tatsächlichen
Durchflussrichtung auf die Gesamtbefüllung (Fortsetzung)

Tabelle 15-8:   

Einstellung der Durch-
flussrichtung

Tatsächliche Durchflussrichtung

Vorwärts Nulldurchfluss Rückwärts

Vorwärts negieren Befüllzähler ändert
sich nicht

Befüllzähler ändert sich
nicht

Befüllzähler steigt

Bidirektional negieren Befüllzähler fällt Befüllzähler ändert sich
nicht

Befüllzähler steigt

Vorwärtsdurchfluss Prozessmedium strömt in Richtung des Pfeils auf dem Sensor

Rückwärtsdurchfluss Prozessmedium strömt in entgegengesetzter Richtung des Pfeils
auf dem Sensor

Hinweis
Wenn ein Rückwärtsdurchfluss in Ihrem Prozess auftreten und Konsistenzprobleme verursachen
könnte, empfiehlt Micro Motion die Einstellung der Durchflussrichtung auf Bidirektional oder Bidirektional
negieren.

Anmerkung
Die Durchflussrichtung wirkt sich außerdem auf die Befüllungsprotokollierung über den mA-Ausgang,
den Frequenzausgang und die digitale Kommunikation aus und wirkt sich auf die
Durchflussprotokollierung über den mA-Ausgang, den Frequenzausgang und die digitale
Kommunikation aus.

15.5 Konfigurieren der Dichtemessung
Die Dichtemessparameter steuern, wie die Dichte gemessen und ausgegeben wird. Die
Dichtemessung (zusammen mit der Massemessung) wird verwendet, um den
Volumendurchfluss für Flüssigkeiten zu bestimmen.

Die Dichtemessparameter beinhalten:

• Dichte Messeinheit
• Schwallstromparameter
• Dichtedämpfung
• Dichteabschaltung

15.5.1 Konfigurieren der Dichte Messeinheit

ProLink II ProLink > Configuration > Density > Density Units

ProLink III Device Tools > Configuration > Process Measurement > Density

PROFIBUS EDD Configure > Manual Setup > Measurements > Density > Density Unit

PROFIBUS Buspara-

meter

Block: Measurement, Index 9
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Überblick

Die Density Measurement Unit gibt die Messeinheiten an, die als Dichtemessung angezeigt
werden.

Verfahren

Die Density Measurement Unit auf die gewünschte Option einstellen.

Die Standardeinstellung für die Density Measurement Unit ist g/cm3 (Gramm pro
Kubikzentimeter).

Optionen für die Dichtemesseinheit
Die Auswerteelektronik bietet einen Standardsatz an Messeinheiten für die
Dichtemesseinheit. Verschiedene Kommunikations-Hilfsmittel verwenden u. U.
unterschiedliche Kennzeichnungen.

Optionen für die Dichtemesseinheit Tabelle 15-9:   

Beschreibung der Einheit

Bezeichnung

ProLink II ProLink III

Spezifische Dichteeinheit (nicht Temp. korrigiert) SGU SGU

Gramm pro Kubikzentimeter g/cm3 g/cm3

Gramm pro Liter g/l g/l

Gramm pro Milliliter g/ml g/ml

Kilogramm pro Liter kg/l kg/l

Kilogramm pro Kubikmeter kg/m3 kg/m3

Pfund pro U.S. Gallone lbs/Usgal lbs/Usgal

Pfund pro Kubikfuß lbs/ft3 lbs/ft3

Pfund pro Kubikzo lbs/in3 lbs/in3

API Dichte degAPI degAPI

Short ton pro Kubikyard sT/yd3 sT/yd3

15.5.2 Schwallstrom Parameter konfigurieren

ProLink II ProLink > Configuration > Density > Slug High Limit

ProLink > Configuration > Density > Slug Low Limit

ProLink > Configuration > Density > Slug Duration

ProLink III Device Tools > Configuration > Process Measurement > Density

PROFIBUS EDD Configure > Manual Setup > Measurements > Density > Slug Low Limit

Configure > Manual Setup > Measurements > Density > Slug High Limit

Configure > Manual Setup > Measurements > Density > Slug Duration

PROFIBUS Buspara-

meter

Slug Low Limit: Block: Diagnostic, Index 2

Slug High Limit: Block: Diagnostic, Index 3

Slug Duration: Block: Diagnostic, Index 1
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Überblick

Die Schwallstrom Parameter steuern, wie die Auswerteelektronik eine
Zweiphasenströmung (Gas in einem Flüssigkeitsprozess oder Flüssigkeit in einem
Gasprozess) erkennt und ausgibt.

Verfahren

1. Setzen Sie Unterer Schwallstrom Grenzwert auf den niedrigsten Dichtewert, der in Ihrem
Prozess als normal betrachtet wird.

Werte unter diesem Grenzwert führen dazu, dass die Auswerteelektronik die für
Schwallstrom konfigurierte Aktion ausführt. Üblicherweise ist dieser Wert die
niedrigste Dichte im normalen Bereich Ihres Prozesses.

Hinweis
Gaseinschlüsse können dazu führen, dass die Prozessdichte kurzzeitig abfällt. Um das
Auftreten von Schwallstrom Alarmen, die für den Prozess nicht von Bedeutung sind, zu
reduzieren, setzen Sie Unterer Schwallstrom Grenzwert etwas unterhalb der niedrigsten
erwarteten Prozessdichte.

Sie müssen Unterer Schwallstrom Grenzwert in g/cm3 auch dann eingeben, wenn Sie eine
andere Einheit für die Dichtemessung konfiguriert haben.

Der voreingestellte Wert für Unterer Schwallstrom Grenzwert ist 0,0 g/cm3. Der Bereich
ist 0,0 bis 10,0 g/cm3.

2. Setzen Sie Oberer Schwallstrom Grenzwert auf den höchsten Dichtewert, der in Ihrem
Prozess als normal betrachtet wird.

Werte über diesem Grenzwert führen dazu, dass die Auswerteelektronik die für
Schwallstrom konfigurierte Aktion ausführt. Üblicherweise ist dieser Wert die
höchste Dichte im normalen Bereich Ihres Prozesses.

Hinweis
Um das Auftreten von Schwallstrom Alarmen, die für den Prozess nicht von Bedeutung sind,
zu reduzieren, setzen Sie Oberer Schwallstrom Grenzwert etwas oberhalb der höchsten erwarteten
Prozessdichte.

Sie müssen Oberer Schwallstrom Grenzwert in g/cm3 auch dann eingeben, wenn Sie eine
andere Einheit für die Dichtemessung konfiguriert haben.

Der voreingestellte Wert für Oberer Schwallstrom Grenzwert ist 5,0 g/cm3. Der Bereich
ist 0,0 bis 10,0 g/cm3.

3. Setzen Sie Schwallstromdauer auf die Anzahl der Sekunden, die die Auswerteelektronik
auf die Beseitigung einer Schwallstrombedingung wartet, bevor die für
Schwallstrom konfigurierte Aktion ausgeführt wird.

Der voreingestellte Wert für Schwallstromdauer ist 0,0 s. Der Bereich ist 0,0 bis 60,0 s.

Hinweis
Füe Abfüllanwendungen empfiehlt Micro Motion, den für Schwallstromdauer voreingestellten
Wert nicht zu verändern.
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Schwallstromerkennung und -ausgabe
Die Schwallströmung wird üblicherweise als Indikator eines Zweiphasenstroms (Gas in
einem Flüssigkeitsprozess oder Flüssigkeit in einem Gasprozess) verwendet. Der
Zweiphasenstrom kann verschiedene Probleme bei der Prozessregelung verursachen.
Durch die richtige Konfiguration der Schwallstromparameter für Ihre Anwendung können
Sie Prozessbedingungen erkennen, die korrigiert werden müssen.

Hinweis
Um das Auftreten von Schwallstromalarmen zu reduzieren, senken Sie den Unteren Schwallstrom-
Grenzwert oder erhöhen den Oberen Schwallstrom-Grenzwert.

Eine Schwallströmung tritt auf, wenn die gemessene Dichte unter den Unteren Schwallstrom-
Grenzwert fällt oder über den Oberen Schwallstrom-Grenzwert steigt. In diesem Fall:

• Wird ein Schwallstromalarm in der aktiven Alarmliste gesetzt.

• Alle Ausgänge, die auf Durchfluss konfiguriert sind, halten den letzten gemessenen
Durchflusswert vor der Schwallströmung bis zum Ende der konfigurierten
Schwallstromdauer.

Wenn der Schwallstromzustand verschwindet, bevor die Schwallstromdauer abgelaufen ist:

• Ausgänge, die auf Durchfluss konfiguriert sind, kehren zur aktuellen
Durchflussanzeige zurück.

• Der Schwallstromalarm wird deaktiviert, verbleibt aber in der Alarmliste bis er
bestätigt ist.

Wenn der Schwallstromzustand nicht verschwindet, bevor die Schwallstromdauer abgelaufen
ist, zeigen die Ausgänge die auf Durchfluss konfiguriert sind, Nulldurchfluss an.

Wenn die Schwallstromdauer auf 0,0 Sekunden eingestellt ist, zeigen die Ausgänge, die auf
Durchfluss konfiguriert sind, Nulldurchfluss an, sobald ein Schwallstromzustand erkannt
wird.

15.5.3 Konfigurieren der Dichtedämpfung

ProLink II ProLink > Configuration > Density > Density Damping

ProLink III Device Tools > Configuration > Process Measurement > Density

PROFIBUS EDD Configure > Manual Setup > Measurements > Density > Density Damping

PROFIBUS Buspara-

meter

Block: Measurement, Index 14

Überblick

Die Dämpfung wird verwendet, um kleine, plötzlich auftretende Schwankungen des
Prozessmesswerts zu glätten. Damping Value gibt die Zeitdauer (in Sekunden) an, über die
die Auswerteelektronik die Änderungen in der ausgegebenen Prozessvariable verteilt. Am
Ende des Intervalls spiegelt die ausgegebene Prozessvariable 63 % der Änderung des
eigentlichen gemessenen Wertes wider.

Verfahren

Density Damping auf den gewünschten Wert einstellen.
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Der Standardwert ist 1,28 Sekunden. Der Bereich liegt bei 0 bis 40,96 Sekunden.

Hinweise

• Ein hoher Dämpfungswert lässt die Prozessvariable regelmäßiger erscheinen, da der
ausgegebene Wert sich langsamer ändert.

• Ein niedriger Dämpfungswert lässt die Prozessvariable unregelmäßiger erscheinen, da der
ausgegebene Wert sich schneller ändert.

• Immer, wenn der Dämpfungswert nicht Null ist, wird der ausgegebene Messwert hinter der
eigentlichen Messung liegen, da der ausgegebene Wert über die Zeit gemittelt wird.

• Allgemein werden niedrigere Dämpfungswerte vorgezogen, da das Risiko von Datenverlusten
und die Verzögerung zwischen dem eigentlichem und dem ausgegebenen Wert geringer ist.

Der eingegebene Wert wird automatisch auf den nächst gültigen Wert abgerundet. Die
gültigen Werte für Density Damping sind: 0, 0,04, 0,08, 0,16, ... 40,96.

Effekt der Dichtedämpfung auf die Volumenmessung
Die Dichtedämpfung wirkt sich auf die Flüssigkeitsvolumenmessung aus. Die Werte des
Flüssigkeitsvolumens werden mittels des gedämpften Dichtewerts anstatt des
gemessenen Dichtewerts errechnet. Die

Interaktion zwischen Dichtedämpfung und Zusätzlicher Dämpfung
In einigen Fällen werden sowohl die Dichtedämpfung als auch die Zusätzliche Dämpfung auf den
ausgegebenen Dichtewert angewandt.

Die Dichtedämpfung regelt die Änderungsrate der Dichte-Prozessvariablen. Die Zusätzliche
Dämpfung regelt die Änderungsrate, die über den mA-Ausgang ausgegeben wird. Wenn die
mA-Ausgangs-Prozessvariable auf Dichte gesetzt ist und sowohl die Dichtedämpfung als auch die
Zusätzliche Dämpfung auf einen Wert ungleich Null gesetzt sind, wird zuerst die
Dichtedämpfung angewandt, und die Berechnung der zusätzlichen Dämpfung wird auf
das Ergebnis der ersten Rechnung angewandt

15.5.4 Konfigurieren der Dichteabschaltung

ProLink II ProLink > Configuration > Density > Low Density Cutoff

ProLink III Device Tools > Configuration > Process Measurement > Density

PROFIBUS EDD Configure > Manual Setup > Measurements > Density > Density Cutoff

PROFIBUS Buspara-

meter

Block: Measurement, Index 20

Überblick

Density Cutoff gibt den niedrigsten Dichtewert an, der als gemessen ausgegeben wird. Alle
Dichtewerte unter dieser Abschaltung werden als 0 ausgegeben.

Verfahren

Density Cutoff auf den gewünschten Wert einstellen.
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Der Standardwert für Density Cutoff ist 0,2 g/cm3. Der Bereich liegt bei 0,0 g/cm3 bis
0,5 g/cm3.

Auswirkung der Dichteabschaltung auf die Volumenmessung
Dichteabschaltung beeinflusst die Volumenmessung von Flüssigkeiten Wenn der Dichtewert die
Dichteabschaltung unterschreitet, wird die Volumendurchflussrate als 0 wiedergegeben.

15.6 Konfigurieren einer Temperaturmessung
Die Parameter der Temperaturmessung steuern, wie die Temperaturdaten vom Sensor
ausgegeben werden. Die Temperaturdaten werden verwendet, um die Auswirkungen zu
kompensieren, die die Temperatur auf Messrohre während Durchflussmessungen hat.

Die Parameter der Temperaturmessung umfassen:

• Temperature Measurement Unit
• Temperature Damping

15.6.1 Konfigurieren einer Temperatur Messeinheit

ProLink II ProLink > Configuration > Temperature > Temp Units

ProLink III Device Tools > Configuration > Process Measurement > Temperature

PROFIBUS EDD Configure > Manual Setup > Measurements > Temperature > Temperature Unit

PROFIBUS Buspara-

meter

Block: Measurement, Index 7

Überblick

Temperature Measurement Unit gibt die Einheit an, die für die Temperaturmessung verwendet
wird.

Verfahren

Setzen Sie Temperature Measurement Unit auf die gewünschte Option.

Die Standardeinstellung ist Degrees Celsius.

Optionen für die Temperatur Messeinheit
Die Auswerteelektronik bietet einen Standardsatz an Messeinheiten für Temperature
Measurement Unit. Unterschiedliche Kommunikations-Hilfsmittel verwenden
möglicherweise unterschiedliche Kennzeichnungen für die Einheiten.

Optionen für Temperature Measurement UnitTabelle 15-10:   

Beschreibung der Einheit

Kennzeichnung

ProLink II ProLink III

Grad Celsius GradC °C

Grad Fahrenheit °F °F
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Optionen für Temperature Measurement Unit (Fortsetzung)Tabelle 15-10:   

Beschreibung der Einheit

Kennzeichnung

ProLink II ProLink III

Grad Rankine °R °R

Kelvin degK °K

15.6.2 Konfigurieren der Temperaturdämpfung

ProLink II ProLink > Configuration > Temperature > Temp Damping

ProLink III Device Tools > Configuration > Temperature

PROFIBUS EDD Configure > Manual Setup > Measurements > Temperature > Temperature Damping

PROFIBUS Buspara-

meter

Block: Measurement, Index 13

Überblick

Die Dämpfung wird verwendet, um kleine, plötzlich auftretende Schwankungen des
Prozessmesswerts zu glätten. Damping Value gibt die Zeitdauer (in Sekunden) an, über die
die Auswerteelektronik die Änderungen in der ausgegebenen Prozessvariable verteilt. Am
Ende des Intervalls spiegelt die ausgegebene Prozessvariable 63 % der Änderung des
eigentlichen gemessenen Wertes wider.

Verfahren

Geben Sie den Wert ein, der für Temperature Damping verwendet werden soll.

Der Standardwert beträgt 4,8 Sekunden. Der Bereich liegt zwischen 0,0 und
38,4 Sekunden.

Hinweise

• Ein hoher Dämpfungswert lässt die Prozessvariable regelmäßiger erscheinen, da der
ausgegebene Wert sich langsamer ändert.

• Ein niedriger Dämpfungswert lässt die Prozessvariable unregelmäßiger erscheinen, da der
ausgegebene Wert sich schneller ändert.

• Immer, wenn der Dämpfungswert nicht Null ist, wird der ausgegebene Messwert hinter der
eigentlichen Messung liegen, da der ausgegebene Wert über die Zeit gemittelt wird.

• Allgemein werden niedrigere Dämpfungswerte vorgezogen, da das Risiko von Datenverlusten
und die Verzögerung zwischen dem eigentlichem und dem ausgegebenen Wert geringer ist.

Der eingegebene Wert wird automatisch auf den nächsten gültigen Wert abgerundet.
Gültige Werte für Temperature Damping sind 0, 0,6, 1,2, 2,4, 4,8, … 38,4.

Auswirkung der Temperaturdämpfung auf die Prozessmessung
Die Temperaturdämpfung beeinflusst die Reaktionsgeschwindigkeit der
Temperaturkompensation bei schwankenden Temperaturen. Die
Temperaturkompensation passt die Prozessmessung an, um den Temperatureinfluss auf
das Messrohr zu kompensieren.
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15.7 Druckkompensation konfigurieren
Die Druckkompensation nimmt Anpassungen an der Prozessmessung vor, um den Einfluss
des Drucks auf den Sensor zu kompensieren. Der Einfluss des Drucks ist die Änderung der
Empfindlichkeit des Sensors bezüglich Durchfluss und Dichte, die durch die Differenz
zwischen dem Kalibrierdruck und dem Prozessdruck verursacht wird.

Hinweis
Verwenden Sie die Druckkompensation nur dann für Abfüllanwendungen, wenn dies ausdrücklich
von Micro Motion empfohlen wurde. Wenn Sie Fragen zum Einfluss des Drucks auf eine
Abfüllungsmessung haben, wenden Sie sich an den Micro Motion Kundenservice.

15.7.1 Druckkompensation konfigurieren mittels ProLink II
Vorbereitungsverfahren

Sie benötigen den Durchflussfaktor, den Dichtefaktor und die Kalibrierdruckwerte für den
Sensor.

• Durchflussfaktor und Dichtefaktor sind im Produktdatenblatt des Sensors
angegeben.

• Der Kalibrierdruck ist im Kalibrierdatenblatt des Sensors zu finden. Sind die Daten
nicht verfügbar, verwenden Sie 20 psi.

Verfahren

1. Wählen Sie View > Preferences und stellen Sie sicher, dass das Kontrollfeld Externe
Druckkompensation aktivieren markiert ist.

2. Wählen Sie ProLink > Configuration > Pressure.

3. Geben Sie den Flow Factor für Ihren Sensor ein.

Der Durchflussfaktor ist die prozentuale Änderung des Durchflusses pro psi. Bei der
Eingabe des Wertes verwenden Sie das umgekehrte Vorzeichen.

Beispiel: 

Wenn der Durchflussfaktor 0,000004 % pro psi ist, geben Sie −0,000004 %  pro  psi ein.

4. Geben Sie den Density Factor für Ihren Sensor ein.

Der Dichtefaktor ist die Änderung der Dichte des Prozessmediums in g/cm3/psi. Bei
der Eingabe des Wertes verwenden Sie das umgekehrte Vorzeichen.

Beispiel: 

Wenn der Dichtefaktor 0,000006 g/cm3/psi ist, geben Sie −0,000006 g/cm3/psi ein.

5. Geben Sie den Cal Pressure für Ihren Sensor ein.

Der Kalibrierdruck ist der Druck, bei dem der Sensor kalibriert wurde. Dies entspricht
dem Druck, bei dem kein Einfluss des Drucks vorhanden ist. Sind die Daten nicht
verfügbar, geben Sie 20 psi ein.

6. Ermitteln Sie, wie die Auswerteelektronik die Druckdaten empfängt, und führen Sie
die entsprechende Einrichtung durch.
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Option Einrichtung

Ein vom Anwender
konfigurierter, sta-
tischer Druckwert

a. Setzen Sie Pressure Units auf die gewünschte Einheit.
b. Setzen Sie External Pressure auf den gewünschten Wert.

Abfragen von
Druck(1)

a. Stellen Sie sicher, dass der primäre mA Ausgang gemäß HART
Abfrage verdrahtet wurde.

b. Wählen Sie ProLink > Configuration > Polled Variables.
c. Wählen Sie einen freien Abfrage Slot.
d. Setzen Sie Polling Control auf Poll As Primary oder Poll as Secondary

und klicken Sie dann auf Apply.
e. Setzen Sie External Tag auf die HART Kennzeichnung des externen

Druckmessgeräts.
f. Setzen Sie Variable Type auf Pressure.

Hinweis
• Als Primär abfragen: Auf dem Netzwerk ist kein anderer HART Mas-

ter vorhanden.
• Als Sekundär abfragen: Auf dem Netzwerk sind andere HART Mas-

ter vorhanden. Das Handterminal ist kein HART Master.

Ein von der digital-
en Kommunikation
bereitgestellter
Wert

a. Setzen Sie Pressure Units auf die gewünschte Einheit.
b. Führen Sie die erforderlichen Schritte zur Programmierung des

Hostsystems und zur Einrichtung der Kommunikation durch, um
die Druckdaten in entsprechenden Intervallen auf die Auswer-
teelektronik zu schreiben.

(1) Nicht bei allen Auswerteelektroniken verfügbar.

Nachbereitungsverfahren

Wenn Sie ein externes Druckmessgerät verwenden, überprüfen Sie die Einstellung, indem
Sie ProLink > Process Variables wählen und den in External Pressure angezeigten Wert prüfen.

15.7.2 Druckkompensation konfigurieren mittels ProLink III
Vorbereitungsverfahren

Sie benötigen den Durchflussfaktor, den Dichtefaktor und die Kalibrierdruckwerte für den
Sensor.

• Durchflussfaktor und Dichtefaktor sind im Produktdatenblatt des Sensors
angegeben.

• Der Kalibrierdruck ist im Kalibrierdatenblatt des Sensors zu finden. Sind die Daten
nicht verfügbar, verwenden Sie 20 psi.

Verfahren

1. Wählen Sie Device Tools > Configuration > Process Measurement > Pressure Compensation.

2. Setzen Sie Pressure Compensation Status to Enabled.

3. Geben Sie den Flow Calibration Pressure für Ihren Sensor ein.

Der Kalibrierdruck ist der Druck, bei dem der Sensor kalibriert wurde. Dies entspricht
dem Druck, bei dem kein Einfluss des Drucks vorhanden ist. Sind die Daten nicht
verfügbar, geben Sie 20 psi ein.
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4. Geben Sie den Flow Factor für Ihren Sensor ein.

Der Durchflussfaktor ist die prozentuale Änderung des Durchflusses pro psi. Bei der
Eingabe des Wertes verwenden Sie das umgekehrte Vorzeichen.

Beispiel: 

Wenn der Durchflussfaktor 0,000004 % pro psi ist, geben Sie −0,000004 %  pro  psi ein.

5. Geben Sie den Density Factor für Ihren Sensor ein.

Der Dichtefaktor ist die Änderung der Dichte des Prozessmediums in g/cm3/psi. Bei
der Eingabe des Wertes verwenden Sie das umgekehrte Vorzeichen.

Beispiel: 

Wenn der Dichtefaktor 0,000006 g/cm3/psi ist, geben Sie −0,000006 g/cm3/psi ein.

6. Setzen Sie Pressure Source auf die Methode, die die Auswerteelektronik für den
Empfang der Druckdaten verwendet.

Option Beschreibung

Externen Wert abfragen(2) Die Auswerteelektronik fragt ein externes Druckmessgerät
ab. Sie verwendet hierfür das HART Protokoll über den pri-
mären mA Ausgang.

Statische oder digitale Kommuni-
kation

Die Auswerteelektronik verwendet den aus dem Speicher
gelesenen Druckwert.
• Statisch: Der konfigurierte Wert wird verwendet.
• Digitale Kommunikation: Ein Host schreibt Daten in den

Speicher der Auswerteelektronik.

(2) Nicht bei allen Auswerteelektroniken verfügbar.

7. Wenn Sie die Abfrage von Druckdaten wählen:

a. Wählen Sie den zu verwendenden Abfrage Slot.
b. Setzen Sie Polling Control auf Poll as Primary oder auf Poll as Secondary und klicken Sie

dann auf Apply.

Hinweis

• Als Primär abfragen: Auf dem Netzwerk ist kein anderer HART Master vorhanden.

• Als Sekundär abfragen: Auf dem Netzwerk sind andere HART Master vorhanden. Das
Handterminal ist kein HART Master.

c. Setzen Sie External Device Tag auf die HART Kennzeichnung des externen
Druckmessgeräts und klicken Sie dann auf Apply.

8. Wenn Sie einen statischen Druckwert verwenden:

a. Setzen Sie Pressure Unit auf die gewünschte Einheit.

b. Setzen Sie Static or Current Pressure auf den Wert, den Sie verwenden möchten,
und klicken Sie auf Apply.
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9. Wenn Sie digitale Kommunikation verwenden möchten, klicken Sie auf Apply und
führen Sie dann die erforderlichen Schritte zur Programmierung des Hostsystems
und zur Einrichtung der Kommunikation durch, um Druckdaten in entsprechenden
Intervallen auf die Auswerteelektronik zu schreiben.

Nachbereitungsverfahren

Wenn Sie einen externen Druckwert verwenden, überprüfen Sie die Einstellung, indem Sie
den Wert External Pressure prüfen, der im Bereich Inputs des Hauptfensters angezeigt wird.

15.7.3 Optionen für Druckmesseinheit
Die Auswerteelektronik bietet ein Standardsatz an Messeinheiten für Pressure Measurement
Unit. Unterschiedliche Kommunikations-Hilfsmittel verwenden möglicherweise
unterschiedliche Kennzeichnungen für die Einheiten. In den meisten Anwendungen sollte
Pressure Measurement Unit so eingestellt sein, dass sie mit dem vom externen Gerät
verwendeten Druckmesseinheit übereinstimmt.

Optionen für Pressure Measurement UnitTabelle 15-11:   

Beschreibung der Einheit

Kennzeichnung

ProLink II ProLink III

Feet Wasser bei 68 °F Ft Wasser bei 68 °F Ft Water @ 68°F

In. Wasser bei 4 °C In. Wasser bei 4 °C In Water @ 4°C

In. Wasser bei 60 °F In. Wasser bei 60 °F In Water @ 60°F

In. Wasser bei 68 °F In. Wasser bei 68 °F In Water @ 68°F

Millimeter Wasser bei 4 °C mm Wasser bei 4 °C mm Water @ 4°C

Millimeter Wasser bei 68 °F mm Wasser bei 68 °F mm Water @ 68°F

Millimeter Quecksilber bei 0 °C mm Quecksilber bei 0 °C mm Mercury @ 0°C

In. Quecksilber bei 0 °C In. Quecksilber bei 0 °C In Mercury @ 0°C

Pounds pro Quadratinch PSI PSI

bar bar bar

mbar mbar millibar

Gramm pro Quadratzentimeter g/cm2 g/cm2

Kilogramm pro Quadratzentimeter kg/cm2 kg/cm2

Pascal Pa pascals

kPa kPa Kilopascals

Megapascal MPa Megapascals

Torr bei 0 °C Torr bei 0 °C Torr @ 0°C

Atmosphären at atms
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16 Geräteoptionen und Präferenzen
konfigurieren
In diesem Kapitel behandelte Themen:

• Konfigurieren der Alarmverwaltung

• Informationsparameter konfigurieren

16.1 Konfigurieren der Alarmverwaltung
Die Alarmverwaltungsparameter steuern die Reaktion der Auswerteelektronik auf Prozess-
und Gerätebedingungen.

Die Alarmverwaltungsparameter umfassen:

• Fehler-Timeout
• Status Alarmstufe

16.1.1 Konfigurieren von Störung-Timeout

ProLink II ProLink > Configuration > Frequency > Last Measured Value Timeout

ProLink III Device Tools > Configuration > Fault Processing

PROFIBUS EDD Configure > Alert Setup > Alert Severity > Fault Timeout

PROFIBUS Buspara-

meter

Block: Diagnostic, Index 19

Überblick

Fault Timeout steuert die Verzögerung, bevor Störaktionen eingeleitet werden.

Einschränkung
Fault Timeout findet nur auf die folgenden Alarme Anwendung (aufgelistet nach Statusalarmcode):
A003, A004, A005, A008, A016, A017, A033. Bei allen anderen Alarmen werden Störaktionen
durchgeführt, sobald ein Alarm erkannt wird.

Verfahren

Fault Timeout wie gewünscht einstellen.

Der Standardwert ist 0 Sekunden. Der Bereich liegt bei 0 bis 60 Sekunden.

Wenn Fault Timeout auf 0 eingestellt wird, werden Störaktionen durchgeführt, sobald eine
Alarmbedingung erkannt wird.

Die Zeitspanne Störung-Timeout beginnt, sobald die Auswerteelektronik eine
Alarmbedingung erkennt. Während der Zeitspanne Störung-Timeouts gibt die
Auswerteelektronik weiterhin die zuletzt gültigen Messwerte aus.
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Wenn Störung-Timeout abläuft und der Alarm noch aktiv ist, werden die Störaktionen
durchgeführt. Wenn die Alarmbedingung nicht mehr aktiv ist, bevor Störung-Timeout
abläuft, wird keine Störaktionen durchgeführt.

Hinweis
ProLink IIermöglicht die Einstellung von Fault Timeout in zwei Bereichen. Allerdings gibt es nur einen
Parameter und dieselbe Einstellung gilt für alle Ausgänge.

16.1.2 Konfigurieren von Status Alarmstufe

ProLink II ProLink > Configuration > Alarm > Alarm

ProLink > Configuration > Alarm > Severity

ProLink III Device Tools > Configuration > Alert Severity

PROFIBUS EDD Configure > Alert Setup > Alert Severity > Change Alert Severity

PROFIBUS Buspara-

meter

Alarm index: Block: Diagnostic, Index 20

Alarm x severity: Block: Diagnostic, Index 21

Überblick

Verwenden Sie Status Alarm Severity, um Störaktionen zu steuern, die die
Auswerteelektronik ausführt, wenn eine Alarmbedingung erkannt wird.

Einschränkungen

• Für einige Alarme ist Status Alarm Severity nicht konfigurierbar.

• Für einige Alarme kann Status Alarm Severity nur auf zwei der drei Optionen eingestellt werden.

Hinweis
Micro Motion empfiehlt, die Standardeinstellungen für Status Alarm Severity zu verwenden, es sei
denn, es bestehen spezielle Anforderungen, diese zu ändern.

Verfahren

1. Wählen Sie einen Statusalarm aus.

2. Setzen Sie Status Alarm Severity wie gewünscht für den ausgewählten Statusalarm.
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Op-
tion Beschreibung

Fault Maßnahmen bei Erkennung einer Störung:
• Der Alarm wird in der Alarmliste angezeigt.
• Die Befüllung wird beendet.(1)

• Die Ausgänge werden auf die konfigurierte Störaktion gesetzt (nach Ablauf
von Fault Timeout, falls zutreffend).

• Die digitale Kommunikation wird auf die konfigurierte Störaktion gesetzt
(nach Ablauf von Fault Timeout, falls zutreffend).

• Die Farbe der Status-LED (falls vorhanden) wechselt auf rot oder gelb (abhän-
gig von der Alarmstufe).

Maßnahmen, wenn der Alarm gelöscht wird:
• Die Ausgänge kehren zu ihrem normalen Verhalten zurück.
• Die digitale Kommunikation kehrt zu ihrem normalen Verhalten zurück.
• Die Farbe der Status-LED (falls vorhanden) wechselt zu grün und die LED kann

ggf. blinken.
• Die Befüllung wird nicht fortgesetzt.(1)

Informa-
tional

Maßnahmen bei Erkennung einer Störung:
• Der Alarm wird in der Alarmliste angezeigt.
• Die Farbe der Status-LED (falls vorhanden) wechselt auf rot oder gelb (abhän-

gig von der Alarmstufe).
• Nur bei Alarm A105 (Schwallströmung) wird die Befüllung beendet, wenn Slug

Duration abläuft.(1)

Maßnahmen, wenn der Alarm gelöscht wird:
• Die Farbe der Status-LED (falls vorhanden) wechselt zu grün und die LED kann

ggf. blinken.
• Nur bei Alarm A105 (Schwallströmung) wird die Befüllung nicht fortgesetzt.(1)

Ignore • Nur bei Alarm A105 (Schwallströmung) wird die Befüllung beendet, wenn Slug
Duration abläuft und wird nicht fortgesetzt, wenn der Alarm gelöscht wird.(1)

• Bei allen anderen Alarmen: Keine Aktion.

(1) Nur bei Befüllungen mit integrierter Ventilsteuerung. Bei Befüllungen mit externer Ventilsteuerung
wird die Verarbeitung durch das Hostprogramm gesteuert.

Statusalarme und Optionen für Status-Alarmstufe

Statusalarme und Status-AlarmstufeTabelle 16-1:   

Alarm Code
Statusmeldung Voreingestellte

Alarmstufe Hinweise
Konfigurier-
bar?

A001 EEPROM-Fehler (Core-Pro-
zessor)

Störung Nein

A002 RAM-Fehler (Core-Prozes-
sor)

Störung Nein

A003 Keine Antwort vom Sensor Störung Ja

A004 Messbereichsüberschrei-
tung für Temperatur

Störung Nein

A005 Messbereichsüberschrei-
tung für Massedurchfluss

Störung Ja

A006 Charakterisierung erfor-
derlich

Störung Ja
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Statusalarme und Status-Alarmstufe (Fortsetzung)Tabelle 16-1:   

Alarm Code
Statusmeldung Voreingestellte

Alarmstufe Hinweise
Konfigurier-
bar?

A008 Dichte Bereichsüberschrei-
tung

Störung Ja

A009 Auswerteelektronik Initiali-
sierung/Aufwärmphase

Störung Ja

A010 Kalibrierfehler Störung Nein

A011 Nullpunktkalibrierung fehl-
geschlagen: Tief

Störung Ja

A012 Nullpunktkalibrierung fehl-
geschlagen: Hoch

Störung Ja

A013 Nullpunktkalibrierung fehl-
geschlagen: Instabil

Störung Ja

A014 Auswerteelektronikfehler Störung Nein

A016 Sensor-RTD-Fehler Störung Ja

A017 T-Serien-RTD-Fehler Störung Ja

A020 K.wrt f. k. Drchflss Störung Ja

A021 Falscher Sensortyp (K1) Störung Nein

A029 PIC/Tochterboard-Kom-
munikationsfehler

Störung Nein

A030 Falscher Platinentyp Störung Nein

A031 Spannung zu niedrig Störung Nein

A033 Unzureichendes Signal von
rechter/linker Aufnehmer-
spule

Störung Ja

A102 Antrieb Bereichsübers-
chreitung

Informativ Ja

A104 Kalibrierung läuft Informativ Kann entweder auf Informativ oder
Ignorieren gesetzt werden, aber
nicht auf Störung.

Ja

A105 Schwallströmung Informativ Ja

A107 Spannungsunterbrechung
eingetreten

Informativ Normales Verhalten der Auswer-
teelektronik; tritt nach jedem Aus-/
Einschalten der Stromversorgung
auf.

Ja

A110 Frequenzausgang gesät-
tigt

Informativ Kann entweder auf Informativ oder
Ignorieren gesetzt werden, aber
nicht auf Störung.

Ja

A111 Frequenzausgang fixiert Informativ Kann entweder auf Informativ oder
Ignorieren gesetzt werden, aber
nicht auf Störung.

Ja

A113 mA-Ausgang 2 gesättigt Informativ Kann entweder auf Informativ oder
Ignorieren gesetzt werden, aber
nicht auf Störung.

Ja

Geräteoptionen und Präferenzen konfigurieren

Konfigurations- und Bedienungsanleitung 203



Statusalarme und Status-Alarmstufe (Fortsetzung)Tabelle 16-1:   

Alarm Code
Statusmeldung Voreingestellte

Alarmstufe Hinweise
Konfigurier-
bar?

A114 mA-Ausgang 2 fest Informativ Kann entweder auf Informativ oder
Ignorieren gesetzt werden, aber
nicht auf Störung.

Ja

A118 Binärer mA Ausgang 1 fix Informativ Kann entweder auf Informativ oder
Ignorieren gesetzt werden, aber
nicht auf Störung.

Ja

16.2 Informationsparameter konfigurieren
Die Informationsparameter können verwendet werden, um das Durchflussmessgerät zu
identifizieren oder zu beschrieben. Sie werden jedoch nicht für die Verarbeitung in der
Auswerteelektronik benötigt und sind auch nicht erforderlich.

Die Informationsparameter umfassen:

• Geräteparameter

- Beschreibung
- Nachricht
- Datum

• Sensorparameter

- Sensor Seriennummer
- Sensor Werkstoff
- Sensor Auskleidungswerkstoff
- Sensor Flanschtyp

16.2.1 Konfigurieren der Beschreibung

ProLink II ProLink > Configuration > Device > Descriptor

ProLink III Device Tools > Configuration > Informational Parameters > Transmitter

PROFIBUS EDD Nicht verfügbar

PROFIBUS Buspara-

meter

Nicht verfügbar

Überblick

Mit Descriptor kann eine Beschreibung im Speicher der Auswerteelektronik gespeichert
werden. Die Beschreibung wird nicht für die Verarbeitung benötigt und ist nicht
erforderlich.

Verfahren

Eine Beschreibung für die Auswerteelektronik eingeben.

Es können bis zu 16 Zeichen als Beschreibung eingegeben werden.
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16.2.2 Nachricht konfigurieren

ProLink II ProLink > Configuration > Device > Message

ProLink III Device Tools > Configuration > Informational Parameters > Transmitter

PROFIBUS EDD Nicht verfügbar

PROFIBUS Buspara-

meter

Nicht verfügbar

Überblick

Nachricht ermöglicht das Speichern einer kurzen Nachricht im Speicher der
Auswerteelektronik. Dieser Parameter wird nicht für die Verarbeitung in der
Auswerteelektronik benötigt und ist auch nicht erforderlich.

Verfahren

Geben Sie eine kurze Nachricht für die Auswerteelektronik ein.

Die Nachricht kann bis zu 32 Zeichen lang sein.

16.2.3 Konfigurieren des Datums

ProLink II ProLink > Configuration > Device > Date

ProLink III Device Tools > Configuration > Informational Parameters > Transmitter

PROFIBUS EDD Nicht verfügbar

PROFIBUS Buspara-

meter

Nicht verfügbar

Überblick

Mittels Date kann eine statisches Datum (wird nicht durch die Auswerteelektronik
aktualisiert) im Speicher der Auswerteelektronik gespeichert werden. Dieser Parameter
wird nicht für die Verarbeitung benötigt und ist nicht erforderlich.

Verfahren

Das Datum im Format MM/TT/JJJJ eingeben.

Hinweis
ProLink II und ProLink III bietet einen Kalender, der die Auswahl des Datums erleichtert.
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16.2.4 Sensor Seriennummer konfigurieren

ProLink II ProLink > Configuration > Sensor > Sensor s/n

ProLink III Device Tools > Configuration > Informational Parameters > Sensor

PROFIBUS EDD Configure > Manual Setup > Informational Parameters > Sensor Serial Number

PROFIBUS Buspara-

meter

Block: Device Information, Index 6

Überblick

Sensor Seriennummer ermöglicht Ihnen das Speichern der Seriennummer der Sensor-
Komponente des Durchflussmessgeräts im Speicher der Auswerteelektronik. Dieser
Parameter wird nicht für die Verarbeitung in der Auswerteelektronik benötigt und ist auch
nicht erforderlich.

Verfahren

1. Sie finden die Seriennummer des Sensors in der Sensor Kennzeichnung.

2. Geben Sie die Seriennummer in das Feld Sensor Seriennummer ein.

16.2.5 Sensor Werkstoff konfigurieren

ProLink II ProLink > Configuration > Sensor > Sensor Matl

ProLink III Device Tools > Configuration > Informational Parameters > Sensor

PROFIBUS EDD Configure > Manual Setup > Informational Parameters > Tube Wetted Material

PROFIBUS Buspara-

meter

Block: Device Information, Index 9

Überblick

Sensor Werkstoff ermöglicht Ihnen das Speichern der Art des Werkstoffs, die für die
mediumberührten Teile des Sensors verwendet werden, im Speicher der
Auswerteelektronik. Dieser Parameter wird nicht für die Verarbeitung in der
Auswerteelektronik benötigt und ist auch nicht erforderlich.

Verfahren

1. Der für die mediumberührten Teile des Sensors verwendete Werkstoff ist in den
Dokumenten aufgeführt, die im Lieferumfang des Sensors enthalten sind, bzw. aus
einem Code in der Modellnummer des Sensor ersichtlich.

Eine Aufschlüsselung der Modellnummer ist im Produktdatenblatt des jeweiligen
Sensors zu finden.

2. Setzen Sie Sensor Werkstoff auf die entsprechende Option.
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16.2.6 Sensor Auskleidungswerkstoff konfigurieren

ProLink II ProLink > Configuration > Sensor > Liner Matl

ProLink III Device Tools > Configuration > Informational Parameters > Sensor

PROFIBUS EDD Configure > Manual Setup > Informational Parameters > Tube Lining

PROFIBUS Buspara-

meter

Block: Device Information, Index 10

Überblick

Sensor Auskleidungswerkstoff ermöglicht Ihnen das Speichern der Art des Werkstoffs, die für
die Auskleidung des Sensors verwendet wird, im Speicher der Auswerteelektronik. Dieser
Parameter wird nicht für die Verarbeitung in der Auswerteelektronik benötigt und ist auch
nicht erforderlich.

Verfahren

1. Der Auskleidungswerkstoff des Sensors ist in den Dokumenten aufgeführt, die im
Lieferumfang des Sensors enthalten sind, bzw. aus einem Code in der
Modellnummer des Sensors ersichtlich.

Eine Aufschlüsselung der Modellnummer ist im Produktdatenblatt des jeweiligen
Sensors zu finden.

2. Setzen Sie Sensor Auskleidungswerkstoff auf die entsprechende Option.

16.2.7 Sensor Flanschtyp konfigurieren

ProLink II ProLink > Configuration > Sensor > Flange

ProLink III Device Tools > Configuration > Informational Parameters > Sensor

PROFIBUS EDD Configure > Manual Setup > Informational Parameters > Sensor Flange

PROFIBUS Buspara-

meter

Block: Device Information, Index 11

Überblick

Sensor Flanschtyp ermöglicht Ihnen das Speichern des Flanschtyps Ihres Sensors im Speicher
der Auswerteelektronik. Dieser Parameter wird nicht für die Verarbeitung in der
Auswerteelektronik benötigt und ist auch nicht erforderlich.

Verfahren

1. Der Flanschtyp des Sensors ist in den Dokumenten aufgeführt, die im Lieferumfang
des Sensors enthalten sind, bzw. aus einem Code in der Modellnummer des Sensors
ersichtlich.

Eine Aufschlüsselung der Modellnummer ist im Produktdatenblatt des jeweiligen
Sensors zu finden.

2. Setzen Sie Sensor Flanschtyp auf die entsprechende Option.
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17 Integrieren des Messgerätes mit dem
Netzwerk
In diesem Kapitel behandelte Themen:

• Konfigurieren der Auswerteelektronikkanäle

• mA Ausgang konfigurieren

• Frequenzausgang konfigurieren

• Konfigurieren des Binärausgangs

• Binäreingang konfigurieren

• Konfigurieren eines erweiterten Ereignisses

• Konfigurieren der digitalen Kommunikation

17.1 Konfigurieren der Auswerteelektronikkanäle

ProLink II ProLink > Configuration > Channel > Channel B > Type Assignment

ProLink III Device Tools > Configuration > I/O > Channels

PROFIBUS EDD Configure > Manual Setup > Inputs/Outputs > Channels

PROFIBUS Buspara-

meter

Block: Filling, Index 83

Überblick

Kanal B der Auswerteelektronik kann so konfiguriert werden, dass er als Binärausgang oder
als Binäreingang fungiert. Die Kanalkonfiguration muss der Verdrahtung an den
Anschlussklemmen der Auswerteelektronik entsprechen.

Vorbereitungsverfahren

Vermeiden von Prozessstörungen:

• Konfigurieren Sie die Kanäle, bevor Sie die Ausgänge konfigurieren.

• Vor dem Ändern der Kanalkonfiguration sicherstellen, dass alle durch diesen Kanal
betroffenen Regelkreise manuell gesteuert werden.

VORSICHT!

Bevor Sie einen Kanal als Binäreingang konfigurieren, prüfen Sie den Status des externen
Eingangsgerätes und die Aktionen, die dem Binäreingang zugeordnet sind. Wenn der
Binäreingang EIN ist, werden alle dem Binäreingang zugeordneten Aktionen ausgeführt, wenn
die neue Kanalkonfiguration implementiert wird. Ist dies nicht akzeptabel, ändern Sie den
Status des externen Gerätes oder warten mit der Konfiguration des Kanals als Binäreingang auf
einen geeigneten Zeitpunkt.

Verfahren

Kanal B wie gewünscht einstellen.
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Option Beschreibung

Binärausgang Kanal B fungiert als Binärausgang.

Binäreingang Kanal B arbeitet als Binärausgang.

Nachbereitungsverfahren

Für jeden konfigurierten Kanal die entsprechende Eingangs- oder Ausgangskonfiguration
durchführen bzw. überprüfen. Wenn die Konfiguration eines Kanals sich ändert, wird das
Verhalten des Kanals durch die Konfiguration geregelt, die für den ausgewählten
Eingangs- oder Ausgangstyp gespeichert ist. Die gespeicherte Konfiguration ist für den
bestimmten Prozess möglicherweise nicht geeignet.

Nach dem Überprüfen der Kanal- und Ausgangskonfiguration die automatische Steuerung
des Regelkreises wieder aktivieren.

17.2 mA Ausgang konfigurieren
Der mA Ausgang wird zum Ausgeben der konfigurierten Prozessvariablen verwendet. Die
mA Ausgangsparameter steuern, wie die Prozessvariable ausgegeben wird. Ihre
Auswerteelektronik hat einen mA Ausgang.

Die Parameter des mA Ausgangs umfassen:

• mA Ausgang Prozessvariable
• Lower Range Value (LRV) und Upper Range Value (URV)

• Analogausgang Abschaltung
• Zusätzliche Dämpfung
• AO Fault Action und AO Fault Value

Wichtig
Immer wenn Sie einen Parameter des mA Ausgangs ändern, prüfen Sie alle anderen Parameter des
mA Ausgangs, bevor Sie das Durchfluss-Messsystem wieder in Betrieb nehmen. In einigen
Situationen lädt die Auswerteelektronik automatisch einige gespeicherte Werte und es kann sein,
dass diese Werte nicht passend für Ihre Anwendung sind.

17.2.1 mA Ausgang Prozessvariable konfigurieren

ProLink II ProLink > Configuration > Analog Output > Secondary Variable

ProLink III Device Tools > Configuration > I/O > Outputs > mA Output

PROFIBUS EDD Configure > Manual Setup > Inputs/Outputs > mA Output > Select Primary Variable

PROFIBUS Buspara-

meter

Block: Filling, Index 42

Überblick

Verwenden Sie mA Ausgang Prozessvariable, um die Variable auszuwählen, die über den mA
Ausgang ausgegeben wird.
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Verfahren

Setzen Sie die mA Ausgang Prozessvariable wie gewünscht.

Die Voreinstellung ist Massedurchfluss.

Optionen für mA Ausgang Prozessvariable
Die Auswerteelektronik liefert einen Grundoptionssatz für Ausgang Prozessvariable,
einschließlich mehrerer anwendungsspezifischer Optionen. Verschiedene
Kommunikations-Hilfsmittel verwenden u. U. unterschiedliche Kennzeichnungen für die
Optionen.

Optionen fürmA Ausgang Prozessvariable Tabelle 17-1:   

Prozessvariable

Bezeichnung

ProLink II ProLink III

Massedurchflussrate Massendurchflussrate Massendurchflussrate

Volumendurchflussrate Volumendurchflussrate Volumendurchflussrate

Temperatur Temperatur Temperatur

Dichte Dichte Dichte

Gelieferter Prozentsatz der Abfüllung Binärbatch: Prozent Abfüllung Binärbatch: Prozent Abfüllung

17.2.2 Messanfang (LRV) und Messende (URV) konfigurieren

ProLink II ProLink > Configuration > Analog Output > Lower Range Value

ProLink > Configuration > Analog Output > Upper Range Value

ProLink III Device Tools > Configuration > I/O > Outputs > mA Output

PROFIBUS EDD Configure > Manual Setup > Inputs/Outputs > mA Output

PROFIBUS Buspara-

meter

Lower Range Value: Block: Filling, Index 43

Upper Range Value: Block: Filling, Index 44

Überblick

Der Messanfang (LRV) und das Messende (URV) werden verwendet, um den mA Ausgang zu
skalieren, d. h. das Verhältnis zwischen der mA Ausgang Prozessvariablen und dem mA
Ausgangswert zu definieren.

Anmerkung
Wenn Sie LRV und URV von den werkseitig voreingestellten Werten ändern und Sie später die mA
Ausgang Prozessvariable ändern, werden LRV und URV nicht auf die voreingestellten Werte
zurückgesetzt. Wenn Sie beispielsweise die mA Ausgang Prozessvariable als Massedurchfluss
konfigurieren und LRV und URV ändern, dann die mA Ausgang Prozessvariable auf Dichte setzen und
schließlich die mA Ausgang Prozessvariable zurück auf Massedurchfluss ändern, werden LRV und URV für
Massedurchfluss auf die konfigurierten Werte zurückgesetzt.

Verfahren

Setzen Sie LRV und URV wie gewünscht.
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• LRV ist der Wert der mA Ausgang Prozessvariablen, der durch einen Ausgang von 4 mA
repräsentiert wird. Der voreingestellte Wert für LRV ist von der Einstellung der mA
Ausgang Prozessvariablen abhängig. Wenn mA Ausgang Prozessvariable auf Batch: Prozent der
Befüllung gesetzt ist, geben Sie LRV in % ein.

• URV ist der Wert der mA Ausgang Prozessvariablen, der durch einen Ausgang von 20 mA
repräsentiert wird. Der voreingestellte Wert für URV ist von der Einstellung der mA
Ausgang Prozessvariablen abhängig. Wenn mA Ausgang Prozessvariable auf Batch: Prozent der
Befüllung gesetzt ist, geben Sie URV in % ein.

Hinweise
Für optimale Leistungsmerkmale:

• Setzen Sie LRV ≥ LSL (untere Sensorgrenze).

• Setzen Sie URV ≤ USL (obere Sensorgrenze).

• Setzen Sie diese Werte so, dass die Differenz zwischen URV und LRV ≥ Min Spanne
(Mindestmessspanne) ist.

Die Festlegung von URV und LRV innerhalb der empfohlenen Werte für Min Spanne, LSL und USL sorgt
dafür, dass die Auflösung des mA Ausgang Signals innerhalb des Bereichs der Bitgenauigkeit des
D/A-Wandlers liegt.

Anmerkung
Sie können URV unterhalb von LRV setzen. Zum Beispiel können Sie URV auf 50 und LRV auf 100
setzen.

Der mA Ausgang verwendet einen Bereich von 4–20 mA zur Darstellung der mA Ausgang
Prozessvariablen. Zwischen LRV und URV ist der mA Ausgang linear zur Prozessvariablen.
Fällt die Prozessvariable unter LRV oder steigt über URV, setzt die Auswerteelektronik
einen Sättigungsalarm.

Voreingestelle Werte für Messanfang (LRV) und Messende (URV)
Jede Option für die mA Ausgang Prozessvariable hat ihre eigenen LRV und URV. Wenn Sie die
Konfiguration der mA Ausgang Prozessvariable ändern, werden die korrospondierenden LRV
und URV geladen und verwendet.

Voreingestelle Werte fürMessanfang (LRV) und Messende (URV)Tabelle 17-2:   

Process variable LRV URV

Alle Massedurchfluss-Variablen –200.000 g/sec 200.000 g/sec

Alle Flüssigkeits Volumendurch-
fluss Variablen

–0.200 l/sec 0.200 l/sec

Alle Dichtevariablen 0.000 g/cm3 10.000 g/cm3

Alle Temperaturvariablen –240.000 °C 450.000 °C

Abfüllung in Prozent 0% 100%
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17.2.3 Analogausgang Abschaltung konfigurieren

ProLink II ProLink > Configuration > Analog Output > AO Cutoff

ProLink III Device Tools > Configuration > I/O > Outputs > mA Output

PROFIBUS EDD Configure > Manual Setup > Inputs/Outputs > mA Output

PROFIBUS Buspara-

meter

Block: Filling, Index 45

Überblick

AO Cutoff (Analogausgang Abschaltung) spezifiziert den niedrigsten Massedurchfluss oder
Volumendurchfluss, der durch den mA Ausgang ausgegeben wird. Jeder Durchfluss
unterhalb der Analogausgang Abschaltung wird als 0 ausgegeben.

Einschränkung
Die Analogausgang Abschaltung wird nur angewandt, wenn die mA Ausgang Prozessvariable auf
Massedurchfluss oder Volumendurchfluss gesetzt ist. Ist die mA Ausgang Prozessvariable auf eine andere
Prozessvariable gesetzt, ist die Analogausgang Abschaltung nicht konfigurierbar und die
Auswerteelektronik implementiert die Funktion der Analogausgang Abschaltung nicht.

Verfahren

Setzen Sie die Analogausgang Abschaltung wie gewünscht.

Der voreingestellte Wert für Analogausgang Abschaltung ist 0,0 g/s.

Hinweis
Für die meisten Anwendungen sollte der voreingestellte Wert der Analogausgang Abschaltung
verwendet werden. Setzen Sie sich mit dem Micro Motion Kundenservice in Verbindung, bevor Sie
die Analogausgang Abschaltung ändern.

Wechselwirkung zwischen AO-Abschaltung und
Prozessvariablen-Abschaltungen
Wenn die mA-Ausgang-Prozessvariable auf eine Durchflussvariable (beispielsweise
Massendurchfluss oder Volumendurchfluss) gesetzt ist, dann hat die AO-Abschaltung
Wechselwirkungen mit der Massendurchfluss-Abschaltung oder der Volumendurchfluss-
Abschaltung. Die Auswerteelektronik setzt die Abschaltung beim höchsten Durchfluss ein,
bei dem diese anwendbar ist.

Beispiel: Wechselwirkung bei Abschaltung

Konfiguration:

• mA-Ausgang-Prozessvariable = Massedurchfluss
• AO-Abschaltung = 10 g/s

• Massedurchfluss-Abschaltung = 15 g/s

Ergebnis: Fällt der Massedurchfluss unter 15 g/s, gibt der mA-Ausgang null Durchfluss aus.
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17.2.4 Zusätzliche Dämpfung konfigurieren

ProLink II ProLink > Configuration > Analog Output > AO Added Damp

ProLink III Device Tools > Configuration > I/O > Outputs > mA Output

PROFIBUS EDD Configure > Manual Setup > Inputs/Outputs > mA Output

PROFIBUS Buspara-

meter

Block: Filling, Index 46

Überblick

Die Dämpfung wird verwendet, um kleine, plötzlich auftretende Schwankungen des
Prozessmesswerts zu glätten. Damping Value gibt die Zeitdauer (in Sekunden) an, über die
die Auswerteelektronik die Änderungen in der ausgegebenen Prozessvariable verteilt. Am
Ende des Intervalls spiegelt die ausgegebene Prozessvariable 63 % der Änderung des
eigentlichen gemessenen Wertes wider. Zusätzliche Dämpfung steuert den Wert der
Dämpfung, die für den mA Ausgang angewandt werden soll. Sie beeinflusst nur die
Ausgabe der mA Ausgang Prozessvariablen durch den mA Ausgang. Sie beeinflusst nicht die
Ausgabe der Prozessvariablen mittels einer anderen Methode (z. B. dem Frequenzausgang
oder der digitalen Kommunikation) oder den Wert der Prozessvariablen, der für
Berechnungen verwendet wird.

Anmerkung
Zusätzliche Dämpfung wird nicht auf den mA Ausgang angewandt, wenn dieser fixiert ist (z. B. während
des Messkreistests) oder wenn der mA Ausgang eine Störung ausgibt. Zusätzliche Dämpfung wird
angewandt, während die Sensor Simulation aktiv ist.

Verfahren

Setzen Sie Zusätzliche Dämpfung auf den gewünschten Wert.

Der voreingestellte Wert ist 0,0 Sekunden.

Wenn Sie einen Wert für Added Damping setzen, rundet die Auswerteelektronik den Wert
automatisch auf den nächsten Wert nach unten ab.

Gültige Werte für Zusätzliche DämpfungTabelle 17-3:   

Gültige Werte für Zusätzliche Dämpfung

0,0, 0,1, 0,3, 0,75, 1,6, 3,3, 6,5, 13,5, 27,5, 55, 110, 220, 440

Interaktion zwischen Zusatzdämpfung und
Prozessvariablendämpfung
Wenn die mA-Ausgang-Prozessvariable auf eine Durchflussvariable, Dichte oder Temperatur
gesetzt ist, dann hat die Zusätzliche Dämpfung Wechselwirkungen mit der Durchflussdämpfung,
Dichtedämpfung oder Temperaturdämpfung. Wenn mehrere Dämpfungsparameter verwendet
werden, wird zuerst der Effekt der Dämpfung der Prozessvariablen berechnet, und die
zusätzliche Dämpfung wird auf das Ergebnis dieser Berechnung angewandt.
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Beispiel: Wechselwirkung bei Dämpfung

Konfiguration:

• Durchflussdämpfung = 1 Sekunde

• mA-Ausgang-Prozessvariable = Massedurchfluss
• Zusätzliche Dämpfung = 2 Sekunden

Ergebnis: Eine Änderung des Massedurchflusses wirkt sich am mA-Ausgang nach mehr als
3 Sekunden aus. Die genaue Zeit wird durch die Auswerteelektronik berechnet, gemäß
einem internen Algorithmus, der nicht konfiguriert werden kann.

17.2.5 mA Ausgang Störaktion und mA Ausgang Störwert
konfigurieren

ProLink II ProLink > Configuration > Analog Output > AO Fault Action

ProLink > Configuration > Analog Output > AO Fault Level

ProLink III Device Tools > Configuration > Fault Processing

PROFIBUS EDD Configure > Manual Setup > Inputs/Outputs > mA Output

PROFIBUS Buspara-

meter

mA Output Fault Action: Block: Filling, Index 47

mA Output Fault Level: Block: Filling, Index 48

Überblick

Die mA Ausgang Störaktion steuert das Verhalten des mA Ausgangs, wenn die
Auswerteelektronik eine interne Störbedingung erkennt.

Anmerkung
Nur für manche Fehler: Wenn Zuletzt gemessener Wert – Zeitüberschreitung auf einen Wert ungleich null
gesetzt ist, wird die Auswerteelektronik die Störaktion erst nach Ablauf der Zeitüberschreitung
implementieren.

Verfahren

1. Setzen Sie die mA Ausgang Störaktion auf den gewünschten Wert.

Die Voreinstellung ist Abwärts.

2. Wenn Sie mA Ausgang Störaktion auf Aufwärts oder Abwärts setzen, setzen Sie den mA
Ausgang Störwert wie gewünscht.

Optionen für mA Ausgang Störaktion und mA Ausgang Störwert

Optionen für mA Ausgang Störaktion und mA Ausgang Störwert Tabelle 17-4:   

Option mA Ausgang Verhalten mA Ausgang Störwert

Aufwärts Geht auf den konfigurierten Störwert Voreinstellung: 22,0 mA

Bereich: 21 bis 24 mA

Abwärts (Voreinstellung) Geht auf den konfigurierten Störwert Voreinstellung: 2,0 mA

Bereich: 1,0 bis 3,6 mA
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Optionen für mA Ausgang Störaktion und mA Ausgang Störwert (Fortsetzung)Tabelle 17-4:   

Option mA Ausgang Verhalten mA Ausgang Störwert

Interner Nullpunkt Geht auf den mA-Ausgangswert der dem
Wert der Prozessvariablen von 0 (Null)
zugeordnet ist, wie durch die Messanfang
and Messende Werte Einstellungen.

Nicht zutreffend

Keine Übertragungsdaten für die zugeordnete
Prozessvariable, keine Störaktion

Nicht zutreffend

VORSICHT!

Wenn Sie die mA-Ausgang-Störaktion oder Frequenzausgang-Störaktion auf Keine setzen, stellen Sie
sicher, dass auch Digitale Kommunikations-Störaktion auf Keine gesetzt ist. Andernfalls gibt der
Ausgang nicht die aktuellen Prozessdaten aus und dies kann Messfehler erzeugen oder
ungewollte Konsequenzen für Ihren Prozess haben.

Einschränkung
Wenn Sie die Digitale Kommunikations-Störaktion auf NAN setzen, können Sie die mA-Ausgang-Störaktion
oder Frequenzausgang-Störaktion nicht auf Keine setzen. Wenn Sie dies versuchen, akzeptiert die
Auswerteelektronik die Konfiguration nicht.

17.3 Frequenzausgang konfigurieren
Der Frequenzausgang wird zum Ausgeben einer Prozessvariablen verwendet. Die
Parameter für den Frequenzausgang steuern, wie die Prozessvariable ausgegeben wird.
Wenn Sie eine Auswerteelektronik für Abfüllanwendungen mit externer Ventilsteuerung
erworben haben, hat die Auswerteelektronik einen Frequenzausgang. Wenn Sie eine
Auswerteelektronik für Abfüllanwendungen mit integrierter Ventilregelung erworben
haben, hat die Auswerteelektronik keinen Frequenzausgang.

Die Parameter Frequenzausgang umfassen:

• Frequenzausgang Polarität
• Frequenzausgang Skaliermethode
• Frequenzausgang max. Impulsbreite
• Frequency Output Fault Action und Frequency Output Fault Value

Anmerkung
Die Frequency Output Process Variable wurde während der Konfiguration der Abfüllanwendung mit
externer Ventilregelung konfiguriert. Wenn Sie diesen Frequenzausgang ändern, ändern Sie die
Prozessvariable, die der Host zum Messen und Steuern der Abfüllanwendung verwendet.

Wichtig
Immer wenn Sie einen Parameter des Frequenzausgangs ändern, prüfen Sie alle anderen Parameter
des Frequenzausgangs, bevor Sie das Durchfluss-Messsystem wieder in Betrieb nehmen. In einigen
Situationen lädt die Auswerteelektronik automatisch einige gespeicherte Werte und es kann sein,
dass diese Werte nicht passend für Ihre Anwendung sind.
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17.3.1 Frequenzausgang Polarität konfigurieren

ProLink II ProLink > Configuration > Frequency > Freq Output Polarity

ProLink III Device Tools > Configuration > I/O > Outputs > Frequency Output

PROFIBUS EDD Configure > Manual Setup > Inputs/Outputs > Frequency Output > Frequency Output Polarity

PROFIBUS Buspara-

meter

Block: Filling, Index 66

Überblick

Die Frequenzausgang Polarität steuert, wie der Ausgang einen Status EIN (aktiv) anzeigt. Der
voreingestellte Wert Aktiv Hoch ist für die meisten Anwendungen anwendbar. Es kann sein,
dass Aktiv Niedrig für Anwendungen mit niederfrequentem Signal benötigt wird.

Verfahren

Setzen Sie die Frequenzausgang Polarität wie gewünscht.

Die vorgegebene Einstellung ist Aktiv Hoch.

Optionen für Frequenzausgang Polarität

Optionen für Frequenzausgang PolaritätTabelle 17-5:   

Polarität Referenzspannung (AUS) Impulsspannung (ON)

Aktiv hoch 0 Bestimmt durch Spannungs-
versorgung, Pull-up-Wider-
stand und Bürde (siehe Installa-
tionsanleitung Ihrer Auswer-
teelektronik)

Aktiv niedrig Bestimmt durch Spannungs-
versorgung, Pull-up-Wider-
stand und Bürde (siehe Installa-
tionsanleitung Ihrer Auswer-
teelektronik)

0

17.3.2 Frequenzausgang Skaliermethode konfigurieren

ProLink II ProLink > Configuration > Frequency > Scaling Method

ProLink III Device Tools > Configuration > I/O > Outputs > Frequency Output

PROFIBUS EDD Configure > Manual Setup > Inputs/Outputs > Frequency Output

PROFIBUS Buspara-

meter

Block: Filling, Index 58
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Überblick

Die Frequenzausgang Skaliermethode definiert das Verhältnis zwischen Ausgangsimpulsen und
Durchflusseinheiten. Setzen Sie die Frequenzausgang Skaliermethode entsprechend den
Anforderungen Ihres frequenzempfangenden Gerätes.

Verfahren

1. Setzen Sie die Frequenzausgang Skaliermethode.

Option Beschreibung

Frequenz = Durchfluss (Vor-
einstellung)

Frequenz berechnet vom Durchfluss

Impulse/Einheit Eine durch den Anwender spezifizierte Impulszahl repräsentiert
eine Durchflusseinheit

Einheiten/Impulse Ein Impuls repräsentiert eine durch den Anwender spezifizierte
Anzahl an Durchflusseinheiten

2. Setzen Sie zusätzlich erforderlicher Parameter.

• Wenn Sie die Frequency Output Scaling Method auf Frequency=Flow setzen, setzen Sie
den Rate Factor und Frequency Factor.

• Wenn Sie die Frequency Output Scaling Method auf Pulses/Unit setzen, definieren Sie
die Anzahl der Impulse, die eine Durchflusseinheit repräsentieren soll.

• Wenn Sie die Frequency Output Scaling Method auf Units/Pulse setzen, definieren Sie
die Einheiten, die jeder Impuls anzeigen soll.

Frequenz anhand des Durchflusses berechnen
Die Option Frequenz = Durchfluss wird verwendet, um den Frequenzausgang Ihrer
Anwendung kundenspezifisch anzupassen, wenn Sie die entsprechenden Werte für
Einheiten/Impuls oder Impulse/Einheit nicht kennen.

Wenn Sie Frequenz = Durchfluss wählen, müssen Sie die Werte für Durchflussfaktor und
Frequenzfaktor angeben:

Durchflussfaktor Der max. Durchfluss, den der Frequenzausgang ausgeben soll. Oberhalb
dieses Durchflusses gibt die Auswerteelektronik A110: Frequenzausgang
gesättigt aus.

Frequenzfaktor Ein Wert wird wie folgt berechnet:

FrequencyFactor = x NRateFactor
T

wobei:

T Faktor zum Umrechnen der gewählten Zeitbasis in Sekunden

N Anzahl der Impulse pro Durchflusseinheit gemäß Konfiguration am
empfangenden Gerät

Der resultierende Frequenzfaktor muss innerhalb des Frequenzbereichs des Ausgangs liegen
(von 0 bis 10 000 Hz).

• Ist der Frequenzfaktor kleiner als 1 Hz, konfigurieren Sie das empfangende Gerät auf
einen höheren Wert für Impulse/Einheit.
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• Ist der Frequenzfaktor größer als 10.000 Hz, konfigurieren Sie das empfangende Gerät
auf einen niedrigeren Wert für Impulse/Einheit.

Hinweis
Ist die Frequenzausgang-Skaliermethode auf Frequenz = Durchfluss gesetzt und Max. Impulsbreite für
Frequenzausgang auf einen Wert ungleich Null gesetzt, empfiehlt MicroMotion die Einstellung des
Frequenzfaktors auf einen Wert kleiner als 200 Hz.

Beispiel: Frequenz = Durchfluss konfigurieren

Wenn Sie möchten, dass der Frequenzausgang alle Durchflüsse bis 2000 kg/min ausgeben
soll.

Das frequenzempfangende Gerät ist auf 10 Impulse/kg konfiguriert.

Lösung:

FrequencyFactor = x 102000
60

333.33FrequencyFactor =

FrequencyFactor = x NRateFactor
T

Setzen Sie die Parameter wie folgt.

• Durchflussfaktor: 2000
• Frequenzfaktor: 333,33

17.3.3 Frequenzausgang max. Impulsbreite konfigurieren

ProLink II ProLink > Configuration > Frequency > Freq Pulse Width

ProLink III Device Tools > Configuration > I/O > Outputs > Frequency Output

PROFIBUS EDD Configure > Manual Setup > Inputs/Outputs > Frequency Output > Maximum Pulse Width

PROFIBUS Buspara-

meter

Block: Filling, Index 61

Überblick

Die Frequenzausgang max. Impulsbreite stellt sicher, dass die Dauer des EIN Signals lang genug
ist, damit das Frequenz empfangende Gerät es erkennt.

Das EIN Signal kann die hohe Spannung sein oder 0,0 V, abhängig von der Frequenzausgang
Polarität.
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Wechselwirkung von Frequenzausgang max. Impulsbreite und Frequenzausgang
Polarität

Tabelle 17-6:   

Polarität Impulsbreite

Aktiv hoch

Aktiv niedrig

Verfahren

Setzen Sie die Frequenzausgang max. Impulsbreite wie gewünscht.

Der voreingestellte Wert ist 277 ms. Sie können den Frequenzausgang max. Impulsbreite auf
0 ms oder einen Wert zwischen 0,5 ms und 277,5 ms einstellen. Die Auswerteelektronik
setzt den eingegebenen Wert automatisch auf den nächsten gültigen Wert.

Hinweis
Micro Motion empfiehlt, den voreingestellten Wert für die Frequenzausgang max. Impulsbreite nicht zu
ändern. Wenden Sie sich an den Micro Motion Kundendienst, wenn Sie die Frequenzausgang max.
Impulsbreite ändern möchten.

17.3.4 Frequenzausgang Störaktion und Frequenzausgang Störwert
konfigurieren

ProLink II ProLink > Configuration > Frequency > Freq Fault Action

ProLink III Device Tools > Configuration > Fault Processing

PROFIBUS EDD Configure > Manual Setup > Inputs/Outputs > Frequency Output

PROFIBUS Buspara-

meter

Block: Filling, Index 64

Überblick

Frequenzausgang Störaktion steuert das Verhalten des Frequenzausgangs, wenn die
Auswerteelektronik eine interne Störbedingung erkennt.

Anmerkung
Nur für manche Fehler: Wenn Zuletzt gemessener Wert – Zeitüberschreitung auf einen Wert ungleich null
gesetzt ist, wird die Auswerteelektronik die Störaktion erst nach Ablauf der Zeitüberschreitung
implementieren.

Verfahren

1. Setzen Sie die Frequenzausgang Störaktion wie gewünscht.

Der voreingestellte Wert ist Abwärts (0 Hz).
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2. Wenn Sie die Frequenzausgang Störaktion auf Aufwärts setzen, setzen Sie den
Frequenzausgang Störwert auf den gewünschten Wert.

Der voreingestellte Wert ist 15000 Hz. Der Bereich ist 10 bis 15000 Hz.

Optionen für Frequenzausgang Störaktion

Optionen für Frequenzausgang StöraktionTabelle 17-7:   

Bezeichnung Frequenzausgang Verhalten

Aufwärts Geht zum konfigurierten Aufwärts Wert:
• Bereich: 10 Hz bis 15000 Hz
• Standardwert: 15000 Hz

Abwärts 0 Hz

Interner Nullpunkt 0 Hz

Keine (Voreinstellung) Übertragungsdaten für die zugeordnete Prozessvariable, keine
Störaktion

VORSICHT!

Wenn Sie die mA-Ausgang-Störaktion oder Frequenzausgang-Störaktion auf Keine setzen, stellen Sie
sicher, dass auch Digitale Kommunikations-Störaktion auf Keine gesetzt ist. Andernfalls gibt der
Ausgang nicht die aktuellen Prozessdaten aus und dies kann Messfehler erzeugen oder
ungewollte Konsequenzen für Ihren Prozess haben.

Einschränkung
Wenn Sie die Digitale Kommunikations-Störaktion auf NAN setzen, können Sie die mA-Ausgang-Störaktion
oder Frequenzausgang-Störaktion nicht auf Keine setzen. Wenn Sie dies versuchen, akzeptiert die
Auswerteelektronik die Konfiguration nicht.

17.4 Konfigurieren des Binärausgangs
Der Binärausgang wird verwendet, um spezifische Durchfluss-Messsystem oder
Prozessbedingungen auszugeben. Die Parameter des Binärausgangs steuern welche
Bedingung ausgegeben wird und wie.
Je nach Kaufoption und der Konfiguration von Channel B verfügt die Auswerteelektronik
entweder über gar keinen bzw. über einen Binärausgang.

Die Parameter Binärausgang enthält:

• Binärausgang Quelle
• Binärausgang Polarität
• Binärausgang Störaktion

Anmerkung
Die präzisen Binärausgänge wurden während der Abfüllungskonfiguration konfiguriert.
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Wichtig
Immer wenn Sie einen Parameter des Binärausgangs ändern, prüfen Sie alle anderen Parameter des
Binärausgangs bevor Sie das Durchfluss-Messsystem wieder in Betrieb nehmen. In einigen
Situationen lädt die Auswerteelektronik automatisch einige gespeicherte Werte und es kann sein,
dass diese Werte nicht passend für Ihre Anwendung sind.

17.4.1 Konfigurieren der Binärausgangsquelle

ProLink II ProLink > Configuration > Discrete Output > DO1 Assignment

ProLink III Device Tools > Configuration > I/O > Outputs > Discrete Output

PROFIBUS EDD Configure > Manual Setup > Inputs/Outputs > Discrete Output > Assignment

PROFIBUS Buspara-

meter

Block: Filling, Index 70

Überblick

Die Discrete Output Source steuert welche Bedingung oder Prozessvariable des Durchfluss-
Messsystems über den Binärausgang ausgegeben wird.

Verfahren

Discrete Output Source auf die gewünschte Option einstellen.

Optionen für Binärausgang Quelle

Optionen für Binärausgang QuelleTabelle 17-8:   

Option Bezeichnung ProLink II Zustand Binärausgang Spannung

Abfüllung läuft Batching/Filling in Progress Abfüllung läuft (eins-
chließlich unterbrochener
Abfüllungen)

0  V

Abfüllung beendet Anwenderspezifisch

Spülventil Discrete Batch: Purge Valve Spülventil offen Anwenderspezifisch

Spülventil geschlossen 0  V

Störung Fault Condition Indication Mindestens eine aktive Stör-
ung

Anwenderspezifisch

Keine aktiven Störungen 0  V

Wichtig
In dieser Tabelle wird davon ausgegangen, dass Binärausgang Polarität auf Aktiv Hoch eingestellt ist. Ist
die Binärausgang Polarität auf Aktiv Niedrig gesetzt, Spannungswerte umkehren.
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17.4.2 Konfigurieren derPolarität des Binärausgangs

ProLink II ProLink > Configuration > Discrete Output > DO1 Polarity

ProLink III Device Tools > Configuration > I/O > Outputs > Discrete Output

PROFIBUS EDD Configure > Manual Setup > Inputs/Outputs > Discrete Output > Polarity

PROFIBUS Buspara-

meter

Block: Filling, Index 71

Überblick

Binärausgänge haben zwei Zustände: EIN (aktiv) und AUS (inaktiv). Zwei unterschiedliche
Spannungswerte werden verwendet, um diese Zustände zu repräsentieren. Die Discrete
Output Polarity steuert welcher Spannungswert welchen Zustand repräsentiert.

Verfahren

Discrete Output Polarity wie gewünscht einstellen.

Die Standardeinstellung ist Active High.

Optionen für Binärausgang Polarität

Optionen für Binärausgang PolaritätTabelle 17-9:   

Polarität Beschreibung

Aktiv hoch • Wenn die festgelegte Bedingung für den
Binärausgang zutrifft, erzeugt der 24 V.

• Wenn die festgelegte Bedingung für den
Binärausgang nicht zutrifft, erzeugt die
Schaltung 0 V.

Aktiv niedrig • Wenn die festgelegte Bedingung für den
Binärausgang zutrifft, erzeugt die Schal-
tung 0 V.

• Wenn die festgelegte Bedingung für den
Binärausgang nicht zutrifft, erzeugt der
Pull-up 24 V.

17.4.3 Konfigurieren von Binärausgang Störaktion

ProLink II ProLink > Configuration > Discrete Output > DO1 Fault Action

ProLink III Device Tools > Configuration > Fault Processing

PROFIBUS EDD Configure > Manual Setup > Inputs/Outputs > Discrete Output > Fault Action

PROFIBUS Buspara-

meter

Block: Filling, Index 72
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Überblick

Discrete Output Fault Action steuert das Verhalten des Binärausgangs, wenn die
Auswerteelektronik eine interne Störbedingung erkennt.

Anmerkung
Nur für manche Fehler: Wenn Zuletzt gemessener Wert – Zeitüberschreitung auf einen Wert ungleich null
gesetzt ist, wird die Auswerteelektronik die Störaktion erst nach Ablauf der Zeitüberschreitung
implementieren.

VORSICHT!

Verwenden Sie Discrete Output Fault Action nicht als Störanzeige. Möglicherweise lässt sich eine
Störbedingung nicht von einem normalen Betriebszustand unterscheiden.
SieheStöranzeige mit dem Binärausgang, wenn der Binärausgang als Störindikator verwendet
werden soll.

Verfahren

Discrete Output Fault Action wie gewünscht einstellen.

Die Standardeinstellung ist None.

Optionen für Binärausgang Störaktion

Optionen für Binärausgang StöraktionTabelle 17-10:   

Bezeichnung

Binärausgang Verhalten

Polarität=Aktiv Hoch Polarität=Aktiv Niedrig

Aufwärts • Störung: Binärausgang ist EIN
(anwenderspezifische Span-
nung)

• Keine Störung: Binärausgang
wird durch seine Zuweisung
gesteuert

• Störung: Binärausgang ist AUS
(0 V)

• Keine Störung: Binärausgang
wird durch seine Zuweisung
gesteuert

Abwärts • Störung: Binärausgang ist AUS
(0 V)

• Keine Störung: Binärausgang
wird durch seine Zuweisung
gesteuert

• Störung: Binärausgang ist EIN
(anwenderspezifische Span-
nung)

• Keine Störung: Binärausgang
wird durch seine Zuweisung
gesteuert

Keine (Voreinstellung) Binärausgang wird durch seine Zuweisung gesteuert

Störanzeige mit dem Binärausgang

Um Störungen über den Binärausgang anzuzeigen, setzen Sie die Parameter wie folgt:

• Binärausgang-Quelle = Störung
• Binärausgang-Störaktion = Keine
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Anmerkung
Wenn Binärausgang-Quelle auf Störung gesetzt ist und eine Störung eintritt, ist der Binärausgang immer
EIN. Die Einstellung Binärausgang-Störaktion wird ignoriert.

17.5 Binäreingang konfigurieren
Der Binäreingang wird verwendet, um eine oder mehrere Aktionen der Auswerteelektronik
von einem externen Gerät aus zu veranlassen. Je nach Kaufoption und der Konfiguration
von Kanal B verfügt die Auswerteelektronik entweder über keinen oder einen
Binäreingang.

Der Parameter Binäreingang enthält:

• Binäreingang Aktion
• Polarität Binäreingang

Wichtig
Immer wenn Sie einen Parameter des Binäreingangs ändern, prüfen Sie alle anderen Parameter des
Binäreingangs bevor Sie das Durchfluss-Messsystem wieder in Betrieb nehmen. In einigen
Situationen lädt die Auswerteelektronik automatisch einige gespeicherte Werte und es kann sein,
dass diese Werte nicht passend für Ihre Anwendung sind.

17.5.1 Binäreingang Aktion konfigurieren

ProLink II ProLink > Configuration > Discrete Input > Assignment > Reset Mass Total

ProLink > Configuration > Discrete Input > Assignment > Reset Volume Total

ProLink > Configuration > Discrete Input > Assignment > Reset All Totals

ProLink > Configuration > Discrete Input > Assignment > Begin Fill

ProLink > Configuration > Discrete Input > Assignment > End Fill

ProLink > Configuration > Discrete Input > Assignment > Pause Fill

ProLink > Configuration > Discrete Input > Assignment > Resume Fill

ProLink III Device Tools > Configuration > I/O > Action Assignment

PROFIBUS EDD Configure > Manual Setup > Inputs/Outputs > Discrete Input > Reset Mass Total

Configure > Manual Setup > Inputs/Outputs > Discrete Input > Reset Volume Total

Configure > Manual Setup > Inputs/Outputs > Discrete Input > Reset All Totals

Configure > Manual Setup > Inputs/Outputs > Discrete Input > Begin Fill

Configure > Manual Setup > Inputs/Outputs > Discrete Input > End Fill

Configure > Manual Setup > Inputs/Outputs > Discrete Input > Pause Fill

Configure > Manual Setup > Inputs/Outputs > Discrete Input > Resume Fill

PROFIBUS Buspara-

meter

Reset mass total: Block: Filling, Index 79

Reset volume total: Block: Filling, Index 80

Reset all totals: Block: Filling, Index 81

Begin filling: Block: Filling, Index 75

End filling: Block: Filling, Index 76

Pause filling: Block: Filling, Index 77

Resume filling: Block: Filling, Index 78
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Überblick

Die Binäreingang Aktion steuert die Aktion oder Aktionen, die die Auswerteelektronik
ausführt wenn der Binäreingang von AUS auf EIN wechselt.

VORSICHT!

Bevor Sie Aktionen einem erweitertem Ereignis oder einem Binäreingang zuordnen, prüfen Sie
den Status des Ereignisses oder des externen Eingangsgerätes. Ist es auf EIN, werden alle
Aktionen ausgeführt, wenn die neue Kanalkonfiguration implementiert wird. Ist dies nicht
akzeptabel, warten Sie auf einen geeigneten Zeitpunkt, um Aktionen dem Ereignis oder
Binäreingang zuzuordnen.

Verfahren

1. Wählen Sie eine Aktion.

2. Wählen Sie den Binäreingang, der die ausgewählte Aktion durchführen soll.

3. Wiederholen Sie diesen Vorgang, bis alle vom Binäreingang auszuführenden
Aktionen zugeordnet sind.

Optionen für Binäreingang Aktion

Optionen für Binäreingang-Aktion oder Erweiterte EreignisaktionTabelle 17-11:   

Aktion

Kennzeichnung

ProLink II ProLink III

Keine (Voreinstellung) Keine Keine

Masse-Summenzähler zurücksetzen Reset Mass Total Reset Mass Total

Volumenzähler zurücksetzen Reset Volume Total Reset Volume Total

Alle Zähler zurücksetzen Reset All Totals Reset All Totals

Befüllung beginnen Begin Fill Befüllung beginnen

Befüllung beenden End Fill Befüllung beenden

Befüllung fortsetzen Resume Fill Befüllung fortsetzen

Befüllung unterbrechen Pause Fill Befüllung unterbrechen

VORSICHT!

Bevor Sie Aktionen einem erweitertem Ereignis oder einem Binäreingang zuordnen, prüfen Sie
den Status des Ereignisses oder des externen Eingangsgerätes. Ist es auf EIN, werden alle
Aktionen ausgeführt, wenn die neue Kanalkonfiguration implementiert wird. Ist dies nicht
akzeptabel, warten Sie auf einen geeigneten Zeitpunkt, um Aktionen dem Ereignis oder
Binäreingang zuzuordnen.
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17.5.2 Binäreingang Polarität konfigurieren

ProLink II ProLink > Configuration > Discrete Input > Polarity

ProLink III Device Tools > Configuration > I/O > Inputs > Discrete Input

PROFIBUS EDD Configure > Manual Setup > Inputs/Outputs > Discrete Input > DI1 Polarity

PROFIBUS Buspara-

meter

Block: Filling, Index 82

Überblick

Der Binäreingang hat zwei Zustände: EIN und AUS. Die Binäreingang Polarität steuert wie die
Auswerteelektronik die eingehenden Spannungswerte dem EIN und AUS Status zuordnet.

Verfahren

Polarität Binäreingang wie gewünscht einstellen.

Die Standardeinstellung ist Aktiv Niedrig.

Optionen für Binäreingang Polarität

Optionen für Binäreingang PolaritätTabelle 17-12:   

Polarität Spannung Status Binäreingin-
gang an der Auswer-
teelektronik

Aktiv hoch Angelegte Spannung zwischen Anschluss-
klemmen ist 3–30 VDC

EIN

Angelegte Spannung zwischen Anschluss-
klemmen ist <0,8 VDC

AUS

Aktiv niedrig Angelegte Spannung zwischen Anschluss-
klemmen ist <0,8 VDC

EIN

Angelegte Spannung zwischen Anschluss-
klemmen ist 3–30 VDC

AUS
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17.6 Konfigurieren eines erweiterten Ereignisses

ProLink II ProLink > Configuration > Discrete Events > Event Name

ProLink > Configuration > Discrete Events > Event Type

ProLink > Configuration > Discrete Events > Process Variable

ProLink > Configuration > Discrete Events > Low Setpoint

ProLink > Configuration > Discrete Events > High Setpoint

ProLink III Device Tools > Configuration > Events > Enhanced Events

PROFIBUS EDD Configure > Alert Setup > Discrete Events > Setup Event Trigger > Discrete Event x > Variable

Configure > Alert Setup > Discrete Events > Setup Event Trigger > Discrete Event x > Event Type

Configure > Alert Setup > Discrete Events > Setup Event Trigger > Discrete Event x > Setpoint A

Configure > Alert Setup > Discrete Events > Setup Event Trigger > Discrete Event x > Setpoint B

PROFIBUS Buspara-

meter

Event index (x = 0, 1, 2, 3, 4): Block: Diagnostics, Index 4

Event x type: Block: Diagnostics, Index 5

Process variable: Block: Diagnostics, Index 8

Setpoint A: Block: Diagnostics, Index 6

Setpoint B: Block: Diagnostics, Index 7

Überblick

Ein erweitertes Ereignis wird verwendet, um Meldungen zu Prozessänderungen zu liefern
und um spezielle Auswerteelektronik Aktionen auszuführen wenn ein Ereignis eintritt. Das
Erweiterte Ereignis tritt ein (ist EIN), wenn der Real-Time Wert einer
anwenderspezifizierten Prozessvariablen den anwenderspezifizierten Sollwert (HI)
überschreitet oder (LO) unterschreitet oder im Bereich (IN) oder ausserhalb des Bereichs
(OUT) liegt, unter Berücksichtigung zweier anwenderspezifizierten Sollwerte. Sie können
bis zu fünf Erweiterte Ereignisse konfigurieren. Für jedes Erweiterte Ereigniss können Sie
eine oder mehrere Aktionen zuordnen, die die Auswerteelektronik ausführt, wenn das
Erweiterte Ereigniss eintritt.

Verfahren

1. Das Ereignis auswählen, das konfiguriert werden soll.

2. Spezifizieren Sie die Ereignisart.

Options Description

HI x > A

Das Ereignis tritt ein, wenn der Wert der zugeordneten Prozessvariable
(x) größer als der Sollwert (Sollwert A) ist (Endpunkt nicht eingeschlossen).

LO x < A

Das Ereignis tritt ein, wenn der Wert der zugeordneten Prozessvariable
(x) kleiner als der Sollwert (Sollwert A) ist (Endpunkt nicht eingeschlossen).

IN A ≤ x ≤ B

Das Ereignis tritt ein, wenn der Wert der zugeordneten Prozessvariable
(x) sich innerhalb “des Bereichs befindet,” d. h. zwischen Sollwert A und
Sollwert B (Endpunkte eingeschlossen).
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Options Description

AUS x ≤ A oder x ≥ B

Das Ereignis tritt ein, wenn der Wert der zugeordneten Prozessvariable
(x) sich “außerhalb des Bereichs befindet,” d. h. kleiner als Sollwert A oder
größer als Sollwert B ist (Endpunkte eingeschlossen).

3. Prozessvariable dem Ereignis zuordnen.

4. Setzen Sie die Werte für die erforderlichen Sollwerte.

• Bei HI- und LO-Ereignissen Sollwert A festlegen.

• Bei IN- und OUT-Ereignissen Sollwert A und Sollwert B festlegen.

5. (Optional) Einen Binärausgang konfigurieren, um den Status entsprechend dem
Ereignisstatus zu wechseln.

6. (Optional) Spezifizieren Sie die Aktion oder Aktionen die die Auswerteelektronik
ausführen soll, wenn das Ereignis eintritt.

• Mit ProLink II: ProLink > Configuration > Discrete Input
• Mit ProLink III:Device Tools > Configuration > I/O > Action Assignment
• Mit PROFIBUS EDD: Configure > Alert Setup > Discrete Events > Assign Discrete Action
• Mit PROFIBUS Busparametern: Diagnoseblock, Index 4 und 5.

17.6.1 Optionen für Erweitertes Ereignisaktion

Optionen für Binäreingang-Aktion oder Erweiterte EreignisaktionTabelle 17-13:   

Aktion

Kennzeichnung

ProLink II ProLink III

Keine (Voreinstellung) Keine Keine

Masse-Summenzähler zurücksetzen Reset Mass Total Reset Mass Total

Volumenzähler zurücksetzen Reset Volume Total Reset Volume Total

Alle Zähler zurücksetzen Reset All Totals Reset All Totals

Befüllung beginnen Begin Fill Befüllung beginnen

Befüllung beenden End Fill Befüllung beenden

Befüllung fortsetzen Resume Fill Befüllung fortsetzen

Befüllung unterbrechen Pause Fill Befüllung unterbrechen

VORSICHT!

Bevor Sie Aktionen einem erweitertem Ereignis oder einem Binäreingang zuordnen, prüfen Sie
den Status des Ereignisses oder des externen Eingangsgerätes. Ist es auf EIN, werden alle
Aktionen ausgeführt, wenn die neue Kanalkonfiguration implementiert wird. Ist dies nicht
akzeptabel, warten Sie auf einen geeigneten Zeitpunkt, um Aktionen dem Ereignis oder
Binäreingang zuzuordnen.
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17.7 Konfigurieren der digitalen Kommunikation
Die Parameter der digitalen Kommunikation steuern die digitale Kommunikation der
Auswerteelektronik.

Die Auswerteelektronik unterstützt die folgenden Typen digitaler Kommunikation:

• Modbus/RS-485 über die RS-485 Anschlussklemmen

• Modbus RTU über Service Port

Anmerkung
Der Service Port reagiert automatisch auf eine Vielzahl von Anschlussanfragen. Er ist nicht
konfigurierbar.

17.7.1 Digitale Kommunikation Störaktion konfigurieren

ProLink II ProLink > Configuration > Digital Comm Settings > Digital Comm Fault Setting

ProLink III Device Tools > Configuration > Fault Processing

PROFIBUS EDD Configure > Alert Setup > Inputs/Outputs Fault Actions > Digital Communications > Fault Action

PROFIBUS Buspara-

meter

Block: Diagnostics, Index 18

Überblick

Die Digital Communications Fault Action spezifiziert den Wert der mittels digitaler
Kommunikation ausgegeben wird, wenn die Auswerteelektronik eine interne
Störbedingung erkennt.

Verfahren

Digital Communications Fault Action wie gewünscht einstellen.

Die Standardeinstellung ist Keine.

Optionen für Digitale Kommunikation Störaktion

Options for Digital Communications Fault ActionTabelle 17-14:   

Bezeichnung

BeschreibungProLink II ProLink III

Aufwärts Aufwärts • Die Prozessvariablenwerte zeigen, dass der Wert höher
als der obere Sensorgrenzwert ist.

• Zählerfortschaltung stoppen.

Abwärts Abwärts • Die Prozessvariablenwerte zeigen, dass der Wert höher
als der obere Sensorgrenzwert ist.

• Zählerfortschaltung stoppen.
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Options for Digital Communications Fault Action (Fortsetzung)Tabelle 17-14:   

Bezeichnung

BeschreibungProLink II ProLink III

Nullpunkt Nullpunkt • Durchflussvariablen gehen auf einen Wert, der einen
Durchfluss von 0 darstellt.

• Dichte wird als 0 ausgegeben.
• Temperatur wird als0 °C, ausgegeben oder aquivalent,

wenn andere Einheiten verwendet werden. (z. B.,
32 °F).

• Antriebsverstärkung wird wie gemessen ausgegeben.
• Zählerfortschaltung stoppen.

Not-a-Number (NAN) Not-a-Number (NAN) • Prozessvariablen werden als IEEE NAN ausgegeben.
• Antriebsverstärkung wird wie gemessen ausgegeben.
• Modbus skalierte Integer werden als Max Int ausgege-

ben.
• Zählerfortschaltung stoppen.

Durchfluss auf Null Durchfluss auf Null • Durchflüsse werden als 0 ausgegeben.
• Andere Prozessvariablen werden wie gemessen ausge-

geben.
• Zählerfortschaltung stoppen.

Keine (Voreinstellung) Keine (Voreinstellung) • Alle Prozessvariablen werden wie gemessen ausgege-
ben.

• Zählerfortschaltung wenn sie laufen.

VORSICHT!

Wenn Sie die mA-Ausgang-Störaktion oder Frequenzausgang-Störaktion auf Keine setzen, stellen Sie
sicher, dass auch Digitale Kommunikations-Störaktion auf Keine gesetzt ist. Andernfalls gibt der
Ausgang nicht die aktuellen Prozessdaten aus und dies kann Messfehler erzeugen oder
ungewollte Konsequenzen für Ihren Prozess haben.

Einschränkung
Wenn Sie die Digitale Kommunikations-Störaktion auf NAN setzen, können Sie die mA-Ausgang-Störaktion
oder Frequenzausgang-Störaktion nicht auf Keine setzen. Wenn Sie dies versuchen, akzeptiert die
Auswerteelektronik die Konfiguration nicht.
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Teil V
Geschäftstätigkeit, Wartung sowie
Fehlersuche und -beseitigung

In diesem Teil enthaltene Kapitel:

• Auswerteelektronikbetrieb

• Messunterstützung

• Störungsanalyse und -behebung

Geschäftstätigkeit, Wartung sowie Fehlersuche und -beseitigung
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18 Auswerteelektronikbetrieb
In diesem Kapitel behandelte Themen:

• Notieren der Prozessvariablen

• Anzeigen von Prozessvariablen

• Anzeigen und Bestätigen von Statusalarmen

• Lesen von Gesamt- und Summenzählerwerten

• Starten und Stoppen von Gesamt- und Summenzählern

• Zähler zurücksetzen

• Gesamtzähler zurücksetzen

18.1 Notieren der Prozessvariablen
Micro Motion empfiehlt die Aufzeichnung von speziellen Messungen von Prozessvariablen
einschließlich des akzeptablen Messbereiches unter normalen Betriebsbedingungen. Mit
diesen Daten können Sie leichter erkennen, wann Prozessvariablenwerte ungewöhnlich
hoch oder niedrig sind, und sie können Ihnen dabei helfen, Anwendungsprobleme besser
zu diagnostizieren und zu lösen.

Verfahren

Notieren Sie die folgenden Prozessvariablen unter normalen Betriebsbedingungen:

Prozessvariable

Messung

Typischer Durchschnitt Typisch hoch Typisch niedrig

Durchfluss

Dichte

Temperatur

Messrohrfrequenz

Aufnehmerspannung

Antriebsverstärkung
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18.2 Anzeigen von Prozessvariablen

ProLink II ProLink > Process Variables

ProLink III Die gewünschte Variable kann auf dem Hauptbildschirm unter Process Variables ange-

zeigt werden. Weitere Informationen finden Sie in Abschnitt 18.2.1.

PROFIBUS EDD Service Tools > Variables > Process Variables

PROFIBUS Buspara-

meter

Mass flow rate: Block: Measurement, Index 4

Volume flow rate: Block: Measurement, Index 10

Density: Block: Measurement, Index 8

Temperature: Block: Measurement, Index 6

Tube frequency: Block: Diagnostics, Index 33

Left pickoff voltage: Block: Diagnostics, Index 35

Right pickoff voltage: Block: Diagnostics, Index 36

Drive gain: Block: Diagnostics, Index 32

Überblick

Prozessvariablen liefern Informationen über den Zustand des Prozessmediums, wie
Strömungsgeschwindigkeit, Dichte und Temperatur sowie über aktuelle Summen.
Prozessvariablen können außerdem Daten über den Betrieb des Durchflussmessgeräts
bereitstellen, wie Antriebsverstärkung und Aufnehmerspannung. Diese Informationen
können zum besseren Verständnis des Prozesses und zur Störungssuche und -beseitigung
verwendet werden.

18.2.1 Anzeigen von Prozessvariablen mittels ProLink III
Sobald eine Verbindung zu einem Gerät hergestellt ist, werden die Prozessvariablen auf
dem Hauptbildschirm von ProLink III angezeigt.

Verfahren

Zeigen Sie die gewünschte(n) Prozessvariable(n) an.

Hinweis
ProLink III ermöglicht Ihnen das Auswählen der Prozessvariablen, die auf dem Hauptbildschirm
angezeigt werden sollen. Außerdem können Sie wählen, ob die Daten in der Ansicht Analog Gauge
oder als Digitalanzeige angezeigt werden sollen, und Sie können die Anzeigeeinstellungen anpassen.
Weitere Informationen finden Sie in der ProLink III Betriebsanleitung.

18.3 Anzeigen und Bestätigen von Statusalarmen
Die Auswerteelektronik gibt einen Statusalarm aus, sobald eine Prozessvariable die
definierten Grenzen überschreitet oder die Auswerteelektronik eine Störung erkennt.
Aktive Alarme können angezeigt und Alarme bestätigt werden.
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18.3.1 Anzeigen und Bestätigen von Alarmen mittels ProLink II
Sie können eine Liste mit allen aktiven oder inaktiven aber unbestätigten Alarmen
anzeigen.

1. Wählen Sie ProLink > Alarm Log.

2. Wählen Sie den Bereich High Priority oder Low Priority.

Anmerkung
Das Gruppieren von Alarmen in diese beiden Kategorien ist fest programmiert und wird durch
Status Alarm Severity nicht beeinflusst.

Alle aktiven oder nicht bestätigten Alarme sind aufgeführt:

• Rote Anzeige: Alarm ist derzeit aktiv.

• Grüne Anzeige: Alarm ist nicht aktiv, aber nicht bestätigt.

Anmerkung
Es werden nur Störungs- und informative Alarme aufgeführt. Alarme mit Status Alarmstufe
Ignorieren werden von der Auswerteelektronik automatisch herausgefiltert.

3. Markieren Sie das Kontrollkästchen Ack, um einen Alarm zu bestätigen.

Nachbereitungsverfahren

• Um die folgenden Alarme zu löschen, müssen Sie das Problem beheben, den Alarm
bestätigen und anschließend die Auswerteelektronik aus- und wieder einschalten:
A001, A002, A010, A011, A012, A013, A018, A019, A022, A023, A024, A025, A028,
A029, A031.

• Für alle anderen Alarme:

- War der Alarm bei der Bestätigung inaktiv, wird er aus der Liste gelöscht.

- War der Alarm bei der Bestätigung aktiv, wird er von der Liste entfernt, sobald
die Alarmbedingung gelöscht ist.

18.3.2 Anzeigen und Bestätigen von Alarmen mittels ProLink III
Sie können eine Liste mit allen aktiven, inaktiven oder unbestätigten Alarmen anzeigen.
Bestimmte Alarme können in der Liste bestätigt oder alle Alarme als bestätigt ausgewählt
werden.

1. Alle Alarme können im ProLink III Hauptbildschirm unter Alerts angezeigt werden.

Alle aktiven oder unbestätigten Alarme werden aufgeführt und entsprechend den
folgenden Kategorien angezeigt:

Kategorie Beschreibung

Failed: Fix Now Ein Messgerätefehler ist aufgetreten und erfordert unverzügliche
Maßnahmen.

Maintenance: Fix Soon Ein Zustand ist aufgetreten, der zu einem späteren Zeitpunkt beho-
ben werden kann.

Advisory: Informational Ein Zustand ist aufgetreten, der kein Eingreifen erfordert.
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Anmerkungen

• Alle Fehleralarme werden in der Kategorie Failed: Fix Now angezeigt.

• Alle Informationsalarme werden entweder in der Kategorie Maintenance: Fix Soon oder
Advisory: Informational angezeigt. Die Kategoriezuweisung ist fest programmiert.

• Alarme mit Alert Severity Ignore werden von der Auswerteelektronik automatisch
herausgefiltert.

2. Markieren Sie das Kontrollkästchen Ack für einen bestimmten Alarm, um diesen zu
bestätigen. Klicken Sie auf Ack All, um alle Alarme auf einmal zu bestätigen.

Nachbereitungsverfahren

• Um die folgenden Alarme zu löschen, müssen Sie das Problem beheben, den Alarm
bestätigen und anschließend die Auswerteelektronik aus- und wieder einschalten:
A001, A002, A010, A011, A012, A013, A018, A019, A022, A023, A024, A025, A028,
A029, A031.

• Für alle anderen Alarme:

- War der Alarm bei der Bestätigung inaktiv, wird er aus der Liste gelöscht.

- War der Alarm bei der Bestätigung aktiv, wird er von der Liste entfernt, sobald
die Alarmbedingung gelöscht ist.

18.3.3 Anzeigen und Bestätigen von Alarmen mittels PROFIBUS
EDD
Sie können alle aktiven Alarme angezeigen und bestätigen sowie detaillierte
Informationen über jeden aktiven Alarm anzeigen.

1. Wählen Sie Service Tools > Alerts.

Eine Liste aller aktiven Alarm wird angezeigt.

2. Klicken Sie auf Acknowledge All Alerts, um alle aktiven Alarme zu bestätigen.

Der Alarm bleibt so lange in der Liste, bis die Alarmbedingung gelöscht wird.

3. Klicken Sie auf die Schaltfläche des entsprechenden Alarms, um weitere
detailliertere Informationen zu erhalten.

18.3.4 Prüfen des Alarmstatus und Bestätigen von Alarmen
mittels PROFIBUS Busparametern
Sie können den Status eines einzelnen Alarms überprüfen und den jeweiligen Alarm
bestätigen. Sie können auch alle aktiven Alarme bestätigen und weitere detaillierte
Informationen über diese abrufen.

• So prüfen Sie den Status eines einzelnen Alarms:

1. Den Alarmindex in den Diagnoseblock schreiben, Index 20.

2. Den Wert im Diagnoseblock lesen, Index 22.

• So bestätigen Sie einen einzelnen Alarm:

1. Den Alarmindex in den Diagnoseblock schreiben, Index 20.

2. 0 in den Diagnoseblock schreiben, Index 22.
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• 1 in den Diagnoseblock schreiben, Index 30, um alle Alarme zu bestätigen.

• Die zusätzlichen Daten aus dem Diagnoseblock lesen, einschließlich Statuswörter,
um weitere detailliertere Alarminformationen zu erhalten.

18.3.5 Alarmdaten im Auswerteelektronik-Speicher
Die Auswerteelektronik speichert drei Datensets für jeden Alarm.

Für jedes Alarmvorkommen werden die folgenden drei Datensets im Auswerteelektronik-
Speicher gepflegt:

• Alarmliste

• Alarmstatistik

• Neueste Alarme

Alarmdaten im Auswerteelektronik-SpeicherTabelle 18-1:   

Alarmdatenstruktur

Auswerteelektronik-Aktion bei Eintreten der Bedingung

Inhalt Löschen

Alarmliste Je nach Bestimmung durch die Alarmstatus-
bits; eine Liste mit:
• Allen derzeit aktiven Alarmen
• Allen zuvor aktiven Alarmen, die noch

nicht bestätigt wurden

Bei jedem Aus-/Einschalten der Spannungsver-
sorgung zur Auswerteelektronik gelöscht und
neu generiert

Alarmstatistik Ein Datensatz für jeden Alarm (nach Alarm-
nummer), der seit der letzten Hauptrückset-
zung gesetzt wurde. Jeder Eintrag enthält:
• Eine Zählung der Vorkommen
• Zeitstempel für die neuesten gesetzten

und gelöschten Alarme

Nicht gelöscht; gespeichert auch nach Aus-/
Einschalten der Auswerteelektronik

Neueste Alarme 50 zuletzt gesetzte oder gelöschte Alarme Nicht gelöscht; gespeichert auch nach Aus-/
Einschalten der Auswerteelektronik

18.4 Lesen von Gesamt- und Summenzählerwerten

ProLink II ProLink > Totalizer Control

ProLink III Sehen Sie sich die gewünschte Variable auf dem Hauptbildschirm unter Prozessvariablen .

PROFIBUS EDD Overview > Totalizer Control

PROFIBUS Buspara-

meter

Mass totalizer: Block: Measurement, Index 27

Volume totalizer: Block: Measurement, Index 28

Mass inventory: Block: Measurement, Index 29

Volume inventory: Block: Measurement, Index 30
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Überblick

Gesamtzähler erfassen die von der Auswerteelektronik seit der letzten
Gesamtzählerrücksetzung gemessene Masse und das Volumen. Summenzähler erfassen
die von der Auswerteelektronik seit der letzten Summenzählerrücksetzung gemessene
Masse und das Volumen

Hinweis
Die Summenzähler können als laufende Summe von Masse und Volumen über mehrere
Gesamtzählerrücksetzungen verwendet werden.

18.5 Starten und Stoppen von Gesamt- und
Summenzählern

ProLink II ProLink > Totalizer Control > Start

ProLink > Totalizer Control > Stop

ProLink III Device Tools > Totalizer Control > Totalizer and Inventories > Start All Totals

Device Tools > Totalizer Control > Totalizer and Inventories > Stop All Totals

PROFIBUS EDD Overview > Totalizer Control > Start

Overview > Totalizer Control > Stop

PROFIBUS Buspara-

meter

Block: Measurement, Index 22

Überblick

Durch Starten eines Gesamtzählers werden Prozessmessungen überwacht. In einer
typischen Anwendung erhöht sich der Wert mit dem Durchfluss. Durch Stoppen eines
Gesamtzählers wird die Überwachung der Prozessmessungen gestoppt und sein Wert wird
nicht mehr durch den Durchfluss beeinflusst. Summenzähler werden durch Starten und
Stoppen der Gesamtzähler automatisch gestartet und gestoppt.

Wichtig
Gesamt- und Summenzähler werden stets als Gruppe gestartet oder gestoppt. Wenn ein
Gesamtzähler gestartet wird, werden gleichzeitig auch alle anderen Gesamt- und Summenzähler
gestartet. Wenn ein Gesamtzähler gestoppt wird, werden gleichzeitig auch alle anderen Gesamtund
Summenzähler gestoppt. Summenzähler können nicht direkt gestartet oder gestoppt werden.
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18.6 Zähler zurücksetzen

ProLink II ProLink > Totalizer Control > Reset Mass Total

ProLink > Totalizer Control > Reset Volume Total

ProLink > Totalizer Control > Reset All Totals

ProLink III Device Tools > Totalizer Control > Totalizer and Inventories > Reset Mass Total

Device Tools > Totalizer Control > Totalizer and Inventories > Reset Volume Total

Device Tools > Totalizer Control > Totalizer and Inventories > Reset All Totals

PROFIBUS EDD Overview > Totalizer Control > Mass: Reset Total

Overview > Totalizer Control > Volume: Reset Total

Overview > Totalizer Control > Reset All

PROFIBUS Buspara-

meter

Reset mass totalizer: Block: Measurement, Index 25

Reset volume totalizer: Block: Measurement, Index 26

Reset all totalizers: Block: Measurement, Index 23

Überblick

Wenn der Zähler zurückgesetzt wird, setzt die Auswerteelektronik seinen Wert auf 0.
Hierbei spielt es keine Rolle, ob der Zähler gestartet oder gestoppt wurde. Wenn der
Zähler gestartet wurde, wird die Überwachung der Prozessmessung fortgeführt.

Hinweis
Wenn ein einzelner Zähler zurückgesetzt wird, werden die Werte der anderen Zähler nicht
zurückgesetzt. Gesamtzählerwerte werden nicht zurückgesetzt.

18.7 Gesamtzähler zurücksetzen

ProLink II ProLink > Totalizer Control > Reset Inventories

ProLink > Totalizer Control > Reset Mass Inventory

ProLink > Totalizer Control > Reset Volume Inventory

ProLink III Device Tools > Totalizer Control > Totalizer and Inventories > Reset Mass Inventory

Device Tools > Totalizer Control > Totalizer and Inventories > Reset Volume Inventory

Device Tools > Totalizer Control > Totalizer and Inventories > Reset Gas Inventory

Device Tools > Totalizer Control > Totalizer and Inventories > Reset All Inventories

PROFIBUS EDD Nicht verfügbar

PROFIBUS Buspara-

meter

Reset mass inventory: Block: Measurement, Index 33

Reset volume inventory: Block: Measurement, Index 34

Reset all inventories: Block: Measurement, Index 24

Überblick

Wenn Sie einen Gesamtzähler zurücksetzen, setzt die Auswerteelektronik den Wert auf 0.
Dabei spielt es keine Rolle, ob der Gesamtzähler gestartet oder gestoppt wurde. Wenn der
Gesamtzähler gestartet wurde, wird die Verfolgung der Prozessmessung fortgesetzt.
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Hinweis
Wenn Sie einen einzelnen Gesamtzähler zurücksetzen, werden die Werte der anderen Gesamtzähler
nicht zurückgesetzt. Die Werte der Summenzähler werden nicht zurückgesetzt.

Vorbereitungsverfahren

Wenn Sie ProLink II oder ProLink III zum Zurücksetzen der Gesamtzähler verwenden
möchten, muss diese Funktion aktiviert sein.

• So aktivieren Sie das Zurücksetzen von Gesamtzählern in ProLink II:

1. Klicken Sie auf View > Preferences.

2. Markieren Sie das Kontrollfeld Enable Inventory Totals Reset.
3. Klicken Sie auf Apply.

• So aktivieren Sie das Zurücksetzen von Gesamtzählern in ProLink III:

1. Wählen Sie Tools > Options.

2. Wählen Sie Reset Inventories from ProLink III.
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19 Messunterstützung
In diesem Kapitel behandelte Themen:

• Nullpunktkalibrierung des Durchflussmesssystems

• Messsystem validieren

• (Standard) D1 und D2 Dichtekalibrierung durchführen

• Durchführen einer Temperaturkalibrierung

19.1 Nullpunktkalibrierung des
Durchflussmesssystems
Die Nullpunktkalibrierung des Durchflussmesssystems etabliert einen Basiswert für die
Prozessmessung, indem der Sensorausgang analysiert wird, wenn kein Durchfluss im
Messrohr vorhanden ist.

Wichtig
In den meisten Fällen ist die werksseitige Nullpunktkalibrierung genauer als die im Feld. Kalibrieren
Sie den Nullpunkt des Durchflussmesssystems nicht, es sei denn:

• Anlagenverfahren erfordern eine Nullpunktkalibrierung.

• Der gespeicherte Nullpunktwert besteht das Nullpunktverifizierungsverfahren nicht.

19.1.1 Nullpunktkalibrierung des Durchflussmesssystems
mittels ProLink II
Die Nullpunktkalibrierung des Durchflussmesssystems etabliert einen Basiswert für die
Prozessmessung, indem der Sensorausgang analysiert wird, wenn kein Durchfluss im
Messrohr vorhanden ist.

Vorbereitungsverfahren

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Vorbereiten des Durchflussmesssystems:

a. Lassen Sie das Durchflussmesssystem nach dem Einschalten mindestens
20 Minuten aufwärmen.

b. Lassen Sie das Prozessmedium durch den Sensor strömen, bis die
Sensortemperatur ungefähr die normale Betriebstemperatur erreicht hat.

c. Stoppen Sie den Durchfluss durch den Sensor, indem Sie das in Flussrichtung
abwärts liegende Ventil und danach das in Flussrichtung aufwärts liegende Ventil
schließen (falls verfügbar).

d. Stellen Sie sicher, dass der Sensor abgesperrt ist, kein Durchfluss mehr
vorhanden ist und der Sensor vollständig mit dem Prozessmedium gefüllt ist.
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e. Beobachten Sie die Werte für Antriebsverstärkung, Temperatur und Dichte. Sind
diese stabil, prüfen Sie den Wert Live Zero oder Field Verification Zero. Wenn der
Mittelwert nahe bei 0 liegt, muss der Nullpunkt des Durchflussmesssystems
nicht kalibriert werden.

2. Wählen SieProLink > Calibration > Zero Verification and Calibration.

3. Klicken Sie auf Calibrate Zero.

4. Ändern Sie Zero Time, falls gewünscht.

Unter Zero Time versteht man die Zeit, die der Auswerteelektronik vorgegeben wird,
um den Referenzpunkt bei einem Durchfluss von Null zu bestimmen. Die
voreingestellte Zero Time beträgt 20 Sekunden. Für die meisten Anwendungen ist die
voreingestellte Zero Time ausreichend.

5. Klicken Sie auf Perform Auto Zero.

Die AnzeigeCalibration in Progress leuchtet während der Nullpunktkalibrierung rot. Am
Ende des Verfahrens:

• Wenn die Nullpunktkalibrierung erfolgreich war, leuchtet die Anzeige Calibration
in Progress wieder grün und ein neuer Nullpunktwert wird angezeigt.

• Wenn die Kalibrierung fehlgeschlagen ist, leuchtet die Anzeige Calibration Failure
rot.

Nachbereitungsverfahren

Öffnen Sie die Ventile, um den normalen Durchfluss durch den Sensor wieder herzustellen.

Benötigen Sie Hilfe?  Wenn die Nullpunktkalibrierung fehlschlägt:

• Stellen Sie sicher, dass kein Durchfluss durch den Sensor erfolgt und wiederholen Sie das
Verfahren.

• Entfernen oder reduzieren Sie elektromagnetisches Rauschen und wiederholen Sie das
Verfahren.

• Setzen Sie Zero Time auf einen niedrigeren Wert und wiederholen Sie das Verfahren.

• Sollte eine Nullpunktkalibrierung weiterhin nicht möglich sein, wenden Sie sich an
Micro Motion.

• Wenn das Durchflussmesssystem mit einem zuvor verwendeten Nullpunktwert wieder in
Betrieb genommen werden soll:

- Wiederherstellen des werksseitig eingestellten Nullpunktwertes: ProLink > Zero Verification
and Calibration > Calibrate Zero > Restore Factory Zero .

- Wiederherstellen des zuletzt gültigen Nullpunktwertes vom Speicher der
Auswerteelektronik: ProLink > Zero Verification and Calibration > Calibrate Zero > Restore Prior
Zero . Restore Prior Zero ist nur dann verfügbar, wenn das Fenster Flow Calibration angezeigt
wird. Wenn das Fenster Flow Calibration geschlossen wird, kann der vorige Nullpunktwert
nicht mehr wiederhergestellt werden.

Einschränkung
Den werksseitigen Nullpunkt nur dann wiederherstellen, wenn das Durchflussmesssystem als eine
Einheit erworben wurde, der Nullpunkt im Werk kalibriert wurde und die Originalteile verwendet
werden.
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19.1.2 Nullpunktkalibrierung des Durchflussmesssystems
mittels ProLink III
Die Nullpunktkalibrierung des Durchflussmesssystems etabliert einen Basiswert für die
Prozessmessung, indem der Sensorausgang analysiert wird, wenn kein Durchfluss im
Messrohr vorhanden ist.

Vorbereitungsverfahren

ProLink III muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Vorbereiten des Durchflussmesssystems:

a. Lassen Sie das Durchflussmesssystem nach dem Einschalten mindestens
20 Minuten aufwärmen.

b. Lassen Sie das Prozessmedium durch den Sensor strömen, bis die
Sensortemperatur ungefähr die normale Betriebstemperatur erreicht hat.

c. Stoppen Sie den Durchfluss durch den Sensor, indem Sie das in Flussrichtung
abwärts liegende Ventil und danach das in Flussrichtung aufwärts liegende Ventil
schließen (falls verfügbar).

d. Stellen Sie sicher, dass der Sensor abgesperrt ist, kein Durchfluss mehr
vorhanden ist und der Sensor vollständig mit dem Prozessmedium gefüllt ist.

e. Beobachten Sie die Werte für Antriebsverstärkung, Temperatur und Dichte. Sind
diese stabil, prüfen Sie den Wert Live Zero oder Field Verification Zero. Wenn der
Mittelwert nahe bei 0 liegt, muss der Nullpunkt des Durchflussmesssystems
nicht kalibriert werden.

2. Wählen Sie Device Tools > Calibration > Zero Verification and Calibration.

3. Klicken Sie auf Calibrate Zero.

4. Ändern Sie Zero Time, falls gewünscht.

Unter Zero Time versteht man die Zeit, die der Auswerteelektronik vorgegeben wird,
um den Referenzpunkt bei einem Durchfluss von Null zu bestimmen. Die
voreingestellte Zero Time beträgt 20 Sekunden. Für die meisten Anwendungen ist die
voreingestellte Zero Time ausreichend.

5. Klicken Sie auf Calibrate Zero.

Die Meldung Calibration in Progress wird angezeigt. Wenn die Kalibrierung
abgeschlossen ist:

• Wenn die Nullpunktkalibrierung erfolgreich war, wird die Meldung Calibration
Success angezeigt und ein neuer Nullpunktwert wird angezeigt.

• Wenn die Nullpunktkalibrierung fehlgeschlagen ist, wird die Meldung Calibration
Failed angezeigt.

Nachbereitungsverfahren

Öffnen Sie die Ventile, um den normalen Durchfluss durch den Sensor wieder herzustellen.

Benötigen Sie Hilfe?  Wenn die Nullpunktkalibrierung fehlschlägt:

• Stellen Sie sicher, dass kein Durchfluss durch den Sensor erfolgt und wiederholen Sie das
Verfahren.
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• Entfernen oder reduzieren Sie elektromagnetisches Rauschen und wiederholen Sie das
Verfahren.

• Setzen Sie Zero Time auf einen niedrigeren Wert und wiederholen Sie das Verfahren.

• Sollte eine Nullpunktkalibrierung weiterhin nicht möglich sein, wenden Sie sich an
Micro Motion.

• Wenn das Durchflussmesssystem mit einem zuvor verwendeten Nullpunktwert wieder in
Betrieb genommen werden soll:

- Wiederherstellen des werksseitig eingestellten Nullpunktwertes: Device Tools > Zero
Verification and Calibration > Calibrate Zero > Restore Factory Zero .

- Wiederherstellen des zuletzt gültigen Nullpunktwertes vom Speicher der
Auswerteelektronik: Device Tools > Zero Verification and Calibration > Calibrate Zero > Restore Prior
Zero . Restore Prior Zero ist nur dann verfügbar, wenn das Fenster Flow Calibration angezeigt
wird. Wenn das Fenster Flow Calibration geschlossen wird, kann der vorige Nullpunktwert
nicht mehr wiederhergestellt werden.

Einschränkung
Den werksseitigen Nullpunkt nur dann wiederherstellen, wenn das Durchflussmesssystem als eine
Einheit erworben wurde, der Nullpunkt im Werk kalibriert wurde und die Originalteile verwendet
werden.

19.1.3 Nullpunktkalibrierung des Durchflussmesssystems
mittels PROFIBUS EDD
Die Nullpunktkalibrierung des Durchflussmesssystems etabliert einen Basiswert für die
Prozessmessung, indem der Sensorausgang analysiert wird, wenn kein Durchfluss im
Messrohr vorhanden ist.

Vorbereitungsverfahren

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, die PROFIBUS EDD muss installiert
sein und Sie müssen eine Verbindung mit der Auswerteelektronik hergestellt haben.

Vorbereiten des Durchflussmesssystems:

1. Zeichnen Sie den gespeicherten Nullpunktwert auf.

2. Lassen Sie das Durchflussmesssystem nach dem Einschalten mindestens 20 Minuten
aufwärmen.

3. Lassen Sie das Prozessmedium durch den Sensor strömen, bis die Sensortemperatur
ungefähr die normale Betriebstemperatur erreicht hat.

4. Stoppen Sie den Durchfluss durch den Sensor, indem Sie das in Flussrichtung
abwärts liegende Ventil und danach das in Flussrichtung aufwärts liegende Ventil
schließen (falls verfügbar).

5. Stellen Sie sicher, dass der Sensor abgesperrt ist, kein Durchfluss mehr vorhanden ist
und der Sensor vollständig mit dem Prozessmedium gefüllt ist.

6. Beobachten Sie die Werte für Antriebsverstärkung, Temperatur und Dichte. Sind
diese stabil, prüfen Sie den Wert Live Zero oder Field Verification Zero. Wenn der
Mittelwert nahe bei 0 liegt, muss der Nullpunkt des Durchflussmesssystems nicht
kalibriert werden.

Wichtig
In vielen Fällen wurde der Nullpunkt des Durchflussmesssystems bereits im Werk kalibriert und
erfordert deshalb keine erneute Kalibrierung vor Ort.
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Anmerkung
Verifizieren bzw. kalibrieren Sie den Nullpunkt nicht, wenn ein Alarm mit hoher Priorität aktiv ist. Das
Problem muss erst behoben werden, bevor der Nullpunkt des Durchflussmesssystems verifiziert
bzw. kalibriert wird. Sie können den Nullpunkt verifizieren bzw. kalibrieren, wenn ein Alarm mit
niedriger Priorität aktiv ist.

Verfahren

1. Wählen SieService Tools > Wartung > Nullabgleich.

2. Klicken Sie auf Perform Auto Zero.

3. Folgen Sie den Anweisungen in der geführten Verfahren.

Unter Zero Time versteht man die Zeit, die der Auswerteelektronik vorgegeben wird,
um den Referenzpunkt bei einem Durchfluss von Null zu bestimmen. Die
voreingestellte Zero Time beträgt 20 Sekunden. Für die meisten Anwendungen ist die
voreingestellte Zero Time ausreichend.

Nachbereitungsverfahren

Öffnen Sie die Ventile, um den normalen Durchfluss durch den Sensor wieder herzustellen.

Benötigen Sie Hilfe?  Wenn die Nullpunktkalibrierung fehlschlägt:

• Stellen Sie sicher, dass kein Durchfluss durch den Sensor erfolgt und wiederholen Sie das
Verfahren.

• Entfernen oder reduzieren Sie elektromagnetisches Rauschen und wiederholen Sie das
Verfahren.

• Setzen Sie Zero Time auf einen niedrigeren Wert und wiederholen Sie das Verfahren.

• Sollte eine Nullpunktkalibrierung weiterhin nicht möglich sein, wenden Sie sich an
Micro Motion.

• Wenn das Durchflussmesssystem mit einem zuvor verwendeten Nullpunktwert wieder in
Betrieb genommen werden soll:

19.1.4 Nullpunktkalibrierung des Durchflussmesssystems
mittels PROFIBUS Busparameter
Die Nullpunktkalibrierung des Durchflussmesssystems etabliert einen Basiswert für die
Prozessmessung, indem der Sensorausgang analysiert wird, wenn kein Durchfluss im
Messrohr vorhanden ist.

Vorbereitungsverfahren

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, das DP-V1 Lese- und
Schreibdienste unterstützt, und Sie müssen eine Verbindung mit der Auswerteelektronik
hergestellt haben.

Vorbereiten des Durchflussmesssystems:

1. Zeichnen Sie den gespeicherten Nullpunktwert auf.

2. Lassen Sie das Durchflussmesssystem nach dem Einschalten mindestens 20 Minuten
aufwärmen.

3. Lassen Sie das Prozessmedium durch den Sensor strömen, bis die Sensortemperatur
ungefähr die normale Betriebstemperatur erreicht hat.
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4. Stoppen Sie den Durchfluss durch den Sensor, indem Sie das in Flussrichtung
abwärts liegende Ventil und danach das in Flussrichtung aufwärts liegende Ventil
schließen (falls verfügbar).

5. Stellen Sie sicher, dass der Sensor abgesperrt ist, kein Durchfluss mehr vorhanden ist
und der Sensor vollständig mit dem Prozessmedium gefüllt ist.

6. Beobachten Sie die Werte für Antriebsverstärkung, Temperatur und Dichte. Sind
diese stabil, prüfen Sie den Wert Live Zero oder Field Verification Zero. Wenn der
Mittelwert nahe bei 0 liegt, muss der Nullpunkt des Durchflussmesssystems nicht
kalibriert werden.

Wichtig
In vielen Fällen wurde der Nullpunkt des Durchflussmesssystems bereits im Werk kalibriert und
erfordert deshalb keine erneute Kalibrierung vor Ort.

Anmerkung
Verifizieren bzw. kalibrieren Sie den Nullpunkt nicht, wenn ein Alarm mit hoher Priorität aktiv ist. Das
Problem muss erst behoben werden, bevor der Nullpunkt des Durchflussmesssystems verifiziert
bzw. kalibriert wird. Sie können den Nullpunkt verifizieren bzw. kalibrieren, wenn ein Alarm mit
niedriger Priorität aktiv ist.

Verfahren

1. Schreiben Siedie gewünschte Zeit zum Null Kalibrierung Block, Index 7.

Unter Zero Time versteht man die Zeit, die der Auswerteelektronik vorgegeben wird,
um den Referenzpunkt bei einem Durchfluss von Null zu bestimmen. Die
voreingestellte Zero Time beträgt 20 Sekunden. Für die meisten Anwendungen ist die
voreingestellte Zero Time ausreichend.

2. Schreiben Sie ein in die Kalibrierung Block, Index 6 und dann warten, bis die
eingestellte Anzahl von Sekunden.

3. Lesen Statuswort 5, Nr. 15 Bit (0x8000) um den Nullverfahren zu überwachen.

Wert Beschreibung

0 Null komplette

1 Zero in Fortschritt

4. Lesen Statuswort 3, Bit # 9, # 10 und # 11 (0x0200, 0x0400, 0x0800 und) für die
Ergebnis der Null Verfahren.

Bit (hexade-
zimal)

Bit (dezi-
mal) Zustand Wert

0x0200 9 Null-Fehler: Null zu niedrig • 0 = Zustand inaktiv
• 1 = Zustand aktiv

0x0400 10 Null-Fehler: Null zu hoch • 0 = Zustand inaktiv
• 1 = Zustand aktiv

0x0800 11 Null-Fehler: Instabile • 0 = Zustand inaktiv
• 1 = Zustand aktiv

Wenn alle drei Bedingungen inaktiv sind, gelang es der Null.
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Nachbereitungsverfahren

Öffnen Sie die Ventile, um den normalen Durchfluss durch den Sensor wieder herzustellen.

Benötigen Sie Hilfe?  Wenn die Nullpunktkalibrierung fehlschlägt:

• Stellen Sie sicher, dass kein Durchfluss durch den Sensor erfolgt und wiederholen Sie das
Verfahren.

• Entfernen oder reduzieren Sie elektromagnetisches Rauschen und wiederholen Sie das
Verfahren.

• Setzen Sie Zero Time auf einen niedrigeren Wert und wiederholen Sie das Verfahren.

• Sollte eine Nullpunktkalibrierung weiterhin nicht möglich sein, wenden Sie sich an
Micro Motion.

• Wenn das Durchflussmesssystem mit einem zuvor verwendeten Nullpunktwert wieder in
Betrieb genommen werden soll:

19.2 Messsystem validieren

ProLink II ProLink > Configuration > Flow

ProLink III Device Tools > Configuration > Process Measurement > Flow

Device Tools > Configuration > Process Measurement > Density

PROFIBUS EDD Configure > Manual Setup > Measurements

PROFIBUS Buspara-

meter

Massefaktor: Block: Messung, Index 15

Volumenfaktor: Block: Messung, Index 17

Dichtefaktor: Block: Messung, Index 16

Überblick

Die Systemvalidierung vergleicht die von der Auswerteelektronik ausgegebenen
Messwerte des Durchflussmessgeräts mit einem externen Messnormal. Weicht der von
der Auswerteelektronik ausgegebene Massdurchfluss-, Volumendurchfluss- oder
Dichtemesswert signifikant vom externen Messnormal ab, sollte der entsprechende
Gerätefaktor gesetzt werden. Der tatsächliche Messwert des Durchflussmessgeräts wird
mit dem Gerätefaktor multipliziert und der resultierende Wert wird ausgegeben und für
die weitere Verarbeitung verwendet.

Vorbereitungsverfahren

Identifizieren Sie den/die Gerätefaktor(en), den/die Sie berechnen und setzen werden. Sie
können jede Kombination der drei Gerätefaktoren setzen: Massedurchfluss,
Volumendurchfluss und Dichte. Beachten Sie, dass alle drei Gerätefaktoren unabhängig
sind:

• Der Gerätefaktor für Massedurchfluss beeinflusst nur den ausgegebenen Wert des
Massedurchflusses.

• Der Gerätefaktor für Dichte beeinflusst nur den ausgegebenen Wert der Dichte.

• Der Gerätefaktor für Volumendurchfluss beeinflusst nur den ausgegebenen Wert
des Volumendurchflusses.
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Wichtig
Zum Justieren des Volumendurchflusses ist der Gerätefaktor für Volumendurchfluss zu setzen. Das
Setzen des Gerätefaktors für Massedurchfluss und des Gerätefaktors für Dichte erzeugt nicht das
gewünschte Ergebnis. Die Berechnung des Volumendurchflusses basiert auf den originalen
Massedurchfluss- und Dichtewerten, bevor der entsprechende Gerätefaktor angewendet wird.

Wenn Sie vorhaben, den Gerätefaktor des Volumendurchflusses zu berechnen, sollten Sie
beachten, dass das Validieren des Volumens in der Anlage kostspielig sein kann. Dieser
Vorgang kann bei manchen Prozessmedien außerdem gefährlich sein. Da das Volumen
umgekehrt proportional zur Dichte ist, ist die Berechnung des Gerätefaktors für
Volumendurchfluss von dem Gerätefaktor für Dichte eine alternative zur direkten
Messung. Anweisungen für diese Methode finden Sie in Abschnitt Abschnitt 19.2.1.

Stellen Sie ein Referenzgerät (ein externes Messgerät) für die entsprechende
Prozessvariable bereit.

Wichtig
Das Referenzgerät muss äußerst genau sein, um zuverlässige Ergebnisse zu erzielen.

Verfahren

1. Bestimmen Sie den Gerätefaktor wie folgt:

a. Nehmen Sie eine Probemessung mit dem Durchflussmessgerät vor.

b. Messen Sie die gleiche Probe mit dem Referenzgerät.

c. Berechnen Sie den Gerätefaktor mit folgender Formel:

NeuerGerätefaktor KonfigurierterGerätefaktor
Referenzmessung

Durchfluss-MesssystemMessung
= x

2. Stellen Sie sicher, dass der berechnete Gerätefaktor zwischen 0,8 und 1,2 liegt
(inklusive). Wenn der Gerätefaktor außerhalb dieser Grenzen liegt, setzen Sie sich
mit dem Micro Motion Kundenservice in Verbindung.

3. Konfigurieren Sie den Gerätefaktor in der Auswerteelektronik.

Beispiel: Gerätefaktor für Massedurchfluss berechnen

Das Durchflussmesssystem wird zum ersten Mal installiert und verifiziert. Der von der
Auswerteelektronik gemessene Massedurchfluss beträgt 250,27 lb. Der vom
Referenzgerät gemessene Massedurchfluss beträgt 250 lb. Der Gerätefaktor für
Massedurchfluss wird wie folgt berechnet:

GerätefaktorMassedurchfluss 1
250

250,27
= x = 0,9989

Der erste Gerätefaktor für Massedurchfluss ist 0,9989.

Ein Jahr später wird das Durchflussmesssystem erneut validiert. Der von der
Auswerteelektronik gemessene Massedurchfluss beträgt 250,07 lb. Der vom
Referenzgerät gemessene Massedurchfluss beträgt 250,25 lb. Der neue Gerätefaktor für
Massedurchfluss wird wie folgt berechnet:
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GerätefaktorMassedurchfluss 0,9989 250,25

250,07
= x = 0,9996

Der neue Gerätefaktor für Massedurchfluss ist 0.9996.

19.2.1 Alternative Methode für die Berechnung des
Gerätefaktors für Volumendurchfluss
Die alternative Methode für die Berechnung des Gerätefaktors für Volumendurchfluss wird
verwendet, um die Schwierigkeiten zu vermeiden, die bei Verwendung der
Standardmethode auftreten können.

Diese alternative Methode basiert auf der Tatsache, dass das Volumen umgekehrt
proportional zur Dichte ist. Sie bietet eine Teilkorrektur der Volumendurchflussmessung
durch Justierung des Anteils des Gesamt Offsets, der durch den Offset der Dichtemessung
begründet ist. Verwenden Sie diese Methode nur dann, wenn keine Referenz für den
Volumendurchfluss verfügbar ist, jedoch eine Referenz für die Dichte.

Verfahren

1. Berechnen Sie den Gerätefaktor für Dichte unter Verwendung der
Standardmethode (siehe Abschnitt 19.2).

2. Berechnen Sie den Gerätefaktor für Volumendurchfluss vom Gerätefaktor für die
Dichte:

GerätefaktorVolumen
1

GerätefaktorDichte
=

Anmerkung
Die folgende Gleichung ist mathematisch äquivalent zur ersten Gleichung. Sie können die
Gleichung verwenden, die Sie bevorzugen.

GerätefaktorVolumen KonfigurierterGerätefaktorDichte
DichteDurchfluss-Messsystem

DichteReferenzgerät
= x

3. Stellen Sie sicher, dass der berechnete Gerätefaktor zwischen 0,8 und 1,2 liegt
(inklusive). Wenn der Gerätefaktor außerhalb dieser Grenzen liegt, setzen Sie sich
mit dem Micro Motion Kundenservice in Verbindung.

4. Konfigurieren Sie den Gerätefaktor für Volumendurchfluss in der
Auswerteelektronik.

19.3 (Standard) D1 und D2 Dichtekalibrierung
durchführen
Mittels der Dichtekalibrierung wird das Verhältnis zwischen der Mediumsdichte bei
Dichtekalibrierung und dem vom Sensor erzeugten Signal ermittelt. Die
Dichtekalibrierung umfasst das Kalibrieren der Kalibrierpunkte D1 (niedrige Dichte) und
D2 (hohe Dichte).
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Wichtig
Micro Motion Auswerteelektroniken werden werksseitig kalibriert und müssen normalerweise nicht
vor Ort kalibriert werden. Führen Sie eine Kalibrierung des Durchflussmessers nur dann durch, wenn
dies durch gesetzliche Bestimmungen gefordert wird. Wenden Sie sich an Micro Motion, bevor Sie
den Durchflussmesser kalibrieren.

Hinweis
Micro Motion empfiehlt eine Systemvalidierung und die Verwendung von Gerätefaktoren anstatt
einer Kalibrierung, um den Durchflussmesser auf ein geeichtes Messnormal abzugleichen oder einen
Messfehler zu korrigieren.

19.3.1 Durchführen einer D1- und D2-Dichtekalibrierung
mittels ProLink II
Vorbereitungsverfahren

• Während der Dichtekalibrierung muss der Sensor komplett mit dem
Kalibriermedium gefüllt sein und der Durchfluss durch den Sensor muss so klein
sein, wie es Ihre Anwendung ermöglicht. Dies wird normalerweise durch Schließen
des auslaufseitig vom Sensor befindlichen Absperrventils erreicht. Anschließend
füllen Sie den Sensor mit dem entsprechenden Medium.

• Die D1 und D2 Dichtekalibrierung erfordert ein D1 Medium (niedrige Dichte) und
ein D2 Medium (hohe Dichte). Hierfür können Sie Luft und Wasser nehmen.

• Die Kalibrierverfahren müssen ohne Unterbrechung in der gezeigten Reihenfolge
durchgeführt werden. Stellen Sie sicher, dass Sie das Verfahren ohne
Unterbrechungen abschließen können.

• Bevor Sie die Kalibrierung durchführen, notieren Sie die aktuellen
Kalibrierparameter. Sie können dies tun, in dem Sie die aktuelle Konfiguration als
Datei auf dem PC speichern. Sollte die Kalibrierung fehlschlagen, können die alten
Werte zurückgespeichert werden.

Verfahren

Siehe Abbildung 19-1.
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D1- und D2-Dichtekalibrierung mittels ProLink IIAbbildung 19-1:   

Dichte des D1 Mediums eingeben

Calibration in Progress LED wechselt auf 
grün

Calibration in Progress LED wechselt auf 
rot

D1 Kalibrierung

Absperrventil schliessen, auslaufseitig 
vom Sensor Sensor mit D1 Medium füllen Sensor mit D2 Medium füllen

Schliessen

Dichte des D2 Mediums eingeben

Calibration in Progress LED wechselt auf 
grün

Calibration in Progress LED wechselt auf 
rot

D2 Kalibrierung

Schliessen

Fertig

Kalibrierung 
ausführen

Kalibrierung 
ausführen

ProLink Menü >
 Calibration >
 Density cal – Point 1

ProLink Menü >
 Calibration >
 Density cal – Point 2

19.3.2 Durchführen einer D1- und D2-Dichtekalibrierung
mittels ProLink III
Vorbereitungsverfahren

• Während der Dichtekalibrierung muss der Sensor komplett mit dem
Kalibriermedium gefüllt sein und der Durchfluss durch den Sensor muss so klein
sein, wie es Ihre Anwendung ermöglicht. Dies wird normalerweise durch Schließen
des auslaufseitig vom Sensor befindlichen Absperrventils erreicht. Anschließend
füllen Sie den Sensor mit dem entsprechenden Medium.

• Die D1 und D2 Dichtekalibrierung erfordert ein D1 Medium (niedrige Dichte) und
ein D2 Medium (hohe Dichte). Hierfür können Sie Luft und Wasser nehmen.

• Die Kalibrierverfahren müssen ohne Unterbrechung in der gezeigten Reihenfolge
durchgeführt werden. Stellen Sie sicher, dass Sie das Verfahren ohne
Unterbrechungen abschließen können.

• Bevor Sie die Kalibrierung durchführen, notieren Sie die aktuellen
Kalibrierparameter. Sie können dies tun, in dem Sie die aktuelle Konfiguration als
Datei auf dem PC speichern. Sollte die Kalibrierung fehlschlagen, können die alten
Werte zurückgespeichert werden.

Verfahren

Siehe Abbildung 19-2.
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D1- und D2-Dichtekalibrierung mittels ProLink IIIAbbildung 19-2:   
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19.3.3 Durchführen einer D1- und D2-Dichtekalibrierung
mittels PROFIBUS EDD
Vorbereitungsverfahren

• Während der Dichtekalibrierung muss der Sensor komplett mit dem
Kalibriermedium gefüllt sein und der Durchfluss durch den Sensor muss so klein
sein, wie es Ihre Anwendung ermöglicht. Dies wird normalerweise durch Schließen
des auslaufseitig vom Sensor befindlichen Absperrventils erreicht. Anschließend
füllen Sie den Sensor mit dem entsprechenden Medium.

• Die D1 und D2 Dichtekalibrierung erfordert ein D1 Medium (niedrige Dichte) und
ein D2 Medium (hohe Dichte). Hierfür können Sie Luft und Wasser nehmen.

• Die Kalibrierverfahren müssen ohne Unterbrechung in der gezeigten Reihenfolge
durchgeführt werden. Stellen Sie sicher, dass Sie das Verfahren ohne
Unterbrechungen abschließen können.

• Bevor Sie die Kalibrierung durchführen, notieren Sie sich die aktuellen
Kalibrierparameter. Sollte die Kalibrierung fehlschlagen, können die alten Werte
zurückgespeichert werden.

Verfahren

1. Durchführen einer D1-Kalibrierung:

a. Den Sensor mit dem D1-Medium befüllen.

b. Service Tools > Maintenance > Density Calibrations > First Point Calibration auswählen.

Der erste Bildschirm der geführten Methode wird angezeigt.
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c. Den Anweisungen im geführten Verfahren folgen.

2. Durchführen einer D2-Kalibrierung:

a. Den Sensor mit dem D2-Medium befüllen.

b. Service Tools > Maintenance > Density Calibrations > Second Point Calibration auswählen.

Der erste Bildschirm der geführten Methode wird angezeigt.

c. Den Anweisungen im geführten Verfahren folgen.

19.3.4 Durchführen einer D1- und D2-Dichtekalibrierung
mittels PROFIBUS Busparameter
Vorbereitungsverfahren

• Während der Dichtekalibrierung muss der Sensor komplett mit dem
Kalibriermedium gefüllt sein und der Durchfluss durch den Sensor muss so klein
sein, wie es Ihre Anwendung ermöglicht. Dies wird normalerweise durch Schließen
des auslaufseitig vom Sensor befindlichen Absperrventils erreicht. Anschließend
füllen Sie den Sensor mit dem entsprechenden Medium.

• Die D1 und D2 Dichtekalibrierung erfordert ein D1 Medium (niedrige Dichte) und
ein D2 Medium (hohe Dichte). Hierfür können Sie Luft und Wasser nehmen.

• Die Kalibrierverfahren müssen ohne Unterbrechung in der gezeigten Reihenfolge
durchgeführt werden. Stellen Sie sicher, dass Sie das Verfahren ohne
Unterbrechungen abschließen können.

• Bevor Sie die Kalibrierung durchführen, notieren Sie sich die aktuellen
Kalibrierparameter. Sollte die Kalibrierung fehlschlagen, können die alten Werte
zurückgespeichert werden.

Verfahren

Siehe Abbildung 19-3.

Messunterstützung

252  Micro Motion® Auswerteelektronik für Masseabfüllung mit PROFIBUS-DP



Durchführen einer D1- und D2-Kalibrierung mittels PROFIBUS
Busparameter

Abbildung 19-3:   
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19.4 Durchführen einer Temperaturkalibrierung
Die Temperaturkalibrierung stellt die Beziehung zwischen der Temperatur der
Kalibriermedien und dem vom Sensor erzeugten Signal her.

19.4.1 Durchführen einer Temperaturkalibrierung mit ProLink II
Die Temperaturkalibrierung stellt die Beziehung zwischen der Temperatur der
Kalibriermedien und dem vom Sensor erzeugten Signal her.

Vorbereitungsverfahren

Die Temperaturkalibrierung ist ein zweiteiliges Verfahren: die Kalibrierung des
Temperatur-Offsets und die Kalibrierung der Temperatursteigung Die beiden
Kalibrierverfahren müssen ohne Unterbrechung in der gezeigten Reihenfolge
durchgeführt werden. Stellen Sie sicher, dass Sie das Verfahren ohne Unterbrechungen
abschließen können.

Wichtig
Wenden Sie sich an Micro Motion, bevor Sie eine Temperaturkalibrierung durchführen. Unter
normalen Umständen ist der Temperaturkreis stabil und sollte nicht eingestellt werden müssen.

Verfahren

Siehe Abbildung 19-4.
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Temperaturkalibrierung mit ProLink IIAbbildung 19-4:   
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19.4.2 Durchführen einer Temperaturkalibrierung mit
ProLink III
Die Temperaturkalibrierung stellt die Beziehung zwischen der Temperatur der
Kalibriermedien und dem vom Sensor erzeugten Signal her.

Vorbereitungsverfahren

Die Temperaturkalibrierung ist ein zweiteiliges Verfahren: die Kalibrierung des
Temperatur-Offsets und die Kalibrierung der Temperatursteigung Die beiden
Kalibrierverfahren müssen ohne Unterbrechung in der gezeigten Reihenfolge
durchgeführt werden. Stellen Sie sicher, dass Sie das Verfahren ohne Unterbrechungen
abschließen können.

Wichtig
Wenden Sie sich an Micro Motion, bevor Sie eine Temperaturkalibrierung durchführen. Unter
normalen Umständen ist der Temperaturkreis stabil und sollte nicht eingestellt werden müssen.

Verfahren

Siehe #unique_263/PL3TempCalFig.
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Temperaturkalibrierung mit ProLink IIIAbbildung 19-5:   
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20 Störungsanalyse und -behebung
In diesem Kapitel behandelte Themen:

• Status Alarme

• Probleme bei Durchflussmessungen

• Probleme bei Dichtemessungen

• Probleme bei der Temperaturmessung

• Probleme bei mA-Ausgängen

• Probleme beim Frequenzausgang

• Verwenden der Sensorsimulation zur Störungsanalyse und -beseitigung

• Verdrahtung der Spannungsversorgung prüfen

• Erdung überprüfen

• Messkreistests durchführen

• mA Ausgänge abgleichen

• Prüfen von Messanfang und Messende
• mA Ausgang Störaktion prüfen

• Prüfung auf hochfrequente Störungen (RFI)

• Frequenzausgang max. Impulsbreite prüfen

• Frequenzausgang Skaliermethode prüfen

• Frequenzausgang Störaktion prüfen

• Prüfen der Durchflussrichtung
• Prüfen der Abschaltungen

• Prüfen auf Schwallströmung (Zweiphasenströmung)

• Antriebsverstärkung prüfen

• Aufnehmerspannung prüfen

• Prüfen auf elektrische Kurzschlüsse

20.1 Status Alarme

Statusalarme und empfohlene MaßnahmenTabelle 20-1:   

Alarm Code Beschreibung Ursache Empfohlene Maßnahmen

A001 EEPROM-Fehler (Core-
Prozessor)

Ein nicht korrigierbarer
Prüfsummenfehler
wurde festgestellt.

• Die Spannungsversorgung zum Messsystem
aus-/einschalten.

• Wenden Sie sich an Micro Motion.

A002 RAM-Fehler (Core-Pro-
zessor)

ROM Prüfsummenfeh-
ler oder ein RAM Be-
reich kann nicht bes-
chrieben werden.

• Die Spannungsversorgung zum Messsystem
aus-/einschalten.

• Wenden Sie sich an Micro Motion.
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Statusalarme und empfohlene Maßnahmen (Fortsetzung)Tabelle 20-1:   

Alarm Code Beschreibung Ursache Empfohlene Maßnahmen

A003 Keine Antwort vom
Sensor

Durchgangsfehler des
Antriebskreises, LPO
oder RPO oder LPO-
RPO Fehler während
des Antriebs.

• Antriebsverstärkung und Aufnehmerspannung
prüfen. Siehe Abschnitt 20.21 und 
Abschnitt 20.22.

• Auf elektrische Kurzschlüsse prüfen. Siehe 
Abschnitt 20.23.

• Die Unversehrtheit der Sensormessrohre prü-
fen.

A004 Messbereichsübers-
chreitung für Tempera-
tur

Kombination von A016
und A017.

• Die Temperatur-Charakterisierungsparameter
(Temperaturkalibrierfaktor) prüfen.

• Überprüfen Sie Ihre Prozessbedingungen an-
hand der vom Durchflussmesser gemeldeten
Werte.

• Wenden Sie sich an Micro Motion.

A005 Messbereichsübers-
chreitung für Masse-
durchfluss

Der gemessene Durch-
fluss hat die maximale
Durchflussmenge des
Sensors überschritten
(ΔT größer als 200 µs).

• Sind andere Alarme vorhanden, diese Alarm-
bedingungen zuerst beheben. Besteht der ak-
tuelle Alarm weiterhin, fahren Sie mit den
Empfehlungen hier fort.

• Überprüfen Sie Ihre Prozessbedingungen an-
hand der vom Durchflussmesser gemeldeten
Werte.

• Auf Schwallströmung prüfen. Siehe 
Abschnitt 20.20.

• Antriebsverstärkung und Aufnehmerspannung
prüfen. Siehe Abschnitt 20.21 und 
Abschnitt 20.22.

• Auf elektrische Kurzschlüsse prüfen. Siehe 
Abschnitt 20.23.

• Die Unversehrtheit der Sensormessrohre prü-
fen.

• Wenden Sie sich an Micro Motion.

A006 Charakterisierung erfor-
derlich

Kalibrierfaktoren wur-
den nicht eingegeben
und der Sensortyp ist
falsch.

• Prüfen Sie, ob alle Charakterisierungsparame-
ter den Daten auf dem Sensor-Tag entspre-
chen.

• Wenden Sie sich an Micro Motion.
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Statusalarme und empfohlene Maßnahmen (Fortsetzung)Tabelle 20-1:   

Alarm Code Beschreibung Ursache Empfohlene Maßnahmen

A008 Dichte Bereichsübers-
chreitung

Die gemessene Dichte
hat 10 g/cm3 übers-
chritten

• Sind andere Alarme vorhanden, diese Alarm-
bedingungen zuerst beheben. Besteht der ak-
tuelle Alarm weiterhin, fahren Sie mit den
Empfehlungen hier fort.

• Die Prozessbedingungen prüfen, insbeson-
dere, ob Luft in den Messrohren vorhanden ist,
ob die Messrohre nicht gefüllt sind oder ob
sich Fremdkörper oder Ablagerungen in den
Messrohren befinden.

• Auf Schwallströmung prüfen. Siehe 
Abschnitt 20.20.

• Bei gleichzeitigem A003-Alarm auf elektrische
Kurzschlüsse prüfen. Siehe Abschnitt 20.23.

• Prüfen Sie, ob alle Charakterisierungsparame-
ter den Daten auf dem Sensor-Tag entspre-
chen.

• Antriebsverstärkung und Aufnehmerspannung
prüfen. Siehe Abschnitt 20.21 und 
Abschnitt 20.22.

• Dichtekalibrierung durchführen.
• Wenden Sie sich an Micro Motion.

A009 Auswerteelektronik Ini-
tialisierung/Aufwärm-
phase

Auswerteelektronik im
Einschaltmodus.

• Lassen Sie das Messsystem warmlaufen.
• Überprüfen Sie, ob die Messrohre voll mit Pro-

zessmedium gefüllt.

A010 Kalibrierfehler Viele mögliche Ursa-
chen, wie beispielswe-
ise zu großer Durch-
fluss durch den Sensor
während eines Kali-
brierverfahrens.

• Erscheint während der Nullpunktkalibrierung
dieser Alarm, überprüfen Sie, ob kein Durch-
fluss durch den Sensor erfolgt, und versuchen
Sie es erneut.

• Spannungsversorgung aus-/einschalten und
erneut versuchen.

A011 Nullpunktkalibrierung
fehlgeschlagen: Tief

Viele mögliche Ursa-
chen, wie beispielswe-
ise zu großer Durch-
fluss – insbesondere
Rückwärtsdurchfluss –
durch den Sensor wäh-
rend eines Kalibrierver-
fahrens.

• Überprüfen Sie, ob kein Durchfluss durch den
Sensor erfolgt, und versuchen Sie es erneut.

• Spannungsversorgung aus-/einschalten und
erneut versuchen.

A012 Nullpunktkalibrierung
fehlgeschlagen: Hoch

Viele mögliche Ursa-
chen, wie beispielswe-
ise zu großer Durch-
fluss – insbesondere
Vorwärtsdurchfluss –
durch den Sensor wäh-
rend eines Kalibrierver-
fahrens.

• Überprüfen Sie, ob kein Durchfluss durch den
Sensor erfolgt, und versuchen Sie es erneut.

• Spannungsversorgung aus-/einschalten und
erneut versuchen.
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Statusalarme und empfohlene Maßnahmen (Fortsetzung)Tabelle 20-1:   

Alarm Code Beschreibung Ursache Empfohlene Maßnahmen

A013 Nullpunktkalibrierung
fehlgeschlagen: Instabil

Der Prozessbedingun-
gen während des Kali-
brierverfahrens waren
zu instabil.

• Entfernen oder reduzieren Sie die Quellen für
elektromagnetisches Rauschen (z. B. Pumpen,
Vibration, Rohrspannungen) und versuchen
Sie es erneut.

• Spannungsversorgung aus-/einschalten und
erneut versuchen.

A014 Auswerteelektronikfeh-
ler

Viele mögliche Ursa-
chen.

• Die Spannungsversorgung zum Messsystem
aus-/einschalten.

• Wenden Sie sich an Micro Motion.

A016 Sensor-RTD-Fehler Der berechnete Wider-
standswert des Lei-
tungs-RTDs liegt außer-
halb des Bereichs.

• Überprüfen Sie Ihre Prozessbedingungen an-
hand der vom Durchflussmesser gemeldeten
Werte.

• Wenden Sie sich an Micro Motion.

A017 T-Serien-RTD-Fehler Der berechnete Wider-
standswert für das RTD-
Messgerät/-Gehäuse
liegt außerhalb der
Grenzwerte.

• Überprüfen Sie Ihre Prozessbedingungen an-
hand der vom Durchflussmesser gemeldeten
Werte. Die Temperatur sollte zwischen -200 °F
und +400 °F liegen.

• Prüfen Sie, ob alle Charakterisierungsparame-
ter den Daten auf dem Sensor-Tag entspre-
chen.

• Wenden Sie sich an Micro Motion.

A020 K.wrt f. k. Drchflss Der Durchflusskalibrier-
faktor und/oder K1
wurden seit der letzten
Hauptrücksetzung
nicht eingegeben.

• Prüfen Sie, ob alle Charakterisierungsparame-
ter den Daten auf dem Sensor-Tag entspre-
chen.

A021 Falscher Sensortyp (K1) Der Sensor wird als Ger-
adrohr erkannt, aber
der K1-Wert deutet auf
einen Sensor mit gebo-
genem Messrohr hin
oder umgekehrt.

• Prüfen Sie, ob alle Charakterisierungsparame-
ter den Daten auf dem Sensor-Tag entspre-
chen.

A029 PIC/Tochterboard-Kom-
munikationsfehler

In einer Hardware-Zwi-
schenbaugruppe ist
eine Kommunikations-
störung aufgetreten.

• Wenden Sie sich an Micro Motion.

A030 Falscher Platinentyp • Wenden Sie sich an Micro Motion.

A031 Spannung zu niedrig Die Auswerteelektronik
erhält zu wenig Span-
nungsversorgung.

• Die Spannungsversorgung und deren Verdrah-
tung prüfen. Siehe Abschnitt 20.8.

A033 Unzureichendes Signal
von rechter/linker Auf-
nehmerspule

Kein Signal von LPO
oder RPO, vermutlich
schwingen die Sensor-
Messrohre nicht.

• Die Prozessbedingungen prüfen, insbeson-
dere, ob Luft in den Messrohren vorhanden ist,
ob die Messrohre nicht gefüllt sind oder ob
sich Fremdkörper oder Ablagerungen in den
Messrohren befinden.
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Statusalarme und empfohlene Maßnahmen (Fortsetzung)Tabelle 20-1:   

Alarm Code Beschreibung Ursache Empfohlene Maßnahmen

A102 Antrieb Bereichsübers-
chreitung

Die Antriebsleistung
(Spannung) hat die
Maximalleistung er-
reicht.

• Antriebsverstärkung und Aufnehmerspannung
prüfen. Siehe Abschnitt 20.21 und 
Abschnitt 20.22.

• Auf elektrische Kurzschlüsse prüfen. Siehe 
Abschnitt 20.23.

A104 Kalibrierung läuft Ein Kalibrierverfahren
läuft.

• Das Verfahren beenden lassen.
• Bei einer Nullpunktkalibrierung kann die Kali-

brierung abgebrochen, der Nullzeitparameter
auf einen niedrigeren Wert eingestellt und die
Kalibrierung erneut gestartet werden.

A105 Schwallströmung Die Dichte hat die be-
nutzerdefinierten
Schwallstromgrenzen
(Dichte) überschritten.

• Auf Schwallströmung prüfen. Siehe 
Abschnitt 20.20.

A107 Spannungsunterbre-
chung eingetreten

Die Auswerteelektronik
wurde neu gestartet.

• Keine Maßnahme erforderlich.
• Falls erforderlich, können Sie die Alarmstufe

auf Ignorieren neu konfigurieren.

A110 Frequenzausgang ge-
sättigt

Der berechnete Fre-
quenzausgangswert
liegt außerhalb des lin-
earen Bereichs.

• Die Skalierung des Frequenzausgangs über-
prüfen. Siehe Abschnitt 20.16.

• Prozessbedingungen überprüfen. Die aktuell-
en Bedingungen können jenseits der normalen
Bedingungen liegen, für die der Ausgang kon-
figuriert ist.

• Die Prozessbedingungen prüfen, insbeson-
dere, ob Luft in den Messrohren vorhanden ist,
ob die Messrohre nicht gefüllt sind oder ob
sich Fremdkörper oder Ablagerungen in den
Messrohren befinden.

• Prüfen Sie, ob die Messeinheiten für Ihre An-
wendung korrekt konfiguriert sind.

• Messrohre spülen.

A111 Frequenzausgang fixiert Der Frequenzausgang
wurde zum Senden
eines Direktwerts konfi-
guriert.

• Prüfen Sie, ob der Ausgang im Messkreistest-
Modus ist. Sollte das der Fall sein, den Aus-
gang lösen.

• Prüfen Sie, ob der Ausgang über die digitale
Kommunikation auf einen konstanten Wert
eingestellt wurde.
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Statusalarme und empfohlene Maßnahmen (Fortsetzung)Tabelle 20-1:   

Alarm Code Beschreibung Ursache Empfohlene Maßnahmen

A113 mA-Ausgang 2 gesät-
tigt

• Prozessbedingungen überprüfen. Die aktuell-
en Bedingungen können jenseits der normalen
Bedingungen liegen, für die der Ausgang kon-
figuriert ist.

• Die Prozessbedingungen prüfen, insbeson-
dere, ob Luft in den Messrohren vorhanden ist,
ob die Messrohre nicht gefüllt sind oder ob
sich Fremdkörper oder Ablagerungen in den
Messrohren befinden.

• Prüfen Sie, ob die Messeinheiten für Ihre An-
wendung korrekt konfiguriert sind.

• Messrohre spülen.
• Die Einstellungen für Messende (URV) und Mes-

sanfang (LRV) überprüfen. Siehe 
Abschnitt 20.12.

A114 mA-Ausgang 2 fest • Prüfen Sie, ob der Ausgang im Messkreistest-
Modus ist. Sollte das der Fall sein, den Aus-
gang lösen.

• Abgleich des mA-Ausgangs gegebenenfalls
beenden.

• Prüfen Sie, ob der Ausgang über die digitale
Kommunikation auf einen konstanten Wert
eingestellt wurde.

A118 Binärer mA Ausgang 1
fix

Der Binärausgang
wurde zum Senden
eines Direktwerts konfi-
guriert.

• Prüfen Sie, ob der Ausgang im Messkreistest-
Modus ist. Sollte das der Fall sein, den Aus-
gang lösen.

A132 Sensorsimulation aktiv Simulationsmodus ist
aktiviert.

• Keine Maßnahme erforderlich.
• Sensor-Simulation deaktivieren.

20.2 Probleme bei Durchflussmessungen

Probleme bei Durchflussmessungen und AbhilfemaßnahmenTabelle 20-2:   

Problem Mögliche Ursachen Empfohlene Maßnahmen

Durchflussrichtung-
sanzeige bei Null-
durchfluss oder Null-
punktverschiebung

• Nicht fluchtende Rohrleitung (speziell
bei neuen Installationen)

• Offenes oder undichtes Ventil
• Falscher Sensor-Nullpunkt

• Prüfen Sie, ob alle Charakterisierungspara-
meter den Daten auf dem Sensor-Tag en-
tsprechen.

• Ist der gemessene Durchfluss nicht besond-
ers hoch, die Echtzeit-Nullpunktkalibrierung
prüfen. Sie müssen die Werkseinstellung für
die Nullpunktkalibrierung wiederherstellen.

• Auf offene oder undichte Ventile oder Dich-
tungen prüfen.

• Den Sensor auf Montagespannungen prüfen
(z. B. Sensor zur Abstützung von Rohrleitun-
gen, nicht fluchtende Rohrleitungen).

• Wenden Sie sich an Micro Motion.
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Probleme bei Durchflussmessungen und Abhilfemaßnahmen (Fortsetzung)Tabelle 20-2:   

Problem Mögliche Ursachen Empfohlene Maßnahmen

Sprunghafter Durch-
fluss bei Nulldurch-
flussbedingungen

• Leckage an Ventil oder Abdichtung
• Slug flow
• Messrohr verstopft oder beschichtet
• Falsche Sensor-Einbaulage
• Verdrahtungsproblem
• Vibrationen der Rohrleitung nahe der

Sensor Messrohrfrequenz
• Dämpfungswert zu niedrig
• Montagespannungen auf dem Sensor

• Prüfen, ob die Sensor-Einbaulage zu Ihrer An-
wendung passt (siehe Sensor-Installationsan-
leitung).

• Antriebsverstärkung und Aufnehmerspan-
nung prüfen. Siehe Abschnitt 20.21 und 
Abschnitt 20.22.

• Messrohre spülen.
• Auf offene oder undichte Ventile oder Dich-

tungen prüfen.
• Die Ursache der Vibration prüfen.
• Die Dämpfungskonfiguration prüfen.
• Prüfen Sie, ob die Messeinheiten für Ihre An-

wendung korrekt konfiguriert sind.
• Auf Schwallströmung prüfen. Siehe 

Abschnitt 20.20.
• Auf HF-Störungen prüfen. Siehe 

Abschnitt 20.14.
• Wenden Sie sich an Micro Motion.

Sprunghafter Durch-
fluss bei stabilem
Durchfluss

• Slug flow
• Dämpfungswert zu niedrig
• Messrohr verstopft oder beschichtet
• Problem mit der Ausgangsverdrahtung
• Problem mit dem empfangenden Gerät
• Verdrahtungsproblem

• Prüfen, ob die Sensor-Einbaulage zu Ihrer An-
wendung passt (siehe Sensor-Installationsan-
leitung).

• Antriebsverstärkung und Aufnehmerspan-
nung prüfen. Siehe Abschnitt 20.21 und 
Abschnitt 20.22.

• Auf Luftanteile, Verschmutzung, Dampfbil-
dung oder Beschädigung des Messrohres
prüfen.

• Messrohre spülen.
• Auf offene oder undichte Ventile oder Dich-

tungen prüfen.
• Die Ursache der Vibration prüfen.
• Die Dämpfungskonfiguration prüfen.
• Prüfen Sie, ob die Messeinheiten für Ihre An-

wendung korrekt konfiguriert sind.
• Auf Schwallströmung prüfen. Siehe 

Abschnitt 20.20.
• Auf HF-Störungen prüfen. Siehe 

Abschnitt 20.14.
• Wenden Sie sich an Micro Motion.
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Probleme bei Durchflussmessungen und Abhilfemaßnahmen (Fortsetzung)Tabelle 20-2:   

Problem Mögliche Ursachen Empfohlene Maßnahmen

Ungenauer Durchfluss
oder Batchmenge

• Verdrahtungsproblem
• Ungeeignete Maßeinheit
• Falscher Durchflusskalibrierfaktor
• Falscher Gerätefaktor
• Falsche Dichtekalibrierfaktoren
• Falsche Erdung des Durchflussmessers
• Slug flow
• Problem mit dem empfangenden Gerät

• Prüfen Sie, ob die Messeinheiten für Ihre An-
wendung korrekt konfiguriert sind.

• Prüfen Sie, ob alle Charakterisierungspara-
meter den Daten auf dem Sensor-Tag en-
tsprechen.

• Mit einem Eimertest die Gesamtcharge über-
prüfen.

• Nullpunktkalibrierung des Messsystems.
• Erdung prüfen. Siehe Abschnitt 20.9.
• Auf Schwallströmung prüfen. Siehe 

Abschnitt 20.20.
• Das empfangende Gerät sowie die Verdrah-

tung zwischen Auswerteelektronik und Core-
Prozessor prüfen.

• Kern-Prozessor oder Auswerteelektronik aus-
tauschen.

20.3 Probleme bei Dichtemessungen

Probleme bei Dichtemessungen und AbhilfemaßnahmenTabelle 20-3:   

Problem Mögliche Ursachen Empfohlene Maßnahmen

Ungenauer Dichte-
wert

• Problem mit dem Prozessmedium
• Falsche Dichtekalibrierfaktoren
• Verdrahtungsproblem
• Falsche Erdung des Durchflussmessers
• Slug flow
• Messrohr verstopft oder beschichtet
• Falsche Sensor-Einbaulage
• Fehlerhafter Widerstandsthermometer
• Physikalische Charakteristik des Sensors

hat sich geändert

• Erdung prüfen. Siehe Abschnitt 20.9.
• Überprüfen Sie Ihre Prozessbedingungen an-

hand der vom Durchflussmesser gemeldeten
Werte.

• Prüfen Sie, ob alle Charakterisierungspara-
meter den Daten auf dem Sensor-Tag en-
tsprechen.

• Auf Schwallströmung prüfen. Siehe 
Abschnitt 20.20.

• Zwei Sensoren mit ähnlicher Frequenz tren-
nen, wenn sie sich zu nahe nebeneinander
befinden.

• Messrohre spülen.

Ungewöhnlich hoher
Dichtewert

• Messrohr verstopft oder beschichtet
• Falscher K2-Wert
• Falsche Temperaturmessung
• Widerstandsthermometerproblem
• In Hochfrequenzmessgeräten kann dies

ein Anzeichen für Erosion oder Korrosion
sein

• In Niederfrequenzmessgeräten kann
dies auf Rohrablagerungen hindeuten

• Prüfen Sie, ob alle Charakterisierungspara-
meter den Daten auf dem Sensor-Tag en-
tsprechen.

• Messrohre spülen.
• Auf Ablagerungen in den Messrohren prüfen.

Störungsanalyse und -behebung

Konfigurations- und Bedienungsanleitung 263



Probleme bei Dichtemessungen und Abhilfemaßnahmen (Fortsetzung)Tabelle 20-3:   

Problem Mögliche Ursachen Empfohlene Maßnahmen

Ungewöhnlich nie-
driger Dichtewert

• Slug flow
• Falscher K2-Wert
• In Niederfrequenzmessgeräten kann

dies ein Anzeichen für Erosion oder Kor-
rosion sein

• Überprüfen Sie Ihre Prozessbedingungen an-
hand der vom Durchflussmesser gemeldeten
Werte.

• Prüfen Sie, ob alle Charakterisierungspara-
meter den Daten auf dem Sensor-Tag en-
tsprechen.

• Die Messrohre auf Erosion prüfen, insbeson-
dere, wenn das Prozessmedium abrasiv ist.

20.4 Probleme bei der Temperaturmessung

Probleme bei der Temperaturmessung und AbhilfemaßnahmenTabelle 20-4:   

Problem Mögliche Ursachen Empfohlene Maßnahmen

Temperaturwert
weicht signifikant von
der Prozesstempera-
tur ab

• Fehlerhafter Widerstandsthermometer
• Verdrahtungsproblem

• Die Anschlussdose auf Feuchtigkeit und
Grünspan prüfen.

• Am Widerstandsthermometer Wider-
standsprüfungen durchführen und auf
Kurzschlüsse zum Gehäuse prüfen (siehe 
Prüfen der Sensorspulen).

• Bestätigen, dass der Temperaturkalibrier-
faktor mit dem Wert auf dem Typenschild
des Sensors übereinstimmt.

• Siehe Status-Alarme (insbesondere RTD-
Fehleralarme).

• Externe Temperaturkompensation deakti-
vieren.

• Temperaturkalibrierung prüfen.
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Probleme bei der Temperaturmessung und Abhilfemaßnahmen (Fortsetzung)Tabelle 20-4:   

Problem Mögliche Ursachen Empfohlene Maßnahmen

Temperaturwert
weicht gering von der
Prozesstemperatur ab

• Sensortemperatur noch nicht angeglichen
• Sensor Wärmeverlust

• Das Widerstandsthermometer hat eine
Spezifikation von ±1 °C. Wenn sich der Feh-
ler in diesem Bereich bewegt, liegt kein
Problem vor. Wenn sich die Temperatur-
messung außerhalb der Spezifikation des
Sensors befindet, Micro Motion kontaktie-
ren.

• Die Temperatur des Mediums ändert sich
möglicherweise schnell. Dem Sensor aus-
reichend Zeit geben, sich an das Prozess-
medium anzupassen.

• Den Sensor falls erforderlich isolieren.
• Am Widerstandsthermometer Wider-

standsprüfungen durchführen und auf
Kurzschlüsse zum Gehäuse prüfen (siehe 
Prüfen der Sensorspulen).

• Das Widerstandsthermometer hat mögli-
cherweise keinen guten Kontakt mit dem
Sensor. Der Sensor muss möglicherweise
ausgetauscht werden.

20.5 Probleme bei mA-Ausgängen

Probleme bei mA-Ausgängen und empfohlene MaßnahmenTabelle 20-5:   

Problem Mögliche Ursachen Empfohlene Maßnahmen

Kein mA-Ausgang • Verdrahtungsproblem
• Störung im Schaltkreis

• Die Spannungsversorgung und deren Ver-
drahtung prüfen. Siehe Abschnitt 20.8.

• Die mA-Ausgangsverdrahtung überprüfen.
• Die Einstellungen für Störaktion prüfen.

Siehe Abschnitt 20.13.
• Gleichspannung an den Ausgangsklem-

men messen, um zu prüfen, ob der Aus-
gang aktiv ist.

• Wenden Sie sich an Micro Motion.

Messkreistest fehler-
haft

• Problem mit der Spannungsversorgung
• Verdrahtungsproblem
• Störung im Schaltkreis
• Falsche Konfiguration der internen/exter-

nen Spannungsversorgung

• Die Spannungsversorgung und deren Ver-
drahtung prüfen. Siehe Abschnitt 20.8.

• Die mA-Ausgangsverdrahtung überprüfen.
• Die Einstellungen für Störaktion prüfen.

Siehe Abschnitt 20.13.
• Wenden Sie sich an Micro Motion.
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Probleme bei mA-Ausgängen und empfohlene Maßnahmen (Fortsetzung)Tabelle 20-5:   

Problem Mögliche Ursachen Empfohlene Maßnahmen

mA-Ausgang unter 4
mA

• Offene Verdrahtung
• Schlechter Ausgangskreis
• Prozessbedingungen unterhalb LRV
• LRV und URV sind nicht korrekt gesetzt
• Störbedingungen liegen vor, wenn die

Störaktion auf intern Null oder abwärts ste-
hen

• Schlechtes, empfangendes mA Gerät

• Überprüfen Sie Ihre Prozessbedingungen
anhand der vom Durchflussmesser gemel-
deten Werte.

• Das empfangende Gerät sowie die Ver-
drahtung zwischen Auswerteelektronik
und Core-Prozessor prüfen.

• Die Einstellungen für Messende (URV) und
Messanfang (LRV) überprüfen. Siehe 
Abschnitt 20.12.

• Die Einstellungen für Störaktion prüfen.
Siehe Abschnitt 20.13.

Konstanter mA-Aus-
gang

• Falsche dem Ausgang zugewiesene Pro-
zessvariable

• Störung besteht
• Eine HART-Adresse ungleich Null (mA-Aus-

gang 1)
• Ausgang ist für den Messkreistestmodus

konfiguriert.
• Fehlerhafte Nullpunktkalibrierung

• Ausgangsvariablen-Zuordnung prüfen.
• Bestehende Alarmzustände anzeigen und

beheben.
• Überprüfen Sie, ob ein Messkreistest läuft

(der Ausgang ist fixiert).
• Bei einer fehlerhaften Nullpunktkalibrier-

ung die Spannungsversorgung zum Mess-
system aus-/einschalten und die Null-
punktkalibrierung zu wiederholen versu-
chen.

mA-Ausgang dauer-
haft außerhalb des
Bereichs

• Falsche dem Ausgang zugewiesene Pro-
zessvariable oder Einheiten

• Störbedingungen liegen vor, wenn die
Störmaßnahme auf aufwärts oder abwärts
steht

• LRV und URV sind nicht korrekt gesetzt

• Ausgangsvariablen-Zuordnung prüfen.
• Die für den Ausgang konfigurierten Mes-

seinheiten überprüfen.
• Die Einstellungen für Störaktion prüfen.

Siehe Abschnitt 20.13.
• Die Einstellungen für Messende (URV) und

Messanfang (LRV) überprüfen. Siehe 
Abschnitt 20.12.

• Abgleich des mA-Ausgangs überprüfen.
Siehe Abschnitt 20.11.

Konstant ungenaue
mA-Messung

• Problem im Messkreis
• Ausgang nicht richtig abgeglichen
• Falsche Durchfluss Messeinheit konfigur-

iert
• Falsche Prozessvariable konfiguriert
• LRV und URV sind nicht korrekt gesetzt

• Abgleich des mA-Ausgangs überprüfen.
Siehe Abschnitt 20.11.

• Prüfen Sie, ob die Messeinheiten für Ihre
Anwendung korrekt konfiguriert sind.

• Zuordnung der Prozessvariablen zum mA-
Ausgang prüfen.

• Die Einstellungen für Messende (URV) und
Messanfang (LRV) überprüfen. Siehe 
Abschnitt 20.12.

Korrekter mA-Aus-
gang bei niedriger
Spannung, jedoch ink-
orrekt bei höherer
Spannung

• mA-Messkreiswiderstand kann zu hoch
eingestellt sein

• Prüfen, ob die Last am mA-Ausgang 1 un-
terhalb der max. Last liegt (siehe Installa-
tionsanleitung Ihrer Auswerteelektronik).
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20.6 Probleme beim Frequenzausgang

Probleme beim Frequenzausgang und empfohlene MaßnahmenTabelle 20-6:   

Problem Mögliche Ursachen Empfohlene Maßnahmen

Kein Frequenzaus-
gang

• Zähler stoppen
• Prozessbedingungen unterhalb Abschal-

tung
• Störbedingungen liegen vor, wenn die

Störaktion auf intern Null oder abwärts
stehen

• Slug flow
• Durchfluss in umgekehrter Richtung

zum konfigurierten Parameter der
Durchflussrichtung

• Schlechtes, empfangendes Frequenz
Gerät

• Ausgangspegel nicht kompatibel zum
empfangenden Gerät

• Schlechter Ausgangskreis
• Falsche Konfiguration der internen/ex-

ternen Spannungsversorgung
• Falsche Konfiguration der Impulsbreite
• Ausgang hat keine Spannungsversor-

gung
• Verdrahtungsproblem

• Prüfen Sie, ob die Prozessbedingungen un-
terhalb der Schleichmengenabschaltung
liegen. Konfigurieren Sie die Schleichmenge-
nabschaltung gegebenenfalls neu.

• Die Einstellungen für Störaktion prüfen. Siehe 
Abschnitt 20.13.

• Prüfen Sie, ob die Zähler nicht gestoppt wur-
den. Durch einen gestoppten Zähler wird der
Frequenzausgang gesperrt.

• Auf Schwallströmung prüfen. Siehe 
Abschnitt 20.20.

• Durchflussrichtung prüfen. Siehe 
Abschnitt 20.18.

• Das empfangende Gerät sowie die Verdrah-
tung zwischen Auswerteelektronik und Core-
Prozessor prüfen.

• Überprüfen Sie, ob der Kanal verdrahtet und
als Frequenzausgang konfiguriert ist.

• Überprüfen Sie die Spannungsversorgung für
den Frequenzausgang (intern und extern).

• Impulsbreite prüfen. Siehe Abschnitt 20.15.
• Messkreistest durchführen Siehe 

Abschnitt 20.10.

Konstant ungenaue
Frequenzmessung

• Ausgang nicht richtig skaliert
• Falsche Durchfluss Messeinheit konfi-

guriert

• Die Skalierung des Frequenzausgangs über-
prüfen. Siehe Abschnitt 20.16.

• Prüfen Sie, ob die Messeinheiten für Ihre An-
wendung korrekt konfiguriert sind.

Ungleichmäßiger Fre-
quenzausgang

• Hochfrequenzstörungen • Auf HF-Störungen prüfen. Siehe 
Abschnitt 20.14.

20.7 Verwenden der Sensorsimulation zur
Störungsanalyse und -beseitigung
Bei aktivierter Sensorsimulation gibt die Auswerteelektronik benutzerdefinierte Werte für
Massedurchfluss, Temperatur und Dichte aus. Hiermit können unterschiedliche
Prozessbedingungen reproduziert bzw. das System geprüft werden.

Mit der Sensorsimulation kann zwischen tatsächlichem Prozessrauschen und extern
verursachten Varianten unterschieden werden. Sie haben beispielsweise ein
empfangendes Gerät, das einen unerwartet ungleichmäßigen Durchflusswert ausgibt.
Wenn die Sensorsimulation aktiviert ist und die gemessene Durchflussrate nicht mit dem
simulierten Wert übereinstimmt, so liegt die Ursache des Problems wahrscheinlich
zwischen Auswerteelektronik und empfangendem Gerät.

Störungsanalyse und -behebung

Konfigurations- und Bedienungsanleitung 267



Wichtig
Wenn die Sensorsimulation aktiviert ist, wird der simulierte Wert bei allen Ausgängen und
Berechnungen der Auswerteelektronik, einschließlich Zähler und Summen, Volumendurchfluss- und
Konzentrationsberechnungen, verwendet. Alle mit den Ausgängen der Auswerteelektronik in
Verbindung stehenden automatischen Funktionen deaktivieren und den Messkreis auf Handbetrieb
setzen. Den Simulationsmodus nur aktivieren, wenn die Anwendung diese Auswirkungen toleriert.
Sicherstellen, dass der Simulationsmodus nach den Tests wieder deaktiviert wird.

Siehe Sensorsimulation bzgl. weiterer Informationen zur Verwendung der
Sensorsimulation.

20.8 Verdrahtung der Spannungsversorgung prüfen
Wenn die Verdrahtung der Spannungsversorgung beschädigt oder falsch angeschlossen
ist, wird die Auswerteelektronik möglicherweise nicht ausreichend mit Spannung versorgt.

Vorbereitungsverfahren

Weitere Informationen sind in der Installationsanleitung der Auswerteelektronik zu finden.

Verfahren

1. Die Spannungsversorgung trennen, bevor deren Verdrahtung überprüft wird.

VORSICHT!

Befindet sich die Auswerteelektronik in einer explosionsgefährdeten Umgebung, nach
dem Trennen der Spannungsversorgung fünf Minuten warten.

2. Prüfen, ob die richtige externe Sicherung verwendet wird.

Eine falsche Sicherung kann den Strom zur Auswerteelektronik begrenzen und so
das Hochfahren verhindern.

3. Stellen Sie sicher, dass die Adern der Spannungsversorgung an den richtigen
Anschlussklemmen angeschlossen sind.

4. Prüfen Sie, ob die Adern der Spannungsversorgung guten Kontakt haben und nicht
über die Isolierung angeklemmt sind.

5. Erneut Spannung an der Auswerteelektronik anlegen.

VORSICHT!

Wenn die Auswerteelektronik in einer explosionsgefährdeten Umgebung installiert ist,
nicht erneut Spannung bei entferntem Gehäuse anlegen. Das Anlegen von Spannung an
die Auswerteelektronik bei entferntem Gehäusedeckel kann zu einer Explosion führen.

6. Prüfen Sie mit einem Spannungsmessgerät die Spannung an den
Anschlussklemmen der Auswerteelektronik.

Die Spannung muss sich innerhalb der festgelegten Grenzwerte befinden. Bei einer
DC Spannung kann eine Kabelauslegung erforderlich sein.
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20.9 Erdung überprüfen
Sensor und Auswerteelektronik müssen geerdet sein.

Vorbereitungsverfahren

Sie benötigen:

• Installationsanleitung für Ihren Sensor

• Installationsanleitung für Ihre Auswerteelektronik

Verfahren

Anforderungen und Hinweise zur Erdung finden Sie in der Installationsanleitung des
Sensors und der Auswerteelektronik.

20.10 Messkreistests durchführen
Ein Messkreistest ermöglicht die Überprüfung, ob Auswerteelektronik und externes Gerät
ordnungsgemäß kommunizieren. Ein Messkreistest hilft Ihnen ebenso bei der
Entscheidung, ob die mA Ausgänge abgeglichen werden müssen.

20.10.1 Messkreistests durchführen mittels ProLink II
Ein Messkreistest ermöglicht die Überprüfung, ob Auswerteelektronik und externes Gerät
ordnungsgemäß kommunizieren. Ein Messkreistest hilft Ihnen ebenso bei der
Entscheidung, ob die mA Ausgänge abgeglichen werden müssen.

Vorbereitungsverfahren

Bevor Sie den Messkreistest durchführen, konfigurieren Sie die Kanäle der Ein-/Ausgänge
der Auswerteelektronik, die für Ihre Anwendung konfiguriert sind.

Folgen Sie den entsprechenden Vorgehensweisen, um sicherzustellen, dass die
Messkreistests existierende Mess- und Regelkreise nicht beeinträchtigen.

ProLink II muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Testen Sie den oder die mA Ausgänge.

a. Wählen Sie ProLink > Test > Fix Milliamp 2.

b. Geben Sie 4 mA in Set Output To ein.

c. Klicken Sie auf Fix mA.

d. Lesen Sie den mA Wert am empfangenden Gerät ab und vergleichen diesen mit
dem Ausgang der Auswerteelektronik.

Die Werte müssen nicht exakt übereinstimmen. Weichen die Werte nur
geringfügig voneinander ab, können Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

e. Klicken Sie auf UnFix mA.

f. Geben Sie 20 mA in Set Output To ein.
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g. Klicken Sie auf Fix mA.

h. Lesen Sie den mA Wert am empfangenden Gerät ab und vergleichen diesen mit
dem Ausgang der Auswerteelektronik.

Die Werte müssen nicht exakt übereinstimmen. Weichen die Werte nur
geringfügig voneinander ab, können Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

i. Klicken Sie auf UnFix mA.

2. Testen Sie den oder die Frequenzausgänge.

a. Wählen Sie ProLink > Test > Fix Freq Out.
b. Geben Sie den Frequenzausgangswert in Set Output To ein.

c. Klicken Sie auf Fix Frequency.

d. Lesen Sie das Frequenzsignal am empfangenden Gerät ab und vergleichen dieses
mit dem Ausgang der Auswerteelektronik.

e. Klicken Sie auf UnFix Freq.

3. Testen Sie den oder die Binärausgänge.

a. Wählen Sie ProLink > Test > Fix Discrete Output.
b. Wählen Sie On.

c. Prüfen Sie das Signal am empfangenden Gerät.

d. Wählen Sie Off.
e. Prüfen Sie das Signal am empfangenden Gerät.

f. Klicken Sie auf UnFix.

Nachbereitungsverfahren

• Weicht der mA Ausgangswert am empfangenden Gerät geringfügig vom Wert an
der Auswerteelektronik ab, können Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

• Weicht der mA Ausgangswert am empfangenden Gerät signifikant ab oder war der
Messwert bei einem Schritt fehlerhaft, prüfen Sie die Verdrahtung zwischen der
Auswerteelektronik und dem externen Gerät und wiederholen Sie den Test.

• Wird der Messwert des Binärausgangs umgekehrt angezeigt, prüfen Sie die
Einstellung der Discrete Output Polarity.

20.10.2 Messkreistests durchführen mittels ProLink III
Ein Messkreistest ermöglicht die Überprüfung, ob Auswerteelektronik und externes Gerät
ordnungsgemäß kommunizieren. Ein Messkreistest hilft Ihnen ebenso bei der
Entscheidung, ob die mA Ausgänge abgeglichen werden müssen.

Vorbereitungsverfahren

Bevor Sie den Messkreistest durchführen, konfigurieren Sie die Kanäle der Ein-/Ausgänge
der Auswerteelektronik, die für Ihre Anwendung konfiguriert sind.

Folgen Sie den entsprechenden Vorgehensweisen, um sicherzustellen, dass die
Messkreistests existierende Mess- und Regelkreise nicht beeinträchtigen.
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ProLink III muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1. Testen Sie den oder die mA Ausgänge.

a. Wählen Sie Device Tools > Diagnostics > Testing > mA Output 2 Test.
b. Geben Sie 4 in Fix to: ein.

c. Klicken Sie auf Fix mA.

d. Lesen Sie den mA Wert am empfangenden Gerät ab und vergleichen diesen mit
dem Ausgang der Auswerteelektronik.

Die Werte müssen nicht exakt übereinstimmen. Weichen die Werte nur
geringfügig voneinander ab, können Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

e. Klicken Sie auf UnFix mA.

f. Geben Sie 20 in Fix to: ein.

g. Klicken Sie auf Fix mA.

h. Lesen Sie den mA Wert am empfangenden Gerät ab und vergleichen diesen mit
dem Ausgang der Auswerteelektronik.

Die Werte müssen nicht exakt übereinstimmen. Weichen die Werte nur
geringfügig voneinander ab, können Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

i. Klicken Sie auf UnFix mA.

2. Testen Sie den oder die Frequenzausgänge.

a. Wählen Sie Device Tools > Diagnostics > Testing > Frequency Output Test.
b. Geben Sie den Frequenzausgangswert in Fix to ein.

c. Klicken Sie auf Fix FO.

d. Lesen Sie das Frequenzsignal am empfangenden Gerät ab und vergleichen dieses
mit dem Ausgang der Auswerteelektronik.

e. Klicken Sie auf UnFix FO.

3. Testen Sie den oder die Binärausgänge.

a. Wählen Sie Device Tools > Diagnostics > Testing > Discrete Output Test.
b. Setzen Sie Fix To: auf ON.

c. Prüfen Sie das Signal am empfangenden Gerät.

d. Setzen Sie Fix To: auf OFF.

e. Prüfen Sie das Signal am empfangenden Gerät.

f. Klicken Sie auf UnFix.

4. Testen Sie den Binäreingang.

a. Setzen Sie das externe Eingangsgerät auf EIN.

b. Wählen Sie Device Tools > Diagnostics > Testing > Discrete Input Test.
c. Prüfen Sie das Signal an der Auswerteelektronik.

d. Setzen Sie das externe Eingangsgerät auf AUS.
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e. Prüfen Sie das Signal an der Auswerteelektronik.

Nachbereitungsverfahren

• Weicht der mA Ausgangswert am empfangenden Gerät geringfügig vom Wert an
der Auswerteelektronik ab, können Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

• Weicht der mA Ausgangswert am empfangenden Gerät signifikant ab oder war der
Messwert bei einem Schritt fehlerhaft, prüfen Sie die Verdrahtung zwischen der
Auswerteelektronik und dem externen Gerät und wiederholen Sie den Test.

• Wird der Messwert des Binärausgangs umgekehrt angezeigt, prüfen Sie die
Einstellung der Discrete Output Polarity.

20.10.3 Messkreistest mittels PROFIBUS EDD durchführen
Ein Messkreistest ermöglicht die Überprüfung, ob Auswerteelektronik und externes Gerät
ordnungsgemäß kommunizieren. Ein Messkreistest hilft Ihnen ebenso bei der
Entscheidung, ob die mA Ausgänge abgeglichen werden müssen.

Vorbereitungsverfahren

Bevor Sie den Messkreistest durchführen, konfigurieren Sie die Kanäle der Ein-/Ausgänge
der Auswerteelektronik, die für Ihre Anwendung konfiguriert sind.

Folgen Sie den entsprechenden Vorgehensweisen, um sicherzustellen, dass die
Messkreistests existierende Mess- und Regelkreise nicht beeinträchtigen.

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, die PROFIBUS EDD muss installiert
sein und Sie müssen eine Verbindung mit der Auswerteelektronik hergestellt haben.

Verfahren

1. Testen des mA Ausgangs 2.

a. Wählen Sie Service Tools > Simulate > mA Output Loop Test.
b. Wählen Sie 4 mA und klicken Sie auf Next.
c. Lesen Sie den mA Wert am empfangenden Gerät ab und vergleichen diesen mit

dem Ausgang der Auswerteelektronik.

Die Werte müssen nicht exakt übereinstimmen. Weichen die Werte nur
geringfügig voneinander ab, können Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

d. Klicken Sie auf Next.
e. Wählen Sie 20 mA und klicken Sie auf Next.
f. Lesen Sie den mA Wert am empfangenden Gerät ab und vergleichen diesen mit

dem Ausgang der Auswerteelektronik.

Die Werte müssen nicht exakt übereinstimmen. Weichen die Werte nur
geringfügig voneinander ab, können Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

g. Klicken Sie auf Next.
h. Klicken Sie auf End.
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2. Testen des Frequenzausgangs.

a. Wählen Sie Service Tools > Simulate > Frequency Output Test.
b. Wählen Sie 10 kHz und klicken Sie auf Next.
c. Lesen Sie das Frequenzsignal am empfangenden Gerät ab und vergleichen dieses

mit dem Ausgang der Auswerteelektronik.

d. Klicken Sie auf Next.
e. Klicken Sie auf End.

3. Testen des Binärausgangs 1.

a. Wählen Sie Service Tools > Simulate > Discrete Output Test.
b. Wählen Sie On und klicken Sie auf Next.
c. Prüfen Sie das Signal am empfangenden Gerät.

Der Binärausgang ist EIN. Die tatsächliche Spannung wird durch das Setzen der
Binärausgang Polarität bestimmt.

d. Klicken Sie auf Next.
e. Wählen Sie Off und klicken Sie auf Next.
f. Prüfen Sie das Signal am empfangenden Gerät.

Der Binärausgang ist AUS. Die tatsächliche Spannung wird durch das Setzen der
Binärausgang Polarität bestimmt.

g. Klicken Sie auf Next.
h. Klicken Sie auf End.

4. Testen des Binärausgangs 1 mit hoher Genauigkeit.

a. Wählen Sie Service Tools > Simulate > Discrete Output Test > Precision Discrete Output 1.

b. Wählen Sie On und klicken Sie auf Next.
c. Prüfen Sie das Signal am empfangenden Gerät.

Der Binärausgang ist EIN. Die tatsächliche Spannung wird durch das Setzen der
Polarität des Binärausgangs 1 mit hoher Genauigkeit bestimmt.

d. Klicken Sie auf Next.
e. Wählen Sie Off und klicken Sie auf Next.
f. Prüfen Sie das Signal am empfangenden Gerät.

Der Binärausgang ist AUS. Die tatsächliche Spannung wird durch das Setzen der
Polarität des Binärausgangs 1 mit hoher Genauigkeit bestimmt.

g. Klicken Sie auf Next.
h. Klicken Sie auf End.

5. Testen des Binärausgangs 2 mit hoher Genauigkeit.

a. Wählen Sie Service Tools > Simulate > Discrete Output Test > Precision Discrete Output 2.

b. Wählen Sie On und klicken Sie auf Next.
c. Prüfen Sie das Signal am empfangenden Gerät.

Der Binärausgang ist EIN. Die tatsächliche Spannung wird durch das Setzen der
Polarität des Binärausgangs 2 mit hoher Genauigkeit bestimmt.

d. Klicken Sie auf Next.
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e. Wählen Sie Off und klicken Sie auf Next.
f. Prüfen Sie das Signal am empfangenden Gerät.

Der Binärausgang ist AUS. Die tatsächliche Spannung wird durch das Setzen der
Polarität des Binärausgangs 2 mit hoher Genauigkeit bestimmt.

g. Klicken Sie auf Next.
h. Klicken Sie auf End.

20.10.4 Messkreistests mittels PROFIBUS Busparametern
durchführen
Ein Messkreistest ermöglicht die Überprüfung, ob Auswerteelektronik und externes Gerät
ordnungsgemäß kommunizieren. Ein Messkreistest hilft Ihnen ebenso bei der
Entscheidung, ob die mA Ausgänge abgeglichen werden müssen.

Hinweis
Messkreistests sind nicht vorgeschrieben. Jedoch empfiehlt Micro Motion die Durchführung eines
Messkreistests für jeden Ein-/Ausgang, der bei der Auswerteelektronik verfügbar ist. Die bei der
Auswerteelektronik verfügbaren Ein- und Ausgänge variieren je nach erworbenen Optionen und der
Kanalkonfiguration. Sie müssen möglicherweise nicht alle hier beschriebenen Messkreistests
durchführen.

Vorbereitungsverfahren

Sie benötigen ein PROFIBUS Konfigurations-Hilfsmittel, das DP-V1 Lese- und
Schreibdienste unterstützt, und Sie müssen eine Verbindung mit der Auswerteelektronik
hergestellt haben.

Bevor Sie den Messkreistest durchführen, konfigurieren Sie die Kanäle der Ein-/Ausgänge
der Auswerteelektronik, die für Ihre Anwendung konfiguriert sind.

Folgen Sie den entsprechenden Vorgehensweisen, um sicherzustellen, dass die
Messkreistests existierende Mess- und Regelkreise nicht beeinträchtigen.

Verfahren

1. Testen des mA Ausgangs 2.

a. 4 in den Filling Block schreiben, Index 51.

b. 1 in den Filling Block schreiben, Index 50.

c. Lesen Sie den mA Wert am empfangenden Gerät ab und vergleichen diesen mit
dem Ausgang der Auswerteelektronik.

Die Werte müssen nicht exakt übereinstimmen. Weichen die Werte nur
geringfügig voneinander ab, können Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

d. 20 in den Filling Block schreiben, Index 51.

e. 1 in den Filling Block schreiben, Index 50.

f. Lesen Sie den mA Wert am empfangenden Gerät ab und vergleichen diesen mit
dem Ausgang der Auswerteelektronik.
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Die Werte müssen nicht exakt übereinstimmen. Weichen die Werte nur
geringfügig voneinander ab, können Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

g. 0 in den Filling Block schreiben, Index 50.

2. Testen Sie den oder die Frequenzausgänge.

a. Den Testwert in den Filling Block schreiben, Index 68.

b. 1 in den Filling Block schreiben, Index 67.

c. Lesen Sie das Frequenzsignal am empfangenden Gerät ab und vergleichen dieses
mit dem Ausgang der Auswerteelektronik.

d. 0 in den Filling Block schreiben, Index 67.

3. Testen des Binärausgangs 1.

a. 1 in den Filling Block schreiben, Index 74.

b. 1 in den Filling Block schreiben, Index 73.

c. Prüfen Sie das Signal am empfangenden Gerät.

Der Binärausgang ist EIN. Die tatsächliche Spannung wird durch das Setzen der
Binärausgang Polarität bestimmt.

d. 0 in den Filling Block schreiben, Index 74.

e. 1 in den Filling Block schreiben, Index 73.

f. Prüfen Sie das Signal am empfangenden Gerät.

Der Binärausgang ist AUS. Die tatsächliche Spannung wird durch das Setzen der
Binärausgang Polarität bestimmt.

g. 0 in den Filling Block schreiben, Index 73.

4. Testen des Binärausgangs 1 mit hoher Genauigkeit.

a. 1 in den Filling Block schreiben, Index 88.

b. 1 in den Filling Block schreiben, Index 87.

c. Prüfen Sie das Signal am empfangenden Gerät.

Der Binärausgang ist EIN. Die tatsächliche Spannung wird durch das Setzen der
Polarität des Binärausgangs 1 mit hoher Genauigkeit bestimmt.

d. 0 in den Filling Block schreiben, Index 88.

e. 1 in den Filling Block schreiben, Index 87.

f. Prüfen Sie das Signal am empfangenden Gerät.

Der Binärausgang ist AUS. Die tatsächliche Spannung wird durch das Setzen der
Polarität des Binärausgangs 1 mit hoher Genauigkeit bestimmt.

g. 0 in den Filling Block schreiben, Index 87.

5. Testen des Binärausgangs 2 mit hoher Genauigkeit.

a. 1 in den Filling Block schreiben, Index 90.

b. 1 in den Filling Block schreiben, Index 89.

c. Prüfen Sie das Signal am empfangenden Gerät.
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Der Binärausgang ist EIN. Die tatsächliche Spannung wird durch das Setzen der
Polarität des Binärausgangs 2 mit hoher Genauigkeit bestimmt.

d. 0 in den Filling Block schreiben, Index 90.

e. 1 in den Filling Block schreiben, Index 89.

f. Prüfen Sie das Signal am empfangenden Gerät.

Der Binärausgang ist AUS. Die tatsächliche Spannung wird durch das Setzen der
Polarität des Binärausgangs 2 mit hoher Genauigkeit bestimmt.

g. 0 in den Filling Block schreiben, Index 89.

Nachbereitungsverfahren

• Weicht der mA Ausgangswert am empfangenden Gerät geringfügig vom Wert an
der Auswerteelektronik ab, können Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

• Weicht der mA Ausgangswert am empfangenden Gerät signifikant ab oder war der
Messwert bei einem Schritt fehlerhaft, prüfen Sie die Verdrahtung zwischen der
Auswerteelektronik und dem externen Gerät und wiederholen Sie den Test.

• Wird der Messwert des Binärausgangs umgekehrt angezeigt, prüfen Sie die
Einstellung der Discrete Output Polarity.

20.11 mA Ausgänge abgleichen
Beim Abgleich eines mA Ausgangs wird der mA Ausgang der Auswerteelektronik
entsprechend des empfangenden Geräts kalibriert. Wenn die aktuellen Abgleichswerte
nicht richtig sind, wird der Ausgang durch die Auswerteelektronik über- oder
unterkompensiert.

20.11.1 Abgleichen der mA Ausgänge mittels ProLink II
Der Abgleich des mA Ausgangs erzeugt einen gemeinsamen Messkreis zwischen der
Auswerteelektronik und dem Gerät, das den mA Ausgang empfängt.

Wichtig
Der Abgleich des Ausgangs muss an beiden Punkten (4 mA und 20 mA) durchgeführt werden, um
sicherzustellen, dass eine entsprechende Kompensation über den gesamten Ausgangsbereich
erfolgt.

Vorbereitungsverfahren

Stellen Sie sicher, dass der mA Ausgang mit dem empfangenden Gerät verdrahtet ist, das
bei der Produktion verwendet wird.

Verfahren

1. Wählen Sie ProLink > Calibration > Milliamp 2 Trim .

2. Folgen Sie den Anweisungen der geführten Methode.

3. Prüfen Sie die Abgleichswerte und wenden Sie sich an den Micro Motion
Kundenservice, wenn ein Wert kleiner als −200 Mikroampere oder größer als
+200 Mikroampere ist.
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20.11.2 Abgleichen der mA Ausgänge mittels ProLink III
Der Abgleich des mA Ausgangs erzeugt einen gemeinsamen Messkreis zwischen der
Auswerteelektronik und dem Gerät, das den mA Ausgang empfängt.

Wichtig
Der Abgleich des Ausgangs muss an beiden Punkten (4 mA und 20 mA) durchgeführt werden, um
sicherzustellen, dass eine entsprechende Kompensation über den gesamten Ausgangsbereich
erfolgt.

Vorbereitungsverfahren

Stellen Sie sicher, dass der mA Ausgang mit dem empfangenden Gerät verdrahtet ist, das
bei der Produktion verwendet wird.

Verfahren

1. Wählen Sie Device Tools > Calibration > MA Output Trim > mA Output 2 Trim.

2. Folgen Sie den Anweisungen der geführten Methode.

3. Prüfen Sie die Abgleichswerte und wenden Sie sich an den Micro Motion
Kundenservice, wenn ein Wert kleiner als −200 Mikroampere oder größer als
+200 Mikroampere ist.

20.11.3 Abgleichen der mA Ausgänge mittels PROFIBUS EDD
Der Abgleich des mA Ausgangs erzeugt einen gemeinsamen Messkreis zwischen der
Auswerteelektronik und dem Gerät, das den mA Ausgang empfängt.

Wichtig
Der Abgleich des Ausgangs muss an beiden Punkten (4 mA und 20 mA) durchgeführt werden, um
sicherzustellen, dass eine entsprechende Kompensation über den gesamten Ausgangsbereich
erfolgt.

Vorbereitungsverfahren

Stellen Sie sicher, dass der mA Ausgang mit dem empfangenden Gerät verdrahtet ist, das
bei der Produktion verwendet wird.

Verfahren

1. Wählen Sie Service Tools > Maintenance > mA Output Trim.

2. Folgen Sie den Anweisungen der geführten Methode.

3. Prüfen Sie die Abgleichswerte und wenden Sie sich an den Micro Motion
Kundenservice, wenn ein Wert kleiner als −200 Mikroampere oder größer als
+200 Mikroampere ist.

20.11.4 Abgleichen der mA Ausgänge mit PROFIBUS
Busparametern
Der Abgleich des mA Ausgangs erzeugt einen gemeinsamen Messkreis zwischen der
Auswerteelektronik und dem Gerät, das den mA Ausgang empfängt.
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Wichtig
Der Abgleich des Ausgangs muss an beiden Punkten (4 mA und 20 mA) durchgeführt werden, um
sicherzustellen, dass eine entsprechende Kompensation über den gesamten Ausgangsbereich
erfolgt.

Vorbereitungsverfahren

Stellen Sie sicher, dass der mA Ausgang mit dem empfangenden Gerät verdrahtet ist, das
bei der Produktion verwendet wird.

Verfahren

1. mA Ausgang 2 bei 4 mA abgleichen.

a. 4 in den Füllblock schreiben, Index 51.

b. 1 in den Füllblock schreiben, Index 53.

c. Ausgangspegel am externen Gerät ablesen.

d. Ausgangspegel vom vorigen Schritt in den Füllblock schreiben, Index 52.

e. 1 in den Füllblock schreiben, Index 53.

f. Ausgangspegel am externen Gerät ablesen.

g. Wenn der Ausgang der Auswerteelektronik dicht genug am Ausgang des
externen Gerätes liegt, 0 in den Füllblock schreiben, Index 53. Mit dem Abgleich
von 20 mA fortfahren.

h. Wenn der Ausgang der Auswerteelektronik nicht dicht genug am Ausgang des
externen Gerätes liegt, Schritte 1c bis 1e wiederholen.

2. mA Ausgang 2 bei 20 mA abgleichen.

a. 1 in den Füllblock schreiben, Index 55.

b. Ausgangspegel am externen Gerät ablesen.

c. Ausgangspegel vom vorigen Schritt in den Füllblock schreiben, Index 52.

d. 1 in den Füllblock schreiben, Index 55.

e. Ausgangspegel am externen Gerät ablesen.

f. Wenn der Ausgang der Auswerteelektronik dicht genug am Ausgang des
externen Gerätes liegt, 0 in den Füllblock schreiben, Index 53. Der Abgleich ist
abgeschlossen.

g. Wenn der Ausgang der Auswerteelektronik nicht dicht genug am Ausgang des
externen Gerätes liegt, Schritte 2c bis 2e wiederholen.

3. Prüfen Sie die Abgleichswerte und wenden Sie sich an den Micro Motion
Kundenservice, wenn ein Wert kleiner als −200 Mikroampere oder größer als
+200 Mikroampere ist.

20.12 Prüfen von Messanfang und Messende
Wenn die Prozessbedingungen unter den konfigurierten Lower Range Value (LRV) fallen oder
über den konfigurierten Upper Range Value (URV) steigen, können unerwartete Werte über
die Ausgänge der Auswertelektronik ausgegeben werden.

1. Bewerten Sie die aktuellen Prozessbedingungen.

2. Prüfen Sie die Konfiguration von LRV und URV.
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20.13 mA Ausgang Störaktion prüfen
Die mA Ausgang Störaktion steuert das Verhalten des mA Ausgangs, wenn die
Auswerteelektronik eine interne Störbedingung erkennt. Wenn der mA Ausgang einen
konstanten Wert unter 4 mA oder über 20 mA ausgibt, weist die Auswerteelektronik
möglicherweise eine Störbedingung auf.

1. In diesem Fall die Statusalarme auf aktive Störbedingungen prüfen.

2. Wenn keine aktiven Störbedingungen vorhanden sind, funktioniert die
Auswerteelektronik ordnungsgemäß. Wenn Sie das Verhalten des
Frequenzausgangs ändern möchten, haben Sie folgende Möglichkeiten:

• Ändern Sie die Einstellung der mA Ausgang Störaktion.

• Ändern Sie für die relevanten Statusalarme die Einstellung Alarmstufe auf Ignorieren.

3. Wenn keine aktiven Störbedingungen vorhanden sind, setzen Sie die
Störungsanalyse und -beseitigung fort.

20.14 Prüfung auf hochfrequente Störungen (RFI)
Der Frequenzausgang bzw. der Binärausgang der Auswerteelektronik kann durch
hochfrequente Störungen (RFI) beeinflusst werden. Mögliche RFI-Quellen sind Sender von
Funkemissionen bzw. große Transformatoren, Pumpen oder Motoren, die ein starkes
elektromagnetisches Feld erzeugen können. Es gibt mehrere Methoden zur Reduzierung
hochfrequenter Störungen. Verwenden Sie eine oder mehrere der folgenden
Empfehlungen entsprechend der jeweiligen Installation.

Verfahren

• Hochfrequente Störquelle eliminieren.

• Auswerteelektronik versetzen.

• Abgeschirmte Kabel für den Frequenz- bzw. Binärausgang verwenden.

- Kabelschirm am Ausgangsgerät auflegen. Ist dies nicht möglich, den Schirm an
der Kabelverschraubung oder der Kabelschutzrohrverschraubung auflegen.

- Den Schirm nicht im Inneren des Anschlussraumes auflegen.

- Ein 360° Schirmabschluss ist nicht erforderlich.

20.15 Frequenzausgang max. Impulsbreite prüfen
Wenn die Frequenzausgang max. Impulsbreite falsch eingestellt ist, kann der Frequenzausgang
einen falschen Wert ausgeben.

Prüfen Sie die Konfiguration der Frequenzausgang max. Impulsbreite.

Für die meisten Anwendungen ist der für Frequenzausgang max. Impulsbreite voreingestellte
Wert geeignet. Dieser Wert entspricht einem Impuls/Pause-Verhältnis von 50 %.
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20.16 Frequenzausgang Skaliermethode prüfen
Wenn die Frequenzausgang Skaliermethode falsch eingestellt ist, kann der Frequenzausgang
einen falschen Wert ausgeben.

1. Prüfen Sie die Konfiguration von Frequenzausgang Skaliermethode.

2. Wenn Sie die Einstellung für Frequenzausgang Skaliermethode geändert haben, prüfen
Sie alle anderen Parameter des Frequenzausgangs.

20.17 Frequenzausgang Störaktion prüfen
Die Frequenzausgang Störaktion steuert das Verhalten des Frequenzausgangs, wenn die
Auswerteelektronik eine interne Störbedingung erkennt. Wenn der Frequenzausgang
einen konstanten Wert ausgibt, liegt möglicherweise eine Störbedingung der
Auswerteelektronik vor.

1. In diesem Fall die Statusalarme auf aktive Störbedingungen prüfen.

2. Wenn keine aktiven Störbedingungen vorhanden sind, funktioniert die
Auswerteelektronik ordnungsgemäß. Wenn Sie das Verhalten des
Frequenzausgangs ändern möchten, haben Sie folgende Möglichkeiten:

• Ändern der Einstellung Frequenzausgang Störaktion.

• Ändern Sie für die relevanten Statusalarme die Einstellung Alarmstufe auf Ignorieren.

3. Wenn keine aktiven Störbedingungen vorhanden sind, setzen Sie die
Störungsanalyse und -beseitigung fort.

20.18 Prüfen der Durchflussrichtung
Wenn die Durchflussrichtung für Ihren Prozess nicht korrekt eingestellt ist, zeigt die
Auswerteelektronik möglicherweise unerwartete Durchflusswerte oder Zähler an.
Der Parameter Durchflussrichtung interagiert mit der eigentlichen Durchflussrichtung und
hat somit Auswirkungen auf Durchflusswerte, Durchflusszähler und -summen und das
Ausgangsverhalten. Der einfachste Betrieb wird erreicht, indem der eigentliche
Prozessfluss mit dem Richtungspfeil für den Durchfluss auf der Seite des Sensorgehäuses
übereinstimmt.

Verfahren

1. Die eigentliche Durchflussrichtung des Prozessflusses durch den Sensor überprüfen.

2. Die Konfiguration der Durchflussrichtung prüfen.

20.19 Prüfen der Abschaltungen
Wenn die Abschaltungen der Auswerteelektronik falsch konfiguriert sind, kann die
Auswerteelektronik bei vorhandenem Durchfluss oder bei sehr geringen
Durchflussmengen einen Null Durchfluss ausgeben.
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Es gibt separate Abschaltparameter für Massedurchfluss, Volumendurchfluss, Standard-
Gasvolumen-Durchfluss (falls zutreffend) und Dichte. Für jeden mA-Ausgang an der
Auswerteelektronik gibt es eine separate Abschaltung. Die Wechselwirkung zwischen den
Abschaltungen kann zu unerwarteten Ergebnissen führen.

Verfahren

Die Konfiguration der Abschaltungen überprüfen.

Hinweis
Bei typischen Anwendungen empfiehlt Micro Motion, Mass Flow Cutoff auf den
Nullpunktstabilitätswert des Sensors multipliziert mit 10 einzustellen. Nullpunktstabilitätswerte sind
im Produktdatenblatt des Sensors zu finden.

20.20 Prüfen auf Schwallströmung
(Zweiphasenströmung)
Schwallströmung (Zweiphasenströmung, Gaseinschlüsse) kann zu Spitzenwerten bei der
Antriebsverstärkung führen. Dies kann dazu führen, dass die Auswerteelektronik Null
Durchfluss oder mehrere unterschiedliche Alarme meldet.

1. Auf durch Schwallströmung ausgelöste Alarme prüfen.

Wenn die Auswerteelektronik keine Schwallstromalarme erzeugt, ist
Schwallströmung nicht die Ursache des Problems.

2. Prozess auf Kavitation, Dampfbildung oder Leckagen prüfen.

3. Die Dichte des Prozessmediumausgangs unter normalen Prozessbedingungen
überwachen.

4. Die Einstellungen für Slug Low Limit, Slug High Limit und Slug Duration prüfen.

Hinweis
Das Auftreten von Schwallstromalarmen kann durch die Einstellung von Slug Low Limit auf
einen niedrigeren Wert, Slug High Limit auf einen höheren oder Slug Duration auf einen höheren
Wert reduziert werden.

20.21 Antriebsverstärkung prüfen
Übermäßige oder fehlerhafte Antriebsverstärkung kann auf vielfältige
Prozessbedingungen, Sensor- oder Konfigurationsprobleme hindeuten.

Um herauszufinden, ob die Antriebsverstärkung zu hoch oder fehlerhaft ist, müssen Daten
in der Problemsituation gesammelt und mit den Daten der Antriebsverstärkung unter
normalen Betriebsbedingungen verglichen werden.
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Übermäßige (gesättigte) Antriebsverstärkung

Mögliche Ursachen und Abhilfemaßnahmen bei übermäßiger
(gesättigter) Antriebsverstärkung

Tabelle 20-7:   

Mögliche Ursache Empfohlene Maßnahmen

Schwallströmung Auf Schwallströmung prüfen. Siehe Abschnitt 20.20.

Teilweise gefülltes Durch-
flussrohr

Prozessbedingungen so korrigieren, dass die Durchflussrohre ge-
füllt sind.

Verstopfte Messrohre Aufnehmerspannungen prüfen (siehe Abschnitt 20.22). Ist eine der
Spannungen fast null (aber keine null), können verstopfte Rohre
die Ursache des Problems sein. Rohre spülen. In Extremfällen kann
es sein, dass der Sensor ersetzt werden muss.

Kavitation, Dampfbildung
oder Lufteinschluss; Abschei-
den von Zwei- oder Dreis-
tromflüssigkeiten

• Den einlaufseitigen oder auslaufseitigen Druck am Sensor er-
höhen.

• Befindet sich einlaufseitig vor dem Sensor eine Pumpe, den Ab-
stand zwischen Pumpe und Sensor vergrößern.

• Der Sensor muss möglicherweise neu ausgerichtet werden.
Weitere Informationen bzgl. der Sensorausrichtung sind im In-
stallationshandbuch zu finden.

Störung in Antriebsplatine
oder Modul

Kontaktieren Sie .

Messrohr verbogen Aufnehmerspannungen prüfen (siehe Abschnitt 20.22). Ist eine der
Spannungen fast null (aber keine null), sind die Messrohre mögli-
cherweise verbogen. Der Sensor muss ausgetauscht werden.

Messrohr gerissen Sensor austauschen.

Sensorunwucht Kontaktieren Sie Micro Motion.

Mechanische Verbindung am
Sensor

Stellen Sie sicher, dass der Sensor frei schwingen kann.

Offene Antriebs- oder Auf-
nehmerspule links

Kontaktieren Sie Micro Motion.

Durchfluss außerhalb des Be-
reichs

Stellen Sie sicher, dass der Durchfluss innerhalb der Sensorgrenzen
liegt.

Falsche Sensor-Charakteri-
sierung

Charakterisierungsparameter prüfen.

Sprunghafte Antriebsverstärkung

Mögliche Ursachen und Abhilfemaßnahmen bei fehlerhafter
Antriebsverstärkung

Tabelle 20-8:   

Mögliche Ursache Empfohlene Maßnahmen

Falsche K1-Charakterisierungskonstante für
den Sensor

Charakterisierungsparameter K1 prüfen.

Polarität der Aufnehmer- oder Antriebsspule
vertauscht

Kontaktieren Sie Micro Motion.

Schwallströmung Auf Schwallströmung prüfen. Siehe 
Abschnitt 20.20.
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Mögliche Ursachen und Abhilfemaßnahmen bei fehlerhafter
Antriebsverstärkung (Fortsetzung)

Tabelle 20-8:   

Mögliche Ursache Empfohlene Maßnahmen

Fremdkörper in den Messrohren • Messrohre spülen.
• Sensor austauschen.

20.21.1 Daten der Antriebsverstärkung sammeln

ProLink II ProLink > Diagnostic Information

ProLink III Device Tools > Diagnostics > Core Processor Diagnostics

PROFIBUS EDD Service Tools > Maintenance > Diagnostic Variables

PROFIBUS Buspara-

meter

Block: Diagnostics, Index 32

Überblick

Daten der Antriebsverstärkung können für die Diagnose einer Reihe von Prozess- und
Gerätebedingungen verwendet werden. Die Daten der Antriebsverstärkung können für
eine Zeitspanne während des normalen Betriebs gesammelt und als Referenz zur
Störungsanalyse/-beseitigung verwendet werden.

Verfahren

1. Zu den Daten der Antriebsverstärkung navigieren.

2. Die Daten der Antriebsverstärkung über eine bestimmte Zeitspanne und unter
verschiedenen Prozessbedingungen beobachten und aufzeichnen.

20.22 Aufnehmerspannung prüfen
Wenn die Aufnehmerspannungswerte ungewöhnlich niedrig sind, ist es möglich, dass eine
von vielen möglichen Störungen im Prozess oder bei der Ausrüstung aufgetreten sind.

Um zu erfahren, ob die Aufnehmerspannung ungewöhnlich niedrig ist, müssen
Aufnehmerspannungsdaten gesammelt werden, während die Störung vorherrscht, und
diese Daten dann mit Daten der Aufnehmerspannung während des normalen Betriebs
verglichen werden.

Mögliche Ursachen und empfohlene Maßnahmen für eine niedrige
Aufnehmerspannung

Tabelle 20-9:   

Mögliche Ursache Empfohlene Maßnahmen

Lufteinschlüsse • Den einlaufseitigen oder auslaufseitigen Druck am Sensor
erhöhen.

• Befindet sich einlaufseitig vor dem Sensor eine Pumpe, den
Abstand zwischen Pumpe und Sensor vergrößern.

• Der Sensor muss möglicherweise neu ausgerichtet werden.
Weitere Informationen bzgl. der Sensorausrichtung sind im
Installationshandbuch zu finden.
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Mögliche Ursachen und empfohlene Maßnahmen für eine niedrige
Aufnehmerspannung (Fortsetzung)

Tabelle 20-9:   

Mögliche Ursache Empfohlene Maßnahmen

Fehlerhafte Verdrahtung zwi-
schen Sensor und Auswerteelek-
tronik

Verdrahtung zwischen Sensor und Auswerteelektronik prüfen.

Der Durchfluss befindet sich
außerhalb der Sensorgrenz-
werte.

Stellen Sie sicher, dass der Durchfluss nicht außerhalb des Sen-
sor-Messbereichs liegt.

Schwallströmung Auf Schwallströmung prüfen. Siehe Abschnitt 20.20.

Keine Schwingung der Sensor
Messrohre

• Auf verstopfte Messrohre prüfen.
• Stellen Sie sicher, dass der Sensor frei schwingen kann

(keine mechanische Verbindungen).
• Verdrahtung prüfen.

Feuchtigkeit in der Sensorelek-
tronik

Beseitigen Sie die Feuchtigkeit in der Sensorelektronik.

Der Sensor ist beschädigt oder
die Sensormagnete haben sich
entmagnetisiert.

Sensor austauschen.

20.22.1 Aufnehmer Spannungsdaten sammeln

ProLink II ProLink > Diagnostic Information

ProLink III Device Tools > Diagnostics > Core Processor Diagnostics

PROFIBUS EDD Service Tools > Maintenance > Diagnostic Variables

PROFIBUS Buspara-

meter

Left pickoff voltage: Block: Diagnostics, Index 35

Right pickoff voltage: Block: Diagnostics, Index 36

Überblick

Die Aufnehmer Spannungsdaten können zur Diagnose einer Vielzahl von Prozess- und
Gerätebedingungen verwendet werden. Die Aufnehmer Spannungsdaten können für eine
Zeitspanne während des normalen Betriebs gesammelt und als Referenz zur
Störungsanalyse/-beseitigung verwendet werden.

Verfahren

1. Die Aufnehmer Spannungsdaten aufrufen.

2. Die Daten für den linken und für den rechten Aufnehmer für einen bestimmte
Zeitspanne und unter verschiedenen Prozessbedingungen beobachten und
aufzeichnen.

20.23 Prüfen auf elektrische Kurzschlüsse
Kurzschlüsse zwischen Sensor Anschlussklemmen oder Sensor Anschlussklemmen und
dem Sensorgehäuse können einen Ausfall des Sensors bewirken.
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Mögliche Ursachen und empfohlene Maßnahmen bei elektrischen
Kurzschlüssen

Tabelle 20-10:   

Mögliche Ursache Empfohlene Maßnahme

Feuchtigkeit im Innern der Ans-
chlussdose

Sicherstellen, dass die Anschlussdose trocken und ohne Kor-
rosion ist.

Flüssigkeit oder Feuchtigkeit im
Sensorgehäuse

Micro Motion kontaktieren.

Kurzschluss in interner Durchfüh-
rung

Micro Motion kontaktieren.

Fehlerhaftes Kabel Das Kabel austauschen.

Unsachgemäße Kabelanschlüsse Kabelanschlüsse in der Sensor Anschlussdose prüfen. Das
Micro Motion Dokument mit dem Titel Kabelvorbereitung und
Installationsanleitung für 9-adrige Durchfluss-Messsysteme kann
hierbei möglicherweise hilfreich sein.
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Anhang A
Voreingestellte Werte und Bereiche

A.1 Voreingestellte Werte und Bereiche
Die Standardwerte und -bereiche repräsentieren die typische Auswerteelektronik-
Konfiguration. Je nach Bestellung der Auswerteelektronik sind bestimmte Werte vom
Hersteller konfiguriert und entsprechen nicht den Standardwerten und -bereichen. Diese
Werte gelten auch für Abfüllanwendungen mit externer Ventilsteuerung. Siehe 
Abschnitt 5.2.1 bzgl. Standardwerte für Abfüllungen mit integrierter Ventilsteuerung

Voreingestellte Werte und Bereiche der AuswerteelektronikTabelle A-1:   

Typ Parameter Standard Bereich Bemerkungen

Durchfluss Fließrichtung Vorwärts

Durchflussdämpfung 0,04 s 0,0 – 40,96 s Vom Anwender eingegebener
Wert, korrigiert auf den nächst
niedrigeren vorkonfigurierten
Wert in der Liste. Micro Motion
empfiehlt für Abfüllanwendun-
gen den Standardwert.

Massedurchfluss-Messeinheiten g/s

Massedurchflussabschaltung 0,0 g/s Empfohlene Einstellung ist 5 %
des max. Durchflusses vom Sen-
sor.

Volumendurchfluss-Messein-
heiten

l/s

Volumendurchflussabschaltung 0/0 l/s 0,0 – x L/s x erhalten Sie durch die Multipli-
kation des Durchflusskalibrier-
faktors mit 0,2, bei Verwendung
der Einheit L/s.

Messgeräte-
faktoren

Massefaktor 1

Dichtefaktor 1

Volumenfaktor 1

Dichte Dichtedämpfung 1,28 s 0,0 – 40,96 s Vom Anwender eingegebener
Wert, korrigiert auf den nächs-
ten vorkonfigurierten Wert in
der Liste.

Dichteeinheiten g/cm3

Dichteabschaltung 0,2 g/cm3 0,0 – 0,5
g/cm3

D1 0

D2 1
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Voreingestellte Werte und Bereiche der Auswerteelektronik (Fortsetzung)Tabelle A-1:   

Typ Parameter Standard Bereich Bemerkungen

K1 1000

K2 50.000,00

FD 0

Temp.-koeffizient 4,44

Schwallströ-
mung

Unterer Schwallstrom-Grenz-
wert

0,0 g/cm3 0,0 – 10,0
g/cm3

Oberer Schwallstrom-Grenzwert 5,0 g/cm3 0,0 – 10,0
g/cm3

Schwallstromdauer 0,0 s 0,0 – 60,0 s

Temperatur Temperaturdämpfung 4,8 s 0,0 – 38,4 s Vom Anwender eingegebener
Wert, korrigiert auf den nächst
niedrigeren vorkonfigurierten
Wert in der Liste.

Temperatureinheiten Grad C

Temperaturkalibrierfaktor 1.00000T0.00
00

Druck Druckeinheiten PSI

Durchflussfaktor 0

Dichtefaktor 0

Kalibrierter Druck 0

Spezialeinheit-
en (1)

Basis-Masseeinheit g

Basis Massezeit s

Massedurchfluss-Umrechnungs-
faktor

1

Basis-Volumeneinheit l

Basis-Volumenzeit s

Volumendurchfluss-Umrech-
nungsfaktor

1

mA-Ausgang Sekundärvariable Massedurch-
fluss

Messanfang -200,00000 g/s

Messende 200,00000 g/s

Analogausgangsabschaltung 0,00000 g/s

AO (Analogausgang) zusätzliche
Dämpfung

0,00000 s

USG -200 g/s Schreibgeschützt.

USG und OSG werden auf Basis
der Sensorgröße und Charakteri-
sierungsparameter berechnet.

OSG 200 g/s

Min. Spanne 0,3 g/s Schreibgeschützt

Fehlermaßnahme Herunterskalie-
ren
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Voreingestellte Werte und Bereiche der Auswerteelektronik (Fortsetzung)Tabelle A-1:   

Typ Parameter Standard Bereich Bemerkungen

Analogausgang-Störpegel – Her-
unterskalieren

2,0 mA 0,0 – 3,6 mA

Analogausgang-Störpegel – Her-
aufskalieren

22 mA 21,0 – 24,0 mA

Zuletzt gemessener Wert vor
Timeout

0,00 s

Messanfang Massedurchflussrate -200,000 g/s

Volumendurchflussrate -0,200 L/s

Dichte 0,000 g/cm3

Temperatur -240,000 ℃

Antriebsverstärkung 0,000 %

Standard-Gas-Volumendurch-
fluss

-423,78 SCFM

Externe Temperatur -240,000 ℃

Externer Druck 0,000 psi

Messende Massedurchflussrate 200,000 g/s

Volumendurchflussrate 0,200 l/s

Dichte 10,000 g/cm3

Temperatur 450,000 ℃

Antriebsverstärkung 100,000 %

Standard-Gas-Volumendurch-
fluss

423,78 SCFM

Externe Temperatur 450,000 ℃

Externer Druck 100,000 psi

Frequenzaus-
gang

Tertiärvariable Massedurch-
fluss

Frequenzfaktor 1.000,00 Hz 0,00091 –
10.000,00 Hz

Durchflussfaktor 16.666,66992
g/s

Frequenz-Impulsbreite 0 (50 % Puls/
Pause-Verhält-
nis)

0,01 – 655,35
ms

Skaliermethode Frequenz =
Durchfluss

Frequenz-Fehlermaßnahme Herunterskalie-
ren

Frequenz-Störpegel – Herauf-
skalieren

15.000 Hz 10,0 – 15.000
Hz

Frequenzausgangs-Polarität Active high

Zuletzt gemessener Wert vor
Timeout

0,0 s 0,0 – 60,0 s
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Voreingestellte Werte und Bereiche der Auswerteelektronik (Fortsetzung)Tabelle A-1:   

Typ Parameter Standard Bereich Bemerkungen

Binärausgang Zuweisung Störung

Fehleranzeige Keine

Spannungsversorgung Intern

Polarität Aktiv hoch

Binäreingang Zuweisung Keine

Polarität Aktiv niedrig

(1) Von PROFIBUS-DP nicht unterstützt.
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Anhang B
Verwendung ProLink II mit der
Auswerteelektronik

In diesem Anhang behandelte Themen:

• Grundlegende Informationen über das ProLink II

• Menüstruktur für ProLink II

B.1 Grundlegende Informationen über das
ProLink II
ProLink II ist ein Softwaretool von Micro Motion. Es läuft auf Windows und ermöglicht den
Zugriff auf alle Daten und Funktionen der Auswerteelektronik.

ProLink II Anforderungen

Die Auswerteelektronik erfordert mindestens ProLink II v2.91.

Zur Installation von ProLink II brauchen Sie:

• Das ProLink II Installationsmedium

• Das ProLink II Installationskit für Ihre Anschlussart

ProLink II sowie das passende Installationskit erhalten Sie von Micro Motion.

ProLink II Dokumentation

Die meisten Anweisungen in dieser Betriebsanleitung setzen voraus, dass Sie bereits mit
ProLink II vertraut sind oder sich mit Windows-Programmen auskennen. Wenn Sie mehr
Informationen brauchen, als Sie in dieser Betriebsanweisung finden, schlagen Sie im
Handbuch ProLink II (ProLink® II Software für Micro Motion® Auswerteelektroniken:
Installations- und Betriebsanleitung) nach.

Für die meisten ProLink II Installationen wird die Betriebsanleitung zusammen mit dem
ProLink II Programm installiert. Darüber hinaus finden die Betriebsanleitung für ProLink II
auf der Micro Motion Dokumentations-CD oder der Micro Motion Website
(www.micromotion.com).

ProLink II Merkmale und Funktionen

ProLink II bietet alle Funktionen zur Konfiguration und zum Betrieb der
Auswerteelektronik. ProLink II bietet außerdem eine Reihe zusätzlicher Merkmale und
Funktionen, einschließlich:

• Der Möglichkeit, die Auswerteelektronik-Konfigurationsdaten auf einer Datei auf
dem PC zu speichern und sie auf andere Auswerteelektroniken zu laden oder zu
kopieren

• Die Möglichkeit, spezifische Datentypen in einer Datei auf dem PC zu protokollieren

• Ein Inbetriebnahme-Wizard

• Ein Prüfungs-Wizard
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• Ein Gas-Wizard

Diese Funktionen werden in der ProLink II Betriebsanleitung beschrieben. Sie werden nicht
im aktuellen Handbuch beschrieben.

ProLink II Meldungen

Wenn Sie ProLink II mit einer Micro Motion Auswerteelektronik verwenden, sehen Sie eine
Reihe von Meldungen und Hinweisen. Diese Betriebsanleitung beschreibt nicht alle dieser
Meldungen und Hinweise.

Wichtig
Der Benutzer ist für die Reaktion auf Meldungen und Hinweise und die Befolgung aller
Sicherheitshinweise verantwortlich.

B.2 Menüstruktur für ProLink II

HauptmenüAbbildung B-1:   

File

Preferences
· Use External Temperature
· Enable Inventory Totals Reset
· Enable External Pressure Compensation
· Copper RTD

Installed options

Data LoggingLoad from Xmtr to File
Send to Xmtr from File

License

Connect to Device
Connect to Densitometer/ Viscometer
Disconnect

View Connection

Options
· ProLink II Language
· Error Log On

Tools Plug-insProLink

Configuration
Output Levels
Process Variables
Status
Alarm Log
Diagnostic Information
Calibration
Test
Totalizer Control
Core Processor Diagnostics
Batcher Control
Run Filler

Calibration
· Zero Calibration
· Milliamp 2 Trim
· Density Cal – Point 1
· Density Cal – Point 2
· Density Cal – Flowing Density
· Density Cal – Point 3
· Density Cal – Point 4
· Temp Offset Cal

Test
· Fix Freq Output
· Fix Milliamp 2
· Fix Discrete Output
· Read Discrete Input

See Fill Operation menu map.
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Abfüll KonfigurationsmenüAbbildung B-2:   

Filling

Flow Source

Filling Control Options
· Enable Filling Option
· Count Up
· Enable Dual Fill
· Enable AOC
· Enable Purge
· Enable Timed Fill
· Enable Fill Logging
· AOC Change Limit
· AOC Convergence Rate
· Fill Type
· Configure By
· Fill Target
· Max Fill Time
· Purge Mode
· Target Time
· Measured Fill Time
· Pump to Valve Delay
· Purge Delay
· Purge Time
· AOC Algorithm
· AOC Window Length
· Fixed Overshoot Comp

Discrete Valves for 2 Stage Filling
· Open Primary
· Open Secondary
· Close Primary
· Close Secondary

Discrete Output

Discrete Output 1
· DO1 Assignment
· DO1 Polarity
· DO1 Fault Action

Precision Discrete Outputs
· Precision DO1
· Precision DO2
· Precision DO1 Polarity
· Precision DO2 Polarity

Configuration

ProLink Menu
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Abfüll BetriebsmenüAbbildung B-3:   

Filling

Fill Setup
· Current Total
· Percent Fill
· Current Target
· Reset Fill Total
· AOC Coeff
· Secondary AOC Coeff
· Target Time

Fill Control
· Begin Filling
· Pause Filling
· Resume Filling
· End Filling
· Begin Purge
· End Purge
· Begin Cleaning
· End Cleaning

AOC Calibration
· Start AOC Cal
· Save AOC Cal
· Override Blocked Start
· Reset AOC Flow Rate
· Start Sec AOC Cal
· Save Sec AOC Cal

Fill Statistics

Fill Data

Fill Status

ProLink

Configuration
Output Levels
Process Variables
Status
Alarm Log
Diagnostic Information
Calibration
Test
Totalizer Control
Core Processor Diagnostics
Batcher Control
Run Filler

· Fill Total Average
· Fill Total Variance
· Secondary Fill Total Average
· Secondary Fill Total Variance
· Reset Fill Statistics

· Max Fill Time Exceeded
· Filling In Progress
· Secondary Fill In Progress
· Cleaning In Progress
· Purge In Progress
· Purge Delay Phase
· Primary Valve
· Secondary Valve
· Pump
· Purge Valve
· AOC Flow Rate Too High
· AOC Calibration Active
· Start Not Okay

· Fill Time
· Fill Count
· Reset Fill Count
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KonfigurationsmenüAbbildung B-4:   

Configuration

ProLink Menu

Flow

· Flow Direction
· Flow Damp
· Flow Cal
· Mass Flow Cutoff
· Mass Flow Units
· Vol Flow Cutoff
· Vol Flow Units
· Mass Factor
· Dens Factor
· Vol Factor

Density

· Density Units
· Density Damping
· Slug High Limit
· Slug Low Limit
· Slug Duration
· Low Density Cutoff
· K1
· K2
· FD
· D1
· D2
· Temp Coeff (DT)

Temperature

· Temp Units
· Temp Cal Factor
· Temp Damping
· External Temperature

Pressure

· Flow Factor
· Dens Factor
· Cal Pressure
· Pressure Units
· External Pressure

Sensor

· Sensor s/n
· Sensor Model
· Sensor Matl
· Liner Matl
· Flange

Special Units

· Base Mass Unit
· Base Mass Time
· Mass Flow Conv Fact
· Mass Flow Text
· Mass Total Text
· Base Vol Unit
· Base Vol Time
· Vol Flow Conv Fact
· Vol Flow Text
· Vol Total Text

T Series

· FTG
· FFQ
· DTG
· DFQ1
· DFQ2
· K3
· D3
· D4
· K4

Analog Output

· Secondary Variable
is

· Lower Range Value
· Upper Range Value
· AO Cutoff
· AO Added Damp
· Lower Sensor Limit
· Upper Sensor Limit
· Min Span
· AO Fault Action
· AO Fault Level
· Last Measured

Value Timeout
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Konfigurationsmenü (Fortsetzung)Abbildung B-5:   

Device

· Model 
· Hardware Rev
· Software Rev
· Option Board
· Manufacturer
· Distributor
· ETO
· Tag
· Date
· Descriptor
· Message
· Sensor Type
· Transmitter Serial
· Floating Pt Ordering
· Add Comm Resp Delay

Digital Comm Settings
· Digital Comm Fault Setting
· Device ID
· Modbus Address
· Response Time

Discrete Events

· Event Name
· Event Type
· Process Variable 
· Low Setpoint
· High Setpoint

Channel

Channel B
· Type Assignment

Alarm

· Alarm 
· Severity

Sensor Simulation

· Enable Simulation 
Mode

· Mass Flow
· Density
· Temperature

Discrete Input

Assignment
· Reset Mass Total
· Reset Volume Total
· Reset All Totals
· Begin Fill
· End Fill
· Resume Fill
· Pause Fill

Polarity

Frequency

· Tertiary Variable
· Freq Factor
· Rate Factor
· Freq Pulse Width
· Last Measured Value 

Timeout
· Scaling Method
· Freq Fault Action
· Freq Output Polarity

Configuration

ProLink Menu
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Anhang C
Einrichten und die Verwendung der
PROFIBUS-Schnittstellen

In diesem Anhang behandelte Themen:

• Von der Auswerteelektronik unterstützte PROFIBUS-DP Funktionalität

• Optionen für PROFIBUS Kommunikation

• Menüstruktur für PROFIBUS EDD

• Einrichten der GSD

• Verwenden der PROFIBUS Busparameter

C.1 Von der Auswerteelektronik unterstützte
PROFIBUS-DP Funktionalität
Die Auswerteelektronik fungiert als Standard PROFIBUS-DP Knoten und kann in alle
Standard PROFIBUS-DP Netzwerke integriert werden.

Die Auswerteelektronik unterstützt die folgende PROFIBUS-DP Funktionalität:

• Netzwerkgeschwindigkeiten: Die Auswerteelektronik erkennt automatisch die
Netzwerkgeschwindigkeit und kann bei allen Standard-Baudraten zwischen
9,6 kbit/s und 12,0 Mbit/s kommunizieren.

• E/A Slave Übermittlung:

- Zyklisch

- Azyklisch

• Konfigurationsmethoden:

- Knotenadresse mittels Hardware-Schaltern

- Gerätebeschreibung (EDD) gemäß: Spezifikation für PROFIBUS Gerätebeschreibung
und Geräteintegration: Ausgabe 2: EDDL V1.2, Dezember 2005

- DP-V1-Lese- und Schreibbetrieb mit PROFIBUS Busparametern

• Betriebsmethoden:

- GSD gemäß: Spezifikation für PROFIBUS Gerätebeschreibung und Geräteintegration:
Ausgabe 1: GSD V5.1, Juli 2008

- DP-V0 zyklischer Betrieb

- Gerätebeschreibung oben aufgelistet

- DP-V1-Lese- und Schreibbetrieb (MS1 und MS2) mit PROFIBUS Busparametern

• Identifikations- und Wartungsfunktionen (I&M) gemäß: Profilrichtlinien Teil 1:
Identifikations- und Wartungsfunktionen Version 1.2, Oktober 2009:

- I&M 0

- I&M 1
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C.2 Optionen für PROFIBUS Kommunikation
Die Auswerteelektronik unterstützt sowohl DP-V0 als auch DP-V1 Dienste. Die Parameter,
die durch die DP-V0 Dienste unterstützt werden, sind ein Subset der durch DP-V1 Dienste
unterstützten Parameter. Normalerweise werden DP-V1 Dienste für die Kalibrierung der
Auswerteelektronik und die Störungsanalyse und -beseitigung verwendet.

PROFIBUS KommunikationsmethodenTabelle C-1:   

Kommunikationsart Interface-Option Funktionen

Zyklisch GSD (Generic Station De-
scription)

• Abrufen von Prozessdaten und Alarmen
• Stoppen, Starten und Zurücksetzen der Summenzähler
• Senden externer Druck- oder Temperaturdaten an die

Auswerteelektronik

Azyklisch EDD (Enhanced Device De-
scription)

• Anzeigen von Prozessdaten und Alarmen
• Stoppen, Starten und Zurücksetzen der Summenzähler
• Konfigurieren der Auswerteelektronik
• Anzeigen des Ereignisstatus
• Durchführen von Nullpunkt-, Dichte- und Temperatur-

kalibrierung

Busparameter Abschließen der Arbeiten am Konfigurations-, Betriebs-
und Wartungs-Interface

C.3 Menüstruktur für PROFIBUS EDD

HauptmenüAbbildung C-1:   

Online

Overview Configure Service Tools
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ÜbersichtsmenüAbbildung C-2:   

Online > 
 Overview

Device Information
· Identification
· Revisions
· Materials of

Construction

Variables
· Process Variables
· External Variables
· Outputs

Totalizer Control
· Start
· Stop
· Reset All
· Reset Total (Mass)
· Reset Total (Volume)

Fill Control

Zero Calibration
· Zero Time
· Perform Auto Zero
· Restore Factory Zero

Trends
· Process Variables
· Diagnostics Variables
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Menü AbfüllsteuerungAbbildung C-3:   

Online > 
 Overview >
     Fill Control

Fill Variables
· Current Total
· Percent Fill

Setup
· Fill Target
· Target Time

Alerts

Fill Control
· Reset Fill Total
· Begin Filling
· End Filling
· Pause Filling
· Resume Filling
· Begin Cleaning
· End Cleaning
· Begin Secondary Filling
· End Secondary Filling
· Begin Purge
· End Purge
· Override Blocked Start

· View Active Alerts

Fill Statistics
· Fill Count
· Fill Total Average
· Fill Total Variance
· Secondary Fill Totals

Average
· Secondary Fill Totals

Variance
· Reset Fill Count
· Reset Fill Statistics

AOC Variables
· Primary AOC Coefficient
· Secondary AOC

Coefficient

Control
· Start AOC Cal
· Save AOC Cal
· Start Secondary AOC Cal
· Save Secondary AOC Cal
· Reset AOC Flow Rate

Fill Control Fill Statistics AOC Control

Alerts
· AOC Flow Rate Too High
· Cleaning In Progress
· Training Primary AOC
· Filling In Progress
· Training Secondary AOC
· Secondary Fill In Progress
· Purge In Progress
· Automatic Purge Delay State
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Menü KonfigurationAbbildung C-4:   

Online > 
 Configure

Guided Setup
· Sensor
· Zero Calibration
· Filling
· Inputs/Outputs
· mA Output Trim

Manual Setup Alert Setup

Inputs/Outputs Fault 
Actions

mA Output
· Fault Action
· Fault Level

Frequency Output
· Fault Action
· Fault Level

Digital Communications
· Fault Action

Alert Severity
· Fault Timeout
· Change Alert Severity
· View Alert Severity

Discrete Events
· Setup Event Trigger
· Assign Discrete Action
· Read Discrete Action

Assignment
· Review All Discrete

Actions
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Menü Manuelle EinrichtungAbbildung C-5:   

Online > 
 Configure >
     Manual Setup

Measurements Informational Parameters

Filling Inputs/Outputs
· Channels
· mA Output
· Discrete Input
· Discrete Output
· Frequency Output

Characterize

Filling Configuration
· Fill Configuration
· Secondary Fill

AOC Configuration Purge Configuration

Menü MessungenAbbildung C-6:   

Online > 
 Configure >
     Manual Setup >

   Measurements

Temperature
· Temperature Unit
· Temperature Damping

Advanced Setup
· External Compensation

Flow
· Flow Direction
· Flow Damping
· Mass Flow Cutoff
· Mass Flow Unit
· Mass Factor
· Volume Flow Cutoff
· Volume Flow Unit
· Volume Factor

Density
· Density Unit
· Density Damping
· Density Cutoff
· Density Factor
· Slug Duration
· Slug Low Limit
· Slug High Limit
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Menü AbfüllungAbbildung C-7:   

Online > 
 Configure >
     Manual Setup >

   Filling

Fill Type
· Enable Dual Fill
· Enable Timed Fill
· Enable Fill Logging

Basic Fill Settings
· Count Direction
· Flow Source
· Max Fill Time
· Pump to Valve Delay
· Configure By
· Fill Target
· Target Time

Advanced Fill Settings
· Measured Fill Time
· Fill Type
· Open Primary
· Open Secondary
· Close Primary
· Close Secondary

· Output

· Discrete Input

Discrete Output
· Assignment
· Polarity
· Fault Action
· Fixed DO
· DO Fixed Value

Precision Output
· Precision DO1
· Precision DO1 Polarity
· Precision DO2
· Precision DO2 Polarity

Discrete Input
· Begin Fill
· End Fill
· Pause Fill
· Resume Fill
· Reset Mass Total
· Reset Volume Total
· Reset All Totals
· DI1 Polarity

Filling Configuration
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Menüs AOC- und SpülkonfigurationAbbildung C-8:   

Online > 
 Configure >
     Manual Setup >

   Filling

Setting
· AOC Algorithm
· AOC Change Limit
· AOC Convergence Rate
· Fixed Overshoot Comp
· AOC Window Length
· Primary AOC Coefficient
· Secondary AOC Coefficient

Mode
· Enable AOC

AOC Configuration Purge Configuration

Setting
· Purge Mode
· Purge Purge
· Purge Time

Mode
· Enable Purge

Menü Service ToolsAbbildung C-9:   

Online > 
 Service Tools

Alerts
· Acknowledge All

Alerts
· Alert List

Trends
· Process Variables
· Diagnostic Variables

Variables
· Process Variables
· External Variables
· Outputs

Maintenance

Simulate
· mA Output Loop Test
· Frequency Output Test
· Discrete Output Test
· Precision Discrete Output 1
· Precision Discrete Output 2
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Menü WartungAbbildung C-10:   

Online > 
 Service Tools >
     Maintenance

Maintenance
· mA Output Trim

Density Calibrations
· First Point Calibration
· Second Point Calibration
· Third Point Calibration
· Fourth Point Calibration
· Flow Density Calibration

Zero Calibration
· Zero Time
· Perform Auto Zero
· Restore Factory Zero

Diagnostic Variables
· Drive Gain
· Left Pickoff Amplitude
· Right Pickoff Amplitude
· Tube Frequency
· Live Zero Flow Rate
· Board Temperature

C.4 Einrichten der GSD
Die GSD (Generic Station Description) unterstützt die zyklische Kommunikation
(automatischer, periodischer Datenaustausch) zwischen der Auswerteelektronik und
einem PROFIBUS Host unter Verwendung vordefinierter Ein- und Ausgangsmodule. Sie
können maximal zwanzig Module auswählen.

1. Laden Sie die folgende Datei von der Emerson Website herunter: MMI_0C7E.GSD

a. Öffnen Sie http://micromotion.com im Browser.

b. Klicken Sie in der Liste Quick Links auf Software Downloads und navigieren Sie zur
Seite „Device Drivers“.

c. Gehen Sie zum Geräte-Installationskit für Ihre Auswerteelektronik, wählen Sie die
GSD und laden Sie die Datei auf Ihren PC herunter.

2. Importieren Sie die GSD in Ihren PROFIBUS Host.

3. Konfigurieren Sie den Host mit der Netzknotenadresse der Auswerteelektronik und
anderen erforderlichen Daten.

Hinweis
Knotenadresse des Senders wurde während der Installation festgelegt Sender. Sehen
Micro Motion FMT Auswerteelektronik für Masseabfüllung: Installationsanleitung für weitere
Informationen.

4. Verwenden Sie die für Ihren Host angemessene Methode und wählen Sie die
(maximal 20) Ein- und Ausgangsmodule, die Sie verwenden möchten.
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5. Verwenden Sie die für Ihren Host angemessene Methode und starten Sie die
zyklische Kommunikation.

C.4.1 Eingangsmodule in der GSD
Eingangsmodule werden verwendet, um Prozess- oder Diagnosedaten an den Host zu
senden. Jedes Eingangsmodul ist einer Prozess- oder Diagnosevariable in der
Auswerteelektronik zugeordnet. Sobald der Host einen zyklischen Lesevorgang ausführt,
wird der aktuelle Wert der Variable ermittelt.

Eingangsmodule in der GSDTabelle C-2:   

Modulname Größe (Bytes) Bemerkungen

Device Status 1 • Akzeptable Daten
• Nicht akzeptable Daten

Mass Flow 4

Mass Total 4

Temperature 4

Density 4

Volume Flow 4

Volume Total 4

Drive Gain 4

SNS STATUS WORD1 2 Siehe folgende Tabelle.

SNS STATUS WORD2 2 Siehe folgende Tabelle.

SNS STATUS WORD3 2 Siehe folgende Tabelle.

SNS STATUS WORD4 2 Siehe folgende Tabelle.

SNS STATUS WORD5 2 Siehe folgende Tabelle.

SNS STATUS WORD6 2 Siehe folgende Tabelle.

SNS STATUS WORD7 2 Siehe folgende Tabelle.

Fill Total 4

Fill Time 4

Fill Count 2

Percent Fill Completed 4

Fill Status Word 2

Fill Diagnostics Word 2

Bit descriptions for STATUSWORD1Tabelle C-3:   

Hexadecimal Bit Description

0x0001 0

0x0002 1

0x0004 2

0x0008 3 No Sensor Response

0x0010 4
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Bit descriptions for STATUSWORD1 (Fortsetzung)Tabelle C-3:   

Hexadecimal Bit Description

0x0020 5

0x0040 6 Other Failure

0x0080 7

0x0100 8

0x0200 9

0x0400 10 Sensor Simulation Active

0x0800 11

0x1000 12

0x2000 13

0x4000 14

0x8000 15 Fault

Bit descriptions for STATUSWORD2Tabelle C-4:   

Hexadecimal Bit Description

0x0001 0

0x0002 1

0x0004 2

0x0008 3

0x0010 4 Density Overrange

0x0020 5 Drive Overrange

0x0040 6 PIC/Daughterboard Communications Failure

0x0080 7

0x0100 8 EEPROM Error (Core Processor)

0x0200 9 RAM Error (Core Processor)

0x0400 10

0x0800 11 Temperature Overrange

0x1000 12 Mass Flow Rate Overrange

0x2000 13

0x4000 14 Characterization Required

0x8000 15

Bit descriptions for STATUSWORD3Tabelle C-5:   

Hexadecimal Bit Description

0x0001 0

0x0002 1 Power Reset Occurred

0x0004 2 Transmitter Initializing/Warming Up

0x0008 3
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Bit descriptions for STATUSWORD3 (Fortsetzung)Tabelle C-5:   

Hexadecimal Bit Description

0x0010 4

0x0020 5

0x0040 6

0x0080 7

0x0100 8 Calibration Failure

0x0200 9 Zero Calibration Failed: Low

0x0400 10 Zero Calibration Failed: High

0x0800 11 Zero Calibration Failed: Unstable

0x1000 12 Transmitter Failure

0x2000 13

0x4000 14 Calibration in Progress

0x8000 15 Slug Flow

Bit descriptions for STATUSWORD4Tabelle C-6:   

Hexadecimal Bit Description

0x0001 0

0x0002 1

0x0004 2 Sensor RTD Failure

0x0008 3 T-Series RTD Failure

0x0010 4 Reverse Flow

0x0020 5 Factory Configuration Data Is Invalid

0x0040 6

0x0080 7 Last Measured Value Override Active

0x0100 8

0x0200 9 No Flow Cal Value

0x0400 10

0x0800 11

0x1000 12 No K1 Value

0x2000 13

0x4000 14

0x8000 15

Bit descriptions for STATUSWORD5Tabelle C-7:   

Hexadecimal Bit Description

0x0001 0

0x0002 1

0x0004 2
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Bit descriptions for STATUSWORD5 (Fortsetzung)Tabelle C-7:   

Hexadecimal Bit Description

0x0008 3

0x0010 4 Discrete Output Status

0x0020 5

0x0040 6 Density D3 Calibration in Progress

0x0080 7 Density D4 Calibration in Progress

0x0100 8

0x0200 9

0x0400 10 Temperature Slope Calibration in Progress

0x0800 11 Temperature Offset Calibration in Progress

0x1000 12 Density FD Calibration in Progress

0x2000 13 Density D2 Calibration in Progress

0x4000 14 Density D1 Calibration in Progress

0x8000 15 Zero Calibration in Progress

Bit descriptions for STATUSWORD6Tabelle C-8:   

Hexadecimal Bit Description

0x0001 0

0x0002 1

0x0004 2

0x0008 3

0x0010 4

0x0020 5

0x0040 6

0x0080 7

0x0100 8 Enhanced Event 1 Status (index = 0)

0x0200 9 Enhanced Event 2 Status (index = 1)

0x0400 10 Enhanced Event 3 Status (index = 2)

0x0800 11 Enhanced Event 4 Status (index = 3)

0x1000 12 Enhanced Event 5 Status (index = 4)

0x2000 13

0x4000 14

0x8000 15 Incorrect Board Type

Bit descriptions for STATUSWORD7Tabelle C-9:   

Hexadecimal Bit Description

0x0001 0 K1/FCF Combination Unrecognized

0x0002 1 Transmitter Initializing/Warming Up
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Bit descriptions for STATUSWORD7 (Fortsetzung)Tabelle C-9:   

Hexadecimal Bit Description

0x0004 2 Low Power

0x0008 3 Right/Left Pickoff Signal

0x0010 4

0x0020 5

0x0040 6

0x0080 7

0x0100 8

0x0200 9

0x0400 10

0x0800 11

0x1000 12

0x2000 13

0x4000 14

0x8000 15

C.4.2 Ausgangsmodule in der GSD
Ausgangsmodule werden verwendet, um externe Daten an die Auswerteelektronik zu
senden oder um Aktionen der Auswerteelektronik einzuleiten. Wenn der Host einen
zyklischen Schreibvorgang ausführt, schreibt er den aktuellen Wert des Ausgangsmoduls
in den Speicher der Auswerteelektronik.

Ausgangsmodule in der GSDTabelle C-10:   

Modulname Größe (Bytes) Bemerkungen

Start/Stop Totals 1 • 0 = Stop
• 1 = Start

Reset Process Totals 1 • 0 = No action
• 1 = Perform action

Reset Inv Totals 1 • 0 = No action
• 1 = Perform action

Start Fill 1 • 0 = No action
• 1 = Perform action

Pause Fill 1 • 0 = No action
• 1 = Perform action

Resume Fill 1 • 0 = No action
• 1 = Perform action

End Fill 1 • 0 = No action
• 1 = Perform action

Reset Fill Total 1 • 0 = No action
• 1 = Perform action

Start Secondary Fill 1 • 0 = No action
• 1 = Perform action
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Ausgangsmodule in der GSD (Fortsetzung)Tabelle C-10:   

Modulname Größe (Bytes) Bemerkungen

End Secondary Fill 1 • 0 = No action
• 1 = Perform action

Start Purge 1 • 0 = No action
• 1 = Perform action

End Purge 1 • 0 = No action
• 1 = Perform action

Start Cleaning 1 • 0 = No action
• 1 = Perform action

End Cleaning 1 • 0 = No action
• 1 = Perform action

Reset AOC Flow Rate 1 • 0 = No action
• 1 = Perform action

C.4.3 Inhalte der Diagnosebytes 11 bis 24
Die Auswerteelektronik setzt während zyklischer Kommunikation ein Flag, um anzuzeigen,
dass ein oder mehrere Alarme aufgetreten sind. Der Host liest die Diagnosebytes, um den
entsprechenden Alarm zu bestimmen. Wenn ein Bit gesetzt wurde, sind ein oder mehrere
entsprechende Alarme aktiv.

Anmerkung
Die Diagnosebytes 11 bis 24 enthalten gerätespezifische Daten. Die Inhalte der Diagnosebytes 1 bis
10 sind in der PROFIBUS Spezifikation definiert. Weitere Informationen über Diagnosebytes 1 bis 10
sind in der PROFIBUS Spezifikation zu finden.

Diagnosebyte 11Tabelle C-11:   

Bit Aktive Alarme (einer oder mehrere)

24 A014: Auswerteelektronikfehler

25 Reserviert

26 Reserviert

27 Reserviert

28 A001: EEPROM-Fehler (Core-Prozessor)

A002: RAM-Fehler (Core-Prozessor)

29 A003: Keine Antwort vom Sensor

A004: Messbereichsüberschreitung für Temperatur

A005: Messbereichsüberschreitung für Massedurchfluss

A008: Dichte Bereichsüberschreitung

A016: Sensor-RTD-Fehler

A017: T-Serien-RTD-Fehler

30 A009: Auswerteelektronik Initialisierung/Aufwärmphase

31 Reserviert
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Diagnosebyte 12Tabelle C-12:   

Bit Aktive Alarme (einer oder mehrere)

32 A010: Kalibrierfehler

A011: Nullpunktkalibrierung fehlgeschlagen: Tief

A012: Nullpunktkalibrierung fehlgeschlagen: Hoch

A013: Nullpunktkalibrierung fehlgeschlagen: Instabil

33 Reserviert

34 Reserviert

35 A107: Spannungsunterbrechung eingetreten

36 A107: Spannungsunterbrechung eingetreten

37 Reserviert

38 A006: Charakterisierung erforderlich

A020: K.wrt f. k. Drchflss

A021: Falscher Sensortyp (K1)

39 Reserviert

Diagnosebyte 13Tabelle C-13:   

Bit Aktive Alarme (einer oder mehrere)

40 Reserviert

41 Reserviert

42 Reserviert

43 Reserviert

44 Reserviert

45 Reserviert

46 Reserviert

47 Reserviert

Diagnosebyte 14Tabelle C-14:   

Bit Aktive Alarme (einer oder mehrere)

48 Reserviert

49 Reserviert

50 Reserviert

51 Reserviert

52 Reserviert

53 Reserviert

54 Reserviert

55 Reserviert
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Diagnosebyte 15Tabelle C-15:   

Bit Aktive Alarme (einer oder mehrere)

56 Reserviert

57 A001: EEPROM-Fehler (Core-Prozessor)

58 A002: RAM-Fehler (Core-Prozessor)

59 A003: Keine Antwort vom Sensor

60 A004: Messbereichsüberschreitung für Temperatur

61 A005: Messbereichsüberschreitung für Massedurchfluss

62 A006: Charakterisierung erforderlich

63 Reserviert

Diagnosebyte 16Tabelle C-16:   

Bit Aktive Alarme (einer oder mehrere)

64 A008: Dichte Bereichsüberschreitung

65 A009: Auswerteelektronik Initialisierung/Aufwärmphase

66 A010: Kalibrierfehler

67 A011: Nullpunktkalibrierung fehlgeschlagen: Tief

68 A012: Nullpunktkalibrierung fehlgeschlagen: Hoch

69 A013: Nullpunktkalibrierung fehlgeschlagen: Instabil

70 A014: Auswerteelektronikfehler

71 Reserviert

Diagnosebyte 17Tabelle C-17:   

Bit Aktive Alarme (einer oder mehrere)

72 A016: Sensor-RTD-Fehler

73 A017: T-Serien-RTD-Fehler

74 Reserviert

75 Reserviert

76 A020: K.wrt f. k. Drchflss

77 A021: Falscher Sensortyp (K1)

78 Reserviert

79 Reserviert

Diagnosebyte 18Tabelle C-18:   

Bit Aktive Alarme (einer oder mehrere)

80 Reserviert

81 Reserviert

82 Reserviert
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Diagnosebyte 18 (Fortsetzung)Tabelle C-18:   

Bit Aktive Alarme (einer oder mehrere)

83 Reserviert

84 Reserviert

85 A029: PIC/Tochterboard-Kommunikationsfehler

86 A030: Falscher Platinentyp

87 A031: Spannung zu niedrig

Diagnosebyte 19Tabelle C-19:   

Bit Aktive Alarme (einer oder mehrere)

88 Reserviert

89 A033: Unzureichendes Signal von rechter/linker Aufnehmerspule

90 Reserviert

91 Reserviert

92 Reserviert

93 Reserviert

94 Reserviert

95 Reserviert

Diagnosebyte 20Tabelle C-20:   

Bit Aktive Alarme (einer oder mehrere)

96 Reserviert

97 Reserviert

98 A102: Antrieb Bereichsüberschreitung

99 Reserviert

100 A105: Schwallströmung

101 A105: Schwallströmung

102 Reserviert

103 A107: Spannungsunterbrechung eingetreten

Diagnosebyte 21Tabelle C-21:   

Bit Aktive Alarme (einer oder mehrere)

104 Reserviert

105 Reserviert

106 Reserviert

107 Reserviert

108 Reserviert

109 Reserviert
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Diagnosebyte 21 (Fortsetzung)Tabelle C-21:   

Bit Aktive Alarme (einer oder mehrere)

110 Reserviert

111 Reserviert

Diagnosebyte 22Tabelle C-22:   

Bit Aktive Alarme (einer oder mehrere)

112 Reserviert

113 Reserviert

114 Reserviert

115 Reserviert

116 Reserviert

117 Reserviert

118 Reserviert

119 Reserviert

Diagnosebyte 23Tabelle C-23:   

Bit Aktive Alarme (einer oder mehrere)

120 Reserviert

121 Reserviert

122 Reserviert

123 Reserviert

124 Reserviert

125 Reserviert

126 Reserviert

127 Reserviert

Diagnosebyte 24Tabelle C-24:   

Bit Aktive Alarme (einer oder mehrere)

128 A132: Sensorsimulation aktiv

129 Reserviert

130 Reserviert

131 Reserviert

132 Reserviert

133 Reserviert

134 Reserviert

135 Reserviert
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C.5 Verwenden der PROFIBUS Busparameter
PROFIBUS Busparameter ermöglichen den Zugriff auf alle Funktionen, die über den DP-
Port der Auswerteelektronik verfügbar sind. Sie können die Busparameter verwenden, um
die Auswerteelektronik zu konfigurieren, zu betreiben und um wartungstechnische
Aktivitäten durchzuführen.

Vorbereitungsverfahren

Ihr PROFIBUS Host oder Ihre Verwaltungsumgebung muss auf die Verwendung von DP-V1-
Diensten ausgelegt sein.

Verfahren

1. Stellen Sie die Verbindung zur Auswerteelektronik mittels der für Ihre
Betriebsumgebung geeigneten Methode her.

Hinweis
Knotenadresse des Senders wurde während der Installation festgelegt Sender. Sehen
Micro Motion FMT Auswerteelektronik für Masseabfüllung: Installationsanleitung für weitere
Informationen.

2. Verwenden Sie DP-V1-Dienste, um einen Lese-/Schreibvorgang von Werten auf
spezifische Parameter der Auswerteelektronik auszuführen.

C.5.1 PROFIBUS-Datentypen
Los siguientes tipos de datos se utilizan en la interfaz de parámetros de bus PROFIBUS.

PROFIBUS-DatentypenTabelle C-25:   

Datentyp
Größe
(Byte) Beschreibung Angebot Code

Boolean 1 Wahr/Falsch 0 = Falsch

1 = Wahr

BOOL

Integer8 1 8-Bit-Integer-Wert -128 Bis +127 INT8

Unsigned8 1 8-Bit-Ganzzahl ohne Vorzeichen 0 bis 255 UINT8

Integer16 2 16-Bit-Integer-Wert -32.768 bis 32.767 INT16

Unsigned16 2 16-Bit-Ganzzahl ohne Vorzeichen 0 bis 65535 UINT16

Integer32 4 32-Bit-Integer-Wert -2147483648 bis
+2147483647

INT32

Unsigned32 4 32-Bit-Ganzzahl ohne Vorzeichen 0 bis 4294967296 UINT32

FLOAT 4 IEEE Single-Precision-Fließkomma
Wert

-3.8E38 um 3,8 E38 FLOAT

OCTET STRING Bis zu 128
Bytes

Array von ASCII-Zeichen N/A STRING

BIT_ENUMER-
ATED

2 Aufzählungswert in dem jeder Bit
steht für eine andere Aufzählung

N/A B_ENUM
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C.5.2 PROFIBUS Measurement Block (Slot 1) und relevante
Informationen
In der folgenden Tabelle:

Index Der Index des Parameters innerhalb des Blocks

Name Der für den Parameter im Block verwendete Name

Datentyp Der Datentyp des Parameters

Speicherklasse Die Speicherklasse des Parameters:

D Dynamischen Speicher (zyklische Daten, Parameter regelmäßig
aktualisiert)

S Statische Shop (azyklische Daten, Parameter verändert auf einer
vorsätzlichen Schreiben)

N Nicht-flüchtige Parameter (über Leistungszyklen gespeichert)

Zugriff Die Art des Zugriffs für den Parameter erlaubt:

RO Lesen-nur

RW Lesen / Schreiben

Standardwert Value-at-Werk konfiguriert, es sei denn, eine spezielle Konfiguration
bestellt wurde

Kommentare Eine kurze Definition der Parameter, der Name des Parameters in
ProLink II, oder eine Information über den Parameter

Inhalt des Measurement BlockTabelle C-26:   

Index Name Datentyp
Speicher-
klasse Zugriff

Voreinges-
tellter
Wert Bemerkungen

4 SNS_MassFlow FLOAT D RO 0 Aktueller Wert der Mas-
sedurchfluss Prozessvar-
iablen

5 SNS_MassFlowUnits UINT16 S RW 0x0526
(1318)

Messeinheit der Masse-
durchflussmessung (In-
tegercode; siehe 
Tabelle C-27)

6 SNS_Temperature FLOAT D RO 0 Aktueller Wert der Tem-
peratur Prozessvariablen

7 SNS_TemperatureUnits UINT16 S RW 0x03E9
(1001)

Temperaturmesseinheit
(Integercode; siehe 
Tabelle C-29)

8 SNS_Density FLOAT D RO 0 Aktueller Wert der
Dichte Prozessvariablen

9 SNS_DensityUnits UINT16 S RW 0x044C
(1100)

Dichtemesseinheit (Inte-
gercode; siehe 
Tabelle C-30)

10 SNS_VolFlow FLOAT D RO 0 Aktueller Wert der Volu-
mendurchfluss Prozess-
variablen
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Inhalt des Measurement Block (Fortsetzung)Tabelle C-26:   

Index Name Datentyp
Speicher-
klasse Zugriff

Voreinges-
tellter
Wert Bemerkungen

11 SNS_VolumeFlowUnits UINT16 S RW 0x0547
(1351)

Messeinheit der Volu-
mendurchflussmessung
(Integercode; siehe 
Tabelle C-31)

12 SNS_DampingFlowRate FLOAT S RW 0,04 Durchfluss-Dämpfungs-
wert (0,0 bis 60,0 s)

13 SNS_DampingTemp FLOAT S RW 4,8 Temperatur-Dämp-
fungswert (0,0 bis 80,0
s)

14 SNS_DampingDensity FLOAT S RW 1,6 Dichte-Dämpfungswert
(0,0 bis 60,0 s)

15 SNS_MassMeterFactor FLOAT S RW 1 Massedurchfluss Geräte-
faktor (0,8 bis 1,2)

16 SNS_DensMeterFactor FLOAT S RW 1 Dichte Gerätefaktor (0,8
bis 1,2)

17 SNS_VolMeterFactor FLOAT S RW 1 Volumendurchfluss Ger-
ätefaktor (0,8 bis 1,2)

18 SNS_MassFlowCutoff FLOAT S RW 0 Massedurchflussabschal-
tung (0 bis Sensor-
grenze)

19 SNS_VolumeFlowCutoff FLOAT S RW 0 Volumendurchflussab-
schaltung (0 bis Sensor-
grenze)

20 SNS_LowDensityCutoff FLOAT S RW 0 Dichteabschaltung (0,0
bis 0,5)

21 SNS_FlowDirection UINT16 S RW 0 Durchflussrichtung (In-
tegercode; siehe 
Tabelle C-33)

22 SNS_StartStopTotals UINT16 S RW N/A • 0 = Summenzähler
stoppen

• 1 = Summenzähler
starten

23 SNS_ResetAllTotal UINT16 S RW N/A • 0 = No action
• 1 = Perform action

24 SNS_ResetAll Inventories UINT16 S RW N/A • 0 = No action
• 1 = Perform action

25 SNS_ResetMassTotal UINT16 S RW N/A • 0 = No action
• 1 = Perform action

26 SNS_ResetLineVolTotal UINT16 S RW N/A • 0 = No action
• 1 = Perform action

27 SNS_MassTotal FLOAT D RO 0 Aktueller Wert des
Masse Summenzählers

28 SNS_VolTotal FLOAT D RO 0 Aktueller Wert des Volu-
men Summenzählers
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Inhalt des Measurement Block (Fortsetzung)Tabelle C-26:   

Index Name Datentyp
Speicher-
klasse Zugriff

Voreinges-
tellter
Wert Bemerkungen

29 SNS_MassInventory FLOAT D RO 0 Aktueller Wert des
Masse Gesamtzählers

30 SNS_VolInventory FLOAT D RO 0 Aktueller Wert des Volu-
men Gesamtzählers

31 SNS_MassTotalUnits UINT16 S RO 0x0441
(1089)

Messeinheit für den
Masse Summenzähler
und Gesamtzähler (Inte-
gercode; siehe 
Tabelle C-28)

32 SNS_VolTotalUnits UINT16 S RO 0x040E
(1038)

Messeinheit für den
Volumen Summenzähler
und Gesamtzähler (Inte-
gercode; siehe 
Tabelle C-32)

33 SNS_ResetMassInv UINT16 S RW 0 • 0 = No action
• 1 = Perform action

34 SNS_ResetVolInv UINT16 S RW 0 • 0 = No action
• 1 = Perform action

Integercodes für Messeinheit des MassedurchflussesTabelle C-27:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x0000 0 Keine

0x0526 1318 Gramm/Sekunde

0x0527 1319 Gramm/Minute

0x0528 1320 Gramm/Stunde

0x052A 1322 Kilogramm/Sekunde

0x052B 1323 Kilogramm/Minute

0x052C 1324 Kilogramm/Stunde

0x052D 1325 Kilogramm/Tag

0x052F 1327 Metrische Tonne/Minute

0x0530 1328 Metrische Tonne/Stunde

0x0531 1329 Metrische Tonne/Tag

0x0532 1330 Pfund/Sekunde

0x0533 1331 Pfund/Minute

0x0534 1332 Pfund/Stunde

0x0535 1333 Pfund/Tag

0x0537 1335 Short tons (2000 lbs)/Minute

0x0538 1336 Short tons (2000 lbs)/Stunde

0x0539 1337 Short tons (2000 lbs)/Tag
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Integercodes für Messeinheit des Massedurchflusses (Fortsetzung)Tabelle C-27:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x053C 1340 Long tons (2240 lbs)/Stunde

Integercodes für die Messeinheit für den Masse Summenzähler und
Gesamtzähler

Tabelle C-28:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x0000 0 Keine

0x0440 1088 Kilogramm

0x0441 1089 Gramm

0x0444 1092 Metrische Tonne

0x0446 1094 Pfund

0x0447 1095 Short tons (2000 Pfund)

0x0448 1096 Long tons (2240 Pfund)

Integercodes für TemperaturmesseinheitTabelle C-29:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x0000 0 Keine

0x03E8 1000 Grad Kelvin

0x03E9 1001 Grad Celsius

0x03EA 1002 Grad Fahrenheit

0x03EB 1003 Grad Rankine

Integercodes für DichtemesseinheitTabelle C-30:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x0000 0 Keine

0x0449 1097 Kilogramm pro Kubikmeter

0x044C 1100 Gramm pro Kubikzentimeter

0x044F 1103 Kilogramm pro Liter

0x0450 1104 Gramm pro Milliliter

0x0451 1105 Gramm pro Liter

0x0452 1106 Pfund pro Kubikzoll

0x0453 1107 Pfund pro Kubikfuß

0x0454 1108 Pfund pro US-Gallone

0x0455 1109 Short tons (2000 lbs) pro Kubikyard

0x0459 1113 Grad API

0x045A 1114 Spezifisches Gewicht
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Integercodes für Messeinheit des VolumendurchflussesTabelle C-31:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x0000 0 Keine

0x0543 1347 Kubikmeter/Sekunde

0x0544 1348 Kubikmeter/Minute

0x0545 1349 Kubikmeter/Stunde

0x0546 1350 Kubikmeter/Tag

0x0547 1351 Liter/Sekunde

0x0548 1352 Liter/Minute

0x0549 1353 Liter/Stunde

0x054B 1355 Million Liter/Tag

0x054C 1356 Kubikfuß/Sekunde

0x054D 1357 Kubikfuß/Minute

0x054E 1358 Kubikfuß/Stunde

0x054F 1359 Kubikfuß/Tag

0x0552 1362 US-Gallonen/Sekunde

0x0553 1363 US-Gallonen/Minute

0x0554 1364 US-Gallonen/Stunde

0x0555 1365 Million US-Gallonen/Tag

0x0556 1366 Imperial-Gallonen/Sekunde

0x0557 1367 Imperial-Gallonen/Minute

0x0558 1368 Imperial-Gallonen/Stunde

0x0559 1369 Imperial-Gallonen/Tag

0x055A 1370 Barrel/Sekunde

0x055B 1371 Barrel/Minute

0x055C 1372 Barrel/Stunde

0x055D 1373 Barrel/Tag

0x055E 1374 Bier Barrel/Sekunde (Bier bbl/s)

0x066A 1642 Bier Barrel/Minute (Bier bbl/min)

0x066B 1643 Bier Barrel/Stunde (Bier bbl/h)

0x066C 1644 Bier Barrel/Tag (Bier bbl/Tag)

0x066D 1645 US-Gallonen pro Tag

Integercodes für die Messeinheit für den Volumen Summenzähler und
Gesamtzähler

Tabelle C-32:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x0000 0 Keine

0x040A 1034 Kubikmeter

0x040C 1036 Kubikzentimeter

0x040E 1038 Liter
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Integercodes für die Messeinheit für den Volumen Summenzähler und
Gesamtzähler (Fortsetzung)

Tabelle C-32:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x0413 1043 Kubikfuß

0x0418 1048 US-Gallonen

0x0419 1049 Imperial-Gallonen

0x041B 1051 Barrel

0x0669 1641 Bier Barrel

Integercodes für DurchflussrichtungTabelle C-33:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x0000 0 Vorwärts

0x0002 2 Bidirektional

0x0004 4 Negieren/Vorwärts

0x0005 5 Negieren/Bidirektional

C.5.3 PROFIBUS Calibration Block (Slot 2) und relevante
Informationen
In der folgenden Tabelle:

Index Der Index des Parameters innerhalb des Blocks

Name Der für den Parameter im Block verwendete Name

Datentyp Der Datentyp des Parameters

Speicherklasse Die Speicherklasse des Parameters:

D Dynamischen Speicher (zyklische Daten, Parameter regelmäßig
aktualisiert)

S Statische Shop (azyklische Daten, Parameter verändert auf einer
vorsätzlichen Schreiben)

N Nicht-flüchtige Parameter (über Leistungszyklen gespeichert)

Zugriff Die Art des Zugriffs für den Parameter erlaubt:

RO Lesen-nur

RW Lesen / Schreiben

Standardwert Value-at-Werk konfiguriert, es sei denn, eine spezielle Konfiguration
bestellt wurde

Kommentare Eine kurze Definition der Parameter, der Name des Parameters in
ProLink II, oder eine Information über den Parameter
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Inhalt des Calibration BlockTabelle C-34:   

Index Name Datentyp
Speicher-
klasse Zugriff

Voreinges-
tellter
Wert Bemerkungen

4 SNS_FlowCalGain FLOAT S RW 1 Durchflusskalibrierfaktor
(6-Zeichen Zeichenk-
ette)

5 SNS_FlowCalTemp Coeff FLOAT S RW 5.13 Temperaturkoeffizient
für Durchfluss (4-Zei-
chen Zeichenkette)

6 SNS_FlowZeroCal UINT16 S RW N/A • 0 = Abbruch Null-
punktkalibrierung

• 1 = Start Nullpunkt-
kalibrierung

7 SNS_MaxZeroingTime UINT16 S RW 20 Nullzeit
Bereich: 5 bis
300 Sekunden

8 SNS_AutoZeroStdDev FLOAT S RO N/A Standardabweichung
der Nullpunktkalibrier-
ung

9 SNS_AutoZeroValue FLOAT S RW N/A Aktuelles Offset-Signal
des Durchflusses bei
Null-Durchfluss in µs

10 SNS_FailedCal FLOAT S RO Unter-
schiedlich

Nullpunktwert wenn Ka-
librierung fehlschlägt

11 SNS_K1Cal UINT16 S RW N/A D1 Dichtekalibrierung
starten:

• 0 = No action
• 1 = Perform action

12 SNS_K2Cal UINT16 S RW N/A D2 Dichtekalibrierung
starten:

• 0 = No action
• 1 = Perform action

13 SNS_FdCal UINT16 S RW N/A Dichtekalibrierung bei
Durchfluss starten:

• 0 = No action
• 1 = Perform action

14 SNS_TseriesD3Cal UINT16 S RW N/A D3 Dichtekalibrierung
starten:

• 0 = No action
• 1 = Perform action

15 SNS_TseriesD4Cal UINT16 S RW N/A D4 Dichtekalibrierung
starten:

• 0 = No action
• 1 = Perform action

16 SNS_K1 FLOAT S RW 1000 Dichte, Kalibrierkon-
stante 1 (µs)

17 SNS_K2 FLOAT S RW 50000 Dichte, Kalibrierkon-
stante 2 (µs)
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Inhalt des Calibration Block (Fortsetzung)Tabelle C-34:   

Index Name Datentyp
Speicher-
klasse Zugriff

Voreinges-
tellter
Wert Bemerkungen

18 SNS_FD FLOAT S RW 0 Durchflussdichte, Kali-
brierkonstante (µs)

19 SNS_TseriesK3 FLOAT S RW 0 Dichte, Kalibrierkon-
stante 3 (µs)

20 SNS_TseriesK4 FLOAT S RW 0 Dichte, Kalibrierkon-
stante 4 (µs)

21 SNS_D1 FLOAT S RW 0 Dichte von D1 Kalibrier-
medium

22 SNS_D2 FLOAT S RW 1 Dichte von D2 Kalibrier-
medium

23 SNS_CalValForFD FLOAT S RW 0 Dichte des Kalibrierme-
diums bei Durchfluss

24 SNS_TseriesD3 FLOAT S RW 0 Dichte von D3 Kalibrier-
medium

25 SNS_TseriesD4 FLOAT S RW 0 Dichte von D4 Kalibrier-
medium

26 SNS_DensityTempCoeff FLOAT S RW 4.44 Dichte Temperaturkoef-
fizient

27 SNS_TSeriesFlowTGCO FLOAT S RW 0 T-Serie FTG-Wert

28 SNS_TSeriesFlowFQCO FLOAT S RW 0 T-Serie FFQ-Wert

29 SNS_TSeriesDensTGCO FLOAT S RW 0 T-Serie DTG-Wert

30 SNS_TSeriesDensFQCO1 FLOAT S RW 0 T-Serie DFQ1-Wert

31 SNS_TSeriesDensFQCO2 FLOAT S RW 0 T-Serie DFQ2-Wert

32 SNS_TempCalOffset FLOAT S RW 0 Temperaturkalibrierung
Offset

33 SNS_TempCalSlope FLOAT S RW 1 Temperaturkalibrierung
Steigung

36 SNS_EnablePresComp ENUM S RW 0 Druckkompensation:

• 0 = Disabled
• 1 = Enabled

37 SNS_ExternalPresInput FLOAT S RW 0 Externer Druckwert

38 SNS_PressureUnits UINT16 S RW 0x0475
(1141)

Druckmesseinheit (Inte-
gercode; siehe 
Tabelle C-35)

39 SNS_FlowPresComp FLOAT S RW 0 Druck-Korrekturfaktor
für Durchfluss

40 SNS_DensPresComp FLOAT S RW 0 Druck-Korrekturfaktor
für Dichte

41 SNS_FlowCalPres FLOAT S RW 0 Durchflusskalibrierdruck
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Inhalt des Calibration Block (Fortsetzung)Tabelle C-34:   

Index Name Datentyp
Speicher-
klasse Zugriff

Voreinges-
tellter
Wert Bemerkungen

42 SNS_FlowZeroRestore UINT16 S RW N/A Werksseitigen Null-
punktwert wieder her-
stellen:

• 0 = No action
• 1 = Perform action

43 SNS_AutoZero Factory FLOAT S RO Unter-
schiedlich

Werkseinstellung für das
Durchfluss-Offset-Signal
bei Nulldurchfluss in µs

Integercodes für DruckmesseinheitTabelle C-35:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x0000 0 Keine

0x047C 1148 Zoll Wasser bei 68° Fahrenheit

0x047A 1146 Zoll Wasser bei 60° Fahrenheit

0x0484 1156 Zoll Quecksilber bei 0° Celsius

0x0482 1154 Fuß Wasser bei 68° Fahrenheit

0x047F 1151 Millimeter Wasser bei 68° Fahrenheit

0x0486 1158 Millimeter Quecksilber bei 0° Celsius

0x0475 1141 Pfund/Quadratzoll

0x0471 1137 Bar

0x0472 1138 Millibar

0x0478 1144 Gramm/Quadratzentimeter

0x0479 1145 Kilogramm/Quadratzentimeter

0x046A 1130 Pascal

0x046D 1133 Kilopascal

0x0473 1139 Torr bei 0° Celsius

0x0474 1140 Atmosphären

0x047B 1147 Zoll Wasser bei 4° Celsius

0x047E 1150 Millimeter Wasser bei 4° Celsius

0x046C 1132 Megapascal

C.5.4 PROFIBUS Diagnostic Block (Slot 3) und relevante
Informationen
In der folgenden Tabelle:

Index Der Index des Parameters innerhalb des Blocks

Name Der für den Parameter im Block verwendete Name
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Datentyp Der Datentyp des Parameters

Speicherklasse Die Speicherklasse des Parameters:

D Dynamischen Speicher (zyklische Daten, Parameter regelmäßig
aktualisiert)

S Statische Shop (azyklische Daten, Parameter verändert auf einer
vorsätzlichen Schreiben)

N Nicht-flüchtige Parameter (über Leistungszyklen gespeichert)

Zugriff Die Art des Zugriffs für den Parameter erlaubt:

RO Lesen-nur

RW Lesen / Schreiben

Standardwert Value-at-Werk konfiguriert, es sei denn, eine spezielle Konfiguration
bestellt wurde

Kommentare Eine kurze Definition der Parameter, der Name des Parameters in
ProLink II, oder eine Information über den Parameter

Inhalt des Diagnostic BlockTabelle C-36:   

Index Name Datentyp
Speicher-
klasse Zugriff

Voreinges-
tellter
Wert Bemerkungen

1 SNS_SlugDuration FLOAT S RW 1 Schwallstromdauer:
• Einheit: Sekunden
• Bereich: 0 bis

600 Sekunden

2 SNS_SlugLo FLOAT S RW 0 Unterer Schwallstromgrenz-
wert:
• Einheit: g/cm3
• Bereich: 0 bis

10 g/cm3

3 SNS_SlugHi FLOAT S RW 5 Oberer Schwallstromgrenz-
wert:
• Einheit: g/cm3
• Bereich: 0 bis

10 g/cm3

4 UNI_PCIndex UINT16 S RW 0 Erweitertes Ereignis (Bi-
närereignis) Index (x = 0,
1, 2, 3, 4)

5 SNS_PC_Action UINT16 S RW 0 Erweiterter Ereignistyp
des erweiterten
Ereignisses x (Integer-
code; siehe Tabelle C-37)

6 SNS_PC_SetPointA FLOAT S RW 1 Sollwert A für erwei-
tertes Ereignis x

7 SNS_PC_SetPointB FLOAT S RW 1 Sollwert B für erwei-
tertes Ereignis x

Einrichten und die Verwendung der PROFIBUS-Schnittstellen

Konfigurations- und Bedienungsanleitung 325



Inhalt des Diagnostic Block (Fortsetzung)Tabelle C-36:   

Index Name Datentyp
Speicher-
klasse Zugriff

Voreinges-
tellter
Wert Bemerkungen

8 SNS_PC_PVCode UINT16 S RW 0 Prozessvariable für er-
weitertes Ereignis x (In-
tegercode; siehe 
Tabelle C-38)

9 SNS_PC_Status B_ENUM D RO N/A Status des erweiterten
Ereignisses (Integer-
code; siehe Tabelle C-39)

10 SNS_StatusWords1 B_ENUM D RO N/A Siehe folgende Tabelle.

11 SNS_StatusWords2 B_ENUM D RO N/A Siehe folgende Tabelle.

12 SNS_StatusWords3 B_ENUM D RO N/A Siehe folgende Tabelle.

13 SNS_StatusWords4 B_ENUM D RO N/A Siehe folgende Tabelle.

14 SNS_StatusWords5 B_ENUM D RO N/A Siehe folgende Tabelle.

15 SNS_StatusWords6 B_ENUM D RO N/A Siehe folgende Tabelle.

16 SNS_StatusWords7 B_ENUM D RO N/A Siehe folgende Tabelle.

17 SNS_StatusWords8 B_ENUM D RO N/A Nicht verwendet

18 SYS_DigCommFault Ac-
tionCode

UINT16 S RW 0 Digitale Kommunikation Stör-
aktion (Integercode; siehe 
Tabelle C-47)

19 DB_SYS_TimeoutVa-
lueLMV

UINT16 S RW 0 Timeout für Störungen:

• Bereich: 0 bis
60 Sekunden

20 UNI_Alarm_Index UINT16 S RW 0 Alarmindex zum Konfi-
gurieren oder Lesen der
Alarmstufe oder zum
Bestätigen von Alarmen

21 SYS_AlarmSeverity UINT16 S RW 0 Alarmstufe für Alarm n (für
n, siehe Alarmindex) (In-
tegercode; siehe 
Tabelle C-48)

22 SYS_AlarmStatus B_ENUM D RW N/A Status von Alarm n (für
n, siehe Alarmindex) (In-
tegercode; siehe 
Tabelle C-49)

Zum Bestätigen des
Alarms schreiben Sie 0.

23 SYS_AlarmCount UINT16 S RO N/A Die Anzahl der inaktiv-
zu-aktiv Übergänge des
Alarms n (für n, siehe
Alarmindex)
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Inhalt des Diagnostic Block (Fortsetzung)Tabelle C-36:   

Index Name Datentyp
Speicher-
klasse Zugriff

Voreinges-
tellter
Wert Bemerkungen

24 SYS_AlarmPosted UINT32 S RO N/A Die Zeit, zu der Alarm n
gesetzt wurde, gezeigt
in Anzahl der Sekunden
seit dem letzten Zurück-
setzen der Einschaltda-
uer (Index 52) (für n,
siehe Alarmindex)

25 SYS_AlarmCleared UINT32 S RO N/A Die Zeit, zu der Alarm n
gelöscht wurde, gezeigt
in Anzahl der Sekunden
seit dem letzten Zurück-
setzen der Einschaltda-
uer (Index 52) (für n,
siehe Alarmindex)

26 UNI_AlarmHistoryIndex UINT16 S RW N/A Alarmverlaufsindex

• Bereich: 0 bis 49

27 SYS_AlarmNumber UINT16 S RO N/A Alarmzahl im Datensatz
n im Alarmverlauf (für n,
siehe Alarmverlaufsin-
dex)

28 SYS_AlarmEvent UINT16 S RO N/A Statusänderung im Da-
tensatz n im Alarmver-
lauf (für n, siehe Alarm-
verlaufsindex):

• 1 = Eingetragen
• 2 = Gelöscht

29 SYS_AlarmTime UINT32 S RO N/A Zeitstempel der Status-
änderung im Datensatz
n im Alarmverlauf (für n,
siehe Alarmverlaufsin-
dex)

30 SYS_AckAllAlarms UINT16 S RW N/A Alle Alarme bestätigen:

• 0 = No action
• 1 = Perform action

31 SYS_ClearAlarmHistory UINT16 S RW N/A Art der Statusänderung
im Datensatz n im
Alarmverlauf (für n,
siehe Alarmverlaufsin-
dex):

• 1 = Eingetragen
• 2 = Gelöscht

32 SNS_DriveGain FLOAT D RO 0 Aktuelle Antriebsverstär-
kung:

• Einheit: %
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Inhalt des Diagnostic Block (Fortsetzung)Tabelle C-36:   

Index Name Datentyp
Speicher-
klasse Zugriff

Voreinges-
tellter
Wert Bemerkungen

33 SNS_RawTubeFreq FLOAT D RO 0 Aktuelle Messrohrfre-
quenz:

• Einheit: Hz

34 SNS_LiveZeroFlow FLOAT D RO 0 Ungefilterter Wert des
Massendurchflusses:

• Einheit: Einheit konfi-
guriert für den Mas-
sendurchfluss

35 SNS_LPOamplitude FLOAT D RO 0 Spannung der linken
Aufnehmerspule:

• Einheit: Volt

36 SNS_RPOamplitude FLOAT D RO 0 Spannung der rechten
Aufnehmerspule:

• Einheit: Volt

37 SNS_BoardTemp FLOAT D RO 0 Platinentemperatur:

• Einheit: °C

38 SNS_MaxBoardTemp FLOAT D RO 0 Elektronik - max. aufge-
zeichnete Temperatur
(rücksetzbar):

• Einheit: °C

39 SNS_MinBoardTemp FLOAT D RO 0 Elektronik - min. aufge-
zeichnete Temperatur
(rücksetzbar):

• Einheit: °C

40 SNS_AveBoardTemp FLOAT D RO 0 Elektronik - aufgezeich-
nete Durchschnittstem-
peratur (nicht rücksetz-
bar):

• Einheit: °C

41 SNS_MaxSensorTemp FLOAT D RO 0 Sensor - max. aufge-
zeichnete Temperatur:

• Einheit: °C

42 SNS_MinSensorTemp FLOAT D RO 0 Sensor - min. aufge-
zeichnete Temperatur:

• Einheit: °C

43 SNS_AveSensorTemp FLOAT D RO 0 Sensor - aufgezeichnete
Durchschnittstempera-
tur:

• Einheit: °C

44 SNS_WireRTDRes FLOAT D RO 0 Widerstand des 9-adri-
gen Kabels:

• Einheit: Ohm
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Inhalt des Diagnostic Block (Fortsetzung)Tabelle C-36:   

Index Name Datentyp
Speicher-
klasse Zugriff

Voreinges-
tellter
Wert Bemerkungen

45 SNS_LineRTDRes FLOAT D RO 0 Widerstand des Wider-
standsthermometers in
der Prozessrohrleitung:

• Einheit: Ohm

46 SYS_PowerCycleCount UINT16 D RO 0 Core Prozessor/Auswer-
teelektronik Zählung
Spannungsversorgung
Ein/Aus

47 SYS_PowerOnTimeSec UINT32 D RO N/A Die Anzahl der Sekunden
seit dem letzten Zurück-
setzen der Auswertee-
lektronik (Spannungs-
versorgung Ein/Aus)

48 SNS_InputVoltage FLOAT D RO N/A Coriolis Versorgungss-
pannung (interne Mes-
sung), ~12 VDC:

• Einheit: Volt

49 SNS_TargetAmplitude FLOAT D RO N/A Amplitude, bei der die
Auswerteelektronik ver-
sucht, den Sensor zu er-
regen:

• Einheit: mV/Hz

50 SNS_CaseRTDRes FLOAT D RO N/A Sensorwiderstand Wi-
derstandsthermometer:

• Einheit: Ohm

51 SYS_RestoreFactoryCon-
fig

UINT16 S RW N/A Werkskonfiguration wie-
derherstellen:

• 0 = No action
• 1 = Perform action

52 SYS_ResetPowerOnTime UINT16 S RW N/A Einschaltzeit zurückset-
zen:

• 0 = No action
• 1 = Perform action

56 SYS_AckAlarm UINT16 S RW N/A Alarm bestätigen (Alar-
mindex schreiben, um
den Alarm zu bestäti-
gen):

(1 = A001,…, 39 = A039,
40 = A100, …, 75 =
A135, ...)

57 SNS_DriveCurrent FLOAT D RO N/A Strom, der zum Erregen
des Sensors verwendet
wird:

• Einheit: mA
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Integercodes für erweiterten EreignistypTabelle C-37:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x0000 0 HI (höher als Sollwert A)

0x0001 1 LO (niedriger als Sollwert A)

0x0002 2 IN HI/LO (zwischen Sollwert A und Sollwert B,
inklusive)

0x0003 3 OUT HI/LO (nicht zwischen Sollwert A und Sol-
lwert B, exklusive)

Integercodes für die Prozessvariable des erweiterten EreignistypsTabelle C-38:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x0000 0 Massendurchfluss

0x0001 1 Temperatur

0x0002 2 Masse Summenzähler

0x0003 3 Dichte

0x0004 4 Masse Gesamtzähler

0x0005 5 Volumendurchfluss

0x0006 6 Volumen Summenzähler

0x0007 7 Volumen Gesamtzähler

0x002E 46 Messrohrfrequenz

0x002F 47 Antriebsverstärkung

0x0030 48 Gehäusetemperatur

0x0031 49 Amplitude der linken Aufnehmerspule

0x0032 50 Amplitude der rechten Aufnehmerspule

0x0033 51 Platinentemperatur

0x0035 53 Externer Druck

0x0037 55 Externe Temperatur

0x0045 69 Nullpunktwert

0x00FB 251 Keine

Integercodes für erweiterten EreignisstatusTabelle C-39:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x0000 1 Erweitertes Ereignis 1 aktiv (Index = 0)

0x0002 2 Erweitertes Ereignis 2 aktiv (Index = 1)

0x0004 4 Erweitertes Ereignis 3 aktiv (Index = 2)

0x0008 8 Erweitertes Ereignis 4 aktiv (Index = 3)

0x0010 16 Erweitertes Ereignis 5 aktiv (Index = 4)
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Bit descriptions for STATUSWORD1Tabelle C-40:   

Hexadecimal Bit Description

0x0001 0

0x0002 1

0x0004 2

0x0008 3 No Sensor Response

0x0010 4

0x0020 5

0x0040 6 Other Failure

0x0080 7

0x0100 8

0x0200 9

0x0400 10 Sensor Simulation Active

0x0800 11

0x1000 12

0x2000 13

0x4000 14

0x8000 15 Fault

Bit descriptions for STATUSWORD2Tabelle C-41:   

Hexadecimal Bit Description

0x0001 0

0x0002 1

0x0004 2

0x0008 3

0x0010 4 Density Overrange

0x0020 5 Drive Overrange

0x0040 6 PIC/Daughterboard Communications Failure

0x0080 7

0x0100 8 EEPROM Error (Core Processor)

0x0200 9 RAM Error (Core Processor)

0x0400 10

0x0800 11 Temperature Overrange

0x1000 12 Mass Flow Rate Overrange

0x2000 13

0x4000 14 Characterization Required

0x8000 15
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Bit descriptions for STATUSWORD3Tabelle C-42:   

Hexadecimal Bit Description

0x0001 0

0x0002 1 Power Reset Occurred

0x0004 2 Transmitter Initializing/Warming Up

0x0008 3

0x0010 4

0x0020 5

0x0040 6

0x0080 7

0x0100 8 Calibration Failure

0x0200 9 Zero Calibration Failed: Low

0x0400 10 Zero Calibration Failed: High

0x0800 11 Zero Calibration Failed: Unstable

0x1000 12 Transmitter Failure

0x2000 13

0x4000 14 Calibration in Progress

0x8000 15 Slug Flow

Bit descriptions for STATUSWORD4Tabelle C-43:   

Hexadecimal Bit Description

0x0001 0

0x0002 1

0x0004 2 Sensor RTD Failure

0x0008 3 T-Series RTD Failure

0x0010 4 Reverse Flow

0x0020 5 Factory Configuration Data Is Invalid

0x0040 6

0x0080 7 Last Measured Value Override Active

0x0100 8

0x0200 9 No Flow Cal Value

0x0400 10

0x0800 11

0x1000 12 No K1 Value

0x2000 13

0x4000 14

0x8000 15
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Bit descriptions for STATUSWORD5Tabelle C-44:   

Hexadecimal Bit Description

0x0001 0

0x0002 1

0x0004 2

0x0008 3

0x0010 4 Discrete Output Status

0x0020 5

0x0040 6 Density D3 Calibration in Progress

0x0080 7 Density D4 Calibration in Progress

0x0100 8

0x0200 9

0x0400 10 Temperature Slope Calibration in Progress

0x0800 11 Temperature Offset Calibration in Progress

0x1000 12 Density FD Calibration in Progress

0x2000 13 Density D2 Calibration in Progress

0x4000 14 Density D1 Calibration in Progress

0x8000 15 Zero Calibration in Progress

Bit descriptions for STATUSWORD6Tabelle C-45:   

Hexadecimal Bit Description

0x0001 0

0x0002 1

0x0004 2

0x0008 3

0x0010 4

0x0020 5

0x0040 6

0x0080 7

0x0100 8 Enhanced Event 1 Status (index = 0)

0x0200 9 Enhanced Event 2 Status (index = 1)

0x0400 10 Enhanced Event 3 Status (index = 2)

0x0800 11 Enhanced Event 4 Status (index = 3)

0x1000 12 Enhanced Event 5 Status (index = 4)

0x2000 13

0x4000 14

0x8000 15 Incorrect Board Type
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Bit descriptions for STATUSWORD7Tabelle C-46:   

Hexadecimal Bit Description

0x0001 0 K1/FCF Combination Unrecognized

0x0002 1 Transmitter Initializing/Warming Up

0x0004 2 Low Power

0x0008 3 Right/Left Pickoff Signal

0x0010 4

0x0020 5

0x0040 6

0x0080 7

0x0100 8

0x0200 9

0x0400 10

0x0800 11

0x1000 12

0x2000 13

0x4000 14

0x8000 15

Integercodes für Digitale Kommunikation StöraktionTabelle C-47:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x0000 0 Aufwärts

0x0001 1 Abwärts

0x0002 2 Null

0x0003 3 NAN

0x0004 4 Durchfluss geht auf Null

0x0005 5 Keine

Integercodes für AlarmstufeTabelle C-48:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x0000 0 Ignorieren

0x0001 1 Informativ

0x0002 2 Störung

Integercodes für AlarmstatusTabelle C-49:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x0000 0 Bestätigt und gelöscht

0x0001 1 Aktiv und bestätigt

Einrichten und die Verwendung der PROFIBUS-Schnittstellen

334  Micro Motion® Auswerteelektronik für Masseabfüllung mit PROFIBUS-DP



Integercodes für Alarmstatus (Fortsetzung)Tabelle C-49:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x0002 2 Gelöscht und nicht bestätigt

0x0003 3 Aktiv und nicht bestätigt

C.5.5 Device Information Block (Slot 4) und relevante
Informationen
In der folgenden Tabelle:

Index Der Index des Parameters innerhalb des Blocks

Name Der für den Parameter im Block verwendete Name

Datentyp Der Datentyp des Parameters

Speicherklasse Die Speicherklasse des Parameters:

D Dynamischen Speicher (zyklische Daten, Parameter regelmäßig
aktualisiert)

S Statische Shop (azyklische Daten, Parameter verändert auf einer
vorsätzlichen Schreiben)

N Nicht-flüchtige Parameter (über Leistungszyklen gespeichert)

Zugriff Die Art des Zugriffs für den Parameter erlaubt:

RO Lesen-nur

RW Lesen / Schreiben

Standardwert Value-at-Werk konfiguriert, es sei denn, eine spezielle Konfiguration
bestellt wurde

Kommentare Eine kurze Definition der Parameter, der Name des Parameters in
ProLink II, oder eine Information über den Parameter

Inhalt des Device Information BlockTabelle C-50:   

Index Name Datentyp
Speicher-
klasse Zugriff

Voreinges-
tellter
Wert Bemerkungen

5 SYS_CEQ_Number UINT16 S RO N/A ETO-Nummer (Engineer-
ing to Order) für die Aus-
werteelektronik

6 SNS_SensorSerialNum UINT32 S RW 0 Seriennummer des Sensors:
3-Byte-Ganzzahl.

• Erstes Register:
00000000 in über-
geordnetem Byte,
erste 8 Bits des
Wertes in unter-
geordnetem Byte.

• Zweite Register:
letzte 16 Bits des
Wertes.
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Inhalt des Device Information Block (Fortsetzung)Tabelle C-50:   

Index Name Datentyp
Speicher-
klasse Zugriff

Voreinges-
tellter
Wert Bemerkungen

7 SNS_SensorType STRING S RW N/A Sensortyp

8 SNS_SensorTypeCode UINT16 S RW 0 Sensortypcode:

• 0 = Gebogenes Mess-
rohr

• 1 = Gerades Mess-
rohr

9 SNS_SensorMaterial UINT16 S RW 0x00FD
(253)

Für das Sensorgehäuse
verwendeter Werkstoff
(Integercode; siehe 
Tabelle C-51)

10 SNS_LinerMaterial UINT16 S RW 0x00FD
(253)

Für die Sensorausklei-
dung verwendeter
Werkstoff (Integercode;
siehe Tabelle C-52)

11 SNS_FlangeType UINT16 S RW 0x00FD
(253)

Sensorflanschtyp (Inte-
gercode; siehe 
Tabelle C-53)

12 SNS_MassFlowHiLim FLOAT S RO N/A Obere Massendurch-
flussgrenze des Sensors

13 SNS_TempFlowHiLim FLOAT S RO N/A Obere Temperatur-
grenze des Sensors

14 SNS_DensityHiLim FLOAT S RO N/A Obere Dichtegrenze des
Sensors

15 SNS_VolumeFlowHiLim FLOAT S RO N/A Obere Volumendurch-
flussgrenze des Sensors

16 SNS_MassFlowLoLim FLOAT S RO N/A Untere Massendurch-
flussgrenze des Sensors

17 SNS_TempFlowLoLim FLOAT S RO N/A Untere Temperatur-
grenze des Sensors

18 SNS_DensityLoLim FLOAT S RO N/A Untere Dichtegrenze des
Sensors

19 SNS_VolumeFlowLoLim FLOAT S RO N/A Untere Volumendurch-
flussgrenze des Sensors

20 SNS_MassFlowLoSpan FLOAT S RO N/A Min. Messbereich für
Massendurchfluss

21 SNS_TempFlowLoSpan FLOAT S RO N/A Min. Messbereich für
Temperatur

22 SNS_DensityLoSpan FLOAT S RO N/A Min. Messbereich für
Dichte

23 SNS_VolumeFlowLoSpan FLOAT S RO N/A Min. Messbereich für
Volumendurchfluss

24 HART_HartDeviceID UINT32 S RW N/A Seriennummer der Aus-
werteelektronik
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Inhalt des Device Information Block (Fortsetzung)Tabelle C-50:   

Index Name Datentyp
Speicher-
klasse Zugriff

Voreinges-
tellter
Wert Bemerkungen

25 SYS_SoftwareRev UINT16 S RO N/A Softwareversion der Aus-
werteelektronik (xxx.xx:
1353 = rev13.53)

26 SYS_BoardRevision UINT16 S RO N/A Versionsnummer der
Auswerteelektronik

Integercodes für SensorwerkstoffTabelle C-51:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x0003 3 Hastelloy C-22

0x0004 4 Monel

0x0005 5 Tantal

0x0006 6 Titan

0x0013 19 Edelstahl 316L

0x0017 23 Inconel

0x0032 50 Edelstahl 304

0x00FC 252 Andere

0x00FD 253 Spezial

Integercodes für SensorauskleidungswerkstoffTabelle C-52:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x000A 10 PTFE (Teflon)

0x000B 11 Halar

0x0010 16 Tefzel

0x00FB 251 Keine

0x00FC 252 Andere

0x00FD 253 Spezial

Integercodes für SensorflanschtypTabelle C-53:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x0000 0 ANSI 150

0x0001 1 ANSI 300

0x0002 2 ANSI 600

0x0005 5 PN 40

0x0007 7 JIS 10K

0x0008 8 JIS 20K

0x0009 9 ANSI 900

Einrichten und die Verwendung der PROFIBUS-Schnittstellen

Konfigurations- und Bedienungsanleitung 337



Integercodes für Sensorflanschtyp (Fortsetzung)Tabelle C-53:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x000A 10 Hygieneanschluss

0x000B 11 Verschraubung

0x000C 12 PN 100

0x00FB 251 Keine

0x00FC 252 Andere

0x00FD 253 Spezial

C.5.6 PROFIBUS Filling Block und relevante Informationen
In der folgenden Tabelle:

Index Der Index des Parameters innerhalb des Blocks

Name Der für den Parameter im Block verwendete Name

Datentyp Der Datentyp des Parameters

Speicherklasse Die Speicherklasse des Parameters:

D Dynamischen Speicher (zyklische Daten, Parameter regelmäßig
aktualisiert)

S Statische Shop (azyklische Daten, Parameter verändert auf einer
vorsätzlichen Schreiben)

N Nicht-flüchtige Parameter (über Leistungszyklen gespeichert)

Zugriff Die Art des Zugriffs für den Parameter erlaubt:

RO Lesen-nur

RW Lesen / Schreiben

Standardwert Value-at-Werk konfiguriert, es sei denn, eine spezielle Konfiguration
bestellt wurde

Kommentare Eine kurze Definition der Parameter, der Name des Parameters in
ProLink II, oder eine Information über den Parameter

Inhalt des Filling BlockTabelle C-54:   

Index Name Datentyp
Speicher-
klasse Zugriff

Voreinges-
tellter
Wert Bemerkungen

4 BAT_EnableBatch UINT16 S RW 1 Abfülloption aktivieren:

• 0 = Disabled
• 1 = Enabled

5 BAT_IncrementalFlowS-
ource

UINT16 S RW 0 Durchflussquelle:

• 0 = Massendurchfluss
• 5 = Volumendurchfluss

6 BAT_CurrentTarget FLOAT S RW 0 Abfüllungs-Sollwert
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Inhalt des Filling Block (Fortsetzung)Tabelle C-54:   

Index Name Datentyp
Speicher-
klasse Zugriff

Voreinges-
tellter
Wert Bemerkungen

7 BAT_BatchStages UINT16 S RW 1 Abfüllart:
• 1 = Einstufig
• 2 = Zweistufig

8 BAT_CountDirection UINT16 S RW 1 Hochzählen:

• 0 = Disabled
• 1 = Enabled

9 BAT_StagePercentTar-
get

UINT16 S RW 0 Konfiguration:

• 0 = % Sollwert
• 1 = Menge

10 BAT_OpenPrimary FLOAT S RW 0 Primär öffnen

11 BAT_OpenSecondary FLOAT S RW 0 Sekundär öffnen

12 BAT_ClosePrimary FLOAT S RW 100 Primär schließen

13 BAT_CloseSecondary FLOAT S RW 100 Sekundär schließen

14 BAT_MaximumBatch-
Time

FLOAT S RW 0 Max. Abfüllzeit

15 BAT_EnableTimedFill UINT16 S RW 0 Zeitgesteuerte Abfüllung akti-
vieren:

• 0 = Disabled
• 1 = Enabled

16 BAT_TargetTime FLOAT S RW 0 Sollwertzeit

17 BAT_EnableDualFill UINT16 S RW 0 Doppelabfüllung aktivieren:

• 0 = Disabled
• 1 = Enabled

18 Reserviert

19 BAT_ActualFillTimeMe-
thod

UINT16 S RW 0 Gemessene Abfüllzeit:
• 0 = Ventil schließt
• 1 = Durchfluss stoppt

20 BAT_PumpToValveDelay FLOAT S RW 10 Pumpe-zu-Ventil Verzöger-
ung

21 BAT_EnableAOC UINT16 S RW 1 AOC aktivieren:

• 0 = Disabled
• 1 = Enabled

22 BAT_AOCAlgorithm UINT16 S RW 0 AOC-Algorithmustyp:

• 0 = Unterfüllung
• 1 = Überfüllung
• 2 = Fest

23 BAT_LearningCycles UINT16 S RW 10 Breite des AOC Fensters

24 BAT_AOCChangeLimit FLOAT S RW 0 Begrenzung der in nach-
folgenden AOC-Berech-
nungen enthaltenen
AOC-Werte in Prozent.
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Inhalt des Filling Block (Fortsetzung)Tabelle C-54:   

Index Name Datentyp
Speicher-
klasse Zugriff

Voreinges-
tellter
Wert Bemerkungen

25 BAT_AOCConvergen-
ceRate

UINT16 S RW 1 Begrenzung der Rate,
mit der die AOC-Berech-
nungen konvergieren.

• 1 = Normal
• 2 = Langsam

26 BAT_FixedAOCValue FLOAT S RW 0 Feste Überfüllkomp.

27 BAT_AOC_Kave FLOAT S RW 0,2 Einheitenloser Koeffi-
zient, der von den AOC-
Algorithmen berechnet
wird. Dieser Koeffizient
wird verwendet, um die
Schließzeit des Primär-
ventils einzustellen
(oder, für zweistufige
Abfüllungen, des letzten
zu schließenden Ventils).

28 BAT_SecondaryAOCVal-
ue

FLOAT S RW 0,2 Einheitenloser Koeffi-
zient, der von den AOC-
Algorithmen berechnet
wird. Dieser Koeffizient
wird verwendet, um die
Schließzeit des Sekun-
därventils bei Abfüllvor-
gängen mit doppeltem
Füllkopf einzustellen.

29 BAT_EnableBlowout UINT16 S RW 0 Spülung aktivieren:

• 0 = Disabled
• 1 = Enabled

30 BAT_OperationMode UINT16 S RW 1 Spülmodus:

• 0 = Auto
• 1 = Manuell

31 BAT_PrimaryToSecon-
daryTime

FLOAT S RW 2 Spülverzögerung

32 BAT_SecondaryBatch-
OnTime

FLOAT S RW 1 Spülzeit

33 BAT_PrecisionDO_
Source1

UINT16 S RW 0x006E
(110)

Präzisions-BA1:

• 0x006E (110) = Pri-
märventil

34 BAT_PrecisionDO_Polar-
ity1

UINT16 S RW 1 Polarität des Präzisions-BA1:

• 0 = Active Low
• 1 = Active High

35 BAT_PrecisionDO_
Source2

UINT16 S RW 0x006F
(111)

Präzisions-BA2:

• 0x006D (109) =
Pumpe

• 0x006F (111) = Se-
kundärventil
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Inhalt des Filling Block (Fortsetzung)Tabelle C-54:   

Index Name Datentyp
Speicher-
klasse Zugriff

Voreinges-
tellter
Wert Bemerkungen

36 BAT_PrecisionDO_Polar-
ity2

UINT16 S RW 1 Polarität des Präzisions-BA2:

• 0 = Active Low
• 1 = Active High

37 BAT_EnableFillLogging UINT16 S RW 0 Abfüllprotokollierung aktivie-
ren:

• 0 = Disabled
• 1 = Enabled

38 BAT_FillLogIndex UINT16 S RW 0 Index der Datensätze im
Abfüllprotokoll

39 BAT_FillLogValue FLOAT D RO 0 Wert der Durchflussquelle
im indizierten Datensatz

40 BAT_FillStatusWord UINT16 D RO 0 Siehe Tabelle C-55.

41 BAT_FillDiagnostic-
sWord

UINT16 D RO 0 Siehe Tabelle C-56.

42 MAO_SourceSec UINT16 S RW 0 Prozessvariable des mA-
Ausgangs (Integercode;
siehe Tabelle C-57)

43 MAO_mA4VarSec FLOAT S RW −0,2 Messanfang (sekundärer
mA-Ausgang)

44 MAO_mA20VarSec FLOAT S RW 0,2 Messende (sekundärer
mA-Ausgang)

45 MAO_CutoffSec FLOAT S RW 0 Analogausgang Abschaltung
(sekundärer mA-Aus-
gang)

46 MAO_DampingSec FLOAT S RW 0 Zusätzliche Dämpfung (se-
kundärer mA-Ausgang)

47 MAO_FaultIndicationSec UINT16 S RW 1 mA-Ausgang Störaktion (se-
kundärer mA-Ausgang)
(Integercode; siehe 
Tabelle C-58)

48 MAO_FaultSettingSec FLOAT S RW 2 mA-Ausgang Störwert (se-
kundärer mA-Ausgang)

49 SYS_TimeoutValueLMV UINT16 S RW N/A Timeout für Störungen (zu-
letzt gemessener Wert
vor Timeout)

50 MAO_FixOutputSec UINT16 S RW 0 Fester mA-Ausgang (sekun-
därer mA-Ausgang):

• 0 = Disabled
• 1 = Enabled

51 MAO_FixedMilliampSec FLOAT S RW N/A mA-Ausgang fester Wert
(sekundärer mA-Aus-
gang)

52 MAO_ActualMilliampSec FLOAT S RO N/A mA-Ausgang Istwert (se-
kundärer mA-Ausgang)
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Inhalt des Filling Block (Fortsetzung)Tabelle C-54:   

Index Name Datentyp
Speicher-
klasse Zugriff

Voreinges-
tellter
Wert Bemerkungen

53 MAO_Start4mATrimSec UINT16 S RW 0 Beginn des Abgleichs
des (sekundären) mA-
Ausgangs bei 4 mA:

• 0 = No action
• 1 = Perform action

54 MAO_TrimLowSec FLOAT S RW 10835,12 Abgleichkonstante für
4 mA (sekundärer mA-
Ausgang)

55 MAO_Start20mATrim-
Sec

UINT16 S RW 0 Beginn des Abgleichs
des (sekundären) mA-
Ausgangs bei 20 mA:

• 0 = No action
• 1 = Perform action

56 MAO_TrimHighSec FLOAT S RW 54175,6 Abgleichkonstante für
20 mA (sekundärer mA-
Ausgang)

57 FO_Source UINT16 S RW 0 Frequenzausgang Prozess-
variable:

• 0 = Massendurchfluss
• 5 = Volumendurchfluss

58 FO_ScalingMethod UINT16 S RW 0 Frequenzausgang Skalier-
methode:

• 0 = Frequenz = Durch-
fluss

• 1 = Impulse pro Einheit
• 2 = Einheiten pro Impuls

59 FO_FrequencyFactor FLOAT S RW 1000 Frequenzfaktor

60 FO_FlowRateFactor FLOAT S RW 16,66667 Durchflussfaktor

61 FO_PulseWidth FLOAT S RW 0 Maximale Impulsbreite

62 FO_PulsesPerUnit FLOAT S RW 60 Impulse pro Einheit

63 FO_UnitsPerPulse FLOAT S RW 0,0166666
7

Einheiten pro Impuls

64 FO_FaultIndication UINT16 S RW 1 Frequenzausgang Störaktion
(Integercode; siehe 
Tabelle C-59)

65 FO_FaultFrequency FLOAT S RW 15000 Frequenzausgang Störwert

66 FO_Polarity UINT16 S RW 1 Frequenzausgang Polarität:
• 0 = Active Low
• 1 = Active High

67 FO_FixOutput UINT16 S RW 0 Frequenzausgang fixieren:

• 0 = Disabled
• 1 = Enabled

68 FO_FixedFrequency FLOAT S RW N/A Frequenzausgang Festwert

69 FO_ActualFrequency FLOAT D RO N/A Frequenzausgang Istwert

Einrichten und die Verwendung der PROFIBUS-Schnittstellen

342  Micro Motion® Auswerteelektronik für Masseabfüllung mit PROFIBUS-DP



Inhalt des Filling Block (Fortsetzung)Tabelle C-54:   

Index Name Datentyp
Speicher-
klasse Zugriff

Voreinges-
tellter
Wert Bemerkungen

70 DO_Source UINT16 S RW 0x00CE
(206)

BA1 Zuordnung:

• 0x0068 (104) = Stör-
anzeige

• 0x006A (106) = Ab-
füllung läuft

• 0x00CE (206) = Batch:
Spülventil

71 DO_Polarity UINT16 S RW 1 BA1 Polarität:
• 0 = Active Low
• 1 = Active High

72 DO_FaultIndication UINT16 S RW 4 Binärausgang Störaktion (In-
tegercode; siehe fol-
gende Tabelle)

73 DO_FixOutput UINT16 S RW 0 Binärausgang fixieren:

• 0 = Disabled
• 1 = Enabled

74 DO_FixedDiscrete UINT16 S RW 0 Binärausgang Festwert:
• 0 = Off
• 1 = On

75 SNS_ActionStartBatch UINT16 S RW 251 (nicht
zugewie-
sen)

Abfüllung starten dem Binä-
reingang zuweisen:

• 0 = No action
• 1 = Perform action

76 SNS_ActionEndBatch UINT16 S RW 251 (nicht
zugewie-
sen)

Abfüllung beenden dem Bi-
näreingang zuweisen:

• 0 = No action
• 1 = Perform action

77 SNS_ActionStopBatch UINT16 S RW 251 (nicht
zugewie-
sen)

Abfüllung anhalten dem Bi-
näreingang zuweisen:

• 0 = No action
• 1 = Perform action

78 SNS_ActionResume-
Batch

UINT16 S RW 251 (nicht
zugewie-
sen)

Abfüllung fortsetzen dem Bi-
näreingang zuweisen:

• 0 = No action
• 1 = Perform action

79 SNS_ActionResetMas-
sTotal

UINT16 S RW 251 (nicht
zugewie-
sen)

Massezähler zurücksetzen
dem Binäreingang zu-
weisen:

• 0 = No action
• 1 = Perform action

80 SNS_ActionResetVolTo-
tal

UINT16 S RW 251 (nicht
zugewie-
sen)

Volumenzähler zurücksetzen
dem Binäreingang zu-
weisen:

• 0 = No action
• 1 = Perform action
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Inhalt des Filling Block (Fortsetzung)Tabelle C-54:   

Index Name Datentyp
Speicher-
klasse Zugriff

Voreinges-
tellter
Wert Bemerkungen

81 SNS_ActionResetAllTo-
tals

UINT16 S RW 251 (nicht
zugewie-
sen)

Alle Zähler zurücksetzen
dem Binäreingang zu-
weisen:

• 0 = No action
• 1 = Perform action

82 DI_Polarity UINT16 S RW 0 BE1 Polarität:
• 0 = Active Low
• 1 = Active High

83 IO_ChannelB_Assign-
ment

UINT16 S RW 4 Kanal B Kanaltyp:

• 0 = Frequenzausgang
• 4 = Binärausgang
• 5 = Binäreingang

84 IO_ChannelB_Power UINT16 S RW 0 Kanal B Spannungstyp:

• 0 = Extern (passiv)

85 BAT_PrecisionDO_Ac-
tual1

UINT16 S RO N/A Präzisions-BA1 Istwert:
• 0 = Off
• 1 = On

86 BAT_PrecisionDO_Ac-
tual2

UINT16 S RO N/A Präzisions-BA2 Istwert:
• 0 = Off
• 1 = On

87 BAT_PrecisionDO_Fix-
Output1

UINT16 S RW 0 Präzisions-BA1 fixieren:

• 0 = Off
• 1 = On

88 BAT_PrecisionDO_Fix-
Value1

UINT16 S RW 0 Präzisions-BA1 Festwert:
• 0 = Off
• 1 = On

89 BAT_PrecisionDO_Fix-
Output2

UINT16 S RW 0 Präzisions-BA2 fixieren:

• 0 = Disabled
• 1 = Enabled

90 BAT_PrecisionDO_Fix-
Value2

UINT16 S RW 0 Präzisions-BA2 Festwert:
• 0 = Off
• 1 = On

91 BAT_BatchTotalAverage FLOAT D RO 0 Durchschnittliche Gesamtab-
füllung

92 BAT_BatchTotalVariance FLOAT D RO 0 Abweichung bei Gesamtab-
füllung

93 BAT_SecondaryBatchTo-
talAverage

FLOAT D RO 0 Sekundäre durchschnittliche
Gesamtabfüllung

94 BAT_SecondaryBatchTo-
talVariance

FLOAT D RO 0 Abweichung der sekundären
Gesamtabfüllung

95 BAT_ResetBatchStatis-
tics

UINT16 S RW 0 Abfüllstatistik zurücksetzen:

• 0 = No action
• 1 = Perform action
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Inhalt des Filling Block (Fortsetzung)Tabelle C-54:   

Index Name Datentyp
Speicher-
klasse Zugriff

Voreinges-
tellter
Wert Bemerkungen

96 BAT_OverrideBlocked-
Start

UINT16 S RW 0 Blockierten Start überschrei-
ben:

• 0 = No action
• 1 = Perform action

97 BAT_StartPurge UINT16 S RW 0 Spülvorgang beginnen:

• 0 = No action
• 1 = Perform action

98 BAT_StopPurge UINT16 S RW 0 Spülvorgang beenden:

• 0 = No action
• 1 = Perform action

99 BAT_StartAOCCalibra-
tion

UINT16 S RW 0 AOC-Kal beginnen:

• 0 = No action
• 1 = Perform action

100 BAT_StartSecondar-
yAOCTraining

UINT16 S RW 0 Sekundäre AOC-Kal begin-
nen:

• 0 = No action
• 1 = Perform action

101 BAT_SaveAOCCalibra-
tion

UINT16 S RW 0 AOC-Kal speichern:

• 0 = No action
• 1 = Perform action

102 BAT_SaveSecondar-
yAOCTraining

UINT16 S RW 0 Sekundäre AOC-Kal spei-
chern:

• 0 = No action
• 1 = Perform action

103 BAT_BatchCount UINT16 D RO 0 Abfüllzählung

104 BAT_ResetBatchCount UINT16 S RW 0 Abfüllzählung zurücksetzen:

• 0 = No action
• 1 = Perform action

105 BAT_PercentFill FLOAT D RO 0 Abfüllung in Prozent

106 BAT_StartFill UINT16 S RW 0 Abfüllung beginnen:

• 0 = No action
• 1 = Perform action

107 BAT_StopFill UINT16 S RW 0 Abfüllung beenden:

• 0 = No action
• 1 = Perform action

108 BAT_ResumeFill UINT16 S RW 0 Abfüllung fortsetzen:

• 0 = No action
• 1 = Perform action

109 BAT_ResetAocFlowRate UINT16 S RW 0 AOC-Durchfluss zurückset-
zen:

• 0 = No action
• 1 = Perform action
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Inhalt des Filling Block (Fortsetzung)Tabelle C-54:   

Index Name Datentyp
Speicher-
klasse Zugriff

Voreinges-
tellter
Wert Bemerkungen

110 BAT_PauseFill UINT16 S RW 0 Abfüllung anhalten:

• 0 = No action
• 1 = Perform action

111 BAT_StartClean UINT16 S RW 0 Reinigung beginnen:

• 0 = No action
• 1 = Perform action

112 BAT_StopClean UINT16 S RW 0 Reinigung beenden:

• 0 = No action
• 1 = Perform action

113 BAT_ParamUnits UINT16 D RO N/A Einheiten, die zur Mes-
sung der Abfüllung ver-
wendet werden. Wenn
Configure By auf % Target
eingestellt ist, ist die Ein-
heit %. Wenn Configure By
auf Quantity eingestellt
ist, ist die Einheit die für
die Prozessvariable
Durchflussquelle verwen-
dete Einheit. Siehe 
Tabelle C-61.

114 BAT_ResetBatch UINT16 S RW 0 Abfüllzähler zurücksetzen:

• 0 = No action
• 1 = Perform action

115 BAT_StartSecondaryFill UINT16 S RW 0 Sekundäre Abfüllung starten:

• 0 = No action
• 1 = Perform action

116 BAT_StopSecondaryFill UINT16 S RW 0 Sekundäre Abfüllung been-
den:

• 0 = No action
• 1 = Perform action

117 BAT_CurrentTotal FLOAT D RO 0 Aktueller Zählerstand

118 BAT_BatchFillTime FLOAT D RO 0 Abfüllzeit

119 BAT_RotarySwitchSet-
ting

UINT16 S RO 0 Netzwerkknoten-
Adresse (Netzwerka-
dresse) der Auswertee-
lektronik

120 IO_ChannelC_Assign-
ment

UINT16 S RW 3 Kanal C Kanaltyp:

• 3 = (Sekundärer) mA-
Ausgang

121 IO_ChannelC_Power UINT16 S RW 1 Kanal C Spannungstyp:

• 1 = Intern (aktiv)

Einrichten und die Verwendung der PROFIBUS-Schnittstellen

346  Micro Motion® Auswerteelektronik für Masseabfüllung mit PROFIBUS-DP



Bit-Definitionen für AbfüllstatuswortTabelle C-55:   

Hexadezimal Bit Beschreibung

0x0001 0 Primärabfüllung läuft

0x0002 1 Sekundärabfüllung läuft

0x0004 2 Spülverzögerung läuft

0x0008 3 Spülvorgang läuft

0x0010 4 Reinigung läuft

0x0020 5 Primärventil offen

0x0040 6 Sekundärventil offen

0x0080 7 Spülventil offen

0x0100 8 Pumpe läuft

0x0200 9 Primäre AOC-Kalibrierung läuft

0x0400 10 Sekundäre AOC-Kalibrierung läuft

0x0800 11 Abfüllung mit doppeltem Füllkopf aktiviert

0x1000 12 Zeitgesteuerte Abfüllung aktiviert

0x2000 13 Reserviert

0x4000 14 Abfüllprotokollierung läuft

0x8000 15 Nicht definiert

Bit-Definitionen für AbfüllungsdiagnosewortTabelle C-56:   

Bit (hexadezimal) Bit (Nr.) Beschreibung

0x0001 0 Start nicht in Ordnung

0x0002 1 AOC-Durchfluss zu hoch

0x0004 2 Max. Abfüllzeit überschritten

0x0008 3 Schwallströmung

0x0010 4 Keine Antwort vom Sensor

0x0020 5 Antrieb Bereichsüberschreitung

0x0040 6 Sensor Fehler

0x0080 7 Auswerteelektronik Fehler

0x0100 8 Dichte Bereichsüberschreitung

0x0200 9 Temperatur Bereichsüberschreitung

0x0400 10 PROFIBUS Adresse Bereichsüberschreitung

0x0800 11 Nicht definiert

0x1000 12 Nicht definiert

0x2000 13 Nicht definiert

0x4000 14 Nicht definiert

0x8000 15 Nicht definiert
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Integercodes für Prozessvariable des mA-AusgangsTabelle C-57:   

Code (hexadezi-
mal) Code (dezimal) Beschreibung

0x0000 0 Massedurchfluss

0x0001 1 Temperatur

0x0002 2 Masse Summenzähler

0x0003 3 Dichte

0x0004 4 Masse Gesamtzähler

0x0005 5 Volumendurchfluss

0x0006 6 Volumen Summenzähler

0x0007 7 Volumen Gesamtzähler

0x000F 15 API: temperaturkorrigierte Dichte

0x0010 16 API: temperaturkorrigierter (Standard) Volumendurchfluss

0x0011 17 API: temperaturkorrigierter (Standard) Volumen Summen-
zähler

0x0012 18 API: temperaturkorrigierter (Standard) Volumen Gesamt-
zähler

0x0013 19 API: Batch gewichtete Durchschnittsdichte

0x0014 20 API: Batch gewichtete Durchschnittstemperatur

0x0015 21 Erweiterte Dichte: Dichte bei Referenztemperatur

0x0016 22 Erweiterte Dichte: Dichte (feste SG-Einheiten)

0x0017 23 Erweiterte Dichte: Standard Volumendurchfluss

0x0018 24 Erweiterte Dichte: Standardvolumen Summenzähler

0x0019 25 Erweiterte Dichte: Standardvolumen Gesamtzähler

0x001A 26 Erweiterte Dichte: Netto Massendurchfluss

0x001B 27 Erweiterte Dichte: Nettommasse Summenzähler

0x001C 28 Erweiterte Dichte: Nettomasse Gesamtzähler

0x001D 29 Erweiterte Dichte: Netto Volumendurchfluss

0x001E 30 Erweiterte Dichte: Nettovolumen Summenzähler

0x001F 31 Erweiterte Dichte: Nettovolumen Gesamtzähler

0x0020 32 Erweiterte Dichte: Konzentration

0x0021 33 API: CTL

0x002E 46 Messrohrfrequenz

0x002F 47 Antriebsverstärkung

0x0030 48 Gehäusetemperatur

0x0031 49 Amplitude linke Aufnehmerspule

0x0032 50 Amplitude rechte Aufnehmerspule

0x0033 51 Platinentemperatur

0x0035 53 Externer Druck

0x0037 55 Externe Temperatur

0x003F 63 Gas Standard Volumendurchfluss

0x0040 64 Gas Standardvolumen Summenzähler
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Integercodes für Prozessvariable des mA-Ausgangs (Fortsetzung)Tabelle C-57:   

Code (hexadezi-
mal) Code (dezimal) Beschreibung

0x0041 65 Gas Standardvolumen Gesamtzähler

0x0045 69 Nullpunktwert

0x00FB 251 Keine

Integercodes für mA-Ausgang Störaktion Tabelle C-58:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x0000 0 Aufwärts

0x0001 1 Abwärts

0x0003 3 Intern Null

0x0004 4 Keine Störaktion

Integercodes für Frequenzausgang Störaktion Tabelle C-59:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x0000 0 Aufwärts

0x0001 1 Abwärts

0x0003 3 Intern Null

0x0004 4 Keine Störaktion

Integercodes für Binärausgang Störaktion Tabelle C-60:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x0000 0 Aufwärts

0x0001 1 Abwärts

0x0004 4 Keine Störaktion

Integercodes für AbfüllungsmesseinheitenTabelle C-61:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x0039 57 In Prozent

0x003C 60 Gramm

0x003D 61 Kilogramm

0x003E 62 Metrische Tonne

0x003F 63 Pfund

0x0040 64 Short tons (2000 Pfund)

0x0041 65 Long tons (2240 Pfund)

0x0028 40 Gallonen

0x0029 41 Liter
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Integercodes für Abfüllungsmesseinheiten (Fortsetzung)Tabelle C-61:   

Code (hexadezimal) Code (dezimal) Beschreibung

0x002A 42 Imperial Gallonen

0x002B 43 Kubikmeter

0x002E 46 Barrel

0x0070 112 Kubikfuß

0x00AA 170 Bier Barrel

C.5.7 PROFIBUS Identification and Maintenance Function
Block
In der folgenden Tabelle:

Index Der Index des Parameters innerhalb des Blocks

Name Der für den Parameter im Block verwendete Name

Datentyp Der Datentyp des Parameters

Speicherklasse Die Speicherklasse des Parameters:

D Dynamischen Speicher (zyklische Daten, Parameter regelmäßig
aktualisiert)

S Statische Shop (azyklische Daten, Parameter verändert auf einer
vorsätzlichen Schreiben)

N Nicht-flüchtige Parameter (über Leistungszyklen gespeichert)

Zugriff Die Art des Zugriffs für den Parameter erlaubt:

RO Lesen-nur

RW Lesen / Schreiben

Standardwert Value-at-Werk konfiguriert, es sei denn, eine spezielle Konfiguration
bestellt wurde

Kommentare Eine kurze Definition der Parameter, der Name des Parameters in
ProLink II, oder eine Information über den Parameter

Inhalt des I&M Function BlockTabelle C-62:   

Index Kategorie Name Datentyp Größe

Spei-
cher-
klasse Zugriff

Vorein-
gestell-
ter
Wert

Beschrei-
bung

255 I&M0 HEADER STRING 10 S RO 0x20
0x20
0x20
0x20
0x20
0x20
0x20
0x20

Hersteller-
spezifischer
String
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Inhalt des I&M Function Block (Fortsetzung)Tabelle C-62:   

Index Kategorie Name Datentyp Größe

Spei-
cher-
klasse Zugriff

Vorein-
gestell-
ter
Wert

Beschrei-
bung

MANUFACTURER_
ID

UINT16 2 S RO 0x001F Hersteller-
kennung, zu-
geordnet
nach PTO

ORDER_ID STRING 20 S RO Auswerte-
elektronik
für Masse
abfüllung

Auftrags-
nummer des
Gerätes

SERIAL_NO STRING 16 S RO Unter-
schied-
lich

Produktions-
Seriennum-
mer des Ger-
ätes

HARDWARE_REVI-
SION

UINT16 2 S RO 0 Versions-
nummer der
Hardware

SOFTWARE_REVI-
SION

• Oktett 1
= STRING

• Oktett 2
= UINT8

• Oktett 3
= UINT8

• Oktett 4
= UINT8

4 Ok-
tetts

S RO Typerken-
nung

REV_COUNTER UINT16 2 S RO 0 Kennzeich-
net die Än-
derung der
Hardware-
version oder
ihrer Parame-
ter

PROFILE_ID UINT16 2 S RO 0xF600 Profiltyp des
unterstüt-
zenden Pro-
fils

PROFILE_SPECIF-
IC_TYPE

UINT16 2 S RO 0xF600 Spezieller
Profiltyp

IM_VERSION_0 UINT8 1 S RO 11 Implemen-
tierte Version
der I&M0-
Funktionen

IM_VERSION_1 UINT8 1 S RO 11 Implemen-
tierte Version
der I&M1-
Funktionen
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Inhalt des I&M Function Block (Fortsetzung)Tabelle C-62:   

Index Kategorie Name Datentyp Größe

Spei-
cher-
klasse Zugriff

Vorein-
gestell-
ter
Wert

Beschrei-
bung

IM_SUPPORTED UINT16 (1) 2 S RO 0x0003 Angezeigte
Verfügbar-
keit der I&M-
Funktionen

15 I&M1 HEADER STRING 10 S RO 0x20
0x20
0x20
0x20
0x20
0x20
0x20
0x20

Hersteller-
spezifischer
String

16 TAG_FUNCTION STRING 32 S RW Gerätekenn-
zeichnung

17 TAG_LOCATION STRING 32 S RW Geräteort-
Kennzeich-
nung

(1) Implementiert als Bit-Array.
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Index

A
Abfrage

Druck
mit ProLink II   196

mit ProLink III   197

Abfüllstatistik
mittels ProLink II   65

Abfüllsteuerung
Konfigurieren des Binäreingangs

mittels ProLink II   46

Konfigurieren eines Ereignisses
mittels ProLink II   48

Abfüllungen mit doppeltem Füllkopf
Definition   2

Abfüllungen mit doppeltem Füllkopf, zeitgesteuert
Definition   2

Abfüllungen mit externer Ventilsteuerung
Betrieb   166, 168, 171

Definition   2
Abfüllungen mit integrierter Ventilsteuerung

Betrieb
mittels ProLink II   54

Definition   2
Abfüllungs-Konfiguration

Siehe auch Abfüllsteuerung
Siehe auch Abfüllungsberichte

Abfüllungsanalyse
Abfüllstatistik

mittels ProLink II   65

Abfüllungsprotokollierung
mittels ProLink II   64

Abfüllungsberichte
Konfigurieren des Binärausgangs

mittels ProLink II   52

Konfigurieren des mA-Ausgangs
mittels ProLink II   53

Abfüllungskonfiguration
Siehe auch Abfüllungsoptionen

Abfüllungsoptionen
Konfigurieren der Automatischen

Überfüllkompensation
mit PROFIBUS EDD   84

Konfigurieren der Pumpfunktion
mit ProLink II   45

Konfigurieren der Spülfunktion
mit PROFIBUS EDD   89, 90

mit ProLink II   43

Abfüllungsoptionens
Konfigurieren der Automatischen

Überfüllkompensation
mit ProLink II   39

Abfüllungsprotokollierung
mittels ProLink II   64

Abfüllverfahren
Abfüllungen mit externer Ventilsteuerung   166, 168,

171

Abfüllungen mit integrierter Ventilsteuerung
mittels ProLink II   54

Abgleichen, siehe mA-Ausgänge, abgleichen
Abschaltungen

Anwendung Füllungen
Massedurchfluss   178

Volumendurchfluss   183

Dichte   193

Massedurchfluss   179

Störungsanalyse und -beseitigung   280

Volumendurchfluss   184

acyclic communications, siehe PROFIBUS-DP
address

node address   13, 14, 16

Alarme
Alarmcodes   256

Antwort der Auswerteelektronik   236

Anzeigen und Quittieren
unter Verwendung der PROFIBUS EDD   235

unter Verwendung der PROFIBUS-
Busparameter   235

unter Verwendung von ProLink II   234

unter Verwendung von ProLink III   234

Konfigurieren der Alarmbehandlung   200

Status Alarmstufe
Konfigurieren   201

Optionen   202

Störungsanalyse und -beseitigung   256

Alarmmeldungen, siehe Alarme
Analogausgang Abschaltung   212

Antriebsverstärkung
Daten sammeln   283

Störungsanalyse und -beseitigung   281, 282

AOC, siehe Automatic Overshoot Compensation (AOC)
AOC calibration

Siehe auch Automatic Overshoot Compensation
(AOC)

rolling
using PROFIBUS bus parameters   137

standard
using PROFIBUS bus parameters   135

types   135

Index
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AOC-Kalibrierung
Siehe auch Automatische Überfüllkompensation

(AOC)
laufend

mit PROFIBUS EDD   88

Standard
mit PROFIBUS EDD   86

mit ProLink II   41, 42

Typen   40, 86

Aufnehmer
Daten sammeln   284

Störungsanalyse und -beseitigung   283

Auswerteelektronik-Modellcodes
und unterstützte Befüllarten   2
und unterstützte Protokolle   5

Automatic Overshoot Compensation (AOC)
configuring

using PROFIBUS bus parameters   133

types   133

Automatische Überfüllkompensation (AOC)
Definition   3
konfigurieren

mit PROFIBUS EDD   84

mit ProLink II   39

Typen   39, 84

B
Befüllarten   2
Befüllungen mit externer Ventilregelung

Konfigurieren
unter Verwendung der PROFIBUS EDD   167

unter Verwendung der PROFIBUS-
Busparameter   169

unter Verwendung von ProLink II   165

Befüllungen mit integrierter Ventilregelung
Konfigurieren

unter Verwendung der PROFIBUS-
Busparameter   113

unter Verwendung von Modbus   67

unter Verwendung von ProLink II   22

Befüllungskonfiguration
Befüllungen mit externer Ventilregelung

unter Verwendung der PROFIBUS EDD   167

unter Verwendung der PROFIBUS-
Busparameter   169

unter Verwendung von ProLink II   165

Befüllungen mit integrierter Ventilregelung
unter Verwendung der PROFIBUS-

Busparameter   113

unter Verwendung von Modbus   67

unter Verwendung von ProLink II   22

duale Füllhöhen
unter Verwendung der PROFIBUS EDD   78

unter Verwendung der PROFIBUS-
Busparameter   126

unter Verwendung von ProLink II   33

einstufige Befüllungen
unter Verwendung der PROFIBUS EDD   67

unter Verwendung von Modbus   113

unter Verwendung von ProLink II   22

Standardwerte   21

zeitgesteuerte Befüllung mit zwei Füllhöhen
unter Verwendung der PROFIBUS EDD   82

unter Verwendung der PROFIBUS-
Busparameter   130

unter Verwendung von ProLink II   36

zeitgesteuerte Befüllungen
unter Verwendung der PROFIBUS EDD   76

unter Verwendung der PROFIBUS-
Busparameter   123

unter Verwendung von ProLink II   31

zweistufige Befüllungen
unter Verwendung der PROFIBUS EDD   70

unter Verwendung der PROFIBUS-
Busparameter   117

unter Verwendung von ProLink II   25

Benutzerschnittstellen
für Aufgaben   5
von der Auswerteelektronik unterstützte   5

Bestände
Starten und Stoppen   237

Zurücksetzen   238

Binärausgänge
Konfigurieren der Abfüllungsberichte

mittels ProLink II   52

Messkreistest
unter Verwendung der PROFIBUS EDD   272

unter Verwendung der PROFIBUS-
Busparameter   274

unter Verwendung von ProLink II   269

unter Verwendung von ProLink III   270

Binäreingänge
Konfigurieren der Abfüllsteuerung

mittels ProLink II   46

Messkreistest
unter Verwendung von ProLink II   269

unter Verwendung von ProLink III   270

bus parameters, siehe PROFIBUS-DP

C
Calibration block, siehe PROFIBUS-DP
channel configuration   208

Charakterisierung
Dichteparameter   175

Durchflusskalibrierparameter   175

Parameter für Sensor-Tags   174

Verfahren   173

CIP, siehe Clean In Place

Index
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Clean In Place
mittels ProLink II   63

using PROFIBUS bus parameters   161

using the PROFIBUS EDD   110

communications, siehe digital communications
configuration

channel   208

digital communications   229

discrete inputs   224

discrete outputs   220

events
enhanced   227

frequency outputs   215

mA outputs   209

cutoffs
AO cutoff   212

interaction between AO Cutoff and process variable
cutoffs   212

cyclic communications, siehe PROFIBUS-DP

D
Dämpfung

Dichtedämpfung   192

Durchflussdämpfung   177

Temperaturdämpfung   195

damping
Added Damping   213

interaction between Added Damping and process
variable damping   213

on mA outputs   213

Datum   205

Deskriptor   204

Device Information block, siehe PROFIBUS-DP
Diagnose

Messkreistest
unter Verwendung von ProLink II   269

unter Verwendung von ProLink III   270

Sensorsimulation   8
Diagnostic block, siehe PROFIBUS-DP
Dichtefaktor, siehe Druckkompensation
Dichtekalibrierung, siehe Kalibrierung, Dichte
Dichtemessung

Abschaltung
Konfiguration   193

Wirkung auf Volumendurchflussmessung   194

Dämpfung
Wechselwirkung mit zusätzlicher

Dämpfung   193

Wirkung auf Volumendurchflussmessung   193

Konfiguration   189

Messeinheiten
Konfiguration   189

Optionen   190

Schwallströmung
Konfiguration   190

Störungsanalyse und -beseitigung   281

Verhalten der Auswerteelektronik   192

Störungsanalyse und -beseitigung   263

Systemfaktor   246

digital communications
Digital Communications Fault Action

configuring   229

options   229

Digitale Kommunikation Störaktion   229

discrete inputs
actions

configuring   224

options   225

configuring   224

configuring for fill control
using PROFIBUS bus parameters   141

using the PROFIBUS EDD   92

polarity
configuring   226

options   226

discrete outputs
configuring   220

configuring for fill reporting
using PROFIBUS bus parameters   148

using the PROFIBUS EDD   97

Fault Action
configuring   222

options   223

fault indication   223

polarity
configuring   222

options   222

source
configuring   221

options   221

DP-V0 services, siehe PROFIBUS-DP
DP-V1 services, siehe PROFIBUS-DP
Druckkompensation

Druckmesseinheiten
Optionen   199

Konfiguration
mit ProLink II   196

mit ProLink III   197

Übersicht   196

duale Füllhöhen
Konfigurieren

unter Verwendung der PROFIBUS EDD   78

unter Verwendung der PROFIBUS-
Busparameter   126

unter Verwendung von ProLink II   33

Durchflussdämpfung
Konfiguration   177

Wechselwirkung mit zusätzlicher Dämpfung   178

Wirkung auf Volumendurchflussmessung   178

Durchflussfaktor   196, 217, siehe Druckkompensation

Index
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Durchflussrichtung
Auswirkung auf Gesamtbefüllung (Befüllungen mit

integrierter Ventilregelung)   188

Konfiguration   185

Optionen   186

Störungsanalyse und -beseitigung   280

Wirkung auf Binärausgänge   187

Wirkung auf digitale Kommunikation   188

Wirkung auf Frequenzausgänge   187

Wirkung auf mA-Ausgänge   186

Wirkung auf Zähler und Bestände   188

E
EDD, siehe PROFIBUS-DP
Einheit, siehe Messeinheiten
einstufige Befüllungen

Konfigurieren
unter Verwendung der PROFIBUS EDD   67

unter Verwendung von Modbus   113

unter Verwendung von ProLink II   22

einstufige diskrete Abfüllungen
Definition   2

enhanced events, siehe events
Erdung

Störungsanalyse und -beseitigung   269

Ereignisse
Konfigurieren der Abfüllsteuerung

mittels ProLink II   48

events
configuring enhanced events   227

configuring for fill control
using PROFIBUS bus parameters   143

using the PROFIBUS EDD   93

Enhanced Event Action
configuring   227

options   228

F
Fault Action

digital communications   229

discrete outputs   222

frequency outputs   219

mA outputs   214

Fehler-Zeitüberschreitung
Auswirkung auf Störaktion   200

Konfigurieren   200

feste AOC, siehe Automatische Überfüllkompensation
(AOC)

fill analysis
fill logging

using PROFIBUS bus parameters   161

using the PROFIBUS EDD   110

fill statistics
using PROFIBUS bus parameters   162

using the PROFIBUS EDD   111

fill configuration
Siehe auch fill control
Siehe auch fill options
Siehe auch fill reporting

fill control
configuring an event for

using PROFIBUS bus parameters   143

using the PROFIBUS EDD   93

configuring the discrete input for
using PROFIBUS bus parameters   141

using the PROFIBUS EDD   92

fill logging
using PROFIBUS bus parameters   161

using the PROFIBUS EDD   110

fill operation
integrated-valve-control fills

using PROFIBUS bus parameters   151

using the PROFIBUS EDD   100

fill options
configuring Automatic Overshoot Compensation

using PROFIBUS bus parameters   133

configuring the Pump feature
using PROFIBUS bus parameters   140

configuring the Purge feature
using PROFIBUS bus parameters   138

fill reporting
configuring the discrete output for

using PROFIBUS bus parameters   148

using the PROFIBUS EDD   97

configuring the mA output for
using PROFIBUS bus parameters   149

using the PROFIBUS EDD   98

fill statistics
using PROFIBUS bus parameters   162

using the PROFIBUS EDD   111

Filling Block, siehe PROFIBUS-DP
fixed AOC, siehe Automatic Overshoot Compensation

(AOC)
frequency outputs

configuring   215

Fault Action
configuring   219

options   220

maximum pulse width   218

polarity
configuring   216

options   216

scaling method
configuring   216

Frequency = Flow   217

Frequenzausgänge
Konfiguration für Befüllungen mit externer

Ventilregelung
unter Verwendung der PROFIBUS EDD   167
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unter Verwendung der PROFIBUS-
Busparameter   169

unter Verwendung von ProLink II   165

Messkreistest
unter Verwendung der PROFIBUS EDD   272

unter Verwendung der PROFIBUS-
Busparameter   274

unter Verwendung von ProLink II   269

unter Verwendung von ProLink III   270

Störungsanalyse und -beseitigung   267, 279, 280

Frequenzfaktor   217

G
GSD, siehe PROFIBUS-DP

H
Hochfrequenzstörungen (HFS)   279

I
I&M block, siehe PROFIBUS-DP
Informationsparameter   204

input modules, siehe PROFIBUS-DP
integrated-valve-control fills

operation
using PROFIBUS bus parameters   151

using the PROFIBUS EDD   100

K
Kalibrierdruck, siehe Druckkompensation
Kalibrierparameter, siehe Charakterisierung
Kalibrierung

Dichte D1 und D2
Übersicht   248

unter Verwendung der PROFIBUS EDD   251

unter Verwendung der PROFIBUS-
Busparameter   252

unter Verwendung von ProLink II   249

unter Verwendung von ProLink III   250

mA-Ausgänge, siehe mA-Ausgänge, abgleichen
Temperatur

unter Verwendung von ProLink II   253

unter Verwendung von ProLink III   254

Konfiguration
Siehe auch Befüllungskonfiguration
Dichtemessung   189

Druckkompensation, siehe Druckkompensation
Informationsparameter   204

Massedurchflussmessung   176

Sichern   10

Standardwerte
Befüllungen mit integrierter Ventilsteuerung   21

Standard-Auswerteelektronik-Parameter   286

Temperaturmessung   194

Volumendurchflussmessung   181

Werkseinstellungen wiederherstellen
unter Verwendung der PROFIBUS-

Busparameter   17

unter Verwendung von ProLink II   11

unter Verwendung von ProLink III   11

Konfiguriert von
Auswirkungen auf zweistufige Befüllungen   30, 75,

123

Kundenservice
Kontakt   ii

Kurzschlüsse
Störungsanalyse und -beseitigung   284

L
laufende AOC-Kalibrierung, siehe AOC-Kalibrierung
Letzter Messwert - Zeitüberschreitung, siehe Fehler-

Zeitüberschreitung
logging

Siehe auch fill logging
Lower Range Value (LRV)   210

Luftkalibrierung, siehe Kalibrierung, Dichte

M
mA outputs

Added Damping
configuring   213

interaction with flow damping   178

AO cutoff
configuring   212

configuring   209

configuring for fill reporting
using PROFIBUS bus parameters   149

using the PROFIBUS EDD   98

Fault Action
configuring   214

options   214

Lower Range Value and Upper Range Value
configuring   210

default values   211

process variable
configuring   209

options   210

scaling   210

mA-Ausgänge
Abgleichen

unter Verwendung der PROFIBUS EDD   277

unter Verwendung der PROFIBUS-
Busparameter   277

unter Verwendung von ProLink II   276

unter Verwendung von ProLink III   277

AO-Abschaltung
Wechselwirkung mit

Volumendurchflussabschaltung   184

Konfigurieren der Abfüllungsberichte
mittels ProLink II   53
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Konfigurations- und Bedienungsanleitung 357



Messkreistest
unter Verwendung der PROFIBUS EDD   272

unter Verwendung der PROFIBUS-
Busparameter   274

unter Verwendung von ProLink II   269

unter Verwendung von ProLink III   270

Störungsanalyse und -beseitigung   265, 278, 279

Zusätzliche Dämpfung
Wechselwirkung mit Dichtedämpfung   193

Massedurchflussmessung
Abschaltung

Konfiguration   179

Konfiguration für Anwendung Füllungen   178

Wechselwirkung mit AO-Abschaltung   180

Wirkung auf Volumendurchflussmessung   180

Durchflussdämpfung   177

Konfiguration   176

Messeinheiten
Konfiguration   176

Optionen   176

Störungsanalyse und -beseitigung   261

Massendurchflussmessung
Systemfaktor   246

Maximum Pulse Width   218

Measurement block, siehe PROFIBUS-DP
Meldung   205

menu maps
PROFIBUS-DP EDD   297

Menüstruktur
ProLink II   291

Messeinheiten
Dichte

Konfiguration   189, 192

Optionen   190

Druck, siehe Druckkompensation
Massedurchfluss

Konfiguration   176

Optionen   176

Temperatur
Konfiguration   194

Optionen   194

Volumendurchfluss
Konfiguration   181

Optionen   182

Messkreistest
unter Verwendung der PROFIBUS EDD   272

unter Verwendung der PROFIBUS-Busparameter   274

unter Verwendung von ProLink II   269

unter Verwendung von ProLink III   270

Mitgeführtes Gas, siehe Dichtemessung,
Schwallströmung

Modbus
Auswerteelektronik-Modellcode   5
ProLink-II-Verbindungen   7

Modellcodes, siehe Auswerteelektronik-Modellcodes

N
network address, siehe node address
node address   304, 315

Null
Null-Werkseinstellung wiederherstellen

unter Verwendung der PROFIBUS EDD   243

unter Verwendung der PROFIBUS-
Busparameter   244

unter Verwendung von ProLink II   240

unter Verwendung von ProLink III   242

Prozedur
unter Verwendung der PROFIBUS EDD   243

unter Verwendung der PROFIBUS-
Busparameter   244

unter Verwendung von ProLink II   240

unter Verwendung von ProLink III   242

Vorherige Null wiederherstellen
unter Verwendung von ProLink II   240

unter Verwendung von ProLink III   242

O
output modules, siehe PROFIBUS-DP

P
Pause und Fortfahren

Auswirkungen auf zweistufige diskrete
Abfüllungen   57, 58, 60, 61, 103, 104, 106, 107,

154, 155, 157, 158

polarity
discrete inputs   226

discrete outputs   222

frequency outputs   216

PROFIBUS-DP
Auswerteelektonik-Modellcodes   5
bus parameters

Calibration block   321

datatypes   315

Device Information block   335

Diagnostic block   324

Filling Block   338

I&M block   350

Measurement block   316

Busparameter
Verbindung mit der Auswerteelektronik   14, 16

diagnostic bytes   310

EDD
menu maps   297

setting up   13

GSD
input modules   305

output modules   309

setting up   304

supported functionality   296
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ProLink II
Anforderungen   290

Menüstruktur   291

Übersicht   290, 291

Verbinden
Modbus/RS-485   7
Service Port   7

Protokolle
unterstützte Benutzerschnittstellen   5
von der Auswerteelektronik unterstützte   5

Protokollierung
Siehe auch Abfüllungsprotokollierung

Prozessvariablen
Siehe auch Dichtemessung
Siehe auch Massedurchflussmessung
Siehe auch Temperaturmessung
Siehe auch Volumendurchflussmessung
Werte anzeigen   233

Werte aufzeichnen   232

Prüfen, siehe Systemvalidierung
pulse width   218

Pump feature
configuring

using PROFIBUS bus parameters   140

Pumpfunktion
Definition   3
konfigurieren

mit PROFIBUS EDD   90

mit ProLink II   45

Purge feature
configuring

using PROFIBUS bus parameters   138

performing purge
using PROFIBUS bus parameters   160

using the PROFIBUS EDD   109

R
rolling AOC calibration, siehe AOC calibration

S
scaling

frequency outputs   216

mA outputs   210

Schwallströmung, siehe Dichtemessung,
Schwallströmung

Sensor Material   206

Sensor Serial Number   206

Sensor-Auskleidungswerkstoff   207

Sensor-Flanschtyp   207

Sensor-Simulationsmodus
unter Verwendung von ProLink II   8
unter Verwendung von ProLink III   8

Sensorsimulation
Störungsanalyse und -beseitigung   267

Übersicht   10

Sensorspulen
Störungsanalyse und -beseitigung   284

Service Port
ProLink-II-Verbindungen   7

Sicherungen   10

Simulation
Sensorsimulation

unter Verwendung von ProLink II   8
unter Verwendung von ProLink III   8

Spülfunktion
Definition   3
konfigurieren

mit PROFIBUS EDD   89

mit ProLink II   43

Spülvorgang durchführen
mittels ProLink II   63

standard AOC calibration, siehe AOC calibration
Standard-AOC-Kalibrierung, siehe AOC-Kalibrierung
Standardwerte

Befüllungen mit integrierter Ventilsteuerung   21

Standard-Auswerteelektronik-Parameter   286

Statusalarme, siehe Alarme
Störaktion

beeinflusst von Fehler-Zeitüberschreitung   200

Störungsanalyse und -beseitigung
Abfüllung kann nicht abgeschlossen werden

mittels ProLink II   56

Abfüllung startet nicht
mittels ProLink II   56

Alarme   256

Antriebsverstärkung   281, 282

Aufnehmerspannung   283

Binärausgänge   279, 280

Dichtemessung   280, 281

Erdung   269
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